Introduction Symbols

. Multi Selector ‘

Thank you for purchasing the V302SH.

«For proper handset use, read this manual Use Multi Selector to select menu items, move cursor, scroll, etc.
beforehand. !n this manual, Multi Selectpr operations are . @
eFor instructions on how to use Vodafone live!, see indicated as shown to the right. s
Vodafone live! manual. Basic Multi Selector Operations — A
e Keep this manual in a convenient place for m(®): Press ® or (9
reference. m 09: Press ) or
* Accessible Vodafone services may vary by service = <l3: Press (9, (), ©) or (&
area, subscription, etc. . Side Key

. . . . Use Side Key to activate specified functions with
V302SH transmits at 1.5 GHz and is compatible with handset closed or to release shutter. In this manual,

the Vodafone K.K. network. Side Key is indicated as shown to the right.
This product is exclusively for use in Japan. "S" is not inscribed on the actual Shutter Key.

Note

¢ Copying this manual in whole or part without
authorization is prohibited.

eManual content is subject to change without prior
notice.

¢ Efforts have been made to ensure the accuracy and
v @ ¢ |n this manual, most operations are described with handset open.

CIa"t_y of this manual. Ple_ase contact Customer « Sample screen shots, etc. are provided for reference only. Actual handset windows,
Service, General Information (see P.14-20) menus, etc. may differ in appearance.

concerning unclear or missing information.




. Page References

When (O] appears next to a page reference, indicated pages are in Vodafone live!
Manual. When only the page numbers appear, indicated pages are in Basic
Operations Manual.

. Abbreviated Steps
Handset operations starting from Index Menu are abbreviated as follows:

Press <@l to open Handy Features menu
Press (®

| Perform the operation such as opening a window
| |
m » Menu ltem % Handy ((0l) » Selection » Operation % Menu (.)|

Select the folder or file and press (®

Select menu item and press (®)

Press the corresponding key in parentheses

Accessories

M Battery (SHBAD1)’ B Rapid Charger (SHCQ01)'
(Type 1 lithium-ion battery)

*May also be purchased separately.

. Optional Accessories

M Headphones Il In-Car Charger

For accessory-related information, please contact Vodafone Customer Center,
General Information (see P.14-20).



Symbols
Accessories
Contents
Safety Precautions
General Notes
Specific Absorption Rate (SAR)

Contents

Getting

Started

Function & Feature Preview .....
Handset Parts & Functions...
I HANASEL ... 1-4
M Display INdICAtOrS. ......coveeeeeiiieeee e 1-7
Il Sub Display INdiCAtOrS ..........ccovueueveirieeeieirieieee e 1-9
Battery & Charger ............... ...1-10
Il Getting Started........cccoccevveernen. .. 1-10
Ml Installing & Removing Battery...........c.cccocoeurereeunne. 1-14
B Rapid Charger.........ccccoevvveveeeeeeeiceeee e
M In-Car Charger...........
Handset Power On/Off
B Key Guard..............
CloCK SettingsS......cccomrrmrrmrsmrsarsmsnsssessse s ssssnsasanans
Handset Menus ..........ccceerimineemnsmne s sssssssssenns
Il Index Menu
W Functions MenuU .........ccoovevvveieiviciieeeee e
B SOft KEYS....ooeeeeeeeeeeeeeeeeeeeee e
B QUICK OPErations .........c.oveeeeeeeereeeeeeeeeeeeeeeeiesseeeeeas
B GUIE ..o e
Handset Codes
Wl Security COde ..o
Il Center AcCess COe ... 1-26

Engaged Call Operations..........ccceceremnmsnssssnsnsenenas 2-11
B Earpiece VOIUME .......c.ccceurviieiiececeeceeceeeseee
Hl Voice Memo.............
Il Notepad Memory ........
Opening Entries
Redial & Call HiStOry ...
Delete....ooeiieieeec e
Simple Mode .......ccccenimiimiininninneniennns
Il Activating/Canceling Simple Mode
Il Simple Mode Operations.....................
Call TIME ..

Instant Display.....
Call Charge .......cceeereennes

Instant Display ........cccocoeiiniiiiiiiii e,
My Number & Owner Profile........ccocvvimrimncnnirnnnniennns
Edit, Delete & COPY .....covevriieiiiiiiiccieeeee e

Basic
Handset
Operations

Initiating @ Call .......cccvmieriir s 2-2
M Redial
Il International Call & Send With Code ...........cc.c........... 2-5

Setup Preset ..o 2-5
International Call & Send With Code ...........c......... 2-5
B Emergency Calls.......cccoouiueurinieieeieirieeeeeeeeee e 2-5

Incoming Call

Il Call History

Handling Incoming Calls........ccccooimrmnmrsmrsmcsncsnrsnnsnnsannns 2-8
M Placing Callers on Hold.......cccoovoveveveveeeeeeeeeeeseeeveneneen. 2-8
B QUICK RECOTdEr ... 2-9

Delayed RiNGer.......ccoccvismerieminmsmissmsssrssssssssssssssssssenns 2-10

Manner
Mode

Minding Mobile Manners ...........ccccucoimiimiinssssiensesnsnnas
Manner Mode ........cccccueimnmmnermnsneriss .
M Activating & Canceling
Il Manner Mode Settings
Message Recorder ........

Ring Tone Level.........
Vibration ......cooeeceieiiieeiee e

LED INAiCAtOr....ccciiiiieeeiiie e
Whisper Mode .....

Sound Volume......
V-Appli Volume
V-Appli Vibration

(01 21T T3 1 o T =

4

Entering
Characters

Character Selection....
M Entry Modes ...........
B Key ASSIGNMENLS .......c.co.oeiveiiieieieeeeeie e

Entering Characters.........ccccoivmnmnsennssssssssessse s snaens
Il Kanji, Hiragana & Katakana
Il Entering AIphanumerics ..........ccoereeerererenercieerenenenas
Il Symbols, Pictographs & Emoticons............ccceueueeee... 4-7
Il Mail & Web EXtensions............coccucueucvccuceecrceeceeeenns 4-8
Il Copying from Phone BooK...........cccccueveueveueucreverenennnn. 4-9
M Character Code
B Pager COUE ..o




4 Entering
Characters

Conversion Methods (Japanese Only) ........cccceeveeruennes 4-12

Il Phonetic CONVErSion.............ccoeuvveveieieveeieeieeenane 4-12
Il One-Hiragana Conversion ..............cccceevuevrinenennns. 4-12
M Hiragana to Katakana/Alphanumerics Conversion .. 4-13
M Quick Conversion (for Hiragana) .............c...ccc.eu...... 4-13
Il Conversion Settings ..........cocererireeeninciceee e 4-14

Disable Predictive/Previous Usage...........c.......... 4-14

Reset Learning ........ccccceeveiinicicnnnnne 4-14

Dictionaries (Japanese Only) ...
Il User Dictionary

Editing Phone BooK ... 5-15
Il Correction/Change ........ccecuevcveueeeuevcveneeeeeceeeesns 5-15
B Deleting ENtries ......c.cocveveeieeeeeieee s 5-15

Vi

Cancel.......ccveunene.
Editing Characters
BDEIEtiNg ..o
B Replacing...................
M Copy/Cut & Paste ......
Il Deleting Text Before or After Cursor.............coe....... 4-17
=D 1 T= 1 o 4-18
Edit/Delete .....ooieeeeieieeiecereeeee e 4-18
Phone BOOK | OVEIVIEW ... 5-2
5 Saving to Phone BooK.........cccumumimnmnnnsenenescsececnnaes 5-3
Il Phone Book Entry Rems .........cccceveveveeeeeeeeeeeeeenns 5-3
Il New Phone Book ENtries .........cceveveveveveeevevereeenenen. 5-4
BEPHOTO. ... 5-6
Il Saving Secret Mode ENtries ...........ccoceeveveveveeenennnn. 5-7
Il Saving from Redial or Call History ...........ccccoeveneunee. 5-8
Il Phone Book Memory Status ...........ccoeveveveveveeeeenennnn. 5-8
Option Settings ......cccccvmrrmnimnsimneriinn s 5-9
l Overview
Il Setting OPtioNS .......cooveveveeeeeeeeeeeee e 5-10
Personal Ring Tone & Incoming Notice............... 5-10
Mail FOIdEr ......covieiinieieeeeec e ...5-10
Using Phone Book................. .5-11
M Dialing from Phone Book . ..5-11
Il Phone Book Search..........ccooeeeveveeeveveeeeeeeeeeea
Memory No. Search.........ccoooviiiiiiniiiciceee
Katakana Search ..........ccooeiiiiiiiiiiceeee
Group Search ...
Search by Reading ...
B Speed Dial ...
Il ShOW PhOtO......cuceiiiiccceeeeee e

Group Settings .....cocveermrmrierieriricre s 5-16
Il Changing Group Name..........cccooveeoveeceeeeeeeeeeeen 5-16
ging p
Il Group RiNG TONE ... 5-16
p Ring
Mobile Getting Started ... 6-2
Camera M File Formats & Save Locations..........c.ccoeeeeveveennn.e. 6-2

Il Mobile Camera Basics
Il Camera Display Indicators
Hl Viewfinder & Key Assignments............cccooeeuerieennes. 6-4
Still Images ....cccevevvveirnssnnessescnnens «..6-5
M Still Image Modes...........
Il Capturing Still Images ...
Add to Phone BooK .........ccccovceeiiminnie s 6-7
Save AS ThUMD ...c.oiiiiie e
Rotate Thumb.............
Il Still Image Functions
W Self Timer ..o
I AAING Frames ........c.coooveeeeieieeceeceeceesseens
Il LEns EffECtS ..o
Hl Burst Mode .......

l Video Mode .............
M Recording Vide0 ........cevueucerecececceececceeee e
Il Video Recording Operations ...............ccoeuevrerenenenns 6-15
Shooting Options ........cceeveervnnrane
Toggle Preview....
Shutter Click........
Mobile Light ......coevveieieeeeeeeee e
ANti-FICKET ..
Image Settings
Brightness ......cceeeviiiiiieee e
SOft FOCUS ..ot

MiC SettingS......cccecuiiiiriciec e
Additional Settings........coevvmriermrsersersmrrn s
Select Mode .......covviiiiiiiecce e
SAVE 10 1
Auto Reset
Key Ops GUIE .......cceeeiiiiciiiiccececee e

Vi



Original RiNg TONES ......coceimrmrirerern e
BBASICS ...
Il Creating an Original Ring Tone.......
Il Editing an Original Ring Tone.........
M Deleting an Original Ring Tone ...

Instrument Effects......cccovmrimmnismnss e e
BBASICS ...
Il Creating Instrument Effects..........

Other Sound Related Functions

Speaker Phone/Speaker .........
TONE OCLAVE......ecviriiie et

Mobile Opening Images & Playing Video........cccocuvnmnerinrnnas 6-21
Camera Il Opening Still IMages...........cccevvveveveeeeererereeeeene 6-21
M Playing Video ................ ...6-21
Memory Status.......... . 6-22
Sending Still Images........... ... 6-22
Il Sha-mail Mode IMages .........ccooveeueueerinencenirneeeeen. 6-22
Il Wallpaper Mode Images.............cccooveeeveeieveverenennan. 6-23
Il Camera Mode Thumbnails... 6-24
Postcard & Calendar .... .6-25
M Postcard................ ...6-25
B Calendar ..o 6-26
Display Wallpaper........ccuceminemrnmsmneerissssss s sss s sssaseas 7-2
7 Clock & Calendar ..........cooevsemimrsserssnssnssssssesssessssssssssssnses 7-3
I CIOCK DiSPIAY ... 7-3
B Calendar ...
Display Images.........ccoorrmrrmismnsnnnmnsnsssssssssssssassnnnses
Fonts....cccovierinas
Display Patterns
Light Settings.........
Brightness......cocvviiieii e
In-Car Backlight ...........cooiiiiiiiiiiincee,
Sub Display Settings..........
Sub Display On/Off...
Backlight Settings .....
Adjust Contrast ........ccceveeeviiinrie e
Recipient Display .........ccccceviiiiininiieicee e
Other Display Settings ....
Language...............
Power On Message.............
Vodafone live! Animation ..........ccccevveiieneeniennenne 7-9
Mail Background..........cccocceeceiiiiiiiiiiiicccieseee 7-9
Screen Animation ..
DiSNeY Style......ooveeeieeeeeeeeee e
Incoming Light
Sounds & Call FUNCHIONS ..ot
Related .R?ng Tone Level..
Functions HRing Tone......... ...........................................................
W Handset Vibration ..............ccccovvueveviveceeeeecee e 8-3
Il Mobile/Small Light.........c.cccvueruereereeeeieereceeceeeeeeeeneen, 8-4
HRing Time
Sound Effects
B SOUNTS.......ooieeee e

viii

Il Basic Sound Settings.......ccccvveeceeerreecresesenennens
Sound Volume/Set LED to Sound ...
Original VoiCe.......ccucmrimiemnernniss s s e sssssnsnes

Managing Files
(Data Folder)

File Organization .........ccccoevvemiimnsnnsnsssssss s e
Data Folder........
B Contents ..........c..c......
Il Window DesCription...........ccceveeeeeeeeereeeccreesssaens
BICONS ..ot
M Display Settings....
Opening Files........cccveeernuenne
M Handset Data Folder ................
Il Sending Files via Long Malil.............ccccovovveeirineinnnnen.
B PrOPerties .......couevieeeeeeeee e
Animation File................
Il Simple Animation..................
Il Opening Animation Files ......
Using Images & Animation........c.cccuvmrnvnmnseennssnnnssesnnnes
Il Changing Display Size ........ccccceeveieereireercierenenenns
Il Setting Image & Animation as Wallpaper ................. 9-11
Il Setting Image & Animation as Display Images......... 9-11
Il Saving Burst Shot IMages ...........ccceeereeececirenencnnenss
B Slde ShOW......oeeeeceee e
Editing Images........ccoomiisnmsnssnnnenensnnns
M Enlarging/Reducing Image ...
Il Changing IMage Size ......ccvvveveveeeeeeeeeeereeeeenes
I Marker StamMP .....c.oooeeeeeeeeee s
Wl Visual EffectS......c.c.ooeceeieeeceeeeeece e
B FAce Arfange.......c.ceueuieeieeieeeeeeeeeeeee s
Il Additional Picture Effects

90° TUM e
Moving Photo Frame.........ccccvvvvivienvieeeeeee
Change File Format..........ccooiiiiiiniiiiiiiieee
Combining Images
I SPIit SCreeN ...
B Panorama IMages .......ccocoeueeeurerereeceeireeeeeeeeseeieaeeeenes
Il Combining Split Mail Images




Managing Files
(Data Folder)

Melody Files ... 9-22
Il Playback VOIUME ........c.coovvieeeeiiiciceeee e 9-22
Il Using for Incoming Tone/Sound Effects .................. 9-23

Editing Files & Folders.................... 9-23

Changing Folder/File Name... ...9-23

Secret MOde .....oceovuieiiiieie e 9-24

COPY/MOVE. ...ttt 9-24

DeIEte ... 9-24

Infrared Getting Started.........cooeeerrrrrcree s 10-2

1 0 W Available Files.........cccoeevivivieeicceeee e 10-2
I Precautions..........ccoooeieeeeeeeeeeeeeeee e 10-3

Set IR Password..... ..10-3

Transferring Files ........ .10-4
Il One File Transfer ... ...10-4
WAl File Transfer........cccoovveeeeeeiceeeee e 10-5
1 Handset Changing Security Code........cccocmrmminnmrinsninsnrssnnssannns 11-2
. Handset Locks........ .11-2
Security M Keypad Lock .... 112
B AULO KEY LOCK ....vieeieiieieieieieie e 11-3
Il Phone Book LOCK........ccccvvieieieiicicieieeee e 11-3
M Restrict Dial................... .11-4
Accept Call & Reject Call ... .11-4
M Saving Entries................ .. 11-4
B ACCEPE Call....ee e 11-5
BReject Call....coooieeeeecee e 11-5
M Rejecting Other Calls..... .11-6
Secret Mode ........cccevervinrnns ...11-6
M Activating Secret Mode............. ..11-6
Il Opening Secret Mode ENtries...........ccocvuevrieennnnne. 11-6

ReSetl ...t ——————

M Reset Defaults ...

M ResetAll............. ..
Additional Handy Call FUNCLIONS ........cccuiminmrnerinsssss e 12-2
1 Functions W Signal Alert........couviiieieieeeeee e 12-2
Il Push Tones......... .12-2
Side Key Settings ..... .12-3
M For Incoming Calls. ...12-3
W Standoy CS) ..o 12-3
Message Recorder..........ccorvmnimismnsnnnnnssenssnsssnssnsssnns 124
Bl ACHVALING - 12-4
M Deactivating .........ooveveveveeeeeeeeee e 12-5
M Playing Messages.. ..12-5
Voice MEeMmMOS.......cccerimemnsemmsarmnssesssss s sssss s snsanens 12-6

I Setting Alarm .......coovevceeeeeeeeeeeeeee e
W Alarm Options.........ccoveveeeriecieinne.
Ml Canceling & Reactivating Alarm
Cancel ...cceveeieeieeeee e
DEIETE ...
SEHINGS «.veeeeeiieeie e e
Auto Power On/Off .
Il Auto Power On
M Auto Power Off
Schedule ... s
Wl Saving ENtries ......ccoveveeeeeeceeeeeeee e
M Setting Alarm........

AlRIM e

Il Schedule & Action Item Options.....

Wl Opening ENries ......coccureeieeeceeeeeeceeeeeeieee s 12-17

I Editing ENtreSs ...c.ovvvieeiccccccceeeeee s 12-18

M Deleting Entries .... ...12-18
Delete Item....... ....12-18
One Day Schedules ...... ....12-18
Delete All.....ooeeeeeeeeeee e 12-19

Il Other Schedule Settings...........c.coeveevvviririeveeennnn, 12-19
Auto Delete
Secret MOdE .....c.ceiuviriiiiiieeieee e 12-19
SEt COlON it 12-19
VIBW ..ottt
Event List

Useful Diary

W Saving ENtres ...c.c.cveveeeeeeeececeeeccceeeeceeseans 12-20

Il Opening ENtries..........ccoveveeeveceeeceeeeeeseeseeeens 12-21

B Editing ENtries ......oooveueeeieeececeeeeee e 12-22

I Deleting ENtries .......c.oveececeeecccecceeecee e 12-22
Delete Item

Delete All ..o
StOPWALCh ... ————
Kitchen Timer ......
Barcode..........cccvnueue
Create QR Codes....
Battery Saving ........ccccvvmnneinnsnssnss e

B POWEr SaViNg .....c..oevveeiiieieeeece s
M Panel Saving ....
Calculator................

Xi



1 Additional
Functions

Pen Light ... 12-31
Mluminate ... 12-31
Pen Light Settings..... ... 12-31

Headphones...........

Safety Precautions

¢ Read safety precautions before using handset.
¢ Observe precautions to avoid injury to self or others, or damage to property.
¢ VVodafone is not liable for any damages resulting from use of this product.

Before Using Handset

Il Symbols
Make sure you thoroughly understand these symbols before reading on.
Symbols and their meanings are described below:

A DANG ER Great risk of death or serious injury from improper use
A WARNING Risk of death or serious injury from improper use
A CAUTION Risk of injury or damage to property from improper use
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OO O A
Prohibited Actions Compulsory Actions Attention Required
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ADANGER
Handset, Battery & Charger

Use only the specified battery
or Charger (see P.iii).

Using non-specified equipment may
cause malfunctions, electric shock or
fire due to battery leakage,
overheating or bursting.

Battery

Do not short-circuit Charger
terminals.

Keep metal objects away from
Charger terminals. Keep handset
away from necklaces, hairpins, etc.
Battery may leak, overheat, burst or
ignite causing injury. Use a case to
carry handset.

O

Prevent injury from battery

leakage, breakage or fire.

Do not:

¢ Heat or dispose of battery in fire

¢ Disassemble, modify or break
battery

e Damage or solder battery

¢ Use a damaged or deformed battery

¢ Use non-specified charger (see P.iii)

¢ Force battery into handset

e Charge or place battery near fire,
heat sources or expose it to extreme
heat

¢ Use battery for other equipment

Xiv

N

If battery fluid contacts eyes,
do not rub them. Rinse with
clean water and consult a
doctor immediately.

Eyes may be severely damaged.

o

AWARNING
Handset, Battery & Charger

Do not insert foreign objects
into handset.

Do not place metal or flammable
objects in handset or Charger. This
may cause fire or electric shock. Keep
handset out of the reach of children.

O

Keep handset out of rain or
extreme humidity.
Fire or electric shock may occur.

Q

Keep handset away from
liquid-filled containers.

Keep handset and Charger away from
chemicals/liquids.

Fire or electric shock may result.

O

Avoid sources of fire.

Prevent fire or explosion. Do not use
handset in the presence of gas or fine
particles (coal, dust, metal, etc.).

O

Do not use Mobile Light near
people's faces.

Eyesight may be temporarily affected
leading to accidents.

O

Keep battery, handset or
Charger away from microwave
ovens.

Battery or handset may leak, burst,
overheat or ignite and cause
accidents.

O

Do not disassemble or modify

handset.

* Do not open housing of handset or
Charger; may cause electric shock
or injury.

Contact Vodafone Customer Center,
Customer Assistance for repairs.

¢ Do not modify handset or Charger.

Fire or electric shock may result.

If water or foreign matter is %
inside handset:

Discontinue handset use to prevent

fire or electric shock. Turn handset

power off, remove battery, unplug

Charger and contact Vodafone

Customer Center, Customer

Assistance.

Do not subject handset to ®
shocks.

Subjecting handset or Charger to

shocks may cause malfunction or

injury.

Should the handset break, remove the
battery and contact Vodafone

Customer Center, Customer

Assistance. Discontinue handset use.

Fire or electric shock may occur.

If an abnormality occurs: %
Should there be unusual sound,

smoke or odor, discontinue handset

use to avoid fire or electric shock. Turn
handset power off, remove battery and

unplug Charger and contact Vodafone
Customer Center, Customer

Assistance.

XV



AWARNING

Handset

Preventing accidents

e For safety, never use handset while
driving. Pull over beforehand.
Mobile phone use while driving is
prohibited by the revised Road
Traffic Law (effective November 1,
2004).

¢ Do not use headphones while driving
or riding a bicycle.
Accidents may result.

¢ Moderate volume outside, especially
at road/rail crossings to avoid
accidents.

Charger

N

Do not swing handset by ®
handstrap.
May result in injury or breakage.

Turn handset power off before 0
boarding aircraft.

Using wireless devices aboard aircraft

may cause electronic malfunctions or
endanger aircraft operation.

Adjusting vibration and Ring 0
Tone settings:

Users with a heart condition/
pacemaker/defibrillator should adjust
handset settings accordingly.

During thunderstorms, turn 0
power off; find cover.

There is a risk of lightning strike or

electric shock.

Use only the specified voltage.
Non-specified voltages may cause fire
or electric shock.
¢ Rapid Charger

100 VAC
e In-Car Charger

12/24 VDC

O

Do not use In-Car Charger
inside vehicles with a positive
earth.

Fire may result.

Use In-Car Charger only inside
vehicles with a negative earth.

XVi

O

Charger Care A
¢ Do not touch blades with wet hands. @

Electric shock may occur.

¢ Do not use multiple cords in one
outlet. May generate excess heat or
fire.
¢ Do not bend, twist, pull or set objects
on cord. Exposed wire may cause
fire or electric shock.

Do not short-circuit Charger ®
terminals.

Keep metal away from terminals.

May cause overheating, fire or electric

shock.

AWARNING

Charger
Preventing accidents During thunderstorms:
Secure In-Car Charger to avoid injury Unplug Charger to avoid damage, fire

or accidents.

or electric shock.

If Rapid/In-Car Charger cord is 0
damaged:

May cause fire or electric shock;

contact Vodafone Customer Center,
Customer Assistance to replace.

Keep Charger out of the reach
of children.
Electric shock or injury may occur.

Handset Use & Electronic Medical Equipment

This section is based on "Guidelines on the Use of Radio Communications Equipment
such as Cellular Telephones and Safeguards for Electronic Medical Equipment”
(Electromagnetic Compatibility Conference, April 1997) and "Report of Investigation of
the Effects of Radio Waves on Medical Equipment, etc." (Association of Radio

Industries and Businesses, March 2001).

People with implanted 0
pacemakers/defibrillators

should keep handset more than
22 cm away.

Implanted pacemakers or defibrillators
may malfunction due to radio waves.

Turn handset power off in 0
crowded places such as trains.
People with implanted
pacemakers/defibrillators may

be near.

Implanted pacemakers or defibrillators

may malfunction due to radio waves.

Observe these rules when 0
visiting medical facilities:
¢ Do not take handset into operating
rooms or Intensive or Coronary Care
Units.
* Keep handset off in hospitals.
* Keep handset off in hospital lobbies.
Electronic equipment may be near.
® Obey rules regarding mobile phone
use in medical facilities.

Consult manufacturer for radio 0
wave effects on electronic
medical equipment.
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AWARNING

Battery

o |f battery does not charge properly,
stop charging. Battery may overheat,
burst or ignite.

e If there is leakage or abnormal odor,
avoid fire sources.

It may catch fire or burst.

o

If there is abnormal odor, excessive
heat, discoloration or distortion,
remove battery from handset.

It may leak, overheat or explode.

ACAUTION
Handset, Battery & Charger

o

ACAUTION

Handset
Avoid leaving handset in ® Inside vehicles: C
extreme heat (inside vehicles, Handset use may cause electronic
etc.). equipment to malfunction.
Handset may heat up and lead to
burns.

Should skin irritation occur, discontinue handset use and consult a

doctor.

See below for handset materials. Some materials may cause skin irritation, rashes, or

itchiness depending on your physical condition.

Handset care

¢ Place handset on stable surfaces to
avoid malfunction or injury.

¢ Keep handset away from oily smoke
or steam. Fire or accidents may
result.

e Cold air from air conditioners may
condense, resulting in leakage or
burnout.

¢ Keep handset away from direct
sunlight (inside vehicles, etc.) or
heat sources.

Distortion, discoloration or fire may
occur. Battery shape may be
affected.

e Keep handset out of extremely cold
places to avoid malfunction or
accidents.

¢ Keep handset away from fire
sources to avoid malfunction or
accidents.

Xviii

A

Usage environment

® Excessive dust may prevent heat
release and cause burnout or fire.

¢ Avoid using handset on the beach.
Sand may cause malfunction or
accidents.

* Keep handset away from credit
cards, phone cards, etc. to avoid
data loss.

A

Parts

Materials & Finishing

Housing (Display/Keypad/Sub Display/battery side),
battery cover, housing cover ornament (sides)

ABS resin/Acrylic UV curing painting
(sealer: acrylic painting)

Display window, lens cover, Sub Display window

Acrylic resin

Multi Selector (cursor keys), Side Key, camera
ornament

ABS resin/Chrome plating

Vodafone live! Key, Mail Key, Power On/Off Key,
Start Key, Keypad, Clear Key, Schedule/Memo Key,
Text Key, Function Key, battery, screw cover
(above/below Display)

PC resin

Screw cover (back side)

Silicone rubber

Headphone Connector cover, External Device
Connector cover

Elastomeric resin

External Device Connector

Nylon 6T/Brass, Au plating (sealer: nickel, copper)

Screw (Display/Keypad side)

SWCH12A/Ni plating

Infrared port, Mobile Light cover, Small Light

ABS resin
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ACAUTION

Charger

Charger & In-Car Charger

e Grasp plug (not cord) to disconnect
Charger. May cause fire/electric
shock.

¢ Keep cord away from heaters.
Exposed wire may cause fire or
electric shock.

e Stop use if plug is hot or improperly
connected.
May cause fire/electric shock.

¢ Keep In-Car Charger socket clean.
May overheat and cause injury.

N

Use only the specified fuse.
1 A fuse for In-Car Charger.
Or may cause breakage/fire.

O

Always charge handset in a
well-ventilated area.
Avoid covering/wrapping Charger.
May cause damage/fire.

XX

O

Do not use In-Car Charger
when engine is off.

Start engine before use. Or car battery
may be weakened.

N

Long periods of disuse
Be sure to unplug Rapid/In-Car
Charger after use.

€

Handset maintenance

When cleaning, disconnect Rapid/
In-Car Charger to prevent shock/
injury.

€

Installing In-Car Charger
Properly position the cable for safe
driving to avoid injury or accidents.

A

ACAUTION

Battery

Do not throw or abuse battery.
Battery may overheat, burst or ignite.

Do not leave battery in direct sunlight
or inside vehicles.

Overheating/fire may occur; may
reduce performance.

2%

Do not expose battery to liquids.
Performance may deteriorate.

If battery fluid contacts skin or clothes,
rinse with clean water immediately.

Do not dispose of exhausted batteries
with ordinary refuse. Tape over battery
terminals before disposal, or bring
them to a Vodafone shop.

Follow local regulations regarding
battery disposal.

0@ @

Keep battery out of the reach of
children.

e Charge battery within a range of 5°C
- 35°C; outside this range, battery
may leak/overheat and performance
may deteriorate.

o If your child is using handset, explain
all instructions and supervise usage.

o [f there is abnormal odor or
excessive heat, stop using battery
and call Vodafone Customer Center,
Customer Assistance.

¢ Do not leave battery uncharged.
Charge at least once every six
months.
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General Notes

General Use

¢ VVodafone is not liable for any damages resulting from accidental loss/alteration of
handset data. Please keep separate records of Phone Book entries, etc.

¢ Handset transmissions may be disrupted inside buildings, tunnels or underground, or
when moving into/out of such places.

¢ Use handset without disturbing others.

¢ Handsets are radios as stipulated by the Radio Law. Under the Radio Law, handsets
must be submitted for inspection upon request.

¢ Handset use near landlines, TVs or radios may cause interference.

* Beware of eavesdropping.
Because this service is completely digital, the possibility of signal interception is greatly
reduced. However, some transmissions may be overheard.
Eavesdropping
Deliberate/accidental interception of communications constitutes eavesdropping.

Inside Vehicles

¢ Never use handset while driving.
¢ Do not park illegally to use handset.
¢ Handset use may affect a vehicle's electronic equipment.

Aboard Aircraft

Never use handset aboard aircraft (keep power off).
Handset use may impair aircraft operation.

Handset Care

e If handset is left with no battery or an exhausted one, data may be altered/lost. Vodafone
is not liable for any resulting damages.

¢ Use handset within temperatures of 5°C to 35°C and humidity of 35% to 85%.
Avoid extreme temperatures/direct sunlight.

¢ Exposing lens to direct sunlight may damage color filter and affect image color.

XXii

¢ Do not drop or subject handset to shocks.
¢ Clean handset with dry, soft cloth. Using alcohol, thinner, etc. may damage it.
* Do not expose handset to rain, snow or high humidity.
¢ Never disassemble or modify handset.
¢ Avoid scratching handset Display.
¢ When closing handset, keep straps, etc. outside to avoid damaging the Display.
¢ Handset is not water-proof.
Avoid exposure to liquids and high humidity.
m Keep handset away from precipitation.
m Cold air from air conditioning, etc. may condense causing corrosion.
m Avoid dropping handset in damp places (restrooms, bath/shower rooms, etc.).
m On the beach, keep handset away from water and direct sunlight.
m Perspiration may seep inside handset causing malfunction.
* Heavy objects or excessive pressure should be avoided.
May cause malfunction or injury.
® Do not sit down with handset in a back pocket.
m Do not place heavy objects on handset in a bag.
e Connect only specified products to Headphone Connector. Non-specified devices may
malfunction or cause damage.
e Always turn off handset before removing battery.
If battery is removed while saving data or sending mail, data may be lost, changed, or
destroyed.

Copyrights

Copyright laws protect sounds, images, computer programs, databases, other
materials and copyright holders. Duplicated material is limited to private use only. Use
of materials beyond this limit or without permission of copyright holders may constitute
copyright infringement, and be subject to criminal punishment. Comply with copyright
laws when using images captured with handset camera.
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Specific Absorption Rate (SAR)

¢ V302SH meets the government's requirements for exposure to radio waves.
These requirements are based on scientific basis to assure that radio waves emitted from
mobile phones and other handheld wireless devices do not affect human health. They
require that the Specific Absorption Rate (SAR), which is the unit of measurement for the
amount of radiofrequency absorbed by the body, shall not exceed 2 W/kg'. This limit
includes a substantial safety margin designed to assure the safety of all persons,
regardless of age or health, and meets the international standard set by International
Commission on Non-lonizing Radiation Protection (ICNIRP) in cooperation with World
Health Organization (WHO).

¢ The highest SAR value for V302SH is 0.86 W/kg. Tests for SAR are conducted with
handset transmitting at its highest certified power level, and follow the testing methods set
by the government. While there may be differences between the SAR levels for various
handsets, they all meet the governmental requirements for safe exposure. The actual
SAR level of the handset while operating can be well below the highest value. This is
because the handset is designed to operate at multiple power levels so as to use only the
power required to reach the Network.

¢ Additional information on SAR can be obtained on the following Websites:
m Ministry of Public Management

http://www.tele.soumu.go.jp/j/ele/index.htm
m Association of Radio Industries and Businesses (ARIB)
http://www.arib-emf.org/index02.html
*Requirements are stipulated in Radio Law (Ordinance Regulating Radio Equipment, Article 14-2).
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Function & Feature Preview

paLels Bumen ,

Simple Mode
Select a simplified menu,
ideal for users who use only
basic handset functions.

Manner Mode
Press a single key to mute
ringer and activate Message
Recorder automatically.

Kanji Conversion
Use Predictive or Previous
Usage to reduce key strokes
when entering Japanese text.

Infrared
Align handset IR port and a
compatible device port for
wireless file transfers.

P.10-2

One-Shot Mail
Instantly send a preset Sky
Mail message to a preset
address with handset closed.

Option Settings
OFF

P.12-3

Schedule
Add entries for upcoming
events with dates/times. Set
Alarms, etc. for each.

05
205/09/20(T)
W TWOT
.

e
wos 8 7 e 9 W

e o2z
= Toa oa @

P.12-13

Iﬁilli » W: 505 -
S|"|D|e Hloce My Ingg;/ﬁonversmn
(0l Nunber Dinput Method
[Pone Funct| S ST
0ng rUnctions
P.2-16 P.3-3 P.4-12
Phone Book Camera Postcard

Save up to 500 entries (with
up to three phone numbers
and mail addresses each).

Capture still images and
Action Snap video with
built-in handset camera.

EAction Snap Mode

P.6-2

Add text or calendar mask to
still images to create original
Postcards or Calendars.

P.6-25

Display Settings
Change Wallpaper, Display
Images, Fonts, et cetera to
customize handset Ul.

Fonts

P.7-2, P.7-5, P.7-6

Display Language
Set menus, etc. to appear in
English or Japanese.

Data Folder
Access handset image and
sound files from here; files
are organized by file type.

P.9-3

Useful Diary
Create personal diary entries
using both text and images.
Save up to 400 entries.

15:05
F54:Useful Diary
F12005Y 9M26D

| was very lucky to
find it in this seas|
on! | couldn’t help

P.12-20

Mail Templates
Select default or customized
templates by theme and fill in
fields to create messages.

Vodafone live! Manual
Optional Services

Vodafone live!
Exchange mail, access the
Mobile Internet, download
V-Applications via Web, and
retrieve timely area-specific
information via Station.

&

Vodafone live! Manual

Call Forwarding
Automatically direct
incoming calls to a
specified number.

Voice Mail
Manually redirect or
automatically direct
incoming calls to VM.

Call Waiting
Reduce missed calls!
Answer incoming call
while line is engaged.

3 Way Calling
Switch between two
lines or talk on both
simultaneously.

1-2

1-3
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Handset Parts & Functions
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(G

Handset
H—
6]
H Display

Vodafone live! & Mobile Camera Key

* Open Web menu or execute left Soft

Key functions. Press for 1+ seconds to

activate mobile camera.
Start Key
Initiate or answer calls.
El Clear Key
Delete entries or return to previous
window.

Schedule/Memo & A/a Key

Save/check Schedule or record/play
Voice Memos. In text entry windows,
toggle upper/lower case roman letters or
standard/small hiragana/katakana.
Change image display sizes.

@A Keypad

These descriptions (P.1-4 - 1-6) are illustrative of general handset usage. For mobile
camera and other specific key assignments, refer to the descriptions for each

function.

i ¥ Key

While an image or message appears,
press to open next one (newer one). In
alphanumeric entry, open web/mail
address prefixes & suffixes, and in kaniji
(hiragana) entry, toggle Symbol/
Pictograph Lists.

El Earpiece
El Multi Selector

Select menu items, move cursor, scroll,
etc. or use for the following:
[1]Redial & Notepad Memory Key
e Select dialed numbers or return to
the previous window. Press for 1+
seconds to open Notepad Memory.
Shortcut Key
¢ Open list of shortcut keys (press
indicated key to access assigned
function). Press for 1+ seconds to
adjust Earpiece volume.
Phone Book Key
¢ Open entries to make calls, send
messages or open selected menu
items. Press for 1+ seconds to save
new entries.
Function & Key Guard Key
e Access Functions Menu in Standby
or capture images with mobile
camera. Press for 1+ seconds to
toggle Key Guard.
Call History Key
* Open received call records. Press
for 1+ seconds to adjust Earpiece
Volume.

il Mail Key

* Open Mail menu or execute right Soft
Key functions. Press for 1+ seconds to
open V-Appli Library.

Power On/Off & End Key

¢ End calls, place callers on hold or
cancel operations. Press for 2+
seconds to turn handset power on/off.

Text & Manner Key (®)

* Toggle between entry modes or create
Phone Book entries. Press for 1+
seconds to activate/cancel Manner
Mode.

iH # Key

While an image or message appears,
press to open previous one (older one).
In text entry windows, toggle Symbol/
Pictograph Lists.

Microphone

pauels bumen i



pauels 5U!1189 !

Strap Eyelet
Attach straps as shown.

Small Light
llluminates/flashes while charging, for
incoming calls, etc.

External Device Connector

Connect Charger here.
Headphone Connector
Infrared Port

Use for infrared data transmissions.
Side Key

e When camera is active, press to

capture images. Press for 1+ seconds

to activate the assigned function in
Side Key Settings (see P.12-3).

=

Camera (lens cover)
Capture still images and Action Snap
video.

Mobile Light
Flashes for incoming calls/mail. Serves
as a strobe or Pen Light.

Speaker

Sub Display

Internal Antenna Location

Battery Cover

@ Do not cover or place stickers, etc. over the area containing Internal Antenna.

1-6

Display Indicators

(m 14414 fi’&@ﬂ%é&iﬁﬂv
JaSVE
BEA & B oL

H @ Battery Strength
4 Pen Light
@l and & flash when Pen Light is in
use.
§ Secret Mode Active
Flashes when a Secret Mode entry is
open.
Original
] Enlarged
Mail, Web or Data Folder image
display size
B & Speaker Phone Active
i Speaker Active
3 Line Active
Web communication is in progress.
:& (gray) Station Menu Manual Update
& Mail
Unread mail except Long Mail

@A # Web
Unread Web information
Delivery Report
New Delivery Report
B 1 Signal Strength
§il: Strong Wi: Moderate ¥: Low T: Weak
wr: Qut-of-Range
“ Infrared Transmission
El < Scroll
The menu, information, etc. can be
scrolled.
il ¥ Active V-Application
& Paused V-Application
@ Manner Mode Active
4 Long Mail
Unread Long Mail

1-7
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3& (red) Station il M Vibration Active

Unread Station information & % Weather Indicators
& Voice Mail Current forecast (A separate
New Voice Mail subscription is required.)
W Off-Line Mode <t Key Guard Active
@ Schedule (Alarm On) Keypad Lock Active
Schedule (Alarm Off) of Message
A Alarm Set Message Recorder messages
Entry Mode 8l Silent
Current character entry mode Ringer is Silent.
& Message Recorder Active [z Rising Tone
Ringer is set to Rising Tone.
@ Display is a precision device. However, some pixels may appear brighter or darker.
¢ Although Vibration and Ring Tone Level for incoming calls and Vodafone live!
@ functions are set separately, M, [l and [S] are Incoming Call indicators.
e When Wallpaper is set (see P.7-2), cancel Show Indicators to hide indicators (see
P.7-2).
1-8

Sub Display Indicators

Sub Display & Display indicators represent the same functions (see P.1-7 - 1-8).

@ Tyl 0915:05
| | | |

(1]
il @ Battery Strength B Information

@ always appears in Standby. &, ofi, Appears when there is a missed call, a
W, &, 35 or [ appears with messages Message Recorder message, unread
for Alarm, incoming calls, information, mail, etc.
etc. *When B appears with Side Key

4 Pen Light Settings for Standby (see P.12-3) set
@ and Q flash when Pen Light is in to M Details, press for 1+
use. seconds to see specific indicators.

Yull Signal Strength

" Off-Line Mode
Time
Current time and corresponding
indicator flash when Stopwatch or
Kitchen Timer is running.

When handset is closed, press to illuminate Sub Display Backlight. Backlight
stays off if Sub Display Backlight Settings (see P.7-8) is set to Off.
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Battery & Charger

n Getting Started

Charge a new battery before use or after a period of disuse.

pauels 5U!1199

Battery Life

¢ Use specified Charger only. Other
chargers may damage handset, or
cause battery to deteriorate, overheat
or ignite.

¢ Do not use or store battery at extreme
temperatures. May shorten battery life.
Ideal working temperature is between 5°C
and 35°C.

¢ Replace battery if operating time is
noticeably shorter than normal.

Charging

¢ Do not use Charger for other purposes.

¢ Battery may short-circuit, overheat or
burst from contact with metal objects.

e Small Light illuminates red while charging.
(It may take a while for the light to
illuminate when handset power is off.)

¢ Charging takes approximately 115
minutes (with handset power off).
m Charging time may vary by ambient

temperature.

e Charger and battery may become warm
during charging.

* Move Charger away from home TVs or
radios if interference occurs.

Precautions

* Use a dry cotton swab to clean handset,
battery and Charger terminals.

* Avoid:
m Extreme temperatures
= Humidity, dust and vibration
m Direct sunlight

¢ Do not leave battery uncharged. Charge
at least once every six months.

¢ Use a case when carrying battery
separately.

* Handset will charge with power on. @l flashes and stays on when complete.

@ e Battery must be inserted to charge handset.

¢ Handset will charge while open.

Estimated Hours of Use
(fully charged battery)

Continuous Call Time 140 minutes

Continuous Standby Time (450 hours

Continuous Operating Time | 250 minutes

Above values are calculated with Backlight

Brightness set to Level 4 (default).

e Continuous Call Time is an average
measured with a new, fully charged
battery, with both Power Saving and Panel
Saving off, with stable signals.

¢ Continuous Standby Time is an average
measured with a new, fully charged battery,
with handset closed without calls or
operations, in Standby with stable signals.
Standby Time may be less than half this value
if handset is out-of-range or signal is weak.
Standby Time may vary by environment
(battery status, temperature, etc.).

e Continuous Operating Time is measured
while handset is operated without calls.

¢ The above values (Battery Time) are
nominal values, measured under stable
signal conditions.

Battery Time

Battery Time may shorten when
handset is used in poor conditions:
¢ Poor Usage Conditions
m Extreme temperatures (use within a range
of 5°C - 35°C)
m Dirty handset, battery or Charger terminals
(charging may be hampered)
m Weak signals or out-of-range
e Operation
mV-Application is active
m Station service is in use
® Repeated mobile camera use
® Playing video images
® Frequent use of Pen Light
® Continuous Keypad use (Backlight stays
on for long periods)
® Frequent infrared transfers
¢ Setting
m Backlight/Keypad Light time is set longer
® Wallpaper is animated
m Screen Animation is used
m Panel Saving is Off
m Backlight is set brighter

pauels bumen i
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Extend Battery Time

Adjust the following settings:
¢ Backlight (see P.7-7)

e Sub Display Backlight (see P.7-8)
¢ Lighting Time of Mobile Light (see
P.6-17) or Pen Light (see P.12-31)

¢ Panel Saving (see P.12-28)

When Battery Runs Out

A message appears and short beeps
sound. Handset shuts down after 20
seconds unless charged. Press @ to stop
short beeps. (Short beeps do not sound
in Manner Mode.) If battery runs out
during a call, short beeps sound every
five seconds. After 20 seconds, the call
ends and handset shuts down.

Battery Disposal

Do not dispose of exhausted batteries
with ordinary refuse.
Tape over battery terminals before

disposal, or bring them to a Vodafone shop.

Follow local regulations regarding battery
disposal.

. Battery Strength

Strength Levels

@l Tl 15:09
Sub Display

15:05

2005/09/15 Thu

When battery runs out (0), Recharge Battery appears and short beeps sound.

Handset shuts down after 20 seconds.

M Indicator

Battery Strength indicator varies as shown.
Charge or replace when level is low.

Battery Strength indicator is for reference only.

Approx. 70%

[} Recharge Battery appears.

8 Charge or replace battery immediately.

)

> T

2, 1

fol 1

g |

e R [ A Minimum Operating Voltage
Level 3 E Level 2 : Level 1 : Level 0

Approx. 20% EApprox. 10%5
- - Hours of Use

Remaining Strength (at 25°C)

[l Battery Strength & Environment

At low temperatures, battery is consumed faster.
At high temperatures, battery lasts longer.

B small Light & Battery Strength Indicator

[l Handset Power On

Small Light Indicator (i) Conditions
Off Flashes Ambient temperature is outside the range of 5°C - 35°C
Flashes red Flashes Battery life has ended, or battery defect
llluminates red Flashes Charging
Off llluminates Charging completed
M Handset Power Off
Small Light Indicator () Conditions
Flashes red Off Battery life has ended, or battery defect
llluminates red Off Charging
Off Off Charging completed

pauels bumen i
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Installing & Removing Battery

. Inserting

Press down and slide cover as 3 Insert battery
shown

e With printed side up, fit tabs into
battery cavity slots.
Lift and remove cover as

4 Close cover
shown

until it stops.

. Removing ‘
¢ Turn handset power off before removing battery.
* Do not remove battery immediately after saving files, sending messages, etc.

Press down and slide cover as 3 Remove battery
shown

peuels Bumen i

¢ Take hold of Battery Tab here, push as
shown in @, then lift as indicated in @.

shown

Lithium-ion batteries are a recyclable resource.

* To recycle a used lithium-ion battery, take it to any shop displaying (D
the symbol shown to the right.

* To avoid fire or electric shock, do not: =
® Short-circuit batteries R
m Disassemble batteries

@ This product requires a lithium-ion battery.



n Rapid Charger In-Car Charger

o Use specified Charger only. Use specified In-Car Charger only.
(0]
2 2 4
9] Small Light
g 100 VAC . Cigarette Lighter Socket
g Small Light Terminal Cover
Release Tabs
AC Charger. In-Car Charger
Terminal Cover
Release Tabs External Device Connector
Printed Side Up Printed Side Up
((
External Device Connector ) . L
1 7 Open Terminal Cover and 4 Charging is complete when
insert Charger connector until light goes out
. . . it clicks ¢ Charging takes approximately 115
1 Open Terminal Cover and 3 Charging is complete when minutes.
insert Charger connector until light goes out 2 Plug in Charger After Charai
it clicks ¢ Charging takes approximately 115 Start . 5 er arging .
2 minutes. 3 C‘;r car ?':tgm(:s Lot Unplug Charger from cigarette
Plug in Charger * Charging starts and Small Lig lighter socket, then handset
- . . ]
* Charging starts and Small Light 4 After Charging llluminates red (see P.1-13). * Squeeze release tabs and pull
illuminates red (see P.1-13). Unplug Charger from the AC connector straight out.
¢ Extend Charger blades. (Fold back outlet, then handset

¢ Replace Terminal Cover to protect
External Device Connector.

when not in use.) * Squeeze release tabs and pull

. ;2%?:2;0-;:::;22:825& to protect @ * Use In-Car Charger inside vehicles with a negative earth only.
External Device Connector. * Disconnect Charger before leaving vehicle to prevent charging with engine off.
¢ Avoid charging battery inside extremely hot vehicles.
e Never use handset while driving.

¢ For more information, see In-Car Charger manual.
e Use optional In-Car Holder to secure handset.
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Handset Power On/Off

7 Open handset
2 Press @& for 1+ seconds

pauelg Bumen , L

15:05

2005/09/15 Thu

Backlight illuminates; after Power On Graphics,
handset enters Standby (shown above).

Press &) for 2+ seconds to exit
After Power Off Graphic, handset shuts down.

Clock Settings

I If date and time have not been set, a confirmation appears after Power On Graphic.
Choose Dl Yes # Press (® ® Clock Settings window opens (see P.1-20)
m Choose EINo # Press (® ® Standby appears without date and time

¢ Handset receives incoming mail or Web/Station information while closed.
 Display shuts down after a period of inactivity (see P.12-28 "Panel Saving").

Use Key Guard to lock handset keys and prevent accidental operation/function

activation.

1 Press (® for 1+ seconds
<k appears and Key Guard is set.

For Emergency Calls when Key Guard is
active, see P.2-5.

When Key Guard is Active
@ * Incoming calls temporarily cancel Key
Guard. To answer calls, press keys for
Anykey Answer (see P.2-6). Key Guard
reactivates after the calls end.

* Handset power does not turn off even if @)
is pressed for 2+ seconds.

In Standby, press (® for 1+ seconds
<k disappears.

pauels Bunien i



Clock Settings

Handset Menus

pauels 5U!1169 ,

m » Functions % Clock

1 Select E)Clock Settings and press (®)
2 Enter the year

[ il
F59:Clock Settings

2005Y
B—M——D(—)

[ ek ||
Example: Year 2005 %

Enter the month and day
Example: September 15 #

Enter the time

Apply 24-hour clock format.
Example: 3:05 PM & (#3)E0@)ED)

Press (®

Clock starts and handset returns to Standby.
The day of the week is set automatically.

Index Menu

Access functions/operations from Index Menu.

Cursor

Il Use ¢ or () to move cursor (Il or highlight bar). Enter or edit characters at the
cursor position.

1 Press@®

n:

) @] o

ez Cnee —Sceiics

@‘f o
i
[0 &
Functions RIEIEPS]
7 o=
% 5=

IS files)
c *Slect @
Index Menu opens.

2D Use s to select an item
To open Handy Features menu, press <@l.
To open V-Appli Library, press [&.

3 Press(®

Menu for each item opens.

l Index Menu ltems

e
)

1-20

When removing the battery for replacement, etc., Clock settings remain. However,
should the handset go without power for an extended period of time (approximately
one month), Clock will need to be reset.

e When Clock has not been set, --/-- --:-- appears for date and time.
* Choose a Clock type and layout or use Calendar for Standby (see P.7-3).
® Clock can be set during calls.

Briefcase Use Schedule, Calculator, Alarm, etc.
Camera Camera menu opens. Capture still images and record video.
Settings Customize display, sounds, etc.
Infrared Exchange information and data via infrared

. Functions Menu opens (see P.1-22). Check and change settings of
Functions . .

various functions.

Tel Ops Create or search Phone Book entries. Check Redial and Call History.
Vodafone live! Use Mail, Web, V-Application, Station, etc.
My Files Open files saved in handset
Simple Mode Activate Simple Mode

1-21
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Handy Features Menu

H In Index Menu, press <01 IIEAM to open Handy Features menu.

Eammﬁﬂmma

. 0»59)) ‘L 761 @one-Shot Mai |
I Fun(tlunﬁ T BUseful Diary

[EChat Mail Log
%) LlLi = EdVai | Templates
Vodafinelivel m

@ ollect @ B
Index Menu

Handy Features

In Index Menu, select Functions and press (®). Use Functions Menu to access
handset functions and settings. A number is assigned to each function (see P.14-2).

M Selecting First Layer ltems
Select an item with ($) and press (®.

- 15:05 -
L. F10:

@y Number ECal | Functions
MSounds IVolume
BEPrivacy @ ElSound Effects
ElSettings 1 BRinger Out
ESettings 2 ) SSpeaker
B30 1 ock B40riginal Tones
BCharges Binstrument Effects
EdServices ElTone Octave
EVodafone live!

@ (&) elect

Selected item
is highlighted.

First Layer Related Functions

1-22

M Selecting Functions by Numbers
In Standby, press (® to open Index Menu, then enter numbers. Corresponding
function or menu opens.

1505
IE[1]3:Sound Effects

n
Keypad Sound
EError Tone
EPower On
EPower Off
BSound Volume
[ESet LED to Sound

®©yzd
15:05 —

2005/09/15 Thu

\-%—"

Return to Standby

[l Press &) to return to Standby (see P.1-18) from function windows, menus, etc.
» When a confirmation appears, choose [l Yes and press (). Handset returns to
Standby.

Soft Key functions appear at the bottom of Display.

When © Select appears, press (®) to open selected menu items,
execute functions, etc.

When @ Convert appears, press @ to convert kana to kaniji, etc.

When E3 Auto appears, press to execute the function.

e Press to select or execute the assigned function or operation.

Press <@l to select or execute the assigned function or operation.

When appears while creating Original Ring Tone, etc., press to execute the
assigned operation.

1-23
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n Quick Operations
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In Standby, enter numbers to access functions quickly.
Accessible functions vary by the number of digits entered.

(Functions shown to the right appear for single digits.)
To activate functions, press the key next to the function (press

(3 for Speed Dial).

15:05 il

@ :Speed Dial

i - Spending Memo
g3 - Add to PhoneBook
@ Entry Search

Digits
Function

—_

5-6 |7-12|13-24

Speed Dial (see P.5-14)

Spending Memo (see P.12-30)

Add to Phone Book (see P.5-3)

Entry Search' (see P.5-12)

Calculator (see P.12-29)

Send 2-Touch Mail (see COJP.3-12)

Set Alarm? (see P.12-7)

Schedule® (see P.12-7)

X[ X|O|O|0|0|0|0

X[ X[ X|O|X|O|O|O ™

X[ X| X[ O] X|O|O| X| @

O|O|X|O|X|O|O| X[ =~

X|X|X| O X|O|O| X
X| X| X| O] X|O| X| X
X[ X| X| X| X[ O] X| X

'Only Katakana Search is available.

2Enter four digits (24-hour format) to set Alarm. Full appears when there are five entries.
3Enter four digits for month and day. Check entries for the next 12 months.

1-24

Guide

Open quick guides to functions inaccessible from Functions Menu.

m P Functions # Settings 1

Select B Guide and press (®
Pen Light guide appears.

2 Use (D) to toggle guides
3 Press & to exit

MDisplay Content
15:05 W: 15:05
F30:Guide F30:Guide

<Clamshell Open> <Clamshel | Open>
Ringing —————— Situation
9 — Operations (Keys)
Redial

— Function

— Press (®) to use
mE, the function
(Available for
some functions)

(Example: Incoming Call)
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Handset Codes
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Both Security Code and Center Access Code are needed for handset use.

Security Code

9999 or the 4-digit number selected at initial subscription.
Security Code is required to use/change some handset functions.
e ¥appears when Security Code is entered.

e If incorrect, Invalid Code appears. Enter correct Security Code.

e Change Security Code as needed (see P.11-2).

Center Access Code

The 4-digit number in the contract, required to access Optional Services via landlines,
and to subscribe to fee-based information.

Do not attempt to change Center Access Code.

Contact Vodafone Customer Center, General Information (see P.14-20) for details.

¢ Write down Center Access Code. If lost, contact Vodafone Customer Center,
General Information (see P.14-20).

¢ Do not reveal Security Code and Center Access Code. Vodafone is not liable for
misuse or damages.
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Initiating a Call
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=)l

Confirm handset is on

e Check signal.

» Handset will not transmit when a1, &, < or &
appears (see P.14-8).

Enter a phone nhumber
il

Add to PhoneBook

031230XXKT

¢ Include the area code, even for local numbers.
Sending/Blocking Caller ID
* Press the following keys when placing a call.

8

Confirm the number and press (3

Correcting Numbers

« Use 9 to move cursor and press C=] to delete
the digit above the cursor.

* Press &7 for 1+ seconds to delete the entire
number and return to Standby.

e |f you misdial, press @ to hang up and try
again.

Busy Numbers

* Press @) to end the call and try again later.

Press (&) to end call

e Alternatively, close handset.
Cancel Close to End Call to keep the line open
with handset closed (see P.2-3).

Close to End Call

Il Select whether or not to end calls by closing handset.

Press (® ® Select Functions % Press (® # Select ISounds # Press (®) %
Select B Call Functions % Press (®) ® Select llincoming Call % Press (® &
Select EClose to End Call % Press (® % Choose [lOn or BOff % Press (®

[On

| Calls end |Off  [The other party hears no sound

¢ Close to End Call is active by default.

* Do not cover handset microphone while talking
on the phone.

* Avoid covering area over Internal Antenna (see
P.1-6 FH).

* Voice quality is affected depending on how and
where handset is used.

Microphone

e Use Instant Display to see Call Time and Call Charge (see P.2-19, P.2-20).

* Confirm Total Talk Time (see P.2-19) and Total Charges (see P.2-20).
* To use Speaker Phone or Speaker during calls, see P.8-21.

* For information on international calls, contact Vodafone Customer Center, General

Information (see P.14-20).
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Place calls from Redial. Up to 20 recently dialed numbers are saved in Redial.

C -\
oCl=>0

1 Press ©) ()

O vodafone

[EEReceived
@llemo eSelect Menum

2 Dialed numbers appear with date and time.
Name appears if saved in Phone Book.

2 Select a record and press (®)
Press O

Number is dialed.

* When the same number is dialed more than once, only the last record appears.

* Names in Secret Mode entries appear only in Secret Mode.

* Records remain even after handset power is turned off.

* When there are 20 records, oldest records are replaced by new ones. To delete
records manually, see P.2-14.

Preset the number to add before dialing a phone number saved in Phone Book. Use
International Call to place international calls and Send With Code to add one prefix

such as 186 (Send Caller ID) or 184 (Block Caller ID).

Setup Preset Preset the number to add before a phone number

M International Call: 0046010, Send With Code: None

m P> Functions % Services ® Setup Preset

Select [international Call or BSend With Code % Press (®) % Enter

a prefix  Press (®

[¥ To change the prefix, select llInternational Call or B1Send With Code # Press (®) &

Press (3%] (Long Press) ® Enter a new prefix # Press (®
¢ Enter up to seven digits for International Call and up to six digits for Send With Code.

[l ElRe 1 Dial from Phone Book using the number set in Setup Preset
LSRG RGN above

m P Tel Ops ® Entry Search ® Open an entry % Menu ((®))

Select International Call or Send With Code % Press ()

Emergency calls (110, 119, 118, etc.) are possible even while some handset

restrictions are active.

Active Restriction

Emergency Calls

Key Guard (see P.1-19) Not possible
Off-Line Mode (see P.3-6) Not possible
Keypad Lock (see P.11-2) Possible
Auto Key Lock (see P.11-3) |Possible
Restrict Dial (P.11-4) Possible
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Incoming Call
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15:05 i
<<Incoming Call>>

\ .
L

0312300KKT

e llenu

Number appears when Caller ID is sent. Caller's

name appears if saved in Phone Book.

When Message Recorder is Active

¢ Outgoing message plays and recording starts
(see P.12-5).

2 Press(3

e Alternatively, press any of the following keys
(Anykey Answer): -9, 9, @, &,
&z, @l B, ©), (09

Handling Incoming Calls: see P.2-8 - 2-9
3 Press & toend call

e Alternatively, close handset.
Cancel Close to End Call to keep the line open
with handset closed (see P.2-3).

Ring Tone Volume

Il Press (8 (up) or (Q) (down) to adjust volume. (Cancel Manner Mode to adjust level.)
¢ Ring Tone Level setting (see P.8-2) changes accordingly.

H Press to instantly mute Ring Tone for that call only.
Il When Side Key Settings for Incoming Calls (see P.12-3) is set to B Quick Silent,
press for 1+ seconds with handset closed during incoming calls to mute ringer.

* Up to 20 incoming call details are saved (see P.2-14).
* Activate Delayed Ringer (see P.2-10) to delay handset ringer for three seconds for

incoming calls from numbers not saved in Phone Book or Owner Profile.
* To customize Ring Tone and Mobile/Small Light pattern, see P.8-2 "Call Functions."

Call History

Up to 20 received calls are saved in Call History (see P.2-14). When Caller ID is sent,
numbers appear. Place calls directly to those numbers.

2

1 Press(©

15:05 ik
Missed Call

3. 9/23 17:20
Suzuki Itirou
2. 9/22 11:20
Ueda Mikio

1: 9/21 12:45
03123XXXX1

#E\lemo

@Redial ®Select Menums

Received numbers appear with date and time.

Name appears if saved in Phone Book.

2 Select a record and press (®)

Press O

Number is dialed.

* Names in Secret Mode entries appear only in Secret Mode.
* Records remain even after handset power is turned off.

* When there are 20 records, ol
records manually, see P.2-14.

dest records are replaced by new ones. To delete
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Handling Incoming Calls
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Callers placed on hold hear a message explaining that you cannot answer their call
right away and asking them to hold or call back later.

1 When a call arrives, open handset

D Press

Hold tone sounds for five seconds.
* No tone sounds when Ring Tone Level is set to
Silent.

3 Press 1) to answer the call
e Alternatively, press keys for Anykey Answer
(see P.2-6).

Hold or Reject with Handset Closed

Il When Side Key Settings for Incoming Calls (see P.12-3) is set to llHold or EJReject Call,

press for 1+ seconds during incoming calls to activate the function.

Activate Message Recorder (see P.12-4) for one time only to record caller messages
on handset.

1 When a call arrives, open handset

D Press @
Outgoing message plays and recording starts.
[l Press (@57 to play recorded messages
(see P.12-5).

Message recorder is disabled when recording capacity is full (see P.12-4 "Message
Recorder Disabled").

P.2-3) is canceled, line remains engaged even if handset is closed.

@ ® Press @ or close handset to end calls on hold. However, if Close to End Call (see
¢ Calls on hold end if callers hang up.

2-8

Voice Mail

Il Unanswered calls are forwarded to Voice Mail (see P.13-4).

2-9
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Delayed Ringer

Engaged Call Operations
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Activate Delayed Ringer to help screen one-ring sales calls. Handset ringer is delayed for

three seconds for incoming calls from numbers not saved in Phone Book or Owner Profile.

Delayed Ringer is Off by default.

P Functions % Sounds %
Call Functions % Incoming Call

1 Select BDelayed Ringer and press (®)
2 Choose MOn and press ®

2-10

Earpiece Volume

Adjust Earpiece volume (5 levels). Earpiece volume is Level 5 by default.

1 During a call, press (5 or

2 Press (5 (up) or () (down) to adjust
volume level
Each press changes volume by one level.
« Wait five seconds or press (®) to save the level.
® Volume level remains as set even after handset
power is turned off.
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1 During a call, press for 1+
seconds
Recording starts.

D Press again to stop
¢ Recordings remain even after handset power is
turned off.
* To play or delete Voice Memo, refer to the
description for Message Recorder on
P.12-5, P.12-6.

Closing handset ends a call and Voice Memo recording if Close to End Call (see
P.2-3) is active. (The remaining recording time will not appear.)

Save up to 3 sets of numbers during a call.

e Use up to 24 digits (0 - 9, ¥ and #) per entry.

¢ When full, oldest entries are deleted to make room for new ones.
e Save phone numbers from Notepad Memory to Phone Book.

digits
Press

¢ When the current call ends or another call

automatically.

0Jel=lallale) =h1idl=50 | Open saved Notepad entries

During a call, use Keypad to enter

Entered digits are saved to Notepad Memory.

arrives before Step 2, entered digits are saved

index eny [P

Select @Notepad # Press (®)

¢ Up to 3 sets of numbers appear, most recent first.

* Press (3 to dial the number.

o |f there is no entry, Notepad Memory Not Found appears.

« Alternatively, press ¢)<0] MM to open Notepad Memory.
[ Press @) to exit.

|71 To save to Phone Book, select an entry ® Press ®» Select Add to Phone Book

% Press (@ # See P.5-4 - 5-5 for more

[7] To delete, select an entry ® Press % Select Delete or Delete All % Press (@)

% Choose IlYes # Press (®

2-13
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Redial & Call History
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Opening Redial Records

1 Press ©) ()
Dialed numbers appear with date and time.
Name appears if saved in Phone Book.
e When there is no Redial record, Call History
appears.
Press @ to dial the number.
Press (@) to return to Standby.

Opening Call History Records

Press

Received numbers appear with date and time.
Name appears if saved in Phone Book.

Press (J to dial the number.

Press (&) to return to Standby.

Delete Redial/Call History records

Cindex enw NPT

Select @Redial or BCall History  Press (® # Press (&> TR »

Select Delete or Delete All % Press (® » Choose [BYes # Press (®

2-14

. Call History Indicators

Call in Progress

Answered call

Missed Call

Unanswered call (including calls screened by Delayed Ringer)

Hold

Disconnected after hold

Message Recorder

Recorded on Message Recorder

Forward Voice Mail

Forwarded to Voice Mail Center

Reject Rejected call
Payphone Call from payphone
No Caller ID Call without Caller ID

. Missed Call Notice

For missed calls, one of the following notices appears. (X indicates the number of
missed calls or recorded messages.)

Message Recorder

Voice Messages: X

Missed Call

Missed Calls: X

Message Recorder &
Missed Call

Voice Messages: X
Missed Calls: X

« Press (Q) to open most recent first.
Press (8) to open oldest first.
* Press (3 to dial the number.

* Press

* Press @) to exit
&)

to close Missed Call notice.

¢ See P.2-14 to reopen Missed Call details.
* Reject appears for rejected calls.
e For more about Message Recorder, see P.12-4 "Message Recorder."

2-15
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Simple Mode
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Activate Simple Mode to reduce available handset functions
and simplify menus. Handset is limited to basic operations (see

P.2-17 - 2-18).
2N

- ol
Simple Hlode Hleny
(ol lumber
[Phore Function
Bl
ENanera

Activating/Canceling Simple Mode

2-16

Press (®)
Select Simple Mode and press (®)
Choose [BOn and press (®

¢ Simple Mode remains active even after handset
power is turned off.

WN =

Press (®
Select E}Standard Mode and press (®)
Choose [ Yes and press (®

WN =

¢ When Simple Mode is activated while any of the following are in use, a confirmation
appears. Choose [ Yes and press (®) to activate Simple Mode.
m Off-Line Mode' (see P.3-6) = Phone Book Lock-2 (see P.11-3)
m Restrict Dial': 2 (see P.11-4) = Accept Call' 2 (see P.11-5)
® Reject Call" ? (see P.11-5) = Secret Mode? (see P.11-6)
m Alarm’ (see P.12-7) m Auto Power On/Off' (see P.12-11, P.12-12)
m Schedule (Alarm is set)! (see P.12-13)
m Paused V-Application (see COJP.10-6)
Cancel Simple Mode to reactivate.
2Security Code is required.
¢ In Simple Mode, Ring Tone sounds in Pattern 1 (for incoming calls) and Mail (for
incoming mail) even when melody files in Data Folder are used.

Simple Mode Operations

B simple Mode Menu Operations \

In Standby, press (® to open Simple Mode Menu.

EMy Number

Show handset phone number (Owner Profile is not available)

DPhone Functions

Access Add to Phone Book, Entry Search, Incoming Tone, Manner
Mode, Message Recorder and Voice Mail (see below)

BEMail

Create, reply, forward, resend and edit or delete messages (see P.2-18)

ElCamera

Capture images and open saved images (see P.2-18)

ETools & Settings

Access Keypad Lock, Auto Key Lock, Wallpaper, Font Weight,
Calculator, Alarm, Clock Settings and Instant Display (see P.2-18)

Bstandard Mode

Exit Simple Mode (see P.2-16)

Sub menus:
B OPhone Functions

Add to Phone Book

Save entries (see P.5-3).
Enter name, reading, up to three phone numbers
and mail addresses.

Search entries by katakana (see P.5-13 "Katakana

EEntry Search Search"). Only Katakana Search is available.
Ring Tone | Customize Ring Tone for incoming calls (see P.8-3
Dincoming gR'ngT = - 1ze Hing : g ( )
Call L;vil ON€ | Adjust volume (see P.8-2)
Blincoming Customize Ring Tone for incoming mail messages
Tone Ring Tone Y 12e 1l ! ! '
Elincoming ORing (see P.8-3)
Mail i
BRing Tone Adjust volume (see P.8-2)
Level

EManner Mode

Activate or cancel Manner Mode (see P.3-3)

BlMessage |[MRecorder Settings

Activate or cancel Message Recorder (see P.12-4)

Recorder |BPlay

Play messages (see P.12-5)

DActivate Initiate Voice Mail (see P.13-4)
EVoice Mail [ElCancel Cancel Voice Mail (see P.13-4)
ElPlay Voice Mail Check messages (see P.13-5)
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HEwail

Call Time

DMail Dinbox Open received messages (see (O JP.4-2)
ElSent Open sent messages (see (OJP.4-2)

BWrite Mail Send Sky Mail messages (see (OJP.3-3)
In Simple Mode, Mail Settings are disabled and cannot be changed.
BMEB)Camera

. Capture Sha-mail mode or Wallpaper mode images (see P.6-7).
Eistill Photo Press to toggle between the modes.
BView Image Access still images saved in Data Folder (see P.9-6)

Image size is W 120 x H 160 dots (Sha-mail mode) or W 240 x H 320 dots (Wallpaper

mode) and only Brightness, Zoom and Mobile Light are available for image capture.
B BTools & Settings

DKeypad Lock

Restrict access to handset functions (see P.11-2)

BEAuto Key Lock

Automatically activate Keypad Lock each time handset power is turned
on (see P.11-3)

Elwallpaper Show an image or animation in Standby (see P.7-2)
EFont Weight Change the weight of handset fonts (see P.7-6)
Bcalculator Use for basic arithmetic, percentage and tax calculation (see P.12-29)
Set Alarm to sound at a specific time.
To set, choose [lOn # Press (® % Enter time # Press (@) »
EAlarm Choose IB0On or BlOff (for Snooze) # Press (® » Select IlEvery Day
or E\Weekdays (for Weekly) # Press (®) ® Press <0l
® To cancel, choose E1Off » Press (®)
EdClock Settings Enter date and time (see P.1-20)

Einstant Display

Show estimated Call Time and Call Charge after calls (see P.2-19, P.2-20)

. Key Assignments

In Standby:

©) Open Redial records (see P.2-4)

@ Search Phone Book (Katakana Search: see P.5-13)
@ Open Call History records (see P.2-7)

(Long Press) Activate/cancel Manner Mode (see P.3-3)

O Activate/cancel Message Recorder (see P.12-4)

e Other keys are disabled except for placing calls.
¢ In Simple Mode, shortcuts by Keypad and Quick Operations (see P.1-24) are disabled.

2-18

Check estimated Call Time of the most recent call or Total Talk Time.

Call Time appears for calls made and those received.

m P Functions % Charges % Total Talk Time
Press (® # Enter Security Code » Choose [lYes # Press (®

m P Functions % Charges

Select E]Call Time and press (®
For Total Talk Time, select B Total Talk Time

 Press (®

2 Press @ to exit

Reset Total Talk Time

Set Call Time to appear automatically after each call

MR Off

m P Functions » Charges ® Instant Display
Choose IBOn or BOff % Press (@

e Call Charge also appears for calls you made.

e Total Talk Time and Call Time remain even after handset power is turned off.
¢ Ring time for incoming or outgoing calls is not counted. On hold time is counted.
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Call Charge

My Number & Owner Profile
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Check estimated Call Charge of the most recent call or Total Charges.

m P Functions » Charges |

Select [ICall Charge and press (®)
For Total Charges, select @ Total Charges »

Press (®
2 Press & to exit

“ Reset Total Charges I

m P> Functions % Charges % Total Charges |
Press (®) ® Enter Security Code » Choose [l Yes # Press (®)

L) VA Set Call Charge to appear automatically after each call I

Default(olij
m P Functions % Charges # Instant Display |

Choose IOn or BOff # Press (®

¢ Call Charge will not appear after leaving a 3 Way Call (Break Away).
e Call Time appears at the same time.

e When the most recent call is a received call, ====--- Yen appears.
* Sum of charges appears for 3 Way Calling (Optional Service).
¢ Call Charge will not appear when calls are interrupted due to weak signal.

@ * Total Charges and Call Charge remain even after handset power is turned off.

2-20

Confirm handset phone number.

¢ Save name, reading, phone numbers, mail addresses, postal code, personal data and photo.
¢ To create QR Code from Owner Profile, see P.12-27.

¢ Handset phone number cannot be changed or deleted on the handset.

m > Functions |

1 Select @My Number and press (®)
To open Owner Profile, press »
Enter Security Code
¢ Owner Profile contents are similar to those of
Phone Book (see P.5-12).

2 Press @ to exit

Edit, . .
Delete & Copy Add, edit, delete or copy Owner Profile items I

BRI » Functions % My Number # Details (£)) |

Enter Security Code » Press (® » Select Edit % Press (®) #» For
more, see Steps 4 - 6 in "Editing Phone Book" on P.5-15
To delete Owner Profile (all items except handset number), enter Security Code and
press (® # Press (®) % Select Delete # Press (8 % Choose [BYes # Press (®
To copy an item in Owner Profile, enter security code and press (®) # Use €9 to select
an item # Press (®) ® Select Copy # Press (®) # For more, see Step 5 and onward in
"Copy/Cut & Paste" on P.4-17
® Image for Photo cannot be copied.

2-21
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Minding Mobile Manners Manner Mode
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Please use your handset responsibly. Use these basic tips as a guide. Inappropriate 0 0 0

handset use can be both dangerous and bothersome. Please take care not to disturb ACtlvatmg & Cancelmg

others when using your handset. Adjust handset use according to your surroundings. Activate or cancel Manner Mode in Standby, Web information, mail windows (Mail Box,
e Turn it off in theaters, museums and other places where silence is the norm. message window, etc.) or while using V-Applications.

¢ Refrain from using it in restaurants, hotel lobbies, elevators, etc.
¢ Observe signs and instructions regarding handset use aboard trains, etc.

Activating Manner Mode m

¢ Refrain from use that interrupts the flow of pedestrian or vehicle traffic.
Press for 1+ seconds §
® and Manner Mode Set appear. The following S
indicators appear as set in Manner Settings (see g
H Manner Mode: see P.3-3 P.3-4). §
Press Manner Key to automatically mute all Ring Tones and activate Vibration mode &
for incoming calls, mail and information. & |Message Recorder| M |Vibration
[l Vibration Mode: see P.8-3 Sl [Silent & |Rising Tone
Activate Vibration mode to use handset vibration to alert you to incoming calls, mail,
etc. in public places.
Il Volume Settings: see P.8-2, (OJP.12-2
Decrease or mute Ring Tone volume for incoming calls/mail/information as well as Press for 1+ seconds
tones for Web or V-Applications when carrying handset in public places. ¥ disappears and Manner Mode is canceled.
Il Whisper Mode: see P.3-5
Use Whisper Mode to increase microphone sensitivity, allowing you to lower your
voice and speak softly when you must use handset in public places.
[l Off-Line Mode: see P.3-6
Use Off-Line Mode to temporarily suspend all handset transmissions. In Off-Line
Mode, incoming/outgoing calls and Vodafone live! transmissions are blocked.
[l Message Recorder: see P.12-4
Use Message Recorder to handle incoming calls when it is inappropriate or unsafe to
answer. When Manner Mode is Active
Il Power On/Off and error tone as well as Keypad Sound are muted. Beeps in Call
Waiting and 3 Way Calling are heard.
Il Shutter Click and Self Timer tone sound even in Manner Mode.
[l Settings for Manner Mode are applied to: Message Recorder, Ring Tone Level,
Vibration, LED Indicator, Whisper Mode, Sound Volume, V-Appli Volume and V-Appli
Vibration.
Il When Message Recorder is recording messages, the other party's voice is heard
through Earpiece.
3-3
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Customize Manner Mode settings.
Default settings:

Message Recorder | On Ring Tone Level |Silent (All) |Vibration

On (All)

LED Indicator Small Light | Whisper Mode On Sound Volume

Silent

V-Appli Volume | Silent V-Appli Vibration |On

\EERE S E eI e S8 Activate or deactivate Message Recorder

m P Functions % Settings 2 % Manner Settings % Message Recorder|

Choose [On or BOff # Press (®

Sl el cr ESVE B Set Ring Tone volume

m P> Functions % Settings 2 % Manner Settings ® Ring Tone Level |

Select from @incoming Call to @Confirm Delivery » Press (®) %

Select [Silent, BRising Tone or ElLevel 1 % Press (®

¢ For Silent, Speaker is muted and sounds can be heard through headphones. Volume is

fixed to Level 1.

Set vibration to alert you to incoming calls/mail

m P> Functions % Settings 2 % Manner Settings % Vibration

Select from [incoming Call to @Confirm Delivery » Press (® »

Choose [BOn or BOff » Press (®

P.12-15) is set to Off or SMAF Link.

Il When Silent is set for Ring Tone Level (see P.8-2) or Alarm Tone Volume (see
P.12-15), no sound is heard. If Level 1to Level 5is set, Rising Tone is activated and
sound will increase to the set level (Level 3is set: Level 1 — Level 2 — Level 3).

[l Handset vibrates even when Vibration for Call Functions (see P.8-3) or Alarm (see

3-4

LED Indicator Flash Mobile/Small Light for incoming communications

m P Functions % Settings 2 % Manner Settings ® LED Indicator

Select from IINormal to E)Off % Press (®

Normal

Mobile/Small Light flashes as set in Call Functions (see P.8-2)

Small Light Small Light flashes

Off

No lights

W e e s Activate or deactivate Whisper Mode

m P> Functions ® Settings 2 % Manner Settings ® Whisper Mode

Choose [On or BOff  Press (®
¢ Activate Whisper Mode to increase microphone sensitivity, allowing you to lower your voice
and speak softly when you must use handset in public places (¥ flashes).

Whisper Mode can be set On/Off during a call by pressing for 1+ seconds.

After the call, Whisper Mode will be canceled.

ol e G E = Adjust sound volume

m P> Functions % Settings 2 % Manner Settings % Sound Volume

Adjust level » Press (®

Ve IR = Adjust V-Appli volume

m P> Functions % Settings 2 % Manner Settings % V-Appli Volume

Select ISilent or BLevel 1 % Press (®)

VAR e B Handset vibrates while using V-Applications

m P Functions » Settings 2 % Manner Settings ® V-Appli Vibration |
Choose [BOn or BOff » Press (®

3-5
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Off-Line Mode

SpO Jouuep B

Use Off-Line Mode to temporarily suspend all handset transmissions.
¢ In Off-Line Mode, incoming/outgoing calls and Vodafone live! transmissions are blocked.

¢ Off-Line Mode is Off by default.
Activating Off-Line Mode

P> Functions % Settings 1 %
Off-Line Mode

Choose IBOn and press (®)

™ appears.

Canceling Off-Line Mode

P> Functions % Settings 1 %
Off-Line Mode

Choose BlOff and press (®

‘M disappears and Off-Line Mode is canceled.

Emergency calls (110, etc.) are not possible in Off-Line Mode. For more, see P.2-5
"Emergency Calls."

* When Off-Line Mode is set while a Network V-Application is paused (see
(OJP.10-6), V-Appli Paused Cannot Connect to Network in Off-line Mode
Off-line Mode On? appears. Choose [l Yes and press (® to enter Off-Line Mode.
(Network connection is disabled until Off-Line Mode is canceled.)

¢ While handset is closed or Display shuts down for Panel Saving in Off-Line Mode,
Small Light flashes red, green and orange.

3-6
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Character Selection

Use Kana and Pager (see P.4-10) to enter alphanumerics, Symbols, hiragana, kaniji,
katakana and Pictographs. With the exception "Pager Code" on P.4-10, most text
entry operations are described using Kana Mode.

Entry Modes
Press to toggle between character entry modes as follows:
Ao | 8 E>FoTFoa—oa
Alternatively, use €09 to toggle between entry modes after pressing once.
277 a2z Available Modes

Key Assignments

Multiple characters are assigned to each key. Press a key to toggle between character
options for that key.
Example: In katakana entry, press three times for .
When entering characters, press @ to toggle between character options in reverse.
(Not available for entering single-byte numbers, Pictographs and Character Codes.)
Example: Enter L), then press [ to return to &.

/128 5 - Single-byte alphanumerics
i /& | Kanji (hiragana) A (upper/lower case)
7 | Double-byte katakana a Single-byte alphanumerics
(lower case)
7 |Single-byte katakana 1 |Single-byte number
Double-byte alphanumerics & .
@Text  ®0K | Nenuts A (upper/lower case) i Pictograph Code
Current Entry Mode - i
v a I(?g;g:_eczgf) alphanumerics [X |Character Code

Upper & Lower Case

B In double- or single-byte alphanumerics mode, press to toggle between upper
case and lower case. For Pager Mode (see P.4-10), in double- or single-byte entry
mode, press to toggle between upper and lower case.

R77Ma 14 | e [E770 1%

Pictograph & Character Codes

Il Press <@l to toggle as follows:
Pictograph Code 1 — Pictograph Code 2 — Pictograph Code 3 —
Pictograph Code 4 — Pictograph Code 5 — Pictograph Code 6 —
Character Code — Pictograph Code 1
e Pictograph Code page number appears at the bottom.

* Handset Character Codes correspond to 6,355 kaniji.
e Some characters are not available for mail addresses, etc.

Key Kaniji (Hiragana) Katakgna AIphanumerics Numbers Pictograph Code 1 -6
[Double-byte] |[Double & Single-byte][Double & Single-byte]  [Single-byte] & Character Codes
o | BUSAB FAOLA @ /_—1 ) ]
BVWSRB FAOIH [ (space)
hELIFZ HF¥oo3 ABCabc?2 2 2
TUTEZE YRty DEFdef3 3 3
E5DTED #FYFhy | GHIghi 4 4 4
1XICsHRD TR/ JKLjkIb 5 5
(FOBNIE eI MNOmno 6 6 6
FHOHE Y=LXE  |PQRSpars7? 7 7
PR & ¥13va3 TUVtuvs 8 8
5b3N3 Sujbo |[WXYZwxyz9 9 9
d?l_ﬁéu Broak) u?ﬂe’ Break) d (Line greak) 0 0
Bt | S P raer
Log, Double-byte Symbol®/Pictograph List #
® Conversion (Up) Cursor Up
(9) |Conversion (Down) Cursor Down ¢ (Line Break)
©) Cursor Left
(9 Cursor Right
Change Entry Mode
Toggle Case + Toggle
Toggle Case (for some characters) [Mode (upper/lower and
lower case)
2 PO S
&z
Long Delete All
Press
@ Recover up to 64 deleted characters®
® OK
o | frone o Toggl e

Conversion Character Code

Hiragana to Katakana/

o7
Alphanumerics Open list’ for

Pictograph Code 1 - 6

Conversion

' Disabled until hiragana is converted.

2.is available only in single-byte katakana entry.

3Extensions are listed for easy entry.

4.and P (Pause) are for phone number entry.

5Single-byte for single-byte katakana/alphanumeric entry.

8Press (Y once for each character to recover immediately after deleting. [Not available after
deleting text with (3z] (Long Press).]

“List is not available for Character Codes.

slejorleyn Buusiug h



sieoeseyn Buusiug E

Entering Characters

Following the example below, enter #87K to learn how to enter characters in kanji
(hiragana) entry mode. Switch to double-byte or single-byte katakana mode to enter
katakana. Alternatively, enter hiragana and then select katakana from the word
suggestion list.

5 Press and use ({) to select a word

[7 To see other suggestions, press R Back B
[7 To exit the list, press C=].
[ To change segment, see "Segmenting Phrases" below.

6 Press ®

Learning Function

Il The most recently used word appears first in the list.

Predictive & Previous Usage

[l Use Predictive and Previous Usage to convert hiragana to kanji more quickly.

Predictive Word suggestions change as up to 5 hiragana are entered
Previous Usage |Suggests words/characters likely to follow entry based on previous entries

¢ Both functions are active by default (see P.4-14).

User Dictionary

Il Save frequently used words/phrases to select from the word suggestion list (see
P.4-15).

Press &2 three times i
Word suggestions change as hiragana are entered. Vi
@Kanji (*)Convert Inutlethose
Press (09
« When the next character is on the same key, press (©9 first.
0/128
@Kanji (¥)Convert linutletnud?
3 Press three times and press b
128
@Kanj i (™)0onvert Inputlethodt)
Press twice :
* To enter hiragana without converting to kaniji, skip to Step 6. New NMessage
/128
JIE
07857
062 X+
05
PAESARE
@3558
@Kanji (¥)0onvert | mutletroie)

Il Segmenting Phrases

If the word is not in the list, press &= after Step 5 to exit. Then use €09 to segment
hiragana to convert separately.

Example: Segment #5 into & and 5.

LO® @O®
BE |==>E5 | = =H | =

sisoetey) Buusiug h
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Il Selecting Multiple Converted Words

Press
Example: To enter FGLLAH

©@
[CL®FEREVT 1T g N ] |

B smallKana (2, v, etc.)
Enter small hiragana &, L), 5, X, &, D, 1, B and & as well as small katakana.

1 Enter a character and press

. Adding * or °

1 Enter a character and press
¢ In kanji (hiragana)/double-byte katakana entry, press the key
once to add * to A" (Ka) row, & (Sa) row and /& (Ta) row
characters, and press twice to remove. For [& (Ha) row
characters, press once to add * , twice to add ° and three times
to remove.

o |EW | o [ [«
@« @ |« “«| @
&)@ @ 1 |

In Single-byte Katakana Entry
® Press once to add * and twice for ° . Symbols are single-byte.
o Press &7 to remove * or ° .

Entering Alphanumerics

Enter alphanumerics in double-byte alphanumerics (upper & lower case) or
single-byte alphanumerics (upper & lower case) mode. Alternatively, enter numbers in
single-byte number mode.

B ] == ]

¢ In double-byte or single-byte alphanumerics mode, press to toggle between upper
and lower case.

¢ When the next character is on the same key (example: entering A then B), press (©9 first
to move cursor.

4-6

Symbols, Pictographs & Emoticons

. Symbols & Pictographs

1 Press or to open Log List (Log List is available in some
entry modes)
Recently used Symbols/Pictographs appear.
e -- appears by default or when Log List is deleted (see below).

2D Use (s to select one and press (®
* Repeat Step 2 to enter more.
To see more lists, press or C9l. The list toggles as follows:
Log List = Symbol List (1 - 3) = Pictograph List (6 - 1)
m Press to toggle the list in reverse order.
m Press (9) to scroll down.

3 Press to exit list

Deleting Log List

M In a text entry window, press (2> Il » Select B)input/Conversion % Press (®
% Select BClear Symbols % Press (® » Select IOK # Press (®
mPress twice to return to the text entry window.
B Log List cannot be deleted in Pictograph Code mode.

In Pictograph Code Mode

B To enter a Pictograph directly, enter 2 digits (see COJP.16-8 - 16-10).
mTo edit a code mid-entry, press to clear first digit then enter correct digits.
B To select from Pictograph List, follow these steps.
Press % Select a Pictograph # Press (®
* To toggle through Page 1 - 6 and Log List, press <@l.

¢ Single-byte Symbols do not appear in Log List.
e Symbols are double or single-byte according to the entry mode. (Pictographs are all

double-byte.)
* Alternatively, enter &35 and press () [FIMIR. Some Symbols can be selected.
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Emoticons

1
2
3

In a text entry window, press
Select G)Emoticons and press (®)

Select an emoticon and press (®

¢ Enter two digits (01 - 50) to jump to the emoticon assigned to the number.

Emoticons cannot be entered in Pictograph Code (1 - 6) mode.

* Alternatively, enter a descriptive word such as £—{1or 5—As and press () [FIR.

@ « For other emoticons, enter /'@ and press () [(T0E.

Corresponding emoticons can be selected.

Space

In a text entry window, press
e Alternatively in alphanumeric entries, press seven times to
enter a space.

¥ ©

Copying from Phone Book

Insert Phone Book entry items into text entry windows.
Select from names, phone numbers, mail addresses or Personal Data.

1 Inatext entry window, press
Press <0l

Open a Phone Book entry
To search Phone Book, see P.5-13.
m Skip the step of pressing (3 ([FEL).

Use ¢ to select an item and press (®)
Use 52 to move cursor to target location
Press (®

Selected item is inserted.

(RS I WN

@ Set e Start

Back®s|

Line Break

Insert line breaks in text, Text Memo, BBS, etc.

1

Press (Q) at the end of text

* To insert line breaks in text, press until ¢ appears. For kanji
(hiragana) entry mode, then press (®). Line break is inserted at
the cursor position.

o Keystroke count varies by character entry mode (see P.4-3).

Mail & Web Extensions

1

In alphanumeric entry, press

Select an extension and press (®)
* Mail addresses and URLs are single-byte.

Contact me atll
\ JO)

Inserting Owner Profile

H In a text entry window, press » Select EE@ Saved Info »
Press (® # Select DAProfile % Press (® % Enter Security Code

* For more, see Steps 4 - 6 above.

Contact me até¢

Character Code

Use multi-digit Character Codes to enter characters.

1 In Character Code entry mode, enter four digits (see P.14-9 - 14-12)

slejorleyn Buusiug h



Pager Code . Pager Code List |

* Blanks indicate no entry.

In a text entry window, press ¢ Upper and lower case are available for characters with gray background. Press to switch.

sieoeseyn Buusiug E

2 Select EInput/Conversion and press@ Double-byte upper case Double-byte lower case
Second digit (Press secondly) Second digit (Press secondly)
3 Select Il/nput Method and press (®) AR ERERREEEG AR ERERREEE
4 Select BPager and press (® 11&5|V|5|Z|S|A|B|C|D|E 1|s|w|>5|z|s|a|b|c|d|e
Pager Code entry window opens. =2 |p|E|L|F|T|F|[G[H|I|J =2 flglh|ili
To switch to Kana Mode, select llKana # Press (® g 3lxlulglel=lkILIMIN]O g 3 kl1Imlnlo
5 Enter two digits (see P.4-11) @|41/c|5|D|TIEIPIQIRISIT a4 ) plajris|t
 Pager Mode is active until switched to Kana Mode. é S5 |/K|IC|B|R|D|UIVIWIX|Y é 5 ujviwix|y
%GIEKUB\’\IEZ?!—/ %',5 z
= < | = |
Character Entry Modes SFH3OHDHYE @ e 2
. 218 |® (|B]) K| ¥ |[#][=P 218w |®| |&
Il For text entry in Pager Mode, press to toggle between entry modes as follows: ic ~ ic
i i & 9|5|h|% N|B|1|2[3|4]|5 9
Single-byte lower case ( P )— Pictograph Code 1 - 6 (#&) & Character Code olnl=lAl" |16/ 78|90 0
mode ([X)— Double-byte lower case (F) > 1o
* Press <@l to toggle between Pictograph Code 1 - 6 and Character Code mode. Single-byte upper case Single-byte lower case
M Press to toggle bstween upper and lower case. Second digit (Press secondly) Second digit (Press secondly)
1/2(3(4|5|6|7|8|9|0 1/2(3(4|(5|6|7|8|9|0
* Hiragana to Katakana/Alphanumerics Conversion is disabled in Pager Mode. 1(7(4(wlzlslAalBlCc|D|E 1|7(4(olzlslalblc|d|e
eToenter® or° ,see Pager Code List on P.4-11. =12[nl%[s|r[alFleln]1]J =2 tlelnlil]
El3]y]|y[zlelv]k[L[m[n]0O £]3 k[ 1[n]n]o
%49§‘YTI~PQRST %4 Y plajr|s|t
g5 [ F || X|#[JJUjV]W|X]|Y &5 ulviw|x|y
=6 NE|T|AN[R[Z|?2] ][]/ =|6 z
2 = ] 2 ]
B 7|V |S|A[X[E|¥|E &= 5|7
B8 0| (|2])[3 | ¥%|#]|=| " Bl8|v| [2] |3 2
“lol5/ulw|v|oj1]2[3]|4]5 19
0|7(F|Y|"|°|6]7]8[9]0 0
*1Press Z to insert line breaks (in mail message text, Text Memo, etc.).
°Press to toggle between upper and lower case.

e ¢» and @ are double-byte.

4-10 4-11
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Conversion Methods (Japanese Only)

Phonetic Conversion

Enter alternate readings to search for kaniji.
7 Enter reading in hiragana

2 Press @l
3 Select a kaniji and press (®

One-Hiragana Conversion

Enter the first hiragana to access previously selected words.
Example: To enter #57K

N
@®

R i~
[HW]
001 M=AEOIE
011
021
031

041 EFSTNEAS
@Back = e 0K

o @
B ] e BN ] == (Al

* One-Hiragana Conversion and User Dictionary (see P.4-15) share memory. Selected

words may not be saved if User Dictionary is full.

e Up to 20 entries are saved per hiragana (Title Word) between One-Hiragana Conversion
and User Dictionary. When memory is full, the oldest entry is deleted to make room for a

new entry. However, User Dictionary remains unchanged.

4-12

Hiragana to Katakana/Alphanumerics Conversion

Enter katakana and alphanumerics in kanji (hiragana) entry mode.

1 Enter hiragana and press Input lethod
* To enter AM, press then (2> (AWM.

2 Use ({) to select a word and press (®

* Hiragana to Roman Letter Conversion (hiragana with * or ®

characters/Symbols):

is converted to the same

i} @ L) . P) / A _ B | Space
) A T B < C I+ | Space Z Space
& D U E E) F & | Space| # | Space
[ G 5 H ) I T | Space & Space
V72 J [C K ) L fa | Space | (@ | Space
(& M (6] N 3 0 ~ |Space| [F | Space
ES P H Q (B} R 1)) S £ | Space
® T [{0) U ES \Y — — — —

5 W b X %) Y n Z 2 | Space
D , Vs A | Space | — (Long Sound).. Line Break | Space

¢ Hiragana to Number Conversion (hiragana with * or
numbers):

is converted to the same

=35 (A) row...1 = (Ka) row...2 m X (Sa) row...3

m7% (Na) row...5  ®(& (Ha) row...6 = E (Ma) ro

w...7

m fz (Ta) row...4
=42 (Ya) row...8

=5 (Ra)row..9  mpH%&EA— (Long Sound)., Line Break...0

Quick Conversion (for Hiragana)

Quick Conversion helps reduce keystrokes needed to enter frequently used words.

A list of word suggestions appears based on the key pressed.

Use Quick Conversion in kanji (hiragana) mode only.
Example: To enter {4

Normal Conversion

EG) Convert

33) (@) (&)

Quick Conversion

=

(1% &3 (F) () @=3) (8) © (convert)

Enter hiragana and press

Cursor turns green.

« While cursor is green, use o9 to segment entered hiragana and then convert one

segment at a time.

To cancel Quick Conversion, press ® Press (Q) for normal conversion

2 Use () to select a word and press (®

@ The most recently used word (mostly nouns) appears first.

4-13
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. One Hiragana Predictive Entry

Enter hiragana and initiate Quick Conversion. Words starting with a hiragana in the
same row (&, ), 5, X, & for &) appear. Word suggestions vary by time of day.
Example: When & is entered

5:00 - 10:59 11:00 - 16:59 17:00 - 22:59 23:00 - 4:59
BH—& HBL~ BES FOF ! |
;RO #®TR ]S HOHES
fIoTEFTY WWelZE&E~g ) RVTITK&K nx—WL! 1|
WoT5oUL»LY  BEH SET? fIC31

e Words in the list are preset by time blocks.
e If Clock is not set, only words for 11:00 - 16:59 are available.

. One Hiragana Word Call

Enter the first hiragana of entries you used Quick Conversion for. The most recently
selected word appears first.
Example: You entered &/ P and selected £ A last time.

=/
—

Conversion Settings

I Disable Predictive or Previous Usage (see P.4-5) I

BEENHON
In a text entry window, press |2) H[ZlTl » Select Elinput/Conversion
® Press (®) # Select BPredictive or E)Previous Usage # Press (®)
» Choose BlOff » Press (®

I Clear log of words selected in kanji conversion, Predictive, etc. I

In a text entry window, press |2) I[ZTTl » Select Elinput/Conversion
% Press (® # Select @Reset Learning # Press (® % Select OK
% Press (®

* Words saved in User Dictionary remain.

4-14

Dictionaries (Japanese Only)

User Dictionary

Save up to 100 frequently used words/phrases and assign Title Words in hiragana to entries.

In text entry windows, enter Title Word and convert. Entries appear among word suggestions.

Save up to five entries per Title Word.

Save words/phrases to User Dictionary

m P> Functions % Settings 2 % User Dictionary % New Entry

Enter a word/phrase ® Press (® » Enter Title Word # Press (®)

e Enter up to 15 characters per word/phrase and eight characters in hiragana per Title Word.

Edit or delete entries

m P Functions % Settings 2 % User Dictionary % Edit

Edit

Select a word or phrase ® Press (®) # Edit ® Press (®) # Edit Title
Word # Press (®) # Select [lOverwrite or EINew Entry % Press (®)

Deleting One Entry

Select a word or phrase ® Press » Select BDelete »
Press (8 » Choose [BYes # Press (®

Deleting All

Press (2> IS » Select ElDelete All % Press (® % Choose [BYes

% Press (®

V302SH Download Dictionary

Download specialized V302SH Download Dictionaries from Sharp's Space Town

Mobile Internet site. Activate up to two dictionaries at one time to improve handset

character conversion. Dictionary words appear among word suggestions.
For details, access Sharp's Space Town Mobile Internet site (see (O JP.8-2).

Activate downloaded dictionaries

m P> Functions % Settings 2 % User Dictionary % Acquire Dictionary |

Select a number # Press (® # Select a dictionary # Press (®)

To replace current dictionary, select a number # Press (® # Press (2> TR »
Select [IChange % Press (® # Select a dictionary ® Press (@) ® Choose [BYes %

Press (®

4-15
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From Dictionary Library

H Press (® » Select Functions » Press (®) % Select MSettings 2 % Press (® »
Select E)User Dictionary ® Press (® # Select ElAcquire Dictionary % Press (@) &
Select ElDictionary Library % Press (®) ® Select a dictionary ® Press
% Select IBSave Dictionary » Press (® # Select a number ® Press (®)

* When a file is already saved, Overwrite? appears # Choose [l Yes or EINo »

Press (®

4N m S Ly |

sieoesey) Buusiug

m P Functions » Settings 2 ® User Dictionary % Acquire Dictionary |

Select a number # Press (®) #® Press * Select Cancel »
Press (®

Editing Characters
~Deleting

Use ¢$» to select a character and press &)

The highlighted character is deleted. 3 G

* Recover up to 64 characters deleted with &]. Press @ once for Kifshita

each character to recover immediately after deleting. Pressing
any other key disables the recover function.

Press for 1+ seconds to delete an entire entry. Characters deleted in this manner
cannot be recovered.

1 Press &7 to delete a character

2 Enter another character ¥ &3
$

When Menu appears, copy or cut and paste text (up to 6,000 single-byte characters)
into the same window or another.

1 Inatext entry window, press
2 Select MCopy or BCut and press (®

3 Move cursor to the first character of text and
press (®
Start point is set (End appears).
[7l To change the start point, press &=].

15:05 Sl
New Message

<Cut>
Manager of alumni. E
mployee of A trading
company. ®all at ho|

Move cursor to the end of text and press (® me after 19 P,

Open text paste target window and press
Select E]Paste and press (®)

o Start | Backrs
Cut

N OOGK

Move cursor to target location and press (®

Text is inserted. Psénﬁsonal Data
Manager of alumni. C

all at home after 10|
PM.

clelelelele eleleleele)
1 1

Use Delete Use Delete

Previous to Posterior to

delete delete

1 Press
2 Select BDelete Posterior or EdDelete Previous and press (®

3 Press ®

4-17

sisoetey) Buusiug h



Text Memo

Save frequently used phrases for use in mail message, etc.

e Save up to 20 Text Memo phrases.

¢ Save up to 128 single-byte characters per phrase.

¢ Ten editable Text Art are saved by default. Edit and replace default entries.
* When memory is full, delete entries to make room for new ones.

¢ To create QR Code from Text Memo, see P.12-27.

index e [T

n 1 Select EdText Memo and press (®
Titles or the first part of saved text appear.
To open text, select one ® Press @

2 Select a number and press (®
If the number is already used, saved text appears. Press » Select BEdit »

Press (®

3 Enter text and press ®
Text is saved.
¢ To save more text, repeat Steps 2 - 3.

sieoeseyn Buusiug

Saving from Message or Phone Book

H In a text entry window, press » Select @Save Text Memo % Press (®
% Move cursor to the first character of text » Press (8 % Move cursor to the end
of text » Press (®) % Select a number # Press (®

Edit/Delete Edit or delete Text Memo I

m > My Files % Text Memo

Edit Memo
Select text » Press [2> I # Select Edit » Press (®) & Edit »
Press (®

Delete Single Text Memos
Select text » Press (&) I » Select Delete » Press (®) %
Choose [ Yes # Press (®
« Default Text Art is restored after deleting text in @ - O@.

4-18






300g suoyd H

Overview

Saving to Phone Book

Save frequently used phone numbers and mail addresses to Phone Book. Entry
names appear for calls from numbers saved in Phone Book.

M Dialing from Phone Book (see P.5-11)

s E—
15:05 il
Ueda Mikio 005
'IFrienéd_\ééé r=
BB évéy "
o & Ueda Mikio
B)Pattern 1

~)Pattern 2
™ Mail Folder 1
Mail Folder 2

03123XKKK3

@Back |e Menu

03123XXKK3

Il Sending Sky/Long Mail from Phone Book (see (O JP.3-3)

15:05
Select Mail Type

BSend Long Mail

g‘éPatte r.n 2: gﬁ ©©

[+B
B)Pattern 1

B3Send Sky Mai |
~)Pattern 2 ) || Folder ] —)
“Mail Folder 1 (FMail Folder 2
(T Mai I0§q| | Eegrx iXXS @aalxxx. yyy
CLE R
Il When a Call Arrives
15:05 1l 505 1l

<<Incoming Ca |>>
. b /’”’/ ‘..\\ //, \.\\ Al
A call arrives =< - =

Ueda Nikio
0312310KK3

o llenu

15:05

2005/09/15 Thu

Back-up Important Information
Keep a separate copy of important information. When battery is exhausted or

removed for long periods, Phone Book entries may be lost. Handset damage may
also affect information recovery. Vodafone is not liable for any damages resulting
from accidental loss/alteration.

@ ¢ Use Phone Book Lock (see P.11-3) to protect entries from accidental alteration and

to restrict access to Phone Book information.
¢ Exchange Phone Book entries with other handsets, etc. via infrared (see P.10-2).

Phone Book Entry Items

e Save up to 500 entries (000 - 499) in Phone Book.
¢ To create QR Codes from Phone Book entries, see P.12-27.

ltem Description

Enter up to 16 single-byte characters.

& :Name Use kaniji, hiragana, katakana (double or single-byte),
alphanumerics (double or single-byte) and Pictographs.

. . Katakana, alphanumerics or Symbols appear as names are

== . ; L. .

£=1: Reading entered (up to 10 single-byte characters including® and ° )

8 : Phone Number Enter up to three phone numbers (24 digits each)

&&4: Mail Address Enter up to three mail addresses (60 single-byte characters each)

28, Group Sgrt entries into 10 Groups (0 - 9). Change Group names or set
Ring Tone by Group.

£4. ! Personal Data Add personal details. Use up to 60 single-byte characters.

0 Secret Mode Restrict access to Phone Book entries by saving them as Secret

Mode entries

Select an image to appear when you open a Phone Book entry.

B : Photo Activate Picture Call/Mail to see the image set here for incoming
calls/mail.

§, Personal Ring Tone |Set Ring Tone by caller

§ Incoming Notice Set Ring Tone by sender

S | Picture Call/Mail Set images to appear by caller or sender

g— Mail Folder Messages are sorted into folders

Incoming Calls while Editing

Il Contents are temporarily saved for later editing. To return, end the call and
follow these steps.
Press (® % Choose [Yes # Press (®)

yoog auoyd H
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New Phone Book Entries

[EEESET » Tel Ops » Add to Phone Book

1
2

W

SOON OO

Enter a name
Press (®

Characters entered for names (reading for kanji) appear after .

¢ Reading does not appear for Pictographs, pasted characters and
names entered with Quick Conversion.
» Katakana, roman letters, numbers and Symbols appear in
single-byte.
To correct reading, select E=1: % Press (8 # Edit reading #

Press (®
To cancel, press <0l % Choose [BYes # Press (®

Select & :and press (®

Enter a phone number
¢ Include the area code for landline phone numbers.

)
15:05

& :Ueda Mikio

Ueda Mikio PHOT®
8 <Unsaved>
da:<Unsaved>
2&:0Untitled

£4, ‘<Unsaved>

0 0ff

A <Unsaved>

@Cancel e Select  Savers)

Phone Book Details

To correct phone number, press @ to move cursor # Press C=] to delete a digit at the
cursor position ® Enter a phone number (Press for 1+ seconds to clear all.)

Press twice to enter - between digits. (- counts as a digit.)

To enter Push Tones, press three times to enter Pause ( P) # Enter alphanumerics

® Each Pause ( P) indicates a one-second pause. The subsequent alphanumerics are

also sent as Push Tones (see P.12-2).

Press (®
Select an icon and press (®

To save additional phone numbers, select & :<Unsaveds> % Press (® % Repeat

Steps 4 -6
Select é&7: and press (®
Enter a mail address
Press (®
Select an icon and press (®

To save additional mail addresses, select é&a:<Unsaveds % Press (®) % Repeat

Steps 8 - 10

To set a Group, select & » Press (® ® Select a Group ® Press (®)
To enter Personal Data, select &4 ® Press @ ® Enter information ® Press @

Photo: see P.5-6
Saving Secret Mode Entries: see P.5-7

Press

Memory Number entry window opens. Assign a Memory Number to each Phone Book entry.

Enter Memory No. (000 - 499)

Entry is saved to Phone Book.
Use headphones to call the number saved in Memory Number 000 (see P.12-32).
Use Speed Dial to call numbers saved in Memory Numbers 000 - 099 (see P.5-14).

Assign Memory No. Automatically

M Press to assign the smallest available number.
B To specify a range of numbers, enter hundreds or tens digit and press .
* To specify hundreds, enter first digit ® Press
Example: Enter @2)&=2). The range is 300 - 399.
¢ To specify tens, enter two digits ® Press
Example: Enter . The range is 210 - 219.

. Warning Messages

On Display Cause Operation
Choose [Yes and press (® to overwrite the
) The Memory Number entry. Choose EINo and press (®) to enter another
Overwrite? is already in use Memory Number.
y To assign Memory Number automatically, see
above.
Memory Full Al Memory Numbers Overwrite or delete entries (see P.5-15)
Cannot Save are in use
The number is
Secret Data saved already used for a Activate Secret Mode (see P.11-6) to overwrite
Secret Mode Phone
Book entry
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Photo

Save an image (still image or animation) to Phone Book entries. The image appears
for calls/mail from that entry.

. Setting Photo
1 InPhone Book Details (see P.5-4), select EX: and press (®

Selecting from Data Folder
H Select M Data Folder and press (®)
H Select an image from Data Folder (see P.9-6) and press (®
Press (®

Phone Book Details (see P.5-4) returns. Complete other fields.
* Some images may be too large for Phone Book Photo.

Capturing New Image
H Select B Mobile Camera and press (®
Select IlSha-mail Mode or B Wallpaper Mode and press (®)
El Frame image on Display
Press (®

Captured image appears.

Press (®

Image is saved to Data Folder and Phone Book Details (see P.5-4) returns.
Complete other fields.

B Ficture cali/Mail |
Picture Call/Mail is Off by default.

In Phone Book Details (see P.5-4), select Option Settings and press (®)
Select E)Picture Call/Mail and press (®
Choose IBOn and press (®

To cancel Picture Call/Mail (hide images for incoming calls/mail), choose
Boff » Press (®

Press (@

Phone Book Details (see P.5-4) returns. Complete other fields.

NN WN =

@ Picture Call/Mail is canceled when source image in Data Folder is deleted.

5-6

Saving Secret Mode Entries

1 In Phone Book Details (see P.5-4), select »©: and press (®
2 Choose lOn and press (®

Phone Book Details (see P.5-4) returns. Complete other fields.
o Activate Secret Mode (see P.11-6) to open Secret Mode entries.

Change Secret to Standard

B Activate Secret Mode (see P.11-6) and follow these steps.
Open a Phone Book entry (see P.5-11) ® Press (® % Select Edit % Press (®
% Select ™©: » Press (8 » Choose ElOff % Press (® ® Save entry (see

Steps 6 - 8 on P.5-15)

Do not save confidential information in Phone Book. Security Code and thus Secret
Mode entries may be compromised.

incoming calls/mail from numbers/addresses in Secret Mode entries. Personal Ring
Tone and Incoming Notice are disabled. Names for numbers in Secret Mode entries do
not appear in Redial or Call History. Names saved in Redial/Call History before an entry
is converted to a Secret Mode entry appear even if handset is not in Secret Mode.

@ When not in Secret Mode, Phone Book Names/Photo images do not appear for
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Saving from Redial or Call History

> Tel Ops

Select @Redial or ECall History and press (®
Select an entry and press
Select Add to Phone Book and press (®)

New Entry
E Select INew Entry and press (®)
Enter name and press (®)

Phone number is entered automatically and Phone Book Details (see P.5-4) appears.

Complete other fields.

New Item
H Select B New Iltem and press (®)

H Select a Phone Book entry (see Step 2 on P.5-11)

¢ When three phone numbers are already saved, the phone number is not added.

Press (®)
B Select an icon and press (®

Phone Book Details (see P.5-4) appears. Complete other fields.

@ Call History records without Caller ID cannot be saved to Phone Book.

@ Numbers and mail addresses in received messages (see (O JP.4-7) or Notepad

Memory (see P.2-13) can be saved to Phone Book.

Phone Book Memory Status

Option Settings

Set Personal Ring Tone, Incoming Notice, Picture Call/Mail (see P.5-6) and Mail Folder.
Select Set All or One Number/Address.

Set All

Apply the same setting to every number/address in a single Phone
Book entry. Set All cancels One Number/Address settings.

One Number/
Address

Address cancels Set All settings.

Apply setting to each number/address independently. One Number/

m P Functions ® Settings 1

Select Memory and press (®
Number of entries appears.
Press &) to exit.

5-8

505 il
F31:Memory
<Memory Status>

Phone Book XX
Mai | T XX%
ieb T XX%
Station T XX%

[~ ———

Overview

1
2
3

In Phone Book Details (see P.5-4), select Option Settings and press (®)

Option Settings menu appears.

Select an item and press (®)

Apply Same Setting to All
H Select IISet All and press (®)

Settings by Number/Address
Select BOne Number/Address and press (®)
H Select a number or address and press (®)

ElChoose [BOn and press (®
To cancel, choose EJOff % Press (® # Press <@l

Canceling
E Choose EJOff and press (®

Option Settings menu returns.

Press <@l to exit.
Set Options (see P.5-10)

Phone Book Details (see P.5-4) returns. Complete other fields.

am
15:05

Option Settings
[0ff

IPersonal Ring Tone
Blinconing Notice

@Mail Folder

@Set | Select
Option Settings Menu

@ For phone numbers, the following settings apply only to Vodafone handset

numbers: Incoming Notice and Mail Folder.
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Setting Options
Follow these steps after opening Option Settings menu (see P.5-9).

Select Ring Tone, vibration, etc. for incoming calls/mail from
numbers/addresses saved in Phone Book

Ring Tone
Select MlPersonal Ring Tone or Bincoming Notice % Press (®) %
Perform Step 3 on P.5-9 to set target number/address #» Select
D Ring Tone % Press (® » Select a tone or melody (see Steps 1 - 3
on P.8-3) #» Press <9l % Press @l % For One
Number/Address, press <2 again

Vibration
Select llPersonal Ring Tone or Bincoming Notice % Press (®) %
Perform Step 3 on P.5-9 to set target number/address #» Select
BVibration » Press (®) » Select lOn, BOff or E\SMAF Link %
Press (® # Press (0l % Press {0l % For One
Number/Address, press <2 again

Vibration Pattern
Select IPersonal Ring Tone or Bincoming Notice % Press (® % Perform
Step 3 on P.5-9 to set target number/address ® Select E]Vibration Pattern
% Press (® # Select a pattern # Press (®) # Press <0l »
Press <2l % For One Number/Address, press <@ again

Mobile/Small Light
Select llPersonal Ring Tone or Bincoming Notice % Press (®) %
Perform Step 3 on P.5-9 to set target number/address #» Select
@LED Indicator % Press (® % Perform Steps 1 - 3 in "Mobile/Small
Light" on P.8-4 to set pattern » Press <0l » Press (0l
% For One Number/Address, press <9/ again

Ring Time (for Incoming Notice)
Select Blincoming Notice % Press (® # Perform Step 3 on P.5-9 to
set target number/address ® Select BRing Time % Press (®) %
Enter time (01 - 99 seconds) ® Press (®) # Press <0l »
Press <2l % For One Number/Address, press <@/ again

* When source file in Data Folder is deleted, Ring Tone is set to Pattern 1 for
@ Personal Ring Tone and Mail for Incoming Notice.
* To apply Personal Ring Tone or Incoming Notice setting to Secret Mode
entries, activate Secret Mode first.

messages automatically

Select @Mail Folder % Press (® % Select Ilinbox Auto Sort or

BSent Auto Sort % Press (®) » Perform Step 3 on P.5-9 to set target
number/address # Select a folder ® Press (®) # Press <0l »
Press <0l % For One Number/Address, press <@l again

I Specify Mail Folder for each Phone Book entry to sort I

5-10

Using Phone Book

Dialing from Phone Book

Follow these steps to search Phone Book by Memory Number (default search method).
¢ To dial numbers saved in Secret Mode entries, activate Secret Mode first (see P.11-6).
¢ To search by other methods, see P.5-12.

1 Press (5 ([TE)

2 Press or enter Memory No. =
* Press (9) to open Phone Book Entry List in the order of Hd“gUeda Nikio
Memory Number. 007Ki tayama Kaoru
* Enter Memory Number to open Phone Book Entry List (0K inura Tetsuya
including the entered number.
Use () to select an entry.

3 Press ®
Phone Book entry opens.

When multiple numbers or addresses are saved, use 9 to
select other icons.

Press

Number is dialed.

@ Cancel Phone Book Lock (see P.11-3) to open Phone Book.

5-11
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. Window Description

Ueda Mikio
'IJF_rie_nds

[FMail Folder 2

K Name
Group Name
Icon for Saved ltems
= Phone Number ( &: Call, #&: Home,
: Mobile, B&: Company)
— = Mail Address (é&4: Internet, ¢&4: Mobile)
m Personal Data ( 54)
= Photo ( IEX?)
Tone Set for Personal Ring Tone or
Incoming Notice
8. Personal Ring Tone, & Incoming

BB e =

Mail Folders Set for Auto Sort
(™ Inbox Mail Folder
(F: Sent Mail Folder

[E Memory No.

Image Set for Photo

El Phone Number or Mail Address

* Use ¢ to toggle saved items. Phone number or mail address appears in El.
Personal Data or Photo image appears in a new window.
* Press <@l to return to Phone Book Entry List.

Phone Book Search

. Search Methods

Memory No. Search

Lists Memory Numbers including the one you enter

Katakana Search

Shows entries with Reading starting with specified katakana or
katakana in the same row

Group Search

Opens entries in a specified Group

Search by Reading

Shows entries with Reading starting with entered character

Search method is Memory No. Search by default.

5-12

. Switching Search Methods
1 Press (5 ([TE)

The method used last appears.

2D Press & IR
3 Select a method and press (®

Selected method appears.
* To search and open an entry, see below.

. Searching/Opening Phone Book Entries ‘

Follow these steps in Standby. Skip the step of pressing (09 ([TELJ) when continuing
from Step 3 above.

I Search by Memory Number I

M Set search method to Memory No. Search (see P.5-12).
Press (o9 ([TEL]) ® Enter Memory No. (000 - 499) #» Select a name #»

Press (®
Press @ to dial.

Search by katakana row which includes the first character of
Reading

[l Set search method to Katakana Search (see P.5-12).
Press (09 ([TEL])  Specify a row ® Select a name # Press (®)
Press @ to dial.
» Katakana-Key Assignments:
7 (A) row 55 |H (Ka) row # (Sa) row # (Ta) row
7 (Na) row /\ (Ha) row ¥ (Ma) row | @3 |47(Ya) row
S (Ra) row 7 (Wa) row Others

® When Reading starts with a roman letter, number or Symbol, or is not entered, select Others.

I Search by Group I

[l Set search method to Group Search (see P.5-12).
Press (0s ([TEL]) # Select a Group ® Press (®) # Select a name »
Press (®
Press @ to dial.

I Search by Reading saved in : I

[l Set search method to Search by Reading (see P.5-12).
Press (9 ([TELJ) ® Enter reading (up to 10 single-byte characters) »
Press (®) # Select a name # Press (®)
Press (3 to dial.
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Speed Dial

Use Speed Dial to call first phone number saved in Memory Numbers 000 - 099.
To dial numbers saved in Secret Mode entries, activate Secret Mode first (see P.11-6).
If not, Secret Data saved appears and handset returns to Standby.

1 Dialing Memory No. 000 - 009
Enter the last digit (0 - 9)

Dialing Memory No. 010 - 099
Enter the last two digits (10 - 99)

Press @

Name and phone number appear and the number is dialed.

* When no entry/phone number is saved, No Number appears and handset returns to
Standby.

e When multiple phone numbers are saved, the first one is dialed.

N

@ Cancel Phone Book Lock (see P.11-3) to use Speed Dial.

Show Photo
Show the assigned images in Phone Book Entry List.
5 . 5 il
005Ueda Mikio <«[No. 000 - 609]
007K i tayama Kaoru 71005 Ueda Mikiof

008Kimura Tetsuya

007 Kitayama K|
o 03123XXXX8
PHOTO

008 Kimura Tet|

03123XXXX5
PHOTO

Editing Phone Book

Correction/Change
Press (¢ ([TEL]), then open an entry

AR W=

ONO®

Deleting Entries
1 Press (o ([TE), then open an entry

Press (®

Select Edit and press (®

Phone Book Details appears.

Select an item and press (®

Edit contents.

® Procedure is the same as when saving to Phone Book (see P.5-4).
¢ Edit Reading manually after editing names.

Press (® when finished
Phone Book Details returns.
* To edit other items, repeat Steps 4 - 5.
To cancel, press <0l % Choose [BYes # Press (®

Press
Press (®

Choose IBYes and press (®

The entry is overwritten.

To save to another Memory No., choose EINo % Press (®) # Enter another Memory

No. (or press )

Select | Menur

®Select | Menur

D Press@®

Entry List Entry List with Images
(Memory No. Search) (Memory No. Search)
Press (09 ([TED) then
Press (2> HIYTH

Select Show Pics and press (®)

Images appear in Phone Book Entry List.
To hide images, while list with images appears, press (2> HIETE # Select Show List
% Press (®

WN =

5-14

3 Select Delete and press (®)
4 Choose dYes and press (®

®

Picture Call/Mail.

The source files remain in Data Folder, even if you delete entries containing Original
Ring Tones, Voice files and images set for Personal Ring Tone, Incoming Notice or
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Group Settings

Rename Groups and customize Ring Tone settings by Group. Personal Ring Tone
and Incoming Notice settings (see P.5-10) take priority over Group Settings.

Changing Group Name

m P Functions % Settings 1 % Group Settings ® Change Group Name

Select a Group and press (®)

Enter a name
¢ Enter up to 10 single-byte characters.

Press (®
* Repeat Steps 1 - 3 for other Groups.

Press @) to exit

Group Ring Tone

Group Ring Tone is Off for all Groups by default.

m P Functions % Settings 1 % Group Settings % Group Ring Tone
Select a Group and press (®

yoog auoyd H
A W =

Select llincoming Call or Bincoming Mail and press (®)
Select ICall Functions and press (®

Choose [BOn and press (®
To cancel, choose BJOff % Press (®

Select from BlRing Tone to @Ring Time and press (®)
* ERing Time is available for incoming mail only.

For Ring Tone settings, see P.8-3.

For vibration and Mobile/Small Light patterns, see P.8-3 - 8-4.

For Ring Time setting, see P.8-5.

6 Press @ to exit

G AWN=

@ When Group Ring Tone is Off, Ring Tone setting for incoming calls applies.
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Getting Started

V302SH features a 0.31 megapixel camera. Capture still images and record video.
e Still Images: see P.6-5 ¢ Video: see P.6-13
¢ Viewfinder & Key Assignments: see P.6-4 e Shooting Options: see P.6-16

Mode Format Save Location
Sha-mail ;T\EEGnr;i?n:aﬁggfrt (ZJSpg )c,:olors (.png) g:;apF;lger (Images)
Wallpaper JPEG (.jpg) ~
Camera JPEG (.jpg) g::gtg-fzolder
Action Snap MPEG-4 (ASF) g:i°;_§’_’;ap Folder

¢ Check that lens cover (see P.1-6) is clean before image capture. Use a soft cloth to wipe
fingerprints and oil off.

¢ |f handset moves while shooting, images may blur. Hold handset firmly or place it on a
stable surface and use Self Timer (see P.6-9).

¢ Mobile camera is a precision instrument. However, some pixels may appear brighter or darker.

¢ Shooting/saving images while handset is hot may affect the image quality.

¢ Subjecting the lens to direct sunlight will damage the camera's color filter.

Incoming Calls before Saving Image or while Recording Video

Il Captured still image is temporarily saved. To return, end the call and follow these steps.
Press (® % Choose @l Yes ® Press (®
Il Unsaved video is lost.

Camera Mode Image Orientation

Il Camera mode images appear rotated 90 degrees
when viewed on PCs. To compensate for this, hold
handset horizontally for image capture as shown to the
right.

Il Display may flicker (stripes appear) when capturing images under fluorescent lights.

In this case, change Anti-Flicker settings (see P.6-17).

Shutter Click

[l Shutter Click volume is fixed, and sounds even in Manner Mode.
¢ To change Shutter Click sound for still images, see P.6-16.

[l Before image capture, mobile camera ends after five minutes of inactivity and

handset returns to Standby.

Below are descriptions of icons that may appear on Display while mobile camera is
active. For details, see the referenced pages.

o<1 ®oEgids ﬁﬂ %] W
| Ll &5 m—
—
8]
E

Toggle Preview (see P.6-16)
[&: 100%, &d: 200%
Self Timer (see P.6-9)
Mode (see P.6-20)
I: Sha-mail, Ed: Wallpaper, [B]: Camera
B Action Snap
File Format (see P.6-19)
&1: JPEG High, B4 PNG Normal, ®1si: PNG Soft
Image Quality (see P.6-18)
[A: standard, E&: Fine

6-3
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[@ Remaining Memory Capacity (see P.6-6) or Maximum Recording Time (see P.6-13)

e (§8: More than 100 still image files

* Red background: 5 or less still image files
Mobile Light (see P.6-17)
El Brightness (see P.6-18)

22 2 % N 22

Dark € Standard # Bright
El Image Size (see P.6-18) or Mic Settings (see P.6-19)
Burst Shot Picture Count

- E&: Captured/Total

E: Index Image is on Display.
il Burst Mode

Ei: 4-Burst Mode, Ell: 9-Burst Mode, E: 25-Burst Mode
Burst Speed

E: Rapid, &: Slightly Fast, B: Normal, Bl: Moderate, b Slow, E§: Manual

Viewfinder & Key Assignments

View a summary of key assignments on the handset (see P.6-20 "Key Ops Guide").

1)
B
9
1]
g—
6

K Viewfinder
Brightness (see P.6-18)

(®) (brighter), (Q) (darker)
Camera Startup

In Standby, press <@l for 1+ seconds to activate the mode used last (default: Sha-mail).

Bl Toggle Preview (see P.6-16)
Cancel
[ High Speed Zoom (zoom out)

6-4

Image Size (see P.6-18)

In Sha-mail mode, press before image capture to toggle image size between 120x128

and 120x160.
El Menu
El Shutter
End
Zoom

(zoom out), (%9 (zoom in)
Select Mode (see P.6-20)

While mobile camera is active, press keys to activate the corresponding modes.

‘e5) |Sha-mail (see below) Camera (see below)

=) |Wallpaper (see below) Action Snap (see P.6-13)

In Standby, press - for 1+ seconds to activate the corresponding modes.

High Speed Zoom (zoom in)
Mobile Light (see P.6-17)
Press to turn on or off.

Still Images
Still Image Modes

Sha-mail
Attach to Mail/save as Wallpaper Use
Use Burst Shot & Picture Effects

Wallpaper
Resize Images to Display Use
Split and attach images to Mail

Camera
Maximum Image Size: Use
W 640 x H 480 dots

Capture images for Mail,
Wallpaper or Display Images

Set Wallpaper or capture
higher quality images

Edit or print images
on external devices

6-5
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. Mode Comparison

Sha-mail Wallpaper Camera
. W120x H 160 dots |\ 540 4 11320 dots | W 640 x H 480 dots
Image Size (QQVGA) (QVGA) (VGA)!
W 120 x H 128 dots
Image Quality - Standard/Fine
Zoom 2x/4x 2x -

Attach to Long Mail

Sha-mail size

Wallpaper size,
Sha-mail size or Split

Thumbnails only

Format

JPEG/PNG

JPEG

Memory Capacity

1,600 files®

530 files?

200 files?

"Thumbnails (W 120 x H 160 dots) are saved with the original images.
2Values are approximate for images captured with default size and quality.

* To check memory status, see P.6-22.

@ * Saving video or V-Application reduces memory for images.

. File Names

Sha-mail/Wallpaper

Image files are saved by date and time by default.
Example: 05-09-15_12-34 indicates the image was captured at 12:34,
September 15, 2005.

Camera

Default file name starts from VFSH0001 then VFSH0002, and so on

Rename Sha-mail and Wallpaper mode files (see P.9-23).

etc. (Camera mode files cannot be renamed on handset.)

@ Camera mode images may not appear on handset if file names are changed on PCs,

6-6

Capturing Still Images

e en [T

1 Select lASha-mail Mode, BWallpaper Mode or
ElCamera Mode and press

2 Frame image on Display
Viewfinder & Key Assignments: see P.6-4
Shooting Options: see P.6-16

3 Press or(®
Shutter clicks and the captured image appears on Display.
To start over, press C=] % Choose IBYes % Press ®
To edit image, see P.9-12 - 9-19.
To send image via Long Mail, press <& » Perform from
Step 2 on (OJP.3-3

4 Press (® to save image
Viewfinder returns for another shot.

5 Press @) to exit

When Captured Image is Unsaved
EXxit? appears.

ﬁﬂ
5:09 w8 g

e,

« Shoot | Menut)
ﬂ]ﬁu@ 20<60 Og linw:

@Sha-nai | @ Save | Menurs)

» Choose [ Yes and press @ to end. Handset returns to Standby.
* Choose EINo and press (®) to return to the captured image.

. Before Saving

Follow these steps after capturing an image in Step 3 above.

Save images to Phone Book

Press (&> I[N » Select Add to Phone Book % Press (®) %

Perform Step 4 on P.5-8

Save only thumbnails (W 120 x H 160 dots) to Data Folder I

(Images)

Press (&) [T » Select Save As Thumb % Press (®)

Rotate and save thumbnails (W 120 x H 160 dots) to Data I

Folder (Images)

Press (&) HTMA # Select Rotate Thumb % Press (®)

* To rotate further, press (&> [TYE.
Press (® to save rotated thumbnails.

eIBWERD 9|IJON h
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7 7 Camera
Still Image Functions -

DiToggle Preview Switch Viewfinder size (see P.6-16)
. Before Image Capture SSave As Thumb Save only thumbnails (see P.6-7)
- - Rotate Thumb Rotate thumbnails by 90 degrees (see P.6-7)
Press W to use.the following functions: Eimage Quality Select Standard or Fine (see P.6-18)
In Camera mode, Special Features does not appear. BAttach Thumb Attach thumbnails (see P.6-24)
Toggle Preview Switch Viewfinder size (see P.6-16) EDelete Delete files on handset (see P.6-22)
Mobile Light Turn Mobile Light on or off (see P.6-17) .
Image Size' Select image size (see P.6-18) Self Timer
— - . . . .
iz Uiy Select Standard or Fine (see P.6-18) Release shutter automatically to capture images or record video.
Self Timer Set Self Timer (see P.6-9)
o |Set Burst Mode? | Select mode and speed (see P.6-11 Sha-mai O | Wallpaper =)
(_!; g e uss ode” | Select mode and speed (see P. ) Camera O | Action Snap o
= |F Add f P.6-1 - - : -
8T rame dd frames (see P.6-10) e Follow these steps before capturing an image (after Step 2 on P.6-7) or recording video
[}
@ 0 |Lens Effects® | Capture images with special effects (see P.6-11) (after Step 1 on P.6-14).
Soft Focus' Capture softer images for attachments (see P.6-18) e Self Timer is Off by default.
Shutter Click Change Shutter Click sound (see P.6-16) 1 Press .m
° Save As! Select file format (see P.6-19) e For Camera and Action Snap modes, skip ahead to Step 3.
c o 3
% £ Save to Select a folder (see P.6-20) 2 Select Special Features and press @
o g Auto Reset All settings return to defaults when mobile camera shuts down (see P.6-20) .
Change the setting when Display flickers under fluorescent lights 3 Select Self Timer and press @
Anti-Flicker (see 36-1 7) 9 play 9 To change countdown time (default: 70 Seconds), select BlSet Time % Press ®»
. Select time # Press (®)
Delete Delete files on handset (see P.6-22)
Key Ops Guide View a summary of key assignments (see P.6-20) 4 S_ele_Ct IBSelf Timer On and press @
Brightness Adjust amount of light (see P.6-18) Viewfinder returns (% appears). _
Select Mode Switch to other mobile camera modes (see P.6-20) To cancel, select ElSelf Timer Off % Press @) (Omit the next steps.)
1 Available for Sha-mail mode. 2Available for Wallpaper and Camera modes. 5 Frame image on Display and press (®)
3 Available for Sha-mail and Wallpaper modes. Tone sounds and countdown starts.
- o After the set time, shutter is released and captured image appears or video recording
B Before Saving starts.
Press to use the following functions: *To relgase shutter manually dur.ing countdown, press (®). Image is captured or video
recording starts and Self Timer is canceled.
Il Sha-mail & Wallpaper To cancel Self Timer during countdown, press <ol [El.
- - — - m Viewfinder returns. (Self Timer setting remains.)
Toggle Preview Switch Viewfinder size (see P.6-16)
Save As' Select file format (see P.6-19) 6 Saving Still Images
Picture Effect Edit images (see P.9-12 - 9-19) Press (®)
Image Quality? Select Standard or Fine (see P.6-18) Self Timer is canceled and Viewfinder returns.
Save to Select a folder (see P.6-20) Saving Video
Attach t Attach i toL Mail P.6-22
I .- e v Prone 5ok cce P HITo stop, press ©
Delet Soloto fi 9 - andst (soo P.6.22) HTo save, select [BSave and press (®
eete elete files on handset (see P.6-22) Self Timer is canceled and Viewfinder returns.
' Available for Sha-mail mode. 2Available for Wallpaper mode.

6-8 6-9
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7 Press @ to exit

¢ Incoming calls and Alarm cancels image capture and Self Timer.
¢ During countdown, the following settings are not available:
m Brightness, Mobile Light, Select Mode and Image Size

Adding Frames

Lens Effects

Sha-mail O |Wallpaper

Camera X |Action Snap

Sha-mail O |Wallpaper

@)

Camera X |Action Snap

X

e In addition to Preset Frames, use transparent PNG files obtained via Web or Long Mail.

e Follow these steps before capturing an image (after Step 2 on P.6-7).

Press (&) N
Select @Special Features and press (®)
Select EJFrame and press (®)

RNRWN =

Preset Frames
Select [lPreset Frames and press (®)

H Select a frame and press (®)
Selected image (frame) appears on Display.

To toggle between frames, press <@l or[® HIA.
Press (®)

Original Frames
H Select BOriginal Frames and press (®)
* Some images may not be used as a frame.

H Select a frame and press (®
Selected image (frame) appears on Display.
To change image (frame), press <@l ®» Start over from Step

Press (®

¢ In Wallpaper mode, frames smaller than W 120 x H 160 dots are enlarged.

Canceling
I Choose E)Off and press (®

Capture an image
For details, see Step 3 and onward on P.6-7.

@ In Burst Mode, frame is added to each image.

6-10

e L ens Effects cancels Frame setting (see P.6-10), and vice versa.
¢ Soft Focus (see P.6-18) is disabled even when set to On.
e Follow these steps before capturing an image (after Step 2 on P.6-7).

1 Press 2 HETH
Select @Special Features and press (®
Select @Lens Effects and press (®)

Choose IBOn and press (®
To cancel, choose E)Off ® Press (® (Omit the next steps.)

Select an effect and press (®
To toggle between effects, press <@l or & HBET.

Press (®

Capture an image
For details, see Step 3 and onward on P.6-7.

Burst Mode

NO O AWN

Sha-mail O |Wallpaper

Camera X |Action Snap

X|O

Use Burst Mode to capture images sequentially.
Press (®) for the first shot. Handset captures the rest automatically.

Mode Description Sha-mail’

Wallpaper

4-Burst Mode Capture four separate images Available

Available

9-Burst Mode Capture nine separate images Available

Available

25-Burst Mode Capture 25 separate images Available

N/A

*Set file format to JPEG beforehand (see P.6-19).

¢ In 4-Burst or 9-Burst Mode, select shutter interval from five levels, or select Manual to

release shutter manually.
e Follow these steps before capturing an image (after Step 2 on P.6-7).

1 Press (> NETE

eIBWERD 9|IJON h



elowe) 9|IqoA a

G K QN

Select @Special Features and press (®)

Select BSet Burst Mode and press (®
To change shutter interval (default: Normal), select Burst Speed % Press (@) # Select
speed # Press (®

Select [14-Burst Mode On, E19-Burst Mode On or E)25-Burst Mode
On (Sha-mail mode) and press (®
To cancel, choose Off » Press (®

Frame image on Display and press or(®

The first frame is captured with subsequent frames captured at selected speed.
* For manual shutter control (4-Burst and 9-Burst Modes), repeat Step 5 for each frame.

To cancel, press [ INTN.

® |mage capture cannot be canceled when Burst Speed is Rapid or in 25-Burst Shot Mode.

® Press (®) to save captured images.

To cancel during manual shutter control, press <&l % Choose [ Yes # Press (®

(Captured images are deleted.)

o)

Index Image appears

Use 9 to toggle between frames and Index Image.

To save images individually, select a frame or Index Image with
s » Press (2> HETH » Select Bl Save Screen % Press (®
To send images via Long Malil, select a frame of Index Image with
s ® Press (2> MM & Select Attach Screen ® Press (@
(Attachment options may appear depending on the image size.)

To save, press (®)

Captured frames are saved with Index Image. Viewfinder returns

with selected Burst Mode active.

8 Press @ to exit

T
15:05 200 %9 m‘uﬁﬂ

o~
%

@Sha-nai| @ Save | Menurs

4-Burst Mode

@ In low light or while Mobile Light is on, Burst Speed may slow down.

M Before Saving

Press [2> I to use the following functions:

Video
Video Mode

Action Snap
Playable only on V302SH
Record with sound and zoom
Self Timer available

Capture short video clips of
Use memorable occasions quickly
and easily

@ For best results, record within 1.5 meters, in well-lit conditions.

Video recording and playback are based on MPEG-4.

This product is licensed under the MPEG-4 Visual Patent Portfolio License for the personal
and non-commercial use of a consumer to (i) encode video in compliance with the MPEG-4
Video Standard ("MPEG-4 Video") and/or (ii) decode MPEG-4 Video that was encoded by a
consumer engaged in a personal and non-commercial activity and/or was obtained from a
licensed video provider. No license is granted or implied for any other use.

Additional information may be obtained from MPEG LA. See http://www.mpegla.com.

This product is licensed under the MPEG-4 Systems Patent Portfolio License for encoding in
compliance with the MPEG-4 Systems Standard, except that an additional license and
payment of royalties are necessary for encoding in connection with (i) data stored or
replicated in physical media which is paid for on a title by title basis and/or (ii) data which is
paid for on a title by title basis and is transmitted to an end user for permanent storage and/or
use. Such additional license may be obtained from MPEG LA, LLC.

See http://www.mpegla.com for additional details.

Il Action Snap Mode Features

Toggle Preview

Switch Viewfinder size (see P.6-16)

Save Screen

Save a selected image (see above)

Image Quality”

Select Standard or Fine (see P.6-18)

Attach Screen

Attach images to Long Mail (see above)

Delete

Delete files on handset (see P.6-22)

*Available for Wallpaper mode.

6-12

Image Size W 120 x H 88 dots

(F:;iosr::tl)g L Up to 60 seconds with Standard quality or 40 seconds with Fine quality
Image Quality Standard/Fine

Zoom 4x

Attach to Long Mail | N/A

Format MPEG (Files are saved by date and time by default.)

Memory Capacity |9 files’

*When recorded for 60 seconds, with default Mic Settings and Image Quality.

¢ Saving V-Applications, etc. reduces memory for video.
® To check memory status, see P.6-22.
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Recording Video

m » Camera % Action Snap Mode

1 Frame image on Display
Viewfinder & Key Assignments: see P.6-4
Shooting Options: see P.6-16

2 Press or(®
Recording begins after a tone.
* To record sound (Mic Settings is On), keep handset within
approximately 50 cm from sound source.

When Memory is Already Full
Insufficient Memory Cannot Record appears and Viewfinder returns. Perform
Steps 1 - 5in "When Memory is Full" on P.6-22 to delete files and try again.

To stop, press or(®

Recording stops with a tone.

* Recording automatically ends when limit is reached.
To play back, select ElPreview #» Press (@
To start over, select EJCancel # Press (® % Choose IBYes %
Press (®

4 To save, select [BSave and press @

Video is saved and Viewfinder returns for another shot.

W

Action Snap Mode

5 Press @ to exit

When Captured Image is Unsaved
EXxit? appears.

» Choose [Yes and press (®) to end. Handset returns to Standby.
» Choose EINo and press (® to return to the window after recording.

6-14

-
15:05 B2 o ﬁﬁﬂ

Video Recording Operations

. Before Recording

Press [&> T to use the following functions:

DiToggle Preview Switch Viewfinder size (see P.6-16)

EMobile Light Turn Mobile Light on or off (see P.6-17)

Blimage Quality Select Standard or Fine (see P.6-18)

Eself Timer Set Self Timer (see P.6-9)

BMic Settings Activate to record sound (see P.6-19)

g, Dsave to Select a file (see P.6-20)

g BlAuto Reset :;I'I;Ze;t;ngs return to defaults when mobile camera shuts down (see
[

g_ ElAnti-Flicker gr;a:ge the setting when Display flickers under fluorescent lights (see
o] 617)

EDelete Delete files on handset (see P.6-22)

ElKey Ops Guide View a summary of key assignments (see P.6-20)

ElBrightness Adjust amount of light (see P.6-18)

#Select Mode Switch to other mobile camera modes (see P.6-20)

. Before Saving

The following menu items appear after recording:

Dsave Save video (see P.6-14)
BEPreview Play video (see P.6-14)
ElCancel Start over (see P.6-14)
ESave to Select a folder (see P.6-20)
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Shooting Options

e Available options vary by mode.

e Follow these steps before capturing image (after Step 2 on P.6-7) or recording video
(after Step 1 on P.6-14). When the setting is complete, Viewfinder returns. Perform from
Step 3 on P.6-7 or Step 2 on P.6-14 to proceed.

I Switch Viewfinder size or hide indicators I
Sha-mail O |Wallpaper O
Camera O |Action Snap O

Press (&> IR » Select Toggle Preview » Press (®)

BEEMNSha-mail: 100%, Action Snap: 200%

¢ Setting returns to default when the mode is changed or mobile camera shuts down.

Change Shutter Click sound

Turn Mobile Light on or off

Sha-mail

O

Wallpaper

©)

Camera

O

Action Snap

X

MEEMDPattern 1

Press (&> XM » Select Option Settings # Press (® # Select
D Shutter Click % Press (8 % Select a pattern # Press (®)

o Shutter Click setting applies to all Sha-mail, Wallpaper and Camera modes.
To check sound, select a pattern and press <! IFETA.

= Press 0l to stop.

* Volume is fixed.
e Shutter Click sound for Burst Mode is unique and fixed.

6-16

Sha-mail O |Wallpaper O
Camera O |Action Snap O
Default{elif

Press (2> I # Select B Mobile Light % Press (® » Choose

DOn or BOff » Press (®
To change lighting time (default: 7 Minute), press » Select BMobile Light
% Press (® ® Select lllumination Time % Press (®) % Select time ® Press (®)
® To return to Viewfinder, select ® Back % Press (®) # Press <0l

¢ Select shorter Lighting Time to lengthen Battery Time.

¢ [llumination Time setting applies to all mobile camera modes.

@ Do not use Mobile Light near people's faces or look into the light yourself.

Change the setting when stripes appear on Display under I

fluorescent lights

Sha-mail

O

Wallpaper

©)

Camera

O

Action Snap

©)

EEEMIMode 2 (60Hz)

Press (&) T # Select Option Settings » Press (®) % Select
Anti-Flicker % Press (® % Select IlMode 1 (50Hz) or BMode 2 (60Hz)

» Press (®)

 Anti-Flicker setting applies to all mobile camera modes.

@ In extremely dark or bright places, stripes may not disappear completely.
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Image Settings

¢ Available settings vary by mode.

e Follow these steps before capturing an image (after Step 2 on P.6-7) or recording video
(after Step 1 on P.6-14). When the setting is complete, Viewfinder returns. Perform from
Step 3 on P.6-7 or Step 2 on P.6-14 to proceed.

I Adjust light sensitivity for still images and video I
Sha-mail O |Wallpaper O
Camera O |Action Snap O

BEEMRO (standard)

Press (2> MM » Select Brightness % Press (® # Select from five

levels ® Press (®

o Setting returns to default when mobile camera shuts down.

I Capture softer Sha-mail mode images for attachments I

Sha-mail O |Wallpaper X

Camera X |Action Snap X
Default{elif

Press (&> I » Select MSpecial Features % Press (® # Select
B Soft Focus # Press (® % Choose [lOn or BOff » Press (®

To return to Viewfinder, press <@l % Press <@l

Select file format

Sha-mail

O |Wallpaper

X

Camera

X |Action Snap

X

I Select image size I
Sha-mail O |Wallpaper X
Camera X |Action Snap X
BEEMR120x160
Press (& I » Select Elimage Size # Press (® % Select a size
% Press (®
I Select image or video quality I
Sha-mail X |Wallpaper (@)
Camera O |Action Snap O
EEEMR Standard

Press (&> XM » Select Eimage Quality % Press (®) % Select

quality » Press (®

in memory and shortens recording time.

@ Select Fine for better quality. Saving higher quality images requires more space

6-18

Before Image Capture
Press (&> XM » Select BOption Settings » Press (®) % Select

BSave As # Press (®) » Select format # Press (®)

Before Saving

BEEMNJPEG High

Press (2> HIM » Select ESave As » Press (® # Select format #»

Press (®

* PNG Softimages are softened by error diffusion.
¢ To change file format after saving to Data Folder, see P.9-19 "Change File Format."

images may not be saved (a message appears after image capture). Convert to

@ Burst Mode (see P.6-11) is not available when format is PNG. Some PNG

JPEG and try again.

Record sound together with video

Sha-mail

X |Wallpaper

Camera

X |Action Snap

X
O

BEEMRON

Press (&> XM » Select BlMic Settings # Press (® #» Choose
DOn or BOff » Press (®

@ Recording sound with video consumes more memory, shortening recording
time.
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Additional Settings

¢ Available settings vary by mode.

¢ Follow these steps before capturing an image (after Step 2 on P.6-7) or recording video
(after Step 1 on P.6-14). When the setting is complete, Viewfinder returns. Perform from
Step 3 on P.6-7 or Step 2 on P.6-14 to proceed.

Select Mode Switch to other mobile camera modes I
Sha-mail O |Wallpaper O
Camera O |Action Snap O

Press » Select Select Mode % Press (®) % Select a mode

% Press (®

* Mode used last activates whenever mobile camera is activated with Camera Startup key.
m Select a folder to save image/video files I
Sha-mail O |Wallpaper O
Camera X | Action Snap O

BEEMRImage Folder B/Action Snap Folder 0

Press » Select Option Settings » Press (® % Select
Save to # Press (®) # Select a folder # Press (®)

All settings return to defaults when mobile camera shuts down I

Auto Reset
Sha-mail O |Wallpaper O
Camera O |Action Snap O

BEEMROff (Settings are retained.)
Press » Select Option Settings » Press (®) ® Select
Auto Reset % Press (® % Choose [BOn or BOff  Press (®)

To return to Viewfinder, press <&l % Press <@l
¢ Auto Reset setting applies to all mobile camera modes.

@ Setting does not affect Anti-Flicker and Shutter Click.

LGyRelsell SR View a summary of key assignments I

Sha-mail O |Wallpaper

O|O

Camera O |Action Snap

Press » Select Key Ops Guide % Press (®)

« Press () to scroll down.
To return to Viewfinder, press <@l % Press <0l

6-20

Opening Images & Playing Video
Opening Still Images

m P> My Files % Data Folder % Camera |

1 Select Sha-mail/Wallpaper or Camera Images and

press (®
For Camera Images, select a folder ® Press (®)

Select a file and press (®
Image appears.
To open other files, press C7=].

To view available functions, open a file and
press (&> M. For more, see P.9-10 - 9-22.

£

@She-nail|® Show | Menur
Sha-mail/Wall paper

Camera Mode Images

Il Images are reduced to thumbnail size (Show Thumbnails) to fit Display. To restore
the original size, follow these steps.
Press ® Select ElOriginal Size » Press (®
* Use ¢ to scroll up, down, left and right.
« Press (® to rotate images 90 degrees clockwise.

Opening Burst Shot Files

H Press (® » Select My Files % Press (®) % Select [lData Folder » Press (® »
Select Burst Shots » Press (® # Select a file % Press (®)

H To toggle between frames and Index Image faster, press » Select
Fast Forward % Press (®

Playing Video
m > My Files % Action Snap Folder |

Select a file and press (®

Video plays and stops automatically at the end.
To open other files, press <01 IFERA.
Use (8 (up) or (9) (down) to adjust volume.
To replay, press (2> .

15:05 .
Action Snap Folder
91KB

Action Snap
H04-09-21_22-08

ePlay  Menur

6-21

eIBWERD 9|IJON h



elowe) 9|IqoA a

Memory Status
[index Menu EVEES

Select EIMemory Status and press (®

Memory usage status appears as a percentage (%).

When Memory is Full

When saving images, memory shortage warning may appear. To save images, follow
these steps to delete files.

GRAWN=

Press (&) HTH

Select Delete and press (®)
Select a folder and press (®
Select a file and press (®
Choose IBYes and press (®

Sending Still Images

Sha-mail Mode Images

Capture and send images as Long Mail attachments.
e To attach Burst Shot images, use ¢29 to select a frame or Index Image.
¢ To attach images in Data Folder, see P.9-7.

2

6-22

Capture an image in Sha-mail mode
For details, see Steps 1 - 3 on P.6-7.

Before saving, press <2l

Image is saved to Data Folder and Long Mail Composition window
opens with image attached.

To send images without saving to Data Folder, see (OJP.6-3
"Save & Send Image."

When 2-Touch Mail List Appears
@ * Select a recipient and press (®). Long Mail
Composition window opens (see COJP.3-3).
e 2-Touch Mail: see COJP.3-12

When Target Recipient is not in 2-Touch Mail List
Select E<Mail Address> and press (®).

5 W
Long Mai |

7o [No Address ]
Brive [No Subject ]
Erext [No Body Text ]
& [05-09-21_22-08]

QFF|
Save Auto Send OFF|

@Save eSelect Sendes)

Complete other fields and send Long Mail (see Step 2 and onward

on (O JP.3-3)

When attaching images before saving, character limit for message subject is 46
single-byte alphanumerics (20 double-byte characters or 44 single-byte katakana).
Once attached, files cannot be added, deleted or changed.

@ Make sure that the recipient's handset is able to receive attachments. For information

about Mail service and compatibility with other handset models, contact Vodafone
Customer Center, General Information (see P.14-20).

Wallpaper Mode Images

. Attaching as Wallpaper or Sha-mail ‘

1 Capture an image in Wallpaper mode
For details, see Steps 1 - 3 on P.6-7.

2 Before saving, press @l
3 Select DMAttach as Sha-mail or BWallpaper Size and press (®)

Image is saved to Data Folder and Long Mail Composition window opens with image

attached.

« To send images without saving to Data Folder, see COJP.6-3 "Save & Send Image."
When 2-Touch Mail List Appears: see P.6-22

eIBWERD 9|IJON h

4 Complete other fields and send Long Mail (see Step 2 and onward
on (O JP.3-3)

B splitimages
Split Mail transmission charges are equivalent to sending four Long Mail messages.

1 Capture an image in Wallpaper mode
For details, see Steps 1- 3 on P.6-7.

2 Before saving, press ¢
8 Select ElAttach Split Mail and press O)

Image is saved to Data Folder and Select Address window opens (image attached).
* To send images without saving to Data Folder, see (O JP.6-3 "Save & Send Image."
When 2-Touch Mail List Appears: see P.6-22
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Select or enter a recipient (see Steps 3 - 4 on (O JP.3-4)

Four messages with split images are saved to Outbox.

® For each Split Mail message, subject is automatically entered as: Upper Lefft,
Upper Right, Lower Left and Lower Right.

Sending Messages from Outbox

Choose [l Yes and press (®
» Outbox opens. See (O JP.4-19 to send Long Mail.

Saving Messages to Outbox
I Choose BINo and press (®

single-byte alphanumerics (20 double-byte characters or 44 single-byte katakana).

@ When attaching images before saving, character limit for message subject is 46

Once attached, files cannot be added, deleted or changed.

Make sure that the recipient's handset is able to receive attachments.
For information about Mail service and compatibility with other handset models,
contact Vodafone Customer Center, General Information (see P.14-20).

Camera Mode Thumbnails

Capture an image in Camera mode
For details, see Steps 1 - 3 on P.6-7.

2 Before saving, press (2> N

3

4

Select BAttach Thumb and press (®)

Image is saved to Data Folder and Long Mail Composition window opens with image

attached.

* To send images without saving to Camera folder, see (O JP.6-3 "Save & Send Image.
When 2-Touch Mail List Appears: see P.6-22

Complete other fields and send Long Mail (see Step 2 and onward

on (O JP.3-3)

When attaching images before saving, character limit for message subject is 46
single-byte alphanumerics (20 double-byte characters or 44 single-byte katakana).
Once attached, files cannot be added, deleted or changed.

For information about Mail service and compatibility with other handset models,

@ Make sure that the recipient's handset is able to receive attachments.

contact Vodafone Customer Center, General Information (see P.14-20).
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Postcard & Calendar

Add text or calendar mask to Camera mode images to create original Postcards or
Calendars.

¢ Created Postcard/Calendar images are saved to Camera folder as new files.
¢ Postcard images are compressed when created and the quality may change.

Postcard

m > My Files » Camera % Select a folder

1

ORhWN

o)}

N

Select an image and press (®
« Alternatively, select an image and press [2> IIENM. Skip ahead to Step 3.
Press (® to rotate images 90 degrees clockwise.

Press (2> HETH

|]5 ﬁﬂ:
Select Postcard and press (®) Postcard
ext
Select Il Text and press (® B ondar

Enter text and press (®)

e Enter up to 18 single-byte characters per line (up to five lines are
available).

¢ Animated Pictographs stay still in Postcard images.

Text Outside Frame
Will Not Appear

Select a color combination and press (®)
To not to outline text with the latter color, follow these steps first: Select [EBorder »
Press (@ ® Choose BEJOff % Press (®

Select a size and press (®
A rectangle appears indicating the location of text.

Use ;2 to move the rectangle to target location
and press (®
Text appears for confirmation.

Press (®)

@ Postcard images are saved with thumbnails (see P.6-6). Portions of thumbnails may

turn black depending on the size of original images.

6-25
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Calendar

m > My Files » Camera % Select a folder

1 Select an image and press (®
* Alternatively, select an image and press [2> HIINM. Skip ahead to Step 3.
Press @ to rotate images 90 degrees clockwise.

Press (2> HETR

Select Postcard and press @
Select BCalendar and press (®
Select @Month (Small) or B12-Month and press (®)

Current month appears.

Enter month and press (®
A rectangle appears indicating the location of calendar mask.

Use ¢ to move the rectangle to target location
and press (®
Calendar mask appears for confirmation.

Press (®

e Calendar images are saved with thumbnails (see P.6-6). Portions of thumbnails

@ e Change color for days of the week in Set Color (see P.7-3).
may turn black depending on the size of original images.
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Wallpaper
Use Wallpaper to set an image or animation to appear in Standby. Choose from
preset images, images captured with mobile camera, and images or animation
obtained via Web or Long Mail.

e Some images may not be used.
e Wallpaper is Off by default.

m P> Functions % Settings 2 % Display Settings ® Wallpaper

1 Choose DlOn and press (®
To cancel Wallpaper, choose EJOff # Press (®) (Omit the next step.)

Preset Images
H Select from [Squared Away to BDisney2 and press (®)

Press (®

Original Images

H Select EOriginal and press (®
If Original image is already saved, press to use other image.

m Existing image is replaced. (Images not saved to Data Folder are deleted.)
H Select an image from Data Folder (see P.9-6) and press (®)

To change image size, press [2> I » Select MEnlarge/Reduce » Press (®)

» Use @ to enlarge or reduce
To create split-screen Wallpaper, press (2> lEMH # Select BSplit Picture »

Press (® # Select from B to @ # Press (® # Select an image from Data Folder

® Press (® twice ® Press @
Press (®

Fb3

Vodafone live! or Data Folder is saved as Wallpaper.

e When a V-Application is set for Standby, Wallpaper may not appear.

¢ Using Wallpaper shortens Battery Time. Using animation or multiple images
consumes more handset power.

* Wallpaper does not appear when Calendar Large Stamp or Schedule & Stamps
appears in Standby (see below).

e Animation may stop after 15 seconds of inactivity.

¢ During animation, Calendar (Month (Large) - 6-Month) does not appear (see
below); Small Clock appears even if Large Clock is set.

@ e Even if Wallpaper is not set, it is automatically activated when an image from

Show Indicators

B To hide indicators in Standby while Wallpaper is set, follow these steps.
Press (® % Select Functions % Press (®) ® Select @Settings 2 % Press (®

# Select EDisplay Settings ® Press (® ® Select BShow Indicators %

Press (® % Choose BlOff % Press (®
B While indicators are hidden, press @ Indicators appear for five seconds.

and when Wallpaper is not set.

¢ Regardless of this setting, indicators always appear in windows other than Standby

Clock & Calendar

Choose a Clock type and layout or use Calendar for Standby.

Clock Display
Clock Display is Large by default.

m P Functions % Clock % Clock Display

Select [lLarge or ElSmall and press (®
To hide Clock, choose EOff # Press (®

@ When EJOff is set, Calendar (see below) is also hidden.

Calendar
Select from seven Calendars: Month (Large Stamp, Schedule & Stamps, Large and

Small), 2-Month, 4-Month and 6-Month.
e Select Large Stamp to show stamps on Large Calendar. Select Schedule & Stamps to

show Schedule as well as stamps.
¢ For Month (Small) and 2-Month, select a display position.

m P Functions % Clock % Clock Display

1 Select ElCalendar and press (®)
To hide Calendar, choose @Off » Press @
m When @JOffis set, Calendar (see above) is also hidden.

Select from [lLarge Stamp to Ed6-Month and press (®)
For @Month (Small) and E12-Month, select a display position # Press (®)

To customize colors of the days of the week, select ElSet Color # Press (®) # Select a day

% Press (® ® Select a color # Press (®)
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[ Current Date . . . .
il o Select images to use them for Power On/Off, incoming calls and Alarm windows. Use
) ¢ Highlighted ) > i g ) }
= w ETEEC e o Scheduled Date images captured with mobile camera or received via Web or Long Mail.
K Y 2 « Underlined, except when stamp appears (see P.12-13 for Display Images is Off for all items by default.
N ES more about Schedule) m - - - - -
S — Stamp (see P.12-13) P Functions ® Settings 2 % Display Settings # Display Images |
1 Selectan item and press (®
920 (1e) 15:05 2 select IFixed Graphic, BDisney or ElOriginal and press (®)
Schedule & Stamps « For INFixed Graphic or BDisney, skip ahead to Step 5.
. To cancel Display Images, choose EOff and press (®). (Omit the next steps.)
« Press (8) once to open the previous month, and press (Q) once to open the next month. When Original image is already saved, press to use other image.
Use (@) to toggle between months. (In 2-Month Calendar, display changes by one month m Existing Original image is replaced. (Images not saved to Data Folder are deleted.)
at a time. In 4-Month and 6-Month Calendars, display changes by two months at a time.)
Press to return to the current month. 3 Select an image from Data Folder (see P.9-6) and press O
¢ Press (@) to hide Calendar temporarily. While Calendar is hidden, press (©) to open Key Image appears with a rectangle indicating display size (see below).
Long Press Guide or () to open Call History. (Press &) again to show Calendar.) ¢ Unavailable images do not appear.
» Calendar appears on Wallpaper. However, Wallpaper does not appear when Power On W120xH 130dots  |Incoming Calls |W 120 x H 38 dots
Calendar is Large Stamp or Schedule & Stamps. Power Off W 120 x H 130 dots Alarm W 120 x H 51 dots
e Calendar does pot 'app'ear while a Wallpaper animation is active. « Display Images appear 200% larger.
e When a V-Application is set for Standby, Calendar may not appear. To toggle display size between 100% and 200%, press £z,

4 Use < to specify display area
¢ Display area may not be specified depending on image size.
Press to select another image ® Start over from Step 3

5 Press ®

Picture Call/Mail setting takes priority over Display Images when receiving calls (with
caller ID) from callers with Picture Call/Mail set while Ellncoming Call is E)Original.
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& Fonts

Change the size and weight of handset fonts.

Font weight is Font 3, and font size is standard (Large Font: Off) by default.

m P Functions % Settings 2 % Display Settings

1 Font Weight
Select E)lFonts and press (®
H Select from [Font 1 to EFont 4 and press (®

Font Size
Select @Large Font and press (®)
H Choose IOn or BOff and press (®

e When Large Font is active, major menu items (Functions, Settings, Briefcase, etc.)
always appear large. However, other items may appear in standard size.

V302SH employs LC Fonts for easing viewing of handset menus
and messages. LC Font/LC FONT, as well as the LC logo are all

Aejdsig !

zle"

registered trademarks of SHARP Corporation. (o) |
Item Description Default
Battery Level Select from five icons Icon 1
Signal Strength | Select from five icons Icon 1
Title Bars Select from five color schemes Color 1
Menu Design Select from five number key patterns for menu items Menu Design 1
Guide Keys Select from five Soft Key patterns Pattern 1
Indicator Bar Sglect from f|Ye b.ack.ground patterns for upper part of Background 1
Display on which indicators appear

m P> Functions % Settings 2 % Display Patterns
1 Select an item and press (®)

Select an option and press (®
¢ For other settings, repeat Steps 1 - 2.

@ Cancel Disney Style to customize Display Patterns.

7-6
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Light Settings

Activate or deactivate Backlight and Keypad Light. Adjust Active Time and Brightness.

¢ Specify Active Hours to activate lights for a set period of time each day. (Set Clock first.
See P.1-20.)

¢ Backlight and Keypad Light are On (15 seconds) by default.

m P> Functions % Settings 1 % Light Settings

1 Backlight
Select [l Backlight and press (®

Keypad Light
H Select BKeypad Light and press (®)

Changing Active Time
i Choose [BOn and press (®
Enter Active Time (01 - 99 seconds) and press ®

Active Time is set.

Backlight Off
I Choose BOff and press (®

¢ Backlight remains on while using mobile camera even if Offis set.

Aeidsiqg i

Specifying Active Hours and Active Time
Select E)Active Hours and press (®)

Enter Start Time and End Time, then press (®
Backlight and Keypad Light are available between Start Time and End Time.

Enter Active Time (01 - 99 seconds) and press (®)
e Active Hours is ignored if Clock is not set.
* Shorten Active Time to lengthen Battery Time.

Brightness Select Display Brightness from four levels I

MR Level 4

P Functions % Settings 1 # Light Settings ® Brightness |
Press (®) (Brighter) or (Q) (Darker) ® Press (®)

In-Car Backlight 2ﬁ2?g§kllgtheypad Light to illuminate while using In-Car I

MR Off

m P> Functions % Settings 1 % Light Settings % In-Car Backlight |

Choose [BOn # Press (®
To cancel In-Car Backlight, choose E1Off ® Press ®

7-7
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Sub Display Settings

Sl s EVAeTylle)iE Activate or deactivate Sub Display I

BEEIRON

m P> Functions % Settings 1 % Sub Display ® Sub Display On/Off |
Choose On or BOff » Press (®

=l dTeale=Eii e 5 Specify Active Hours and Active Time I

M Available when Sub Display is active.
BEEMNActive Time: 15 seconds, Active Hours: 17:00 - 6:00

m P Functions % Settings 1 % Sub Display ® Backlight Settings |
Active Time
Choose IIOn # Press (® # Enter Active Time (01 - 99 seconds) #
Press (®
[7 To disable Backlight, choose ElOff ® Press (®
Active Hours
Select E)Active Hours # Press (®) % Enter Start Time and End Time
% Press (®) # Enter Active Time (01 - 99 seconds) # Press (®

¢ Backlight is available between Start Time and End Time.

LAGlIE Eee i Adjust Sub Display contrast from nine levels I

W Available when Sub Display is active.
EEEMEContrast 5

m P Functions ® Settings 1 % Sub Display ® Adjust Contrast |
Press (&) (Darker) or () (Lighter) ® Press (®)

S{Eel = s BV Show or hide caller's number or name on Sub Display I

W Available when Sub Display is active.
[Defaultiely

Aejdsig ’

m P Functions % Settings 1 % Sub Display % Recipient Display

Choose IOn or BOff # Press (®
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Other Display Settings F48

Switch handset user interface between Japanese and English I

EEMR A58 (Japanese)
P> Functions ® Settings 1 % SEEFER |
Select %55 or BEnglish % Press (®
Power On Create a short text message to appear on Display each time
Message handset power is activated
Default(ejij

m P> Functions % Settings 2% Display Settings ® Power On Message |
Choose [BOn # Press (®) # Enter text » Press (®)

¢ Enter up to 16 single-byte characters.
¥ To cancel, choose BJOff » Press (®)

. Show or hide animations when sending/receiving mail or
1
Voda-fone_ — receiving Web/Station information. Set for each occasion
Animation
separately.
BEEMRON (All)
m P Functions % Settings 2 % Animation % Vodafone live! |
Select from IBSend Mail to B Web Activated % Press (8 % Choose

DOn or BOff » Press (®

Mail Background Set amr_nanon to appear in backgrounds of received messages
containing compatible Pictographs

Default{@]p}

m P> Functions % Settings 2 % Animation % Mail Background |
Choose [On or BOff » Press (®

Keidsig i
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St Aol Ammauog appears on Display when left open for a specified
period of inactivity

Default(oji]
m P> Functions % Settings 2 % Animation % Screen Animation |

Preset Animation
Choose [BOn # Press (@ # Select MAnimation % Press (®) #»
Select IlAnimation 1 or Bl Animation 2 % Press (®) twice
Original Animation
Choose [BOn # Press (@) # Select DAnimation % Press (®) »
Select E)Original » Press (®) # Select an image # Press (®) twice
Period of Inactivity
Choose [BOn # Press (®) # Select BStart Time #» Press (® »
Select a period ® Press (®)
Canceling
Choose BlOff » Press (®

® Only E-Animation files (.nva) are available.

* While animation appears, press any key to stop it.

¢ Animation may not appear depending on handset status (in Standby, mobile camera
active, etc.).

@ Using Screen Animation shortens Battery Time.

Disney Style Dlsn_ey themed graphllcs appear during calls, when sending/
receiving messages, in Index Menu, etc.

EEMROff

m P> Functions % Settings 2 % Disney Style |
Choose IBOn or BOff » Press (®

¢ Disney themed indicators also appear for Signal Strength and Battery Strength.

[alelelylale P ETeliie " Set Small Light to flash for incoming calls/mail, Alarm, etc. I

BEENROA (All)

m P Functions % Settings 2 % Incoming Light |
Select an item # Press (8 ® Choose IOn or BOff # Press (®

e Small Light flashes while Missed Call notice or Delivery Notice appears.
¢ |In Off-Line Mode, Small Light always flashes while handset is closed or while Display shuts
down for Panel Saving.
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Call Functions

Use Call Functions menu items to adjust Ring Tones, Vibration, Mobile or Small Light,
and Ring Time settings. See below for the default settings.

Incoming | Incoming | Incoming New Received | Confirm
Call Mail Web Station Info | Complete | Delivery

Ring Tone Pattern 1 Mail Web Station Pattern 5 Report
Ring Tone Level Level 5 Level 5 Level 5 Level 5 Level 1 Level 5
Vibration Off
Vibration Pattern | Vibration 1 | Vibration 2 | Vibration 3 | Vibration 4 | Vibration 5 | Vibration 2
LED Indicator '\ﬂ‘i’:r']'te Small Light
Mobile/Small
Light Blink Pattern 1
Patterns
Ring Time N/A 10 Seconds | 10 Seconds | 10 Seconds | 1 Second | 10 Seconds

* Received Complete settings apply after you:
m Retrieve complete messages or acquire Unretrieved List
m Delete Server Mail
® Manually update Station Main List or Location Info
e Confirm Delivery settings apply to Delivery Reports.
¢ Settings remain even after handset power is turned off.
e Manner Settings (see P.3-4) take priority over.

V-Application set for Standby that also responds to incoming communications may
take priority over Ring Tone and Vibration Pattern set in Call Functions.

Ring Tone Level

suonouN4 palejey % spunog H

P Functions ® Sounds % Call Functions % Select an item %
Ring Tone Level

Use () to adjust level
* Level 5is maximum. When Rising Tone is set, volume increases in the order of
Level 1 - Level 5 every three seconds.
To check volume, press <! BIIEM.
® Press <0l to stop.

Press (®
When Ring Tone Level is Rising Tone for Incoming Call, [E appears in Standby, and
[l appears for Silent.

Ring Tone

Select from preset patterns, preset melodies, Original Ring Tones, Voice files, etc.
Check preset melodies on handset.

P Functions ® Sounds % Call Functions % Select an item %
Ring Tone

Preset Patterns/Melodies
Select IMPreset Tones or ElPreset Melodies and press (®
s S wF—IIXV—F (Mickey Mouse March) is preset on handset.

License: T-0570387

Melodies in Data Folder
H Select ElData Folder and press (®)

Voice Files
Select @ Voice Folder and press (®

* Voice files cannot be used for Received Complete.
¢ Files cannot be selected if the file name exceeds 24 single-byte characters.
* Some files may not be used.

Select a tone or melody
To play tones or melodies, press <0l BEEA.
® Press <0l to stop.
® When Manner Mode is active or Ring Tone Level is Rising Tone or Silent, sounds
play at Level 1.

For some preset melodies, handset vibrates to the melody when Vibration (see
below) is set to SMAF Link.

3 Press ®

@ If source file in Data Folder or Voice Folder is deleted, Ring Tone returns to default.

Handset Vibration

» Functions ® Sounds % Call Functions % Select an item %
Vibration

Choose [BOn and press (®
To cancel, choose BJOff % Press (®
To link to SMAF files, select E}SMAF Link % Press @

suoloUN4 pelejey %® Spunog h



suonouN4 palejey % spunog H

@ Select ENSMAF Link to allow compatible SMAF files to control Vibration.

e Disable vibration when charging.
e Manner Settings (see P.3-4) take priority over.

. Vibration Pattern

P Functions ® Sounds % Call Functions % Select an item %
Vibration Pattern

1 Select a pattern and press (®)

Vibration Pattern Operation (repeats)
Vibration 1 Vibrate (0.75 Sec) — Stop (0.75 Sec)
Vibration 2 Vibrate (0.25 Sec) — Stop (0.25 Sec) — Vibrate (0.25 Sec) — Stop (1 Sec)
Vibration 3 Vibrate (1 Sec) — Stop (2 Sec)
Vibration 4 Vibrate (1 Sec) = Stop (1 Sec) — Vibrate (1 Sec) — Stop (2 Sec)
Vibration 5 Vibrate (0.5 Sec) — Stop (0.5 Sec) — Vibrate (0.5 Sec) — Stop (1 Sec)

Mobile/Small Light

Select lMobile Light or BSmall Light and press (®)

» Functions ® Sounds % Call Functions % Select an item %
LED Indicator

To cancel, choose EJOff ® Press (8 (Omit the next steps.)

2 Select a blink pattern
To check patterns, press <0l INFIX.

® Press <0l to stop.
Pattern Operation (repeats)
Pattern 1 On (0.75 Sec) — Off (0.75 Sec)
Pattern 2 On (0.25 Sec) — Off (0.25 Sec) = On (0.25 Sec) — Off (1 Sec)
Pattern 3 On (1 Sec) — Off (2 Sec)
Pattern 4 On (1 Sec) — Off (1 Sec) = On (1 Sec) — Off (2 Sec)
Pattern 5 On (0.5 Sec) — Off (0.5 Sec) = On (0.5 Sec) — Off (1 Sec)
SMAF Link Flashes according to SMAF files (Small Light only)

@ Select BSMAF Link to allow compatible SMAF files to control Small Light.

3 Press @

Ring Time

Ring Time settings are not available for Incoming Call.

m > Functions ® Sounds ® Call Functions

1 Select an item other than Ilincoming Call and press (®

2 Select BRing Time and press (®)
3 Enter time (01 - 99 seconds) and press (®)

Sound Effects

Adjust sounds and volume for handset operations.

Keypad Error Tone | Power On | Power Off S e
Sound Volume to Sound
Setting On On On On
Opening 1 Ending 1
Sound Push TorTes Error To‘ne pening nding Level 5 Small Light
Volume |Level Medium |Level Medium Level 5 Level 5
Time 0.05 Seconds | 0.5 Seconds | 3 Seconds | 3 Seconds

e Power On is when turning on handset, and Power Off is when turning off.

e Sound Volume applies to sounds in Data Folder, mail attachments, Web, etc.
e Set LED to Sound is for flashing Mobile or Small Light with sounds.
¢ Settings remain even after handset power is turned off.

Sounds

m - Functions % Sounds % Sound Effects

Select IlKeypad Sound, BError Tone, EJlPower On or @Power Off
and press (®)

2 Choose MlOn and press (®

To cancel, choose ElOff » Press (8 (Omit the next steps.)

3 select MSound and press (®)

Fi13
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4 Preset Patterns/Melodies
Select IMPreset Tones or E)Preset Melodies and press (®

Melodies in Data Folder
H Select ElData Folder and press (®)

¢ Files cannot be selected if the file name exceeds 24 single-byte characters.
* Some files may not be used.

Push Tones (Keypad Sound)

H Select @Push Tones and press (®
Pattern is set (omit the next steps).

5 Select a tone or melody
[7 To play tones or melodies, press <0 IEIEY.
= Press (@ to stop.

6 Press ®

[¥ To adjust Sound Effect volume, select E}Volume # Press (®) % Use () to adjust level
P Press (®

[ To set Sound Effect duration, select E}Time # Press (®) % Select time (Keypad Sound/
Error Tone) or enter time (Power On/Power Off) ® Press (®

@ If source file in Data Folder is deleted, sound pattern returns to default.

Sound Volume/Set ) ) .
LED to Sound Set to flash Mobile or Small Light with sound I

EEMSee P.8-5.

m - Functions  Sounds % Sound Effects |

Sound Volume
Select BSound Volume % Press (® #» Use () to adjust level %
Press (®

Light Settings
Select @Set LED to Sound % Press (® % Select llMobile Light,
B Small Light or EJOff % Press (®) to complete

Blink pattern for Set LED to Sound is fixed to Pattern 1 for Mobile Light and
SMAF Link for Small Light.

Original Voice

¢ Record sound for up to 30 seconds and use as Ring Tones.
e Sound is saved to Voice Folder 0.

m P Functions % Sounds % Original Tones % Original Voice

1 Enter title and press (®
¢ Enter up to 24 single-byte characters. Title is mandatory.
 Original Voice files are saved by title by default.

2 Press(@®

Recording starts.

3 Press (® to stop
e When maximum recording time is reached, recording stops automatically and sound is
saved.

Incoming Calls while Recording

[l Recording stops and recorded material is lost.

Playing Recorded Sounds

Il After Step 3, select a Voice file » Press ®
mPress <@l to stop.

Voice Ring Tone

Il To use as Ring Tone, follow these steps after Step 3.
Select a Voice file  Press % Select Incoming Tone % Press (®
® Select an item # Press (®
¢ Voice files cannot be used for Received Complete.

F17
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Original Ring Tones

Basics

Create melodies to use as Ring Tones, or to send via Long Mail.

e Use up to 95 sounds x 32 chords, 190 sounds x 16 chords, or 380 sounds x 8 chords.

¢ Original Ring Tones are saved to Data Folder (Melodies). See P.9-3.

¢ Original Ring Tones are saved in SUM format. To send Original Ring Tones to
handsets other than Vodafone live! packet-enabled Sharp handsets, convert them

to Melody files or SMAF files (see COJP.3-7).
¢ Converted files may not play on recipient handsets.

. Window Description

—— Sound at Cursor

—— Entered Notes/Rests

—— Cursor

*Move to enter/edit sounds

Duration

Melody Chord — -
o#=E:Chord 1, #=2&:Chord 2 ﬁgone LevelP
Tong ;Chord 3... #32: Chord 32 lTEJ/;* (0050041
Loudness ) J' l

TR EaE
Pitch <
o(Low)z— »—no symbol—*—*(High)
o#: Semitone =z
*(F): Rest @)Play e Save [ Nenurs

Sound
e|ndicated by pitch

eVaries by note or rest

3: Triplet, _: Slur

and note

. Pitch Range

Use the following scales (range: approximately 4 octaves including semitones).

. Notes & Rests

Note Rest Duration Note Rest Duration
o - Whole note/rest J. - Dotted half note/rest
N g Sixteenth note/rest 553 i Whole note triplet/rest
) ¥ Eighth note/rest I5p 5% | Sixteenth triplet/rest
) Y- Dotted eighth note/rest Iop oy Eighth triplet/rest
J ] Quarter note/rest g 41 |Quarter triplet/rest
J s Dotted quarter note/rest 71 ia Half note triplet/rest
J - Half note/rest

. Tones

Handset contains 128 basic tones and 61 extra tones preset.
¢ Create tones and save as Instrument Effects (up to 8 types to 3 locations).
¢ Adjust octave of tones (see P.8-21).

. Procedure ‘

Kl Enter title
¢ The entered title will appear when selecting Ring Tone.
¢ Enter up to 24 single-byte characters. Title is mandatory.

Select tempo
« J: Number of quarter notes played per minute
DFast J=150 |BElSlightly Slow | J = 107
Estandard J=125 |@Slow J=94

El Select number of chords
¢ Type: 8 Phonetic Chord, 16 Phonetic Chord and 32 Phonetic Chord

E1 Enter sounds one by one for melody chord 1 (£¥)

¢ Arrange pitch, octave or duration of each sound, and use semitones and triplets
(see P.8-10 - 8-11).

* Press <@l to play all entered sounds. When you press ™\, sounds are
played up to cursor. Adjust playback volume in Sound Volume (see P.8-6).

¢ In Manner Mode, sounds play at Level 1 even if Silent is set in Manner Settings,
Sound Volume.

¢ To change tone or loudness while creating melodies, press [ lenu §

For harmony, enter sounds in other melody chords (Melody chord 2:
#=2Z, melody chord 3: #3...melody chord 32: #32)
* Press to move to other melody chords.
¢ Enter sounds in the same way as melody chord 1.
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[ Select tone

® Piano is set for all melody chords by default.
e Select preset tones or Instrument Effects (see P.8-16) created beforehand.

Note/Rest Type
Press or repeatedly to change type.

¢ Selected tone applies to two melody chords (pairs: 1&17, 2&18, 3&19...16&32). J

4 Adjust loudness LJ ﬁ ﬁ
) $)) C))

o

¢ Strong is set for all melody chords by default. (wr) ()
¢ Select Strong, Standard or Faint for each melody chord. Quarter Eighth Sixteenth Whole Half
* Selected loudness applies to two melody chords (pairs: 1&17, 2&18, note/rest  note/rest  note/rest note/rest  note/rest

<Using Dotted Notes or Triplets>

* Enter a note and press @%J.
The dotted version is available for half/quarter/eighth notes and rests.

1821.848, )

Standard Dotted  Triplet Standard

3&19...16&32).

ElSave melody as Original Ring Tone
¢ To use as Ring Tone, select from Data Folder (see P.8-3).

. Entering Sounds

This section describes how to enter a sound.
The same procedure applies to melody chord 1 to 32.

El Pitch & Rest

e Connect 3 triplets as follows:

suonouN4 palejey % spunog H

Key Assignments:

Do Re Mi Fa Sol La Ti Rest

<Changing Pitch>

* Press a key once to enter a quarter note. Press the same key repeatedly to adjust
the octave.

A EME A E A

[
—
 Use (§) to change pitch by semitone.
@ ©) ©) @
G ’C#?D ,/_D#_E
©) ©) ©) ©)

<Entering Rests>
e Press (@), A quarter rest (with (B)) is entered.

8-10

gﬁgﬁg)
@ Melodies may not play properly, or may not attach to Long Mail if contained

triplets are not a set of three. Use triplets of similar pitch to avoid failure.

<Using Slurs>
* Enter a note and press &%). _ appears on the right connecting the note to the

next.
J
) J_ =)

Standard  Slur  Standard

B A sound is entered.
To enter more, press (C3 to move cursor and repeat the same procedure.
e Use (Q) to enter the same sound as the one on the left.

chords simultaneously.
e Distortion may occur when multiple melody chords play simultaneously.

@ * Sounds may not play properly if notes of the same scale/pitch play in some melody
@ In Manner Mode, Keypad sound is muted.

8-11
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C

Make sure there is enough free memory. When Data Folder is full, delete files and try

reating an Original Ring Tone

again (see P.9-24).
m P Functions % Sounds % Original Tones % Original Ring Tone

1

N OORWN

@

=30

—rh
N

8-12

Enter title and press (®
e Enter up to 24 single-byte characters. Title is mandatory.
* Original Ring Tones are saved by title by default.

Select tempo (see P.8-9) and press (®)
Select number of chords and press (®
Enter pitch or rest (see P.8-10)
Specify note or rest type (see P.8-11)
Press (s to set

Cursor moves right.

Repeat Steps 4 - 6 to enter more
* To adjust tone or loudness here, press M and skip ahead to Step 9 (tone) or 14
(loudness).
Press <0l to play sounds in all melody chords.
= Press <0l to stop.
To play current melody chord up to cursor, press &\,
®m Press <@l to stop.
To move to other melody chords, press (repeatedly).

Press (® when finished
* To save melody without adjusting tone or loudness, skip ahead to Step 19 on P.8-13.
To edit entered sounds, select EJEdit % Press (®) % Perform Step 3 on P.8-14

Select Tone and press (®
Select a melody chord and press (®)

Select a genre with <9 and a tone with

* To use Instrument Effects, select Original (FM) or Original (WT).
To check tones, press | Set B
® Press to stop.

Press (®

* Repeat Steps 10 - 12 for other melody chords.
To play melody, press <! IHEYE.
®m Press <@l to stop.

13 Press

® Skip ahead to Step 19 when not adjusting loudness.

14 Select Adjust Loudness and press ®
1 5 Select a melody chord and press (®)

16 Select from DBStrong to E)Faint
To check loudness, press <0! .
e Press <@l to stop.

17 Press ®

* Repeat Steps 15 - 17 for other melody chords.
To play melody, press <! IHEYE.
® Press <0l to stop.

18 Press
19 Select IISave and press (®

Incoming Calls while Creating

Bl Melody is temporarily saved for later editing. To return, end the call and follow these

steps.
Press (® % Choose [l Yes # Press (®

Although most tones are named after musical instruments, they may sound different.
Also, playback volume may vary or distortion may occur depending on the tone/scale.

When you press <! IIEYM, Cannot play back too many Phonetic chords may
appear, and when you press (@) IRYN, Cannot save too many Phonetic chords
may appear. Delete melody chords, replace short notes with longer notes, or reduce

triplets.
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/ Editing Sounds

Editing an Original Ring Tone Use () to change pitch and switch type with F=)/2)/E%)/E%)
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Make sure there is enough free memory. When Data Folder is full, delete files and try (see P.8-11)
again (see P.9-24). * Keys - are not available for this operation.
m P Functions » Sounds % Original Tones % Data Folder Adding Sounds

Enter sound

1 Select a file and press

« Original Ring Tones are marked with [,

2D Select Editand press (®
To change tone, see Steps 9 - 13 on P.8-12 - 8-13 (omit the next steps).
To change loudness, see Steps 14 - 18 on P.8-13 (omit the next steps).

Edit title and press (®)
Select tempo and press (®)
Select number of chords and press (®)

Move cursor to sound
To edit other melody chords, press 2.

ODORhW

appear. To proceed, choose IBYes and press (®) (see table below).
mTo cancel, choose BINo # Press (®

When Changing Number of Chords

Bl When changing the number of phonetic chords, a warning of possible data loss may

Current Chords Changed to Data to be Lost
8 16 Sounds after the 191st
8 32 Sounds after the 96th
16 32 Sounds after the 96th
16 8 Melody chords 9 - 16
32 8 Melody chords 9 - 32
32 16 Melody chords 17 - 32

B Tone may alter when number of chords is changed.

8-14

Sound is entered at the cursor position.
¢ Refer to entry limit (see P.8-8).

Deleting Sounds
Press &)

Sound at the cursor position is deleted.

¢ To delete all sounds, press &7 for 1+ seconds.
To delete sound sequence before or after cursor, press » Select
BDelete Posterior or EDelete Previous % Press (®) twice

Copy/Cut & Paste Melodies

Press (&> HYTH

Select ElCopy or @Cut and press (®

EIMove cursor to the first sound of a portion and press (®)

B Move cursor to the last sound of the portion and press (®)
Portion disappears when cut.

HE Open a window to paste the melody
* When pasting into other melodies, close the current melody and open another

window.

[ Press (&> IETR
i Select BPaste and press (®
ElPress (® at target location

Press (®) when finished
To edit tone or loudness, see Steps 9 - 18 on P.8-12 - 8-13.

Select [lSave and press (®
Select B Overwrite and press (®

Original Ring Tone is overwritten.

To save edited melody separately, select lINew Entry and press (®). The
original melody remains and the edited melody is saved as a new file.
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Deleting an Original Ring Tone

m P Functions % Sounds % Original Tones % Data Folder
1 Selecta file and press

2 Select Delete and press (®)

3 Choose [ Yes and press (®

Instrument Effects

Basics

Create original tones for Original Ring Tones and other melodies.
Save up to eight tones per chord type (8/16 Chords, 32 Chords and WT Original Tone).

. Procedure ‘

This system, based on FM synthesis, allows you to select Algorithm and Effect
Level and adjust parameters of Operator to create Instrument Effects.
¢ Select and arrange preset tones or Instrument Effects you have already created.
¢ Play sounds as you arrange tones to check effects of changes.
e Use WT synthesis by selecting WT Original Tone.
[l Select chord
¢ Type: 8/16 Chords, 32 Chords and WT Original Tone

A Select a location to save

Enter name
* Name appears when selecting tones.
¢ Enter up to 12 single-byte characters.

EiSelect source tone
e Select from preset tones if this is your first time.

8-16

[ Select Algorithm

¢ Choose from six types for 8/16 Chords, and two types for 32 i
Chords.
e Algorithm setting is not available for WT Original Tone.
[A Adjust parameters of each Operator (OP) =
¢ There are four types of Operators for 8/16 Chords and two ‘559",f 0P
types for 32 Chords. liul tiple 1
Sustain On
¢ Default parameters are the same as those of the source Key Scale Rate 1
tone Key Scale Level 2
’ . Total Level 25
e Use () to select parameter and ¢ to adjust. Attack Rate 0
* Press <0l to check effects of parameter changes. pecay Rt ol 3

[Fd Set Effect Level, Basic Octave, etc.

El Save tone (Instrument Effects)
e Select Instrument Effects from tones to use for Original Ring Tone, etc.

@)Play ©Adjust | Set

WT Synthesis

B WT synthesis is based on recorded waveform data from musical instruments, etc.
which are close to original sounds.

B FM synthesis

This system synthesizes various tones by generating a sine wave called Operator.
Algorithm is a combination of Operators. Depending on the Algorithm, Operators
work either as Modulator (that which modulates) or Carrier (that to be modulated).

Feed Back

Operator 1

Operator 2 === \/arious Tones

Modulate
Modulator Carrier

¢ Adjust a variety of parameters including Multiple and Sustain.
e Some Operators have a parameter called Feed Back for more effects.

8-17
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. Algorithm

Select a combination of Operators from six types (8/16 Chords) or two types (32 Chords).

For 8/16 Chords
Algorithm 3 Algorithm 4 Algorithm 5 Algorithm 6
—W_ “ (Shaded)
—ERER Modulator (that which modulates)
ﬁl — L IEl (White)
Algorithm 7 Algorithm 8 Carrier (that to be modulated)
For 32 Chords

Algorithm 1

LEmEm

-

Algorithm 2

¢ Available Operators vary depending on the combination.
e Algorithm setting is not available for WT Original Tone.

. Operator (OP)

See the table for details. Available parameters may vary by the number of chords.

Parameter Description
Multiple Multiple affects tones most. The higher the Carrier level, the higher the
(13 levels) pitch. Adjust the Modulator level for a variety of tones.
Sustain When Sustain is set, sound continues after produced. Choose On to
(On/Off) provide sustaining effects to tones in Piano, Glockenspiel, etc.
Key Scale Rate |Set Key Scale Rate high to shorten the rise and fall time. Select 2to
(two levels) emphasize this effect.

Key Scale Level
(four levels)

The higher the Key Scale Level, the lower the volume level. Select 0 to
disable this effect.

Total Level
(64 levels)

(1) Carrier

The higher the Carrier value, the higher the volume level.

Normally set 64 (maximum value), and select smaller values to use tones
effectively at low volume for accompaniments, etc.

(2) Modulator

Increasing Modulator value brightens tones.

Select smaller values for softer tones. Normally set between 40 and 64 to
enjoy effects of tone changes.

8-18

Parameter

Description

Attack Rate

The higher the Attack Rate, the longer sounds take to reach the maximum
volume. When using tones with Attack Rate high, use longer notes or select

(15 levels)

slower tempo.
Decay Rate Lower Decay Rate to shorten the time sounds reach down to Sustain Level
(16 levels)

Sustain Level
(16 levels)

The Sustain Level for a Normal Tone equals the sustained volume. For
Step-Down Tones, Sustain Level measures the volume at which Ring Tone
begins to decrease. The higher the Sustain Level, the higher the volume.

Sustain Rate
(16 levels)

The lower the Sustain Rate, the longer the Sustain Level volume is
sustained. 716 is Normal Tone, and other levels are Step-Down Tones.

Release Rate
(16 levels)

The Release Rate for a Normal Tone equals the time from beginning to end
of a sound. For Step-Down Tones, Release Rate measures the time from
when a sound begins to decrease until it ends completely. The lower the
Release Rate, the sooner the sound ends. For sustaining effects, increase
Release Rate.

KEYOFF Nullify

Choose On to avoid sound skipping of Step-Down Tones including those in

(four levels/Off)

(On/Off) DRUM

Wave Select Select from 29 waveforms
(29 types)

Vibrato

Vibrato is a periodic variation in pitch

AM Modulation
(four levels/Off)

The higher the AM Modulation level, the stronger the tremolo (periodic
changes in loudness)

Feed Back
(eight levels)

Set Feed Back (not available for some Operators)

@ When Release Rate is set high for Normal Tones, rests may be ignored in playback.

. Additional Settings

Parameter

Description

Effect Level
(four levels)

Effect Level affects cycle time of wavering quality in pitch or loudness.
Select high level to shorten the cycle.

Basic Octave
(four levels)

Adjust octave of tones

Panpot
(31 levels)

Panpot measures the position of sounds, which varies by combination of L (left) and
R (right). Sound bias is emphasized as the value difference increases.

Sustain (On/Off)

Choose On to extend sounds

Vibration Level
(four levels/Off)

Select higher level for stronger vibrato

Basic Octave, Sustain and Vibration Level settings are not available for WT

Original Tone.
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C

reating Instrument Effects

m - Functions % Sounds ® Instrument Effects |

©WO NO Oh W N =

e . .
N - o

13
14
15

16
17

8-20

Select [88/16 Chords, B32 Chords or EIWT Original Tone and press (®)

If Instrument Effects are already saved and renamed, they appear in Effects list.

Select a location to save and press (®) twice
¢ To leave the name unchanged, press @ once and skip ahead to Step 4.

Enter name and press (®)
¢ Enter up to 12 single-byte characters.

Select Base Tone and press (®)

Select a genre with ¢ and a tone with
To check tone, press <! IHEM.
® Press <0l to stop.

Press (®

Select Tone and press (®
* To keep Algorithm unchanged, skip ahead to Step 10.

Select Algorithm and press (®)

Select Algorithm and press (®)
* To keep each Operator (OP) unchanged, skip ahead to Step 14.

Select Operator (OP 1, etc.: see P.8-17) and press (®

Default parameters are the same as those of the source tone.

Select a parameter with (Q) and adjust it with

For parameter descriptions, see P.8-18 - 8-19.

Repeat Step 11 to adjust other parameters
Press <0l to check effects of parameter changes.
= Press <0l to stop.

Press (®) or
Select Effect Level and press (®)

Select a frequency for tremolo/vibrato and press (®)
Confirmation appears.

Select Basic Octave and press (®)
Select a level and press (®

18 Select Panpot and adjust with E;g

1 9 Select Sustain and choose On or Off with
20 Select Vibration Level and adjust with

21 Press

29 When finished with all settings, press

* To create more, repeat Steps 2 - 22 on P.8-20 and above.

Other Sound Related Functions

Select whether to activate Speaker Phone (for handsfree
conversations) or Speaker (to listen only)

MEEMROff

m P Functions % Sounds % Speaker |
Select [lSpeaker Phone or ESpeaker » Press (®)

To use Earpiece and Microphone for phone conversations, choose EJOff # Press (®)

Talk with Speaker

Il Before or during calls, press @ for 1+ seconds.
e i»: Speaker Phone is active. & : Speaker is active.
» When Speaker is EJOff, use Earpiece and Microphone for phone conversations.
* To cancel manually during a call, press @ for 1+ seconds.

B When calls end, speaker talk is canceled.

e Speaker is not available when headphones, etc. are in use.
@ e When Speaker Phone is active, ringback tone may not sound. Handsfree
conversations may be hampered by ambient noise. Keep handset as close as
possible when using Speaker Phone.

suoloUN4 pelejey %® Spunog h

I Select an octave for each tone from four levels I

m P Functions ®» Sounds % Tone Octave |

Select a genre with s and a tone with () » Press (®) # Select a
level » Press (®

To check tone or octave, press <0l IHEE.
® Press <0 to stop.

¢ Adjust octave of Instrument Effects in Basic Octave setting (see Steps 16 - 17 on P.8-20).
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File Organization

Handset has two storage areas. Files are automatically sorted into Memory by function
and into File Cabinet by file format. Handset File Cabinet capacity is approximately 8 MB.

Handset Memory Structure

.....................

~

Memory
Phone Book

Schedule
Text Memo
Mail Box
Bookmarks
Message Folder

Saved Information

....................

File Cabinet

Data Folder

Camera
(Shortcut)

Images
Melodies

Animation
Burst Shots

V-Appli Library
Camera

Action Snap Folder

Voice Folder

File Cabinet Memory Status
To check memory usage status, press (®) # Select My Files » Press (®) »

Save files created/obtained using
assorted handset functions.
Memory capacity varies by
function.

Files are sorted into folders by file
format. File Cabinet capacity is
fixed and shared by all folders.

Select ElMemory Status » Press ®

Data Folder

Contents

Files created or obtained via Web or Sky/Long Mail are organized in separate folders

according to file format. Files are sorted as follows:

Mobile Camera Data
Data Folder ¢ Shortcut to still and video images captured in Sha-mail,
Camera Wallpaper, Camera or Action Snap mode
(Shortcut)
Images ——— Image Files including Still Images
Melodies —+—— Melody Files such as Original Ring Tones
Animation ——— Animation Files
Burst Shots —t—— Burst Shot Files

Create QR Codes from image/melody files in Data Folder (see P.12-27).

Window Description

To open Data Folder from Standby, follow these steps.

Press (®) » Select My Files » Press (®) » Select Data Folder i
D Data Folder % Press (® Data Folder
HCamera
&1 mages
Millelodies
EAnimation
W§Burst Shots
o (pen | Menurs
Data Folder
B File View
Open a folder to view files.
e Example: Images folder
* To customize the appearance of File View, see P.9-5 "Display Settings."
M File View (List)
Format, Name and Size (of selected image)
Saved Files
e Icons appear for files other than images or images not
supported by handset.
9-3
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B File View (List File Names)

File Size

Folder Name

@ To view folders first, select Thumbnails or File Listin Display Settings for Images,

Animation or Burst Shots folder (see P.9-5).

lcons

Saved Files (format and file name)

B stillimage & Animation Files

(JPEG, PNG, or PNG/JPEG Animation)

Icon Format Description
[ P :
(P: white) PNG PNG image
[P} .
(P: purple) Transparent PNG Transparent PNG image
[} JPEG JPEG image
Burst Shot (consisting of Index Image and )
B 4,9, or 25 frames) Burst Mode image
(E: white) E-Animation (NEVA files) Animation (may include sound)
(E: Yellow) E-Animation (NEVA files) with jump buttons | Animation (may include sound)
B Animation Animation

*Blue icon: forwardable, red icon: unforwardable

e Unforwardable files cannot be edited, combined, attached to Long Mail, converted to QR

Codes or sent via infrared.

* A yellow triangle appears (ffl) on icons of the files used in Phone Book, Useful Diary or

Schedule entries.

. Sound Files

Icon Format Description

B SMAF Melon via ng or Long Mail
(may include images)

) Melody Melody via Web or Long Mail
Melody downloaded from Sky

B

Sky Melody Melody Center (unforwardable).

m Original Ring Tone Original melody (forwardable)

i Voice Voice/sound you recorded
(forwardable)

*Blue icon: forwardable, red icon: unforwardable

¢ Unforwardable files cannot be edited, combined, attached to Long Mail, converted to QR
Codes or sent via infrared.

* A yellow triangle appears () on icons of the files set for Ring Tones, Alarm, etc.

Display Settings

Customize appearance of each folder in Data Folder.

Setting Description
List' Thumbnails appear
List File Names®  |File names appear
Thumbnails' Sub folders appear (thumbnails appear within)
File List® Sub folders appear (file names appear within)
"Not available for Melodies folder.

2Appears as List for Melodies folder.
3Appears as Folder for Melodies folder.

m > My Files % Data Folder

1 Select afolder and press (2> HIETH

2 Select @Display Settings and press (®)
3 Enter Security Code

4 Select a type and press (®

In this manual, most operations are described with Data Folder appearance set to
List. Operations may differ if folders are set to appear.

(1opjo4 ereq) saji4 buibeuepy H



(1opjo4 ereq) saji4 buibeuep B

Opening Files

Handset Data Folder

index e LTI

1 Select @l Data Folder and press (®
2 Select a folder and press (®

Thumbnails or file names appear (see P.9-3 "File View").

3 Select afile and press O]
The content plays or appears.
® Press to open or play the next file, and press to open or

play the previous one. (Available in most cases.) ‘ 4
@Sha-nail @ Show | Menurs

File View
(Images Folder)

A

Opening Burst Shot Files
Index Image appears. Use ¢ to view single frames.
JPEG Images Exceeding W 240 x H 320 Dots

Images are reduced to fit Display. To restore the original size, press (&> TN,
select Original Size and press (®).

4 Press &7 to return to File View

E-Animation Files with Jump Buttons

Il Some E-Animation files contain jump buttons with which to access the Mobile
Internet or open linked images. Follow these steps to use the buttons.
Open an E-Animation file and press » Select E-Animation Mode
® Press (®
e Click buttons on screen for operations.

@ Exchange files via infrared with compatible devices (seeP.10-2).

9-6

Sending Files via Long Mail
Attach files to Long Mail from Data Folder.

m » My Files % Data Folder % Open a folder

1 Selecta file and press

Select Attachment and press (®)
For large JPEG image, select IBAttach 1/4 Size, B Attach Original or E)Attach Split Mail
P Press (®
For Melody files or Original Ring Tones, select a file format (see (OJP.3-8) ® Press (®

Complete other fields and send Long Mail (see Step 2 and onward

on (O JP.3-3)

Sending Burst Shot Images

H Press (® » Select My Files % Press (® % Select [lData Folder » Press (® »
Select Burst Shots % Press (®) # Select a file ® Press (® ® Select an image
with ¢ & Press % Select @Attach Screen % Press (® % Perform
from Step 2 on (O JP.3-3

Sending Split Images

B To split an image (240 x 320 dots) into four frames and attach to Long Mail, follow
these steps.
Press (® # Select My Files % Press (® % Select [lData Folder » Press (®)
® Select a folder % Press (®) ® Select an image ® Press »
Select Attachment % Press (® » Select E)Attach Split Mail % Press (@) »
Select or enter recipient % Choose [l Yes # Press (® (See Step 3 and
onward in "Send Continuously" on (O JP.4-19.)

M Split Mail transmission charges are equivalent to sending four Long Mail messages.
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Properties . Creating Simple Animation ‘
m » My Files m P Functions ® Settings 2 % Animation % Simple Animation % New|
1 Open Data Folder or a folder within it, and select a folder or file 1 Enter title and press (®
* Enter up to 32 single-byte characters. Title is mandatory.
2 Press [ Nenu | o Files are saved by title by default; change file names later (see P.9-23).
3 Selgct Property and press (®) 2 Select tempo and press @
Details appear. In animation, images appear in numerical order at the tempo. lsﬁi""?pm MefinEiien

« Press () to scroll down.

« ltem Descriptions File Neme[Easy-goin]

Tempo[Slightly Slow]

Title' Melody file name —
Type File/folder type
Location File/folder location
File Size Data Size
Memory Used File size on handset
| number and pr
Width x Length2 Image size in dots 3 Select a number and press @
OK: can be copied within Data Folder 4 Select an image in Data Folder and press (®
Copy/Fwd . . ;
Invalid: not supported For operations in Data Folder, see P.9-6.
S OK: can be saved To use a 4-Burst Shot (all frames), select a Burst Shot file # Press (@) # Select
ave Invalid: not supported D Animate Burst File % Press (®)
OK: can be transferred to external device ®» Animate Burst File is available only when [ is selected in Step 3 with no other
Transfer Invalid: not supported images specified. Burst Shot files of 240 x 320 dots are not available.
Phone Book (Photo)3 Yes: set for Photo setting To use a Burst Shot framg, select g Burst Shot file # Press (®) ® Select BlChoose One
o Ves: set for Ring Tones. Alarm. etc » Press (8 ® Select an image with €03 ® Proceed to Step 5
9 — 9 — - To start over from selecting an image in Data Folder, press [ Change |
Set Useful Diary’ Yes: set for Useful Diary To start over from Step 3, press <0 IEZNA.
Schedule Memo® Yes: set for Schedule
" Appears for files in Melodies folder. 5 Press @ -
2Appears for JPEG/PNG/Burst Shot images, etc. The image is set. Simple Animation
To play animation, press (2> [[ITH » Select 4

3 . . . . .
Number of entries for which the file is used also appears. File Name[Easy-goin]

D Animation Playback % Press (®) Tempo[Slightly Slow]
21_11-08
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: H H m To return, press <@l % Press &7
An I matlon FI Ie To change images, select one » Press » Select
BlChange # Press (® # Start over from Step 4
S|mp|e Animation To delete images, select one % Press » Select

BElDelete # Press (@ % Choose [BYes # Press (®
Select up to four images to create Simple Animation. Images appear one after another

at the selected tempo. 6 Repeat Steps 3- 5 to add images
¢ Use JPEG images captured with mobile camera or obtained via Web/Long Mail. * Select up to four images.
¢ Simple Animation files are saved to Animation folder. However, those made of a single 7 Press @ when finished
Image are saveq o Images fqlder. To send animation via Long Mail, select ElAttachment % Press () » Perform from
* When memory is full, delete files to free some space (see P.9-24). Step 2 on (OJP.3-3
* Image quality may change when used for animation. ® For large animation, choose IlYes ® Press @® (File may be too large to be attached

even if the size is reduced.)

8 Select [lSave and press (®
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B Editing Animation | Setting Image & Animation as Wallpaper

When memory is full, delete files to free some space (see P.9-24). Save As Wallpaper can be selected only for compatible files.
m P> Functions % Settings 2 % Animation % Simple Animation % Edit | m > My Files ® Data Folder % Open a folder % Open a file % Menu (£) |
1 Select animation and press (® Images

2 Edittitle and press (® H Select BDisplay Setting and press (®

HSelect IISave As Wallpaper and press (®)
3 Select tempo and press (®)

To add images, select a number ® Press (8 # Select an image # Press (®) twice Animation
To change images, select a number ® Press » Select BChange # Press (® Select Save As Wallpaper and press (®)
» Select an image ® Press (®) twice Press (®)
To delete images, select a number # Press ® Select ElDelete # Press (®) . . . .
* Choose MYes # Press ® Setting Image & Animation as Display Images
4 When finished editing, press @l To Display Images can be selected only for compatible files.
5 select @Save and press ® EXEXEY > My Files ® Data Folder % Open a folder % Open a file % Menu (&) |
6 Select @INew Entry and press (®) 1 Images
The animation is saved to Data Folder (Animation). K Select EDisplay Setting and press @
To overwrite, select ElOverwrite  Press (®) Select ETO Display Images and press @
9N Opening Animation Files Animation
il Select To Display Images and press
m P> My Files % Data Folder a piay g P O

2 Select an item and press (®

For more, see Step 4 and onward on P.7-5.

1 Select a folder and press (®)
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Select anlmgthn file and press (® Saving Burst Shot |mages
The selected animation plays.
Press <0l to stop. Save all frames and Index Image of a Burst Shot file () as individual images at one
To use animation files, see below. time, or select a single image to save.
= . . Individual Burst Shot images are saved to Data Folder (Images) in JPEG format.
Using Images & Animation (Source file remains.)
Some images may not be used. m P> My Files % Data Folder % Burst Shots ® Open a Burst Shot file
Chanainqg Display Size 1 Saving All Images Individually
ging play HPress (2> HIETR
1 Open afile and press H Select ESave Single Frames and press (®)
Display size toggles between 100% (with indicators), 100% (no indicators), Enlarged (with ) )
indicators) and Enlarged (no indicators). Saving a Single Image
* Size may not be changed or size options may vary depending on the file. When enlarged, Kl Select a frame or Index Image with and press [ Menu |
the entire image may not appear on Display. H Select [E)Save Screen and press

o [&: 100%, EJ: Enlarged

9-10 9-11
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Slide Show

Allimages in Data Folder (Images, Animation or Burst Shots) or Camera folder appear

sequentially. Adjust Slide Show speed.

IEEAE > My Files » Data Folder % Open a folder
1 Select an image and press

2 Wslide Show and press (®

Select IBSlide Show and press (®

Slide Show starts from the selected image.
To stop Slide Show, press (®).
= To resume, press (®).
To skip images manually, press [ llext |

Setting Interval

M Interval is Standard by default. To change interval, follow these steps.
After Step 2 above, select ElDisplay Speed % Press (®) # Select an interval

» Press (®

Editing Images

Enlarging/Reducing Image

» My Files % Data Folder % Open a folder & Open a file %
Menu (&>) % Image Size

Select IAEnlarge/Reduce and press (®)
* If Move does not appear at the lower left, press <0l (TRYER.
* Shortcut: From Data Folder, open an image and press <0l

9-12

To Center the Point to Enlarge

* Press <0l and use ¢$9 to move the point to the center of Display.

* Image stops when you release the key or the limit is reached.
To Return to Resize Mode

Press <l [B¥EA.

2 Press and hold (%) to enlarge and () to reduce
the size
To stop resizing, release the key (stops automatically when the
limit is reached).
To soften images, press [ Soft B

¢ Portions outside Display are cut when saved.
* When <@l is pressed after resizing, image
returns to the original size.

Press (®

Resized image is saved as a new entry.

Changing Image Size

@llove oSave Softm

Resize images in Data Folder to send via Long Mail or set as Wallpapers.
* Alternatively, crop image for size. File size changes when images are resized.

¢ Images may not appear depending on the size.
® Change Image Size can be selected only for compatible files.

. Resize to Preset Size

» My Files ® Data Folder % Open a folder ® Open a file % Menu (&)
» Image Size % Change Image Size

Select from llWallpaper to B Alarm and press (®

A rectangle appears on the image (except for lBWallpaper.)

Wallpaper W 240 x H 320 dots
Sha-mail Size W 120 x H 160 dots
Power On/Off W 120 x H 130 dots
Incoming Call W 120 x H 38 dots
Alarm W 120 x H 51 dots

To start over from selecting preset size, press &=] or (2> INETE.

@Resize 0K  Sizer
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2 Selecting Display Area 2 Entering Text
Use ¢$» to specify display area and press (®) H Select Character and press (®
¢ Display area may not be specified depending on image size. Enter text and press @
¢ Enter up to 16 single-byte characters.

Enlarge or Reduce To reenter text, press <@l % Start over from Step 1

Press @ Press - to change the color and to toggle Border On and Off.
Move appears in the left bottom corner. .
Press (©) to enlarge and (Q) to reduce the size, and press (® Adding Stamps
H Select a stamp and press (®
Press_ ® To change stamp, press <@l
Image is saved as a new entry. Press - to change the color and to toggle Border On and Off.

. Cropping Images \ Use ¢¥ to move text or stamp to target location and press (®

R W

D My Files ® Data Folder % Open a folder % Open a file % Menu (&) Choose DYes and press (®
» Image Size ® Change Image Size To add more text or stamp, select ElMarking » Press (® % Press (&> IR &
Repeat Steps 2 - 4
1 Select (3Cut and press ® To check the image, select ElCheck Image # Press (®)
To cancel editing, select @Cancel Edit % Press (8 » Choose [#Yes % Press (®
2 Use 9 to move + to the upper left corner of the
portion to crop and press (®) 5 Select IComplete and press (®)
3 Use ¢ to move + to the lower right corner of the 6 Choose DYes and press (®

Image is saved as a new entry.

portion
To cancel, press <@l ® Start over from Step 2 Visual Effects
4 Press Dress up images with preloaded visual effects.

To start over from selecting preset size, press &= or (2> INEZE.
To adjust display area/scale, see Step 2 in "Resize to Preset

¢ Apply to JPEG images including Burst Shot files.
* Use images between W 52 x H 52 and W 240 x H 320 dots. Images larger than

Size" above. W 240 x H 320 dots are automatically cropped and centered.
5 Press @ twice * Blimage Decoration or ElBurst Shot Effects can be selected only for compatible files.
Image is saved as a new entry. BN > My Files # Data Folder ® Open a folder % Open a file # Menu () |
Marker Stamp 1 Select @Picture Effect and press (®

To decorate Burst Shot images, select ElBurst Shot Effects % Press (®) % Skip

Add text/stamps (arrows/plus sign) to images.
Ps ( P an) 9 ahead to Step 3

¢ Apply to JPEG and PNG images. Some images may not be used.
e Marker Stamp can be selected only for compatible files. @

» My Files % Data Folder % Open a folder % Open a file %
Menu (&) % Picture Effect
Select IMarker Stamp and press (®)
To specify the color, select EdFont Color % Press (®) ® Select a combination ® Press (®)

To not to outline text/stamp with the latter color, select EJBorder % Press (® % Choose
Boff » Press (®

For Burst Shot files, decorations are added to all images. To decorate a single
image, save it as an individual image first (see P.9-11).

2 Select BImage Decoration and press O)

@ For PNG images, Font Color and Border cannot be selected (White w/ Black
applies).

9-14 9-15
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Select an effect and press (®

e Picture Effects:

Sepia

Renders image in sepia tones

Sparkling

Adds sparkling effect to bright portions of an image

Soap Bubbles

Superimposes bubbles over an image

Kaleidoscope

Renders an image as a kaleidoscopic image

Emboss

Renders images in black and white relief

Scrunch

Renders image as a pencil sketch

Aluminum Can

Superimposes image onto a 3D can image

Round Frame

Adds a round, opaque frosting to the edges of an image

Soft Frame Adds a soft, opaque edged frame to image
Zigzag Frame Adds a jagged edged frame around image
Press (®

Image is saved as a new entry.

@ Edited images may be too large to save or send via Long Mail.

¢ Use portrait images.

Face Arrange

Make smiley, angry or sad faces.
¢ Apply to JPEG images.

¢ Face Arrange may not fit all images. Adjust position and size as required (see P.9-17).
® Face Arrange can be selected only for compatible files.

P My Files ® Data Folder % Open a folder ® Open a file % Menu (&)
®» Picture Effect » Face Arrange

1 Select a type and press (®

(1opjo4 ereq) saji4 buibeuep B

Mirror: Copies right side of face onto Stretches face to lengthen
- ) Slender

Right-half |left side appearance

Mirror: Copies left side of face onto Crush Face Shortens distance between

Left-half right side top and bottom of face

Grin Pulls eyes down & mouth up |Dark Darkens skin tone

Mad Pulls eyes up & mouth down |Fair Brightens skin tone

Sad Pulls eyes & mouth down Angry Mark |Adds a stress mark to face

To start over, press 0! IETA.

9-16

Press (®

Image is saved as a new entry.

When using Face Arrange, take care not to create images that may embarrass or
offend others. Always obtain permission before photographing others.

. Adjusting Face Arrange Position

After Face Arrange (Step 1 on P.9-16), change the positions and sizes of targets to fit
your images. Changes apply to the current image only.

Select E3Positioning and press (®)

Face Arrange targets appear.

2 Press

A rectangle appears with =+ in the upper left corner.

3 Set the face line

5l!l z
Set Upper Face Line

=

"

Use ¢ to move + to
the upper left corner

®
—

am
15:05
Set Lower Face Line

@Back | ®0K = Setm

Use 53 to move + to
the lower right corner

To start over, press <! IERTA.
4 Set the eyes and then mouth in the same way

W.,
15:05 —
Right Eye/LowerRight

Right Eye

O

5 [&] 2
Left Eye/Lower Right

@Back | #0K Setm
Left Eye

<] W
15:05
Right Eye/Upper Left

®
-—)

@Back  e0K | Setm

Face line is set

5 4] [+
Mouth/Lower Right

Mouth
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5 Press when finished

After Arranging Face..., all the targets appear.
 To start over from the face line, return to Step 2.
To restore the original positions, press <0l [TXX.

6 Press ®
7

Choose IBYes and press (®

Image is saved to Data Folder as a new entry with Face Arrange positions adjusted, and
Face Arrange menu returns.

e Complete Face Arrange. Face Arrange is applied to the adjusted positions.

Additional Picture Effects

* Frame, Burst Mode Frame, 90° turn, Change File Format and Moving Photo Frame
can be selected only for compatible files.
e Edited images are saved as new entries.

m Add Frame to JPEG images I

SN > My Files # Data Folder % Open a folder % Open a file # Menu (&) |

Framing Standard Images
Select @Picture Effect % Press (®) % Select @Frame % Press (®) »
Select DMPreset Frames or EOriginal Frames % Press (®) % Select a
frame # Press (®) twice

To check frames, select one ® Press <0l
® Press <0 to return to Frame list.

Framing Burst Shot Images
Select @Burst Mode Frame % Press (®) # Select [BPreset Frames or
BOriginal Frames % Press (® # Select a frame ® Press (®) twice

To check frames, select one ® Press <0l
= Press <0l to return to Frame list.

For Burst Shot files, frames are added to all images. To frame a single image,
save it as an individual image first (see P.9-11).

P> My Files % Data Folder % Open a folder % Open a file % Menu (&)
= Picture Effect

Select 390° turn  Press (® # Press (®)°
*To rotate further, press (2> [TXEA. Each press rotates image by 90 degrees.

9-18

\leihlefglei i Add Moving Photo Frame to JPEG images to create
Frame animations

P My Files % Data Folder % Open a folder % Open a file % Menu (&)
®» Picture Effect ® Moving Photo Frame

Select a frame # Press (®) twice

To view file animation alone, select one ® Press <0l
®m Press {0l to return to Moving Photo Frame list.
¢ Animations are saved as E-Animation files with a .nva extension.

Moving Photo Frame size is W 120 X H 130 dots. For images larger than this
size, Moving Photo Frames appear centered. Resize or crop images to fit frame
(see P.9-14).

Change File _

P My Files % Data Folder % Open a folder % Open a file % Menu )
®» Change File Format

Select a format # Press (®)

* Apply to images smaller than 120 x 160 dots.
* The original format cannot be selected.

@ Changing file format may affect image quality.

Combining Images
Some images may not be combined and menu items may vary by file type.

Split Screen

Combine up to four reduced images into one.

¢ Apply to JPEG images including Burst Shot files.

* Make sure there is enough free memory.

¢ Images are placed in the upper left, upper right, lower left and
lower right in numerical order.

Split Image

IIEEAE > My Files » Data Folder % Open a folder

1 Select an image for upper left and press (®)
* To use a Burst Shot image for upper left, select any standard image temporarily and
change it to a Burst Shot image later (see Step 10 on P.9-20).

9-19
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ON O ORhWN

©

10

—r
N =

Press
Select BlComposite and press (®)

Select ISplit Image 120 x 160 or B Split Image 240 x 320 and press (®

Enter name and press (®)
e Enter up to 32 single-byte characters. Name is mandatory.

Select a number and press (®)
Data Folder opens.

Select a folder and press (®

Select an image and press (®
* Some images may not be selected.
To change the image, press [Change B
To start over from selecting a number, press <0l IFERA.

Press (®

Repeat Steps 6 - 9 to add images
To preview Split Image, press » Select
DSplit Screen » Press (®)
® To return, press P Press &7
To change images, select one ® Press » Select
BElChange » Press (® » Start over from Step 7
To delete images, select one # Press » Select
BlDelete # Press (® % Choose [BYes # Press (®

15:05 W'
Split Picture

File Name[MyPhoto ]
5-09-20_15-17

@ Set | eSelect  Menurs)

Press <2l when finished
To send Split Image via Long Mail, select ElAttachment % Press (® % Perform from
Step 2 on (O JP.3-3

Select [lSave and press (®

Image is saved as a new entry.

Using a Single Image of Burst Shot File

M Follow these steps after Step 6.

Select Burst Shots % Press (®) % Select a Burst Shot file ® Press (® »
Use ¢ to select an image ® Press (® ® Perform from Step 10 above

* 1/4 - 4/4, etc. is added to the file name.
B Index Image can be used (H is added to the file name).

9-20

Panorama Images

Combine two images into one.

=
=

Select two images
Panorama Image Effects:

Merge Panorama

Standard Applicable to all kinds of shots
Near View Best suited for close-up shots with parallax correction
Document Use for images with text

¢ Use JPEG images between W 48 x H 64 and W 120 x H 160 dots/W 160 x H 120 dots.

e Some portions may be cropped to adjust two images to the same size.
¢ The result may not be satisfactory if color tones are different between two images.

BRI » My Files % Data Folder % Open a folder

Select an image and press (®

Press

* For Burst Shot images, skip ahead to Step 4.
Select ElComposite and press (®)

Select Merge Panorama and press (®)
The first selected image appears on the left when combined.
* Merge Panorama can be selected only for compatible files.

Select from IStandard to E\Document and press (®)
Select B and press (®

Data Folder opens.

Select another image and press (®

N OO, AW =

9-21
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Press (®
The selected image appears on the right. Two images are set.
e If the image is too large or too small, select another.
To change the image press % Start over from Step 7

Press <0l when finished

Combined image appears.
e Use 5% to scroll the image.
To switch the positions, press [2) [TTIER.

10 Press @

Image is saved as a new entry.
Combining Split Mail Images

Use one of four Split Mail images to combine them all into one.

¢ Images may not be combined properly if file names of Split Mail images are changed, or

the same file name exists.
¢ When combined, image quality may change.

05-09-20_15-17
[E305-09-20_15-18

Set eSelect

Using for Incoming Tone/Sound Effects

] Files cannot be used if the file name exceeds 24 single-byte characters.

m P> My Files % Data Folder % Melodies

1 Selecta file and press
2 Select Blincoming Tone or E)Sound Effects and press (®)

¢ Incoming Tone or Sound Effects can be selected only for compatible files.

3 Select an item and press (®

Editing Melodies & Adjusting Tone or Loudness

H Press (® » Select My Files » Press (® ® Select IlData Folder % Press (®) %
Select Melodies % Press (®) % Select a melody ® Press [ Menu |
= To edit melodies, select B Edit » Press (@) % Perform from Step 3 on P.8-14
® To adjust tone, select B Tone # Press (®) # Perform Steps 10 - 13 on P.8-12 - 8-13
® To adjust loudness, select EdAdjust Loudness # Press (®) # Perform Steps

P My Files ® Data Folder % Open a folder % Open a file % Menu )
» Composite

15-18 on P.8-13
¢ Melody format files are saved as Original Ring Tone format after Edit.

n 1 Select EICombine Split Mail and press (®

(1opjo4 ereq) saji4 buibeuep

Press (®)

Image is saved as a new entry.

Editing Files & Folders

To change folder names, set folders to appear from Display Settings (see P.9-5).

Melody Files

Some functions may not be available and menu items may vary by file type.

Playback Volume

I Rename folders (except Folder 0) or files I

m > My Files % Data Folder

Folder Names
Select a folder ® Press (® # Select from Folder 1to Folder 9 %

m » My Files % Data Folder » Melodies

Press % Select EJFolder Name # Press (®) % Enter name

1 Selectafile and press
2 Select MhPlayback Volume and press ®
3 Use (D to adjust level and press (®

9-22

% Press (®

File Names
Select a folder ® Press (® # Select a file # Press »
Select Change File Name % Press (® ® Enter name # Press (®)

e Changing names does not affect titles of sound files.
@ e When you attach a file to Long Mail, single-byte katakana used in the name
change to double-byte, and Pictographs are deleted.
* Some single-byte Symbols may not be used for file names.

9-23
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Secret Mode Restrict access to folders (except Folder 0) I

m » My Files % Data Folder ® Open a folder |
Select from Folder 1to Folder 9 % Press » Select
E)Secret Mode # Press (®) ® Enter Security Code ® Choose IlOn
or BOoff % Press (®

¢ Enter Security Code to open folders set to On.

@ Secret Mode is not available for Camera folder (shortcut).

Copy/Move Copy or move files to other folders within each Data Folder I

[IEEAEI » My Files % Data Folder % Open a folder |
Select a file » Press » Select Copy or Move % Press (®
% Select a destination folder # Press (®)

n Delete a single file or all files at once I

IEEEAE » My Files » Data Folder |
Deleting Single Files
Select a folder » Press (® # Select a file ® Press »
Select Delete # Press (® # Delete? appears ® Choose [BYes »
Press (®

*If the file is used for Incoming Tone, Picture Call/Mail, Useful Diary, etc.,
File in Use Delete? appears.

Deleting All Files
Select a folder # Press (2> HIM # Select ElDelete All % Press (®
% Enter Security Code ® Choose [BYes % Press (®

(1opjo4 ereq) saji4 buibeuep
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Getting Started

Exchange information and files with infrared-compatible Vodafone handsets and other

devices.

¢ V302SH complies with IrMC 1.1, but some files may not be exchanged.

e Infrared transfers are disabled while handset is connected to the Network (receiving/
sending mail or information) or while using Vodafone live! services.

e During infrared transfers, handset automatically enters Off-Line Mode (see P.3-6). Thus

transfers are disabled while receiving calls/messages, during calls, while using Vodafone

live! services, while editing mail or data, etc. Off-Line Mode is canceled after transfers.

Available Files

Function

One File

All Files

Note

Phone Book

Available

Available

The following settings are lost: Photo, Personal Ring
Tone, Incoming Notice and Mail Folder. In one file
transfers, Group and Secret settings are also lost.
All file transfer includes Owner Profile

(except handset phone number).

Data Folder

Available

N/A

Transfer JPEG and PNG files in Images folder as
well as E-Animation (NEVA files) in Animation
folder. Copy protected files cannot be transferred.

Camera Mode Images

Available

N/A

Transfer a DCF format file of up to 210 KB

¢ Files over 40 KB cannot be transferred (except Camera mode images).
¢ Images may not appear on recipient handsets.

10-2

Precautions

¢ Bring handsets to within 20 cm and place the ports face-to-face. Do not place objects
between handsets.

¢ Keep the ports face-to-face during transfer.
¢ Transfers may fail under direct sunlight or fluorescent lights, or near infrared equipment.
e Clean the ports with a soft cloth. Dirty ports may not transfer files properly.

When transfer fails, Remote Device Not Found Reconnect? appears. Take the
above precautions and try again. (Choose [l Yes and press @.)

Set IR Password

IR Password is specific for infrared transfers. Transfers are possible when passwords

of both handsets match.
The password specified when receiving an infrared transfer for the first time remains

valid. Use the procedure described below to change IR Password.
m P> Infrared » Set IR Password |
] Enter Security Code

Enter IR Password
Password is set and Infrared Transfer menu returns.

paJtelju) a

If IR Password is set by this procedure beforehand, password entry is not requested
when receiving an infrared transfer for the first time.
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Transferring Files

One File Transfer

. Sending ‘

Send one file or entry from Phone Book or Data Folder.

1

2
3
4
5

6

Open file list and highlight a file
e Alternatively, for Phone Book, open an entry.

Press (o) HITMH or

Select Send via Infrared and press (®)
Off-Line Mode is set and title entry window opens.
* When handset fails to enter Off-Line Mode, file list returns.

Edit title and press (®

® Source file or entry name remains unchanged. To proceed

(505 Tl
< llo 00 - 809) >

03123XXXX8

PHOTO
008 Kimura Tet
83123XXXXb
PHOTO
Phone Book Entry List

'V‘ 907 Kitayama K

without changing the title, press (®).

Prepare recipient handset

Within 15 seconds, choose [l Yes and press O]

Transfer starts. When finished, file or entry list returns.

. Receiving

m P Infrared % Acquire Signal

Enter Security Code
Standing by... appears and handset receives files if sent within 30 seconds. (A
confirmation appears.)

Press <@l to cancel.

Press @) to end.

10-4
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Infrared Password

* IR Password? appears when receiving an infrared transfer for the first time.
Enter a 4-digit password to start receiving.

¢ The entered password remains valid. See P.10-3 to change the password.

¢ |f incorrect, Infrared Transfer menu returns.

Choose [ Yes and press (®

File is saved and Infrared Transfer menu returns.
To cancel transfer, choose EINo # Press (@ ® Choose [BYes # Press (®

All File Transfer

Security Code and IR Password are required to transfer all files.
m Security Code: see P.1-26

m |R Password is required for infrared transfers. Transfers are possible when the passwords of

both handsets match. To set recipient handset password before transfer, see P.10-3.

. Sending All Phone Book Entries

m P Infrared

1 Select ISend All Entries and press (®
Off-Line Mode is set.
¢ When handset fails to enter Off-Line Mode, Infrared Transfer menu returns.

Enter Security Code
Prepare recipient handset
Enter IR Password

Within 15 seconds, choose [l Yes and press (®
Transfer starts. When finished, Infrared Transfer menu returns.
o |f IR Password is incorrect, Infrared Transfer menu returns.

ORhWN

. Receiving All Phone Book Entries

m P> Infrared % Acquire Signal

Enter Security Code
Standing by... appears and handset receives files if sent within 30 seconds. (A
confirmation appears.)

Press <@l to cancel.

Press @) to end.

When IR Password? appears, see P.10-4 "Infrared Password."
To Add Entries

H Select New Item and press (®)

Transfer starts. When finished, Infrared Transfer menu returns.

To Overwrite Existing Entries

E Select BlDelete All & Save and press (®)

Choose IBYes and press (®

Transfer starts. When finished, Infrared Transfer menu returns.

When Phone Book is overwritten, all Owner Profile contents are deleted, except
handset phone number.

10-5
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& Changing Security Code

Whenever necessary, change Security Code.
Center Access Code cannot be changed from handset.

m P Functions % Privacy ® Change Code

Enter current Security Code
Security Code: see P.1-26
If incorrect, handset returns to Standby.

2 Enter new Security Code

Re-enter Security Code
If incorrect, handset returns to Standby.

Handset Locks
Keypad Lock

Restrict access to handset functions.

m P Functions % Privacy » Keypad Lock

Enter Security Code
A appears and Keypad Lock is set.

When Keypad Lock is Active

B In Standby, press @ for 2+ seconds to deactivate handset power, Press (® for 1+
seconds to activate/cancel Key Guard, - to enter Security Code or to
edit Security Code entry. Emergency calls to Police (110), Fire (119) and Coast
Guard (118) are possible.

Dialing from Keypad is disabled except for emergency calls to Police (110), Fire (119)
and Coast Guard (118).

Il During a call, press &) to end the call, (3 to answer another call or switch between callers
in Call Waiting, - to enter Security Code or to edit Security Code entry.

B Answer calls by pressing (3 or keys for Anykey Answer (see P.2-6). Press @@®) to

Anoag jospueH E

forward incoming calls or press &) to place callers on hold.

Emergency calls (110, etc.) are possible while Keypad Lock is active. For more, see
P.2-5 "Emergency Calls."

F21
. Canceling F23

1 Enter Security Code
3 disappears and Keypad Lock is canceled.
e Keypad Lock can be canceled during calls.
* Keypad Lock remains active even if handset power is deactivated, then reactivated.

Auto Key Lock

m P Functions % Privacy % Auto Key Lock

1 Enter Security Code
Choose [BOn and press (®

¢ Keypad Lock activates from the next time handset power is turned on.

Emergency calls (110, etc.) are possible while Auto Key Lock is active. For more, see
P.2-5 "Emergency Calls."

B canceling |
Cancel Keypad Lock (see above) first and follow these steps.

m P Functions % Privacy % Auto Key Lock |
7 Enter Security Code
2 Choose BOffand press (®

Phone Book Lock

Protect Phone Book entries from accidental alteration and restrict access to Phone
Book information.

m P Functions % Privacy ® Phone Book Lock
] Enter Security Code

2 Choose MOn and press (®
To cancel Phone Book Lock, choose BlOff # Press (@

Anoag 1ospueH E

When Phone Book Lock is active, the following Phone Book operations are disabled:
m Searching, saving, editing and dialing, including Speed Dial (see P.5-14)
m Creating QR Codes from Phone Book entries or Owner Profile (see P.12-27)
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Fo6 Restrict Dial

m P Functions % Privacy ® Restrict Dial

] Enter Security Code

Choose [BOn and press (®
To cancel Restrict Dial, choose BJOff % Press (®

When Restrict Dial is Active

l Dialing from Keypad is disabled except for emergency calls to Police (110), Fire (119)
and Coast Guard (118).

Emergency calls (110, etc.) are possible while Restrict Dial is active. For more, see
P.2-5 "Emergency Calls."

Accept Call & Reject Call

Designate numbers from which to accept or reject calls.

Accept calls from designated numbers only. Calls from other numbers
Accept Call ;

are rejected and caller hears a busy tone.
Reject Call Reject calls from designated numbers. Caller hears a busy tone.

Anoag jospueH E

e For rejected calls, Missed Calls appears in Missed Call notice (see P.2-15) and Reject
appears in Call History.

¢ Accept Call and Reject Call operate only when Caller ID is sent.

¢ To reject calls with No Caller ID or Payphone calls, see P.11-6.

e Accept Call and Reject Call cannot be set at the same time.

Saving Entries

e Save at least one entry before activating Accept Call or Reject Call.

e Save up to 10 entries each.

m P Functions % Privacy

Accept Call

H Select B Accept Call and press (®
Enter Security Code

Reject Call

Select BReject Call and press (®
Enter Security Code
Select @lSpecify Number and press (®)

2 Select ElSave to List and press ®

Names or phone numbers appear if saved.

To delete list entries, select a number ® Press % Choose IBYes # Press (®

3 Select a number and press (®)

¢ Select ------------------ for new entry.

4 Enter a phone number
To select from Phone Book, see P.5-13.

5 Press ®

Name appears if selected from Phone Book. Number appears if entered directly. (Name

does not appear even if saved in Phone Book.)
* Repeat Steps 3 - 5 to save other numbers.

Accept Call

¢ At least one entry is required to set Accept Call (see P.11-4).

¢ Cancel Reject Call before activating Accept Call.

m P Functions ® Privacy % Accept Call

1 Enter Security Code

2 Choose lOn and press (®
To cancel, choose BlOff % Press (®

Reject Call

¢ At least one entry is required to set Reject Call (see P.11-4).

e Cancel Accept Call before activating Reject Call.

m P Functions ® Privacy % Reject Call

1 Enter Security Code
2 Select IlSpecify Number and press (®)

3 Choose [On and press ®
To cancel, choose BlOff % Press (®

Anoag 1ospueH E
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Reject calls with No Caller ID or Payphone calls. Handset does not ring and caller
hears a rejection message.

m » Functions % Privacy % Reject Call
7 Enter Security Code
2 Select BNo ID or ElPayphone and press O)

Choose EBOn and press (®
¥ To cancel, choose BJOff » Press (®)

Secret Mode

Activate Secret Mode to open Secret Mode entries.

m P Functions % Privacy

1 Select BSecret Mode and press (®)
Enter Security Code

Secret Mode is set and § appears.

@ Secret Mode is canceled when handset power is turned off.

B Exiting Secret Mode

m P Functions ® Privacy

Select BSecret Mode and press (®)

§ disappears and Secret Mode is canceled.

Anoag 1espueH E

Activate Secret Mode and open a Phone Book entry. 9
* § lights for standard entries and flashes for Secret Mode entries. Ueda Nikio 005
¢ To edit or delete Secret Mode entries, see procedures for 1Friends

B8 évée. gl
o

B)Pattern 1
~)Pattern 2
™ Mail Folder 1
(Mail Folder 2

03123003

standard entries.

11-6
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Reset

Cancel custom settings and return handset functions to their default settings.

¢ Phone Book entries are unaffected.
e For settings affected by Reset, see P.14-2 - 14-5.

m P Functions % Privacy ® Reset Defaults

7 Enter Security Code

2 Select MOK and press (®)
¥ To cancel, select B3Cancel # Press (®

Clear all Phone Book entries, Original Tones and other data (including Mail and Web).
Custom settings return to their defaults. However, Security Code is unchanged.

m P Functions % Privacy % Reset All
1 Enter Security Code

2 select OK and press ®
["l To cancel, select Bl Cancel # Press (@

@ Files removed using Reset All cannot be recovered.

Rnoesg jespueH H

11-7






F38

SuoIOUN [BUOKIPPY E

Handy Call Functions
Signal Alert

When Signal Alert is active, handset emits warning beeps when the signal is weak
and the call may be disconnected. Signal Alert is Off by default.

m > Functions % Settings 1 % Signal Alert

Choose [BOn and press (®
To cancel Signal Alert, choose BOff ® Press ®

@ Even when Signal Alert is active, calls may be disconnected without warning.

Push Tones

Use Push Tones to send alphanumeric messages to pagers or operate a home
answering machine remotely.

. From Phone Book

Use this function to send set messages to pagers.

e Save Push Tones to Phone Book first (see P.5-4).

¢ When saving Push Tones to Phone Book ( &), do not save other information to that
entry.

After a connection is established, press (°9 ([TEL]) to open Phone Book
entry (see P.5-13)

D Press(®

3 Select Send All Push Tones and press (®)

Enter P (Pause) in Push Tones to separate each sequence. To send following
sequences, press for each.

. Direct Entry
Press Keypad to send individual Push Tones during calls.

1 After a connection is established, use Keypad to enter numbers
¢ For more information, see the manual for the recipient device/corresponding service.
e Use 0 -9, ¥and # to send Push Tones.

2D Press

12-2

Side Key Settings

For Incoming Calls

Press for 1+ seconds to activate the assigned function while ringing/vibrating.
Available functions:

Hold Place callers on hold

Quick Silent Temporarily mute ringer for incoming calls

Reject Call Reject and end the call

Message Recorder |Record caller messages on handset

Forward Voice Mail |Forward incoming calls to Voice Mail

Message Recorder is assigned by default.

m P> Functions % Settings 1 % SideKey Settings
1 Select Iincoming Calls and press (®

2 Select a function and press (®

Standby

Press for 1+ seconds to activate the assigned function in Standby.
Available functions:

Details Corresponding indicators appear on Sub Display for incoming communications
One-Shot Mail Send a preset Sky Mail message to a specific recipient
Off No function is assigned. (Sub Display backlight illuminates.)

Details is set by default.
m P> Functions % Settings 1 % SideKey Settings |
1 Select BStandby and press (®

2 Select a function and press (®
To cancel, choose EJOff % Press (@)

12-3

F39

SUOROUN [BUOHIPPY ﬁ



FYF
F44

SuoIOUN [BUOKIPPY B

Message Recorder

Activating

Record caller messages on handset.

¢ Message Recorder cannot be used when handset is off, out-of-range or in Off-Line Mode.
Use Voice Mail to record caller messages when Message Recorder is not available (see
P.13-4).

¢ Record up to 90 seconds or 20 messages between Message Recorder, Voice Memo (see
P.12-6) and My Voice Memo (see P.12-6).

m > Tel Ops » Message Recorder

Select ARecorder Settings and press (®)

Remaining recording time appears and Message Recorder menu returns (& appears).
To sample outgoing message, select EJOutgoing Message # Press (®)
To activate or mute Earpiece for outgoing message/caller message recordings, select
@Volume Level % Press (® % Select llVolume Level Link or BSilent % Press (®

Message Recorder Disabled

B In Manner Mode, activate/deactivate Message Recorder via Manner Settings only.
B When less than 4 seconds remain or 20 messages are recorded, Message Recorder
is disabled. Delete messages (see P.12-6) to activate Message Recorder.

Answer Time

B Adjust ring time between 0 and 59 seconds (Message Recorder waits to answer
calls). Answer Time is 09 seconds by default.

Press (®) ® Select Tel Ops ® Press (®) ® Select EMessage Recorder %
Press (® #» Select @Answer Time % Press (8 % Enter time (00 - 59) ®
Press (®

m To start recording immediately after a call arrives, enter 00 » Press (®)

l When Message Recorder and Voice Mail or Call Forwarding are both active, the
function with the shortest ring time takes priority. However, if Message Recorder is
full, handset is in Off-Line Mode or out-of-range, incoming calls are handled by Voice
Mail or Call Forwarding.

In-Car Recorder

B Activate In-Car Recorder to automatically activate Message Recorder when In-Car
Charger is in use. In-Car Recorder is active by default. To cancel this setting, follow
these steps.

Press (® % Select Tel Ops % Press (® & Select EdMessage Recorder » Press (®)
% Select BIn-Car Recorder % Press (®) % Choose ElOff % Press (®)

When Message Recorder is Active

B For incoming calls, outgoing message plays and recording starts.
* Recording continues even if handset is closed.
¢ To answer calls, press @ during recording (no message will be recorded).

Bl When recording ends, af appears.

M If recording capacity becomes full (see P.12-4 "Message Recorder Disabled") after
the recording, Message Recorder is deactivated and & disappears. (a® remains lit
until the message is deleted.)

Quick Recorder

B Use Quick Recorder to record caller messages on handset when Message Recorder
is inactive. When a call arrives, press @[> to activate Quick Recorder. Outgoing
message plays and caller's message is recorded.

m Alternatively, set Side Key Settings for incoming calls (see P.12-3) to @Message Recorder
to activate Quick Recorder with Side Key. When a call arrives, press for 1+ seconds.
Outgoing message plays and caller's message is recorded.

Bl When recording capacity is full (see P.12-4 "Message Recorder Disabled"), delete
messages (see P.12-6) to activate Message Recorder.

Deactivating

m P Tel Ops » Message Recorder |

Select MRecorder Settings and press (®)

Message Recorder is deactivated and menu returns (& disappears).

Playing Messages

m P> Tel Ops % Message Recorder |

Select BPlay and press (®
Number of recordings appears and playback starts from the most recent message. After all
messages have played, playback ends and handset returns to Standby.

Press @ to stop playback.

@ Message playback stops for incoming calls. Press @ to answer the call.

M Playback Operations (Example: 3 Messages are Recorded)

12-4

Skip the message Replay the message Play the previous message
Press () during Press (&) during Press (©) twice during
playback playback playback
[ No3 [ No2 [ Not ||| No3 | No2 | Not | | No3 | No2 | Not |

—Playback—h\_‘ o Playback —PlaybaCkT_;' Playback - —Playbac’kT;: Pleyback

12-5
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Deleting Recorded Messages

l While message is playing, press %] % Choose [IlYes » Press (®
 The next message plays, if any. of disappears after all messages are deleted.

Voice Memos

Record the other party's voice (Voice Memo) during a call or your own (My Voice
Memo) in Standby.
¢ For Voice Memo, only the other party's voice is recorded.

¢ Record up to 90 seconds between Voice Memo, My Voice Memo and Message Recorder
(see P.12-4). When less than 3 seconds remain or 20 messages are recorded, messages

cannot be recorded.

1 Recording Voice Memo

During a call, press for 1+ seconds

Recording My Voice Memo

H In Standby, press for 1+ seconds
A select My Voice Memo and press (®)

2 Recording starts

* For My Voice Memo, talk to Microphone from the distance of 5 - 10 cm.

3 Press @® or to stop recording

12-6

o |f Close to End Call (see P.2-3) is active, calls and Voice Memo recordings
end when handset is closed. The remaining recording time will not appear.

e My Voice Memo stops for incoming calls. Press keys for Anykey Answer (see
P.2-6) to answer the call. (The recorded message is saved.)

* Recordings remain even after handset power is turned off.
* Refer to the description for Message Recorder on P.12-5 and above to play or
delete Voice Memo/My Voice Memo.

Alarm

Setting Alarm

Set Alarm to sound at a specific time each day or on specific days of the week.

e Save up to 5 Alarm settings.

e Save a message or phone number to appear with Alarm. Customize Ring Time, Tone

Volume, Alarm Tone, LED Indicator and Vibration.

m » Functions % Clock % Alarm

Select a number and press (®
e For a new entry, select ============--,

Select BInput Time and press (®)

Enter time and press (®
* Apply 24-hour clock format.
® To set Alarm Tones, Vibration, Snooze, etc., see P.12-9.

Select E]Weekly and press (®)

Daily
Select @ Daily and press (®

Specified Day of the Week

Select EWeekly and press (®)

H Select a day of the week and press (®)
The day is set and ¥ appears.
« To cancel, highlight the selected day and press (®).

Repeat H to select more
B Press Ol when finished

6 Press @l when finished

Alarm is set.
* For more settings, repeat Steps 1 - 6.

7 Press @ to exit

(S SN WN =

EdOption Settings

@ Set | eelect
Alarm Settings

Handset returns to Standby and Q appears. € (blue) appears in Alarm list when Schedule

Alert (see P.12-9) is set.

12-7
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. At Alarm Time

Alarm is activated, sounding/vibrating, etc. according to related settings.

Image appears if Display Images is set. However, SMAF file images take priority over

Display Images.

Alarm Options

¢ Follow these steps after Step 3 on P.12-7.
e After each setting, Alarm settings window returns. Complete other settings.

Stopping Alarm Tone

B Press @) or ().

e Alternatively, press keys for Anykey Answer (see P.2-6).

l Alarm repeats at the set interval.
® Snooze is not canceled even when Alarm is stopped by pressing @
e Accept incoming calls. After each call, press &) to reactivate Snooze.
B To cancel Snooze after initial Alarm Time, press keys for Anykey Answer, choose
B Yes and press (®).
® Snooze is canceled automatically 60 minutes after initial Alarm Time.

Phone Number

Bl While saved name or number appears, press @ to dial the number.
¢ Cancel Snooze before dialing.
M Press @ instead of @ to close window without dialing.

Sending Advance Mail Message

H While saved address, name or number appears, press ® Select
BlSend Mail ® Press (® % Press

¢ Cancel Snooze before sending a message.

Alarm Tones

Set a tone to sound at Alarm Time

Select @Sound & Press (@) # Select [BAlarm Tones % Press (@) %
Select a type ® Press (®) ® Select a tone # Press (@) # Press <0l
® To select a tone, see procedures for Ring Tone (see P.8-3).

Tone Volume

Set volume for Alarm Tone

Select @Sound # Press ® % Select ETone Volume % Press (®
% Select a level with (§) ® Press (@) ® Press <8l
* No tone sounds when Silent is selected.

Ring Time

Set ring time

Select @Sound % Press (®) % Select EJRing Time # Press (®) &
Enter time (02 - 99 seconds) # Press (®) # Press <@l

sound for other Alarm settings.
e |f Alarm Time arrives during a call, no tone will sound. End the call to reactivate
Alarm.

@ * While Alarm Message, Phone Number or Advance Mail appears, Alarm will not

While ALARM appears on Sub Display, press to show the saved message,
number, etc. Press again for 1+ seconds to return to Standby (except when
Snooze is active).

12-8

Snooze

Set Alarm to activate at set intervals after initial Alarm Time

Select E§Snooze # Press (@) % Choose [On # Press (®) ® Enter
interval (02 - 20 minutes) ® Press (®
e To cancel, select E¥Snooze # Press (® # Choose BlOff # Press (®

Message

Saved message appears at Alarm Time

Select B Message # Press (8 # Enter message # Press (®)

Vibration

Set handset to vibrate at Alarm Time

Select EOption Settings » Press (@) % Select [Vibration % Press (®)
% Choose EBOn or BOff » Press (@ ® Press <@l
* Vibration Pattern is the same as that for incoming calls.

LED Indicator

Customize blink patterns

Mobile Light

Select EdOption Settings % Press (®) # Select EILED Indicator
Press (® # Select IMobile Light % Press (® % Select a blink
pattern ® Press (®) ® Press <0l

Small Light

Select EdOption Settings % Press (®) # Select EILED Indicator »
Press (® % Select ©Small Light % Press (® # Select a blink pattern
% Press (@ ® Press @l

Cancel

Select EOption Settings % Press (® % Select BILED Indicator #»
Press (® ® Choose EJOff # Press (® # Press (@l

Schedule Alert

Set an Alert to announce upcoming Alarm Time beforehand

Select EOption Settings % Press (®) # Select E}Schedule Alert %
Press (® % Choose IBOn # Press (8 % Enter time (02 - 99 minutes)
% Press (@ # Press @l
« To cancel, select EdOption Settings % Press (® % Select E}Schedule
Alert % Press (® % Choose ElOff % Press (® # Press <0l

12-9
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Phone Number

Saved phone number appears at Alarm Time

Select EOption Settings » Press (® % Select @Phone Number #»
Press (@ ® Enter a phone number ® Press (® % Press <0l

e Dial the number after Alarm stops.

* Phone Number and Advance Mail cannot be set at the same time.

« To copy from Phone Book, press (03 ([TEL]) before entering a phone number.

Advance Mail

Saved outgoing mail appears at Alarm Time

Select EdOption Settings ® Press (@) » Select BAdvance Mail »
Press (® ® Select a message ® Press (® # Press 0l
¢ To cancel, select a message and press % Press <0l
* Advance Mail and Phone Number cannot be set at the same time.

Canceling & Reactivating Alarm

Cancel Alarm and retain the settings I

m » Functions % Clock ® Alarm % Select a number |

Select ElCancel # Press (®)

* Q or € disappears.
* Reactivate Alarm to use the same settings.

Delete Alarm settings I

m » Functions % Clock % Alarm % Select a number |

Select ElDelete # Press (@)

Reactivate Alarm with the same settings, or change current
settings

m » Functions % Clock % Alarm |

Same Settings

Select a number ® Press (® # Select [lSettings #» Press (®) &
Press (0l

Change Settings

Select a number ® Press (® # Select [lSettings #» Press (®) »
Perform from Step 2 on P.12-7

12-10
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Auto Power On/Off

Auto Power On

Use Auto Power On to activate handset power automatically at a specific time each
day.

* Once set, Auto Power On remains active until canceled.

¢ Alarm can be set to sound for Auto Power On.

e Auto Power On is Off by default.

m P Functions ® Clock % Auto Power On

1 Choose Onand press (®
To cancel Auto Power On, choose BJOff # Press (@) (Omit the next steps.)

2 Select Binput Time and press @

3 Enter time and press ®
* Apply 24-hour clock format.
* To set Alarm, see P.12-12.

4 Press &

BE4LED Indicator
ERing Time
@ Set  eSelect

Auto Power On Settings

. At Auto Power On Time ‘
Il When Handset is Off
Handset turns on. When Alarm is set, Alarm is activated, sounding/vibrating, etc.

according to related settings.
Image appears if Display Images is set. However, SMAF file images take priority over

Display Images.

l When Handset is On

When Alarm is set, Alarm is activated, sounding/vibrating, etc. according to related
settings.

SUOROUN [BUOHIPPY ﬁ

If Auto Power On Time arrives during a call, no tone will sound. Press @ after the call
to reactivate Alarm.

@ Press &) to stop Alarm. Alternatively, press or keys for Anykey Answer (see
P.2-6).

12-11
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. Setting Alarm

¢ Follow these steps after Step 3 on P.12-11.
e After each setting, Auto Power On settings window returns. Complete other settings.
e Activate Alarm (Set Alarm On) before setting other Alarm options.

Activate Alarm at Auto Power On Time

Set Alarm
Select E)Set Alarm % Press (@) # Choose IlOn or BlOff # Press (®
Set a tone to sound at Alarm Time

Alarm Tones Select @Alarm Tones % Press (®) % Select a type # Press (®) #

Select a tone # Press (®
¢ To select a tone, see procedures for Ring Tone (see P.8-3).

Set volume for Alarm Tone

Tone Volume

Select B Tone Volume % Press (®) % Select a level with () # Press (@)
¢ No tone sounds when Silent is selected.

Set handset to vibrate at Auto Power On Time

Vibration

Select BVibration » Press (®) % Choose IlOn or BOff % Press (®)
e Vibration Pattern is the same as that for incoming calls.

LED Indicator

Customize blink patterns

Mobile Liaht Select ELED Indicator % Press (® # Select MMobile Light »
9 Press (® ® Select a blink pattern # Press (®
. Select ELED Indicator % Press (®) ® Select ©Small Light % Press (@)

Small Light )
% Select a blink pattern # Press (@)

Cancel Select ELED Indicator % Press (8 % Choose EJOff % Press (®
Set ring time

Ring Time Select EJRing Time % Press (8 ® Enter time (02 - 99 seconds) %

Press (®

Auto Power Off

Use Auto Power Off to

deactivate handset power automatically at a specific time each day.

* Once set, Auto Power Off remains active until canceled.
¢ Auto Power Off is Off by default.

m » Functions % Clock % Auto Power Off

1 Choose IlOnand press (®
To cancel Auto Power Off, choose EJOff # Press (®) (Omit the next step.)

Enter time and press (®
* Apply 24-hour clock format.

12-12

. At Auto Power Off Time

Handset power turns off.

¢ When handset is in use, a confirmation appears (after operation if the time arrives during a call).
®m Handset power turns off after a minute of inactivity. Alternatively, choose I Yes and press (®).

Unsaved data will be deleted.
m Choose EINo and press (® to cancel Auto Power Off.

e Even if there are messages saved as Auto Send, handset power turns off without

confirmation.

Schedule

Enter upcoming events with dates and times. Save general plans as Action ltems.
Save up to 150 Schedule entries (up to 20 entries per day) and 50 Action ltems.

Saving Entries

. Saving Schedule Entries

m D Briefcase ® Schedule

1 Press

e Press to select date from Calendar.

Enter date and time and press (®

¢ Enter 4 digits for year, 2 digits for month and day each, and apply
24-hour clock format for time.

¢ Date and time are mandatory.

N

Select E}Stamp Selection and press (®)
Select a stamp and press (®
Select @}Schedule and press ®

Enter text and press (®
¢ Enter up to 120 single-byte characters.
* Set Alarm (see P.12-14) and Option Settings (see P.12-16).

Press <0l when finished

* Repeat Steps 1 - 7 to enter more entries.
® The scheduled date is underlined. Stamp appears if set.

N OO0ORhW
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S s R
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v e 789w
L R T S TR )
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‘SCHEDULE GEEEERFINEN | (ACTION ITEH EEEMNEN

@View Slect | Menurs)
Schedule Window

ule
[2005/09/20 18:30 ]

B0ption Settings

@ Set | Select

Schedule Settings
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On Scheduled Day

H & (Alarm is set) or B (Alarm is not set) appears. (They will disappear after Schedule
Time.)

. Saving Action ltems ‘

m P> Briefcase » Schedule |
Press

Enter text and press (®

* Enter up to 120 single-byte characters.

Select E}Stamp Selection and press (®)

Select a stamp and press (®)
¢ Set Option Settings (see P.12-16).

Press <0l when finished

* Repeat Steps 1 - 5 to enter more entries.

G AW N

[@0ption Settings

@ Set | eSelect
Action Item Settings

Setting Alarm

Set Alarm to sound at Schedule Time I

In Schedule settings window (see Step 6 on P.12-13), select ElSet Alarm
% Press (® ® Choose [lOn # Press (@)

e Set Alarm window opens. For more, see P.12-15 "Alarm Options."
* Press <0l to return to Schedule settings window. Complete other settings.

12-14

. Alarm Options ‘

¢ Follow these steps after opening Set Alarm window for Schedule.
e After each setting, Set Alarm window returns.

Alarm Tones

Set a tone to sound at Alarm Time

Select [ISound # Press (® # Select [lAlarm Tones % Press (@) %
Select a type # Press (8 ® Select a tone # Press (®) # Press 0l
¢ To select a tone, see procedures for Ring Tone (see P.8-3).

Tone Volume

Set volume for Alarm Tone

Select @lSound % Press (® % Select ETone Volume % Press (®
% Select a level with () ® Press (@ # Press @l
¢ No tone sounds when Silent is selected.

Ring Time

Set ring time

Select Sound # Press (® # Select EJRing Time % Press (@) &
Enter time (02 - 99 seconds) # Press (® # Press <@l

Snooze

Set Alarm to activate at set intervals after initial Alarm Time

Select E}Snooze # Press (@) % Choose [lOn # Press (®) ® Enter
interval (02 - 20 minutes) ® Press (®
* To cancel, select B3Snooze » Press (@) » Choose BJOff # Press (®

Vibration

Set handset to vibrate at Alarm Time

Select E)Option Settings # Press (@) % Select [@Vibration % Press (@)
% Choose IBOn or BOff » Press (@) ® Press <l
e Vibration Pattern is the same as that for incoming calls.

LED Indicator

Customize blink patterns

Mobile Light

Select ElOption Settings % Press (8 # Select BILED Indicator #»
Press (® ® Select MMobile Light % Press (® % Select a blink
pattern ® Press (@) ® Press <0l

Small Light

Select ElOption Settings % Press (8 # Select EILED Indicator »
Press (® % Select ©Small Light % Press (® % Select a blink pattern
® Press (® ® Press <@l

Cancel

Select E1Option Settings % Press (®) ® Select EJLED Indicator
Press (® ® Choose EJOff # Press (® # Press (@l

Schedule Alert

Set an Alert to announce upcoming Alarm Time beforehand

Select EOption Settings ® Press (®) ® Select ElSchedule Alert %

Press (® » Select from ElMinutes to EMonths » Press (®) # Enter

amount of time (5 minutes, 1 week, etc.) ® Press (®) ® Press <0l
« To cancel, select E1Option Settings % Press (® » Select ElSchedule

Alert % Press (@ % Choose IOff % Press (® ® Press <@l

12-15
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. At Schedule Alarm Time

When Alarm is set, Alarm is activated, sounding/vibrating, etc. according to related

settings.

¢ Image appears if Display Images is set. However, SMAF file images take priority over
Display Images.

e For stopping Alarm Tone, dialing numbers, sending Advance Mail and canceling Snooze,
see P.12-8.

If Alarm Time arrives during a call, no tone will sound. Press @ after the call to
reactivate Alarm.

While ALARM appears on Sub Display, press to show the saved message,
number, etc. Press again for 1+ seconds to return to Standby (except when
Snooze is active).

Schedule & Action Item Options

e Follow these steps after Step 6 on P.12-13 (Schedule) or Step 4 on P.12-14 (Action ltem).

e After each setting, Schedule settings window or Action Item settings window returns.
Complete other settings.

Set Calendar date color
Select BOption Settings % Press (8 #» Select BlDate Color »
Press (® ® Select a color  Press (@ # Press @l
e Colors do not appear in 1-Week view (see below).
¢ When multiple entries are saved for the date, setting for the earliest
applies.

Date Color
(Schedule only)

Protect entries from Auto Delete
Select Option Settings ® Press (8 % Select Auto Protect % Press (@) »
Choose IBOn (protect) or EJOff (cancel) ® Press (®) ® Press <0l
e When Auto Delete is Off, entries are protected automatically regardless
of this setting.

Auto Protect

Show or hide entries in Standby

Select Option Settings ® Press (® ® Select Standby Display »

Press (® # Choose IBOn or BOff # Press (® # Press <@l
¢ The setting is effective when Clock Display is set to Calendar (see

Standby Display

P.7-3). For Action ltem, set Calendar type to Schedule & Stamps.

Set an image to appear at Schedule Time

Select B Option Settings % Press (@) » Select Attach Image »
Press (® ® Select BlData Folder # Press (®) # Select a folder #
Press (@ ® Select an image # Press (® # Press <0l
« To cancel, select EOption Settings % Press (®) # Select IDAttach Image
» Press (®) #» Select ElCancel » Press (® » Press <0l
* Select @l Camera instead of B Data Folder to capture a still image or
record video.

Attach Image
(Schedule only)

Saved phone number appears at Schedule Time

Select BOption Settings » Press (® % Select B Phone Number %
Press (@ ® Enter a phone number ® Press (® % Press <0l
e Dial the number after Alarm stops.
¢ Phone Number and Advance Mail cannot be set at the same time.
« To copy from Phone Book, press (o3 ([FEL) before entering a phone
number.

Phone Number
(Schedule only)

Saved outgoing mail appears at Schedule Time

Select @Option Settings # Press (® % Select BAdvance Mail %
Press (@ ® Select a message ® Press (® % Press <0l
* To cancel, select a message and press » Press <2l
e Advance Mail and Phone Number cannot be set at the same time.

Advance Mail
(Schedule only)
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Opening Entries

m D Briefcase ® Schedule |

1 Schedule Entries
H Select a date and press (®
H Select an entry and press (®

15:05

2005/09/26 (Mon)
19:30

Bring a gift!

Action Items
Press <@l until Action Item window
opens
H Select an entry and press (®
To delete an entry, select one » Press (2> I »
Select BlDelete Item % Press (@) % Choose IBYes # Press (®

2 Press @l to end

Toggling View

H Press (® » Select Briefcase % Press (®) ® Select B Schedule # Press (®) &
Press <0l
« Press <@l to toggle between Action Item, 1-Week, 1-Month, All and
Day Detail/Stamps.
B To select the types of view that toggle, follow these steps.
Press (® ® Select Briefcase » Press (® ® Select B Schedule # Press (®)
» Press ® Select @View % Press (® » Select BToggle View »
Press (® % Select a type’ ® Press <0l % (Select another type %
Press <Gl) » Press (®
*Select [ to check and select ¥ to uncheck.

12-17
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M To

Schedule Display for Standby

view Schedule entries in Standby, set Standby Display (see P.12-17) in Option

Settings to On.
Il Show or hide Schedule/Action Item details as follows:
e Set Calendar type to Schedule & Stamps in Clock Display and follow these steps.

Press (® ® Select Briefcase » Press (® » Select BSchedule # Press ()
» Press % Select EStandby Display » Press (8 # Select an
item ® Press (®

m p> Briefcase % Schedule

Schedule Entries

H Select a date and press (®

Action Items

OG0 AhWN

Press @ until Action Item window opens

Select an entry and press
Select Edit and press (®

Select an item and press (®
¢ For details, see procedures for saving Schedule/Action Item.

When finished editing, press <l
Select IINew Entry or ElOverwrite and press (®)

Delete Item Delete one entry

D> Briefcase ® Schedule % Select a date % Select an entry »
Menu (&) % Delete Item

Choose [BYes # Press (®
¢ For Action ltems, see Step 1 on P.12-17.

One Day , .
Schedules Delete the day's Schedule entries

m P> Briefcase ® Schedule ® Select a date » Menu ((Z)) % Delete A//|

Select B One Day Schedules % Press (®) % Select IBSelect All or
BUnprotected % Press (® % Enter Security Code » Choose [l Yes

»

12-18

Press (®

Delete All Delete all past Schedule entries or all entries

m D Briefcase ® Schedule ® Menu (Z>) % Delete All

Select IDPast Schedules, E)Schedules or @Action Items % Press (®)
» Select IiSelect All or BUnprotected % Press (®) % Enter Security

Code # Choose [Yes # Press (®

Auto Delete Delete the oldest unprotecteq Schedule or Action Item entries
automatically when memory is full

MR Off

m P> Briefcase ® Schedule » Menu ) % Auto Delete

Select llSchedule or BAction Item % Press (® % Select IBAuto

Delete On or BlAuto Delete Off % Press (®)

Secret Mode Security Codg must be enltered to save and check
Schedule/Action Item entries

m D> Briefcase % Schedule

Activating
Press » Select ESecret Mode % Press (®) % Enter
Security Code # Choose IlOn # Press (®)

Canceling

Enter Security Code ® Press » Select B)Secret Mode »

Press (® ® Enter Security Code ® Choose BEOff # Press (®

Set Color Change color for days of the week

m »>- Briefcase  Schedule % Menu ) ®» Set Color

Select a day # Press (® # Select a color % Press (®)

m P Briefcase ® Schedule » Menu (2)) % View

Select from [Day Detail/Stamps to BAll » Press (®

Event List Check the number of saved entries

m D Briefcase % Schedule % Menu (&)

Select E3Event List % Press (®)

12-19
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()]

Useful Diary

Keep a diary with photos or video.
e Save up to 400 entries (500 single-byte characters each).
¢ When memory is full, delete entries to make room for new ones (see P.12-22).

Saving Entries

m P Functions % Clock % Useful Diary |

1 Select IINew Diary and press (®)

Useful Diary window for the day opens.
To specify other dates, select llDate # Press (®) % Enter date ® Press (@)
¢ When saving a still image or video only, skip ahead to Step 4.

Select ElMessage and press (®

Enter text and press (®

¢ When saving text only, skip ahead to Step 6.
To use Fixed Text, press <0l % Select a type # Press (®) twice
m Fixed Text cannot be entered after entering characters.

WN

Select Elimage Setting and press (®

Capturing Still Image/Recording Video

H Select Camera and press (®
H Select a mode and press (®
El Capture an image or record video and save it

O K

Selecting from Data Folder
H Select BData Folder and press (®

H Select a still image or video and press (®)
* Some files cannot be selected.

Canceling
H Select ElCancel and press (®

Press (0
To create more entries, press % Select IlCreate ® Press (® ® Enter date
% Press (8 ® Repeat Steps 2 - 6

12-20

Editing/Deleting Fixed Text

B To edit Fixed Text, press <&l in Step 3 on P.12-20 and follow these steps.
Select Fixed Text ® Press ® Select BEdit % Press (® » Edit title
% Press (® ® Edit content ® Press (®
m Fixed Text is overwritten.
B To delete single Fixed Text, press <&l in Step 3 on P.12-20 and follow these
steps.
Select Fixed Text ® Press % Select ElDelete Item % Press (®) &
Choose [l Yes » Press (®
m Default Fixed Text returns when edited Fixed Text is deleted.
M To delete all Fixed Text, press <@l in Step 3 on P.12-20 and follow these
steps.
Press % Select @Delete All % Press (® ® Enter Security Code »
Choose [Yes # Press (®
m Default Fixed Text returns when edited Fixed Text is deleted.

Secret Mode (Restrict Access to Useful Diary)

B To activate Secret Mode, follow these steps in Step 1 on P.12-20.
Select ElSecret Mode # Press (® % Enter Security Code # Choose IlOn %
Press (®
m From the next time, Security Code must be entered to use Useful Diary.
B To cancel Secret Mode, enter Security Code in Step 1 on P.12-20 and follow these
steps.
Select%Secret Mode » Press (® % Enter Security Code % Choose BOff »
Press

Opening Entries

m P Functions % Clock % Useful Diary

Select BDiary List and press (®

Entries appear most recent first.

2 Selectan entry and press (®
To open saved still image, press (® INTIR.

m Press <@l to return.
To play saved video, press (@ IHEYE.
m Press <@l to return.
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. Sending Entries ‘

WEEREI » Functions % Clock % Useful Diary  Diary List |
7 Select an entry and press N Nail |

¢ For entries without still image, skip ahead to Step 3.

2 Choose DYes and press (®
* Some images may not be attached.
e Skip ahead to Step 4.
To send text only, choose EINo # Press @ » Proceed to Step 3
If the image is too large, select IDAttach 1/4 Size or E)Attach Original % Press (@) »
Skip ahead to Step 4

8 Select llLong Mail or BSky Mail and press @

» For E1Sky Mail, text exceeding the character limit is lost.

4 Comoplete other fields and send mail (see (O P.3-3)
Editing Entries

P Functions % Clock % Useful Diary % Diary List % Open an entry
» Menu (&)

1 Select Editand press (®
2 Select an item and press (®)

¢ For details, see procedures for saving Useful Diary.
3 When finished editing, press <2l
Deleting Entries

Delete Item Delete one entry I

P Functions % Clock % Useful Diary % Diary List % Select an entry
» Menu (&>) % Delete Item

Choose [BYes # Press (®

12-22

Delete All Delete all past entries or all entries

m P Functions % Clock ® Useful Diary ® Diary List % Menu (&)

Select ElDelete All or @Delete All Past % Press (®) % Enter Security
Code # Choose [lBYes #» Press (®

Stopwatch

Record elapsed time for up to 24 hours (23 hours 59 minutes 59.9 seconds) in
0.1-second increments. Use lap time feature to segment elapsed time.

e Save times (including the last five lap times) to Text Memo.

¢ Stopwatch ends when battery level is low.

m P Functions % Clock % Stopwatch
1 Press@®

Stopwatch starts.

To record Lap times, press (&> IETH.

2 Press (® to stop

The last five Lap times are recorded. The records are deleted when Stopwatch is canceled.
To save the records to Text Memo, press » Select ISave Text Memo »

Press (® ® Select a number ® Press (®

m To overwrite saved record/entry, choose Il Yes » Press ®

To check saved records, press » Select ElSee Text Memo » Press
Select a number # Press (®

Press (® to resume Stopwatch.

Press (@l to clear the record.

Press &) or to exit

When Stopwatch is running or paused, choose [l Yes # Press (®)

OF2

¢ Records are deleted when Stopwatch is canceled. Save records to Text Memo.

e Stopwatch is not affected by incoming calls. Press @ after the call to return to
Stopwatch.

® Alarm (see P.12-8) is disabled while Stopwatch window is open, and starts when

handset returns to Standby.
» Count continues even if handset is closed. (] flashes on Sub Display.)

12-23
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Kitchen Timer

Barcode

Set Kitchen Timer up to 60 minutes in 1-second increments. Tone sounds when set
time elapses.

m » Functions ® Clock % Kitchen Timer

Enter time (00:01 - 60:00)

e Use % to move cursor and correct the number.

Press (®

e When times over 60 minutes (60:00) are entered, the last set time returns.
To change time, press % Enter time ® Press (®

Press (®

Countdown starts.

Press (® to stop
Press (® to resume.
Press <@l to return to the set time.

Press &) or &= to exit

When Kitchen Timer is running or paused, choose [Yes ® Press ()

G AN W N =

Kitchen Timer End

B Timer End appears. Tone sounds and LED Indicator flashes. (Tone is fixed to
Pattern 1. Volume and LED Indicator depend on the settings for Sound Volume and
Set LED to Sound respectively. Vibration is Off.)

« Tone stops automatically after 60 seconds. Press (®) to stop manually.

¢ In Manner Mode, handset vibrates. (Vibration Pattern is Vibration 1. Volume and
LED Indicator depend on Manner Settings.)

¢ Tone and Vibration Pattern cannot be changed.

Il When the set timer time has elapsed during a call, Timer End appears after &) is
pressed to end the call.

* Countdown is not affected by incoming calls. Press @ after the call to return to
@ Kitchen Timer window.
® Press for 1+ seconds to activate or cancel Manner Mode.
® Alarm (see P.12-8) is disabled while Kitchen Timer window is open, and starts when
handset returns to Standby.
» Count continues even if handset is closed. (IEEF] flashes on Sub Display.)

12-24

Scan barcodes created on handset or downloaded via Web or Long Mail.

e Scan UPC (JAN) or QR Codes. Handset automatically detects code type and reads code
data.

® Barcodes cannot be scanned with mobile camera.

varying width vertical lines (called bars) and spaces. Bars and spaces together are
elements, combinations of which represent different numbers. Handset cannot read
other one-dimensional barcodes (ITF Code, Code39, Codabar/NW-7, etc.).

* QR (Quick Response) Code is a matrix symbology consisting of an array of
nominally square cells. It allows omni-directional reading of up to 7,366
characters-numeric, alphanumeric, byte data as well as kanji and kana.

* QR Code is a registered trademark of DENSO WAVE INCORPORATED.

m > My Files % Data Folder

Select Images and press (®)
To open files in sub folders, select a folder # Press (®)

2 Select a barcode image and press [=> HETH
8 Select @Barcode Reader and press ®
4 Select [IScan Code and press (®)

Scan results appear.
Using Scan Results: see P.12-26

Split Data

B Split Data Scan next Symbol? appears.
To continue, choose IBYes # Press (® ® Select next code # Press (®
To cancel, choose BINo # Press (® % Choose [lYes # Press (®
Il Data will not be saved until all split data is scanned.
B The scanning status appears on the first line of Display. For example, B indicates
that 1 of 4 codes has been scanned.

@ e UPC (Universal Product Code) or JAN (Japanese Article Number) is a series of

Font & Image Size

Hl While scan results appear, press (2> Il » Select Display Size » Press (®
® Select a size ® Press (®)
e Medium Font/100% is set by default.
« Alternatively, press to toggle between Medium Font/200%, Small Font/100%,
Small Font/200%, Large Font/100%, Large Font/200% and Medium Font/100%.
(B8 appears for 100% and [& for 200%.)
B The changes do not affect the settings for received/sent messages or Web.
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* Resized QR Codes may be invalid.
e For invalid codes, Error This data may be Incorrect appears.

Bl Using Scan Results

Create QR Codes

Select a number starting with TELZ % Press (® ® Select 3 Call

Place Calls’ Press ® % Press 0

Select a mail address including @ # Press (® % Select 3 Send Mail »
Send Mail® Press (® % Select IlSend Long Mail or BlSend Sky Mail % Press (®)

(See (OJP.3-3 for more.)

Press % Select Send Mail % Press (® ® Select

ISend Long Mail or BSend Sky Mail % Press (8 ® Scan results
Quote & Send Mail appear # Press ®

m To use a part of text, press # Highlight the first character
of the text block to copy ® Press (@ ® Highlight the text block %
Press (® (See (OJP.3-3 for more.)

Save to Phone
Book!:3

Select a number starting with TEL or a mail address including @ #
Press (® % Select 3 Add to Phone Book % Press (®) (See Step 4 on
P.5-8 for more.)

Access Mobile
Internet Sites?

Select a URL starting with http:/ % Press (®) ® Select 3 Open Link %
Press (® % Perform Step B in "URLs" on (OJP.4-8

Save to Data Folder
(Images & Melodies)

Select an image or melody file # Press (®) % Select To Data Folder
% Press (8 % Check file name # Press (®)

Copy Text

Press % Select Copy # Press (® # Highlight the first
character of the text block to copy ® Press (@ =® Highlight the text
block # Press (®

 Paste the copied text into a text entry window.

'Available when text is in TEL:#format.

2Text strings of 10 to 24 digits starting with 0 are also recognized as phone numbers.
3 Available when text is in #@#format.

4Available when text is in http:/#format.

Krepresents one or more alphanumerics.

MEMORY: or MAILTO:

B When MEMORY: or MAILTO: appears in scan results, press (®)
to save text underlined with a dotted line to Phone Book or send
it via Sky/Long Mail.
¢ All underlined items are entered. However, text after an

invalid character is not underlined and is not copied.

1505

Scanned Data
MEMORY :

NAMET :Ueda Mikio

NAME2: Ueda Mikio

MAIL1 : bbb@xxx. yyy
TEL1:03123XXXX3

@Back |eSelect Menurs

12-26

Create QR Codes from Owner Profile, Phone Book, Mail, Text

Memo, Melodies or Images.

¢ Use saved contents or enter new contents for a QR Code.

¢ Save up to the equivalent of 469 digits or 120 kanji per QR Code.

e Large items up to 3,416 bytes are divided into maximum of 16 QR
Codes.

¢ Created QR Codes are saved to Data Folder (Images). See P.9-3
for more about Data Folder.

Open a file or entry and press (® or
* For mail, select a message in Mail Box.
For image files in Data Folder, select a file ® Press
% Select BBarcode Reader % Press (@) ® Select BlCreate
QR Code % Press (® # Choose IlYes # Press (® twice
(Omit the next steps.)

Bytes Used
Total Bytes

82/3416( 1/16)
& Ueda Mikio
Ueda Mikio
& 03123XXXX3
8 <Unsaved>
@R :aaalxxX. yyy
é4:<Unsaved>
£L <Unsdved>
@lance| |eSelect |Creater

Number of Codes
Code Limit

Create QR Code
Window (Phone Book)

For melody files in Data Folder, select a file ® Press % Select @Create QR
Code ® Press (® ® Choose [lYes # Press (®) twice (Omit the next steps.)

m Create QR Codes from E-Animation in the same manner as above.

» When Format? appears, select a format # Press (®) # Choose IBYes # Press (®

twice (Omit the next steps.)

2 Select Create QR Code and press (®)

Create QR Code window for each item opens.

To add text or attachments, select a field  Press (@ # Enter contents ® Press (®)

3 Press
4 Press(@®

% Press (® % Perform from Step 2 on (O JP.3-3

Press (® » Choose [lYes # Press (®

Attaching to Long Mail

H Before pressing (® to save in Step 4, press » Select M Attachment

Deleting Created QR Codes

Hl Before pressing (® to save in Step 4, press » Select BlDelete »
Press (® # Select a file ® Press (® ® Choose [lYes % Press (®

Incoming Calls while Creating

B Contents are temporarily saved. To return, end the call and follow these steps.
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Battery Saving

Power Saving

Use Power Saving to reduce transmission signal strength.

e When Power Saving is active, other parties may not be able to hear you at the beginning

of a call.
e Power Saving is active by default.

m P Functions % Settings 1 % Battery Saving % Power Saving

1 Choose IOnand press (®
To cancel Power Saving, choose EJOff % Press ®

Panel Saving

Use Panel Saving to place handset in hibernation mode after a period of inactivity.

This will extend Battery Time. Period of inactivity can be specified between 2 and 20

minutes.
Handset may not enter Panel Saving mode depending on its status, such as during
calls or when using Vodafone live!.

. Setting Panel Saving

Handset enters Panel Saving mode after five minutes of inactivity by default.

m P> Functions % Settings 1 % Battery Saving % Panel Saving % On/Off |

1 Choose lOnand press (®

To cancel Panel Saving, select EOff (Light Low) or EJOFf (Light Off) % Press (® (Omit the

next step.)

2 Enter time (02 - 20 minutes) and press (®

Panel Saving Mode

Il After a period of inactivity, Display shuts down automatically.

mode first for Keypad operations).
« If handset is closed in Panel Saving mode, the sound for EJPower On in Sound
Effects settings (see P.8-5) rings. Open handset to cancel Panel Saving mode.

¢ Pressing a key or receiving a call cancels Panel Saving mode (cancel Panel Saving

12-28

Battery is consumed faster when Panel Saving is Off. More handset power is
consumed with EJOff (Light Low).

@ Set shorter time to extend Battery Time.

. Flash Small Light (Orange)

Small Light does not flash in Panel Saving mode by default.

P Functions % Settings 1 % Battery Saving % Panel Saving %
LED Indicator

1 Select IILED Indicator On and press (®
To cancel, select BILED Indicator Off % Press (®

@ In Off-Line Mode, Small Light flashes regardless of this setting.

Calculator
Use Calculator for basic arithmetic, percentage, and tax
calculation. FS:Caloulator
¢ Key Assignments:
+ (Add) RM (Recall Memory) g
T~ T)
- (Subtract) © M+ (Add Memory) v &8
x (Multiply) . (Decimal) \\E-//
+ (Divide) ) +/- (Switch) %E e
= (Equal) ® % (Percent) @l Eg’/
C-CE (Clear) &3] TAX (Tax) &)
CM (Clear Memory)

¢ Tax rate is 5% by default.

m P> Functions ® Settings 2

1 Select ElCalculator and press (®)
e Use Keypad to enter digits, and the above keys for calculation.
* Alternatively, in Standby, enter any number, then press (®) to open Calculator.
To change tax rate, enter rate (01 - 99%) # Press @ (Long Press)

2 Press @ toend
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Saved Information

Il Copy calculation results or numbers saved in Memory to text entry windows.
In a text entry window, press % Press ["\Saved Info % Press (®)
» Select @Calculator % Press (® » Select an entry ® Press (®) ®» Move
cursor to target location ® Press
¢ The last 10 calculation results are saved.

Memory are not affected.

® Press to clear Memory before starting Memory calculations.

* Numbers saved in Memory remain even if Calculator is closed, but are cleared
when handset power is turned off.

@ * Incoming calls clear entered numbers and results. However, numbers saved in

Spending Memo

Use Spending Memo to add expenses, such as travel expenses.
¢ Enter up to 31 entries (up to 30,999,969 yen in total, 999,999 yen per entry).
e Spending Memo cannot be opened during a call.

Enter monetary figure I

Enter amount ® Press » Select a category # Press (®

¢ The entry date and time is automatically saved.
e If Clock is unset (see P.1-20), entry date and time will be saved as =-/-= ==:--.

m P> Functions % Settings 2 % Spending Memo |

Select @I Totals % Press (®
Use () to scroll through entries.

m > Functions % Settings 2 % Spending Memo » Totals |
Press (® # Press &z] % Choose [BYes # Press (®

12-30

m P Functions % Settings 2 % Spending Memo % New ltem |
Select a category # Press (®) » Edit » Press (®

* Enter up to 6 single-byte characters.
« Clear the name and press (®). Default name returns.

Pen Light

Use handset as a flashlight.

m llluminate Pen Light I

In Standby, double-press
To turn off, press (5D, @) or &=].

e Ele e sEiyle s Change Lighting Time I

BEEMRLighting Time: 1 Minute

m P> Briefcase % Pen Light |

Select BlLighting Time % Press (®) % Select time ® Press (®

* Pen light cannot be used when:

m Key Guard is set

m Receiving mail

m Stopwatch is active
® Playing melodies

@ ¢ Do not point Pen Light at people or look at it directly.

m Keypad Lock is set

= SMAF file is active

m Kitchen Timer is active
m Playing Action Snap files

® Mobile camera is active
® During calls

® Calling/sending

m Receiving calls/info

@ * Pen Light goes off and Display Backlight illuminates for incoming calls, messages,
etc.
¢ Pen Light goes off and Display Backlight illuminates for incoming calls, messages,
etc.
m Backlight illuminates after Lighting Time when a V-Application is active and
Backlight in V-Appli Settings (see COJP.12-2) is Always Active.
* When handset is closed, opening handset turns off Pen Light.
e Select shorter Lighting Time to extend Battery Time.
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Ringer Out

When headphones are connected to handset, Ring Tone sounds from headphones
and handset speaker.
To disable speaker, follow these steps.

Headphones

Initiating Calls

Use Call Button on headphones (optional accessory) to call the number saved in Earphone/Speaker is set by default.
Memory Number 000 (see P.5-5).
m P Functions % Sounds % Ringer Out

Connect headphones to handset
1 P 1 Select [Earphone and press (®)
2 Press Call Button for 1+ seconds until a double beep sounds To use headphones and speaker, select Bl Earphone/Speaker » Press (®)

e The number is dialed.

. Even if Earphone is selected, Ring Tone sounds from speaker when headphones

3 Press Call Button for 1+ seconds until a beep sounds o m—

Call ends. Alternatively, press @‘) to disconnect call.
¢ Closing handset does not end the call.

Fax & PC Transmissions

@ e |[f Memory Number 000 is a Secret Mode entry, activate Secret Mode to call it (see

P.11-6).
¢ Cancel Keypad Lock and Phone Book Lock to place calls (see P.11-2 - 11-3). L ia data/t d
* Do not wrap cord around handset or Antenna. This may cause malfunction. Noise Wl il et e 2B (ST SIRS Ui ARy 26 GE
interference occurs if cord is close to Internal Antenna.
Connect a data/fax card

¢ Plug in headphones firmly. If not, sounds may not be heard.
® FAX COM. appears during G3 FAX transmissions.

Answerlng CaIIs I Use handset for PC transmissions via data/fax card I

1 Connect headphones to handset
Ring Tone sounds from headphones only or from both headphones and handset speaker Connect a data/fax card
depending on the setting (see P.12-33).

Press Call Button for 1+ seconds to answer a call @ Use handset for fax or PC transmissions only when signal conditions are stable.

Press Call Button for 1+ seconds until a beep sounds
Call ends. Alternatively, press @ to disconnect call.
¢ Closing handset does not end the call.

e MODEM COM. appears during PC transmissions.

WN

® Handset supports 9,600 bps high-speed data transmissions.

@ e Sign-in window may differ by data/fax card.
¢ To connect data/fax cards to fax machines or PCs, see the manuals for the device.

SUOROUN [BUOHIPPY ﬁ
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Optional Services Overview

¢ When handset is out-of-range or outside your subscription area, access Optional
Services from a touch-tone landline.
e For details, contact Vodafone Customer Center, General Information (see P.14-20).

Call When you know you will be unable to receive calls to your handset, use Call
Forwarding ~ Forwarding to automatically transfer calls to another phone number (see P.13-3)
Unanswered calls are forwarded to Voice Mail. Retrieve caller messages from
Voice Mail handset or any touch-tone phone, anytime. Voice Mail indicator appears on
handset after message is recorded (see P.13-4).
Call Waiting alerts you to incoming calls when the line is already engaged.
Call Waiting  After the tone, place the current call on hold and answer the second, or
alternate between calls (see P.13-6).

. Open a second line while the first is engaged. Switch back and forth between
3 Way Calling  two lines or talk on both simultaneously. Create a conference call by adding
another party to an existing conversation (see P.13-7).
Use Caller ID to identify callers before answering. Show or hide your own phone

el number when placing calls. When no Caller ID is sent, the reason appears.

*An additional contract is required.
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Call Forwarding F74

e Call Forwarding and Voice Mail cannot be used at the same time.
e Activating Call Forwarding cancels Voice Mail.

1Ry 1s 51| Save a forwarding number I

m P Functions % Services % Call Forwarding % Set Fwd Number |

Enter a phone number # Press (®)

Saved number appears following Connecting to Network....
¢ Include the area code for landline phone numbers.

e 1 (Public Service Numbers: 110, 119, 118, etc.)
® 0120 (Toll-free numbers)
® 0990 (Fee-based services: Dial Q2, etc.)

m Initiate Call Forwarding I

M Save a forwarding number beforehand.

m P Functions » Services % Call Forwarding % Start Fwd |

Select [lCall (handset rings/vibrates before forwarding calls) or
BNo Call (calls are forwarded immediately) ® Press (®)

FYt—EX ON (Call Forwarding On) appears following Connecting to Network....
* BNo Call is currently available only for subscribers in Kanto, Koshin, Tokai and Kansai
areas.

o7 o= s T Cancel Call Forwarding I

m P> Functions ® Services ® Cancel Secretary |
Choose IBYes # Press (®
k3 Y—EX OFF (Secretary Service Off) appears following Connecting to Network....

(07)[=1 /¢Sl (=110 Check Call Forwarding status I

m P Functions % Services ® Check Secretary |
Choose [ Yes # Press (®

Service status appears.

Incoming Calls while Call Forwarding is Active

Il To answer calls, press @ while handset is ringing/vibrating.
e Calls are forwarded immediately when No Call is set. (Available only for subscribers
in Kanto, Koshin, Tokai and Kansai areas.)

@ Phone Numbers Beginning with the Following Numbers Cannot be Saved:

seoines [euondo h
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e For details, contact Vodafone Customer Center, General Information (see P.14-20).
¢ Voice Mail and Call Forwarding cannot be used at the same time.
e Activating Voice Mail cancels Call Forwarding.

m - Functions % Services » Voice Mail |

Select [l Call (handset rings/vibrates before forwarding calls) or
BNo Call (calls are forwarded immediately) ® Press (®)

R/ H—EX 0N (Voice Mail On) appears following Connecting to Network....
* BNo Call is currently available only for subscribers in Kanto, Koshin, Tokai and Kansai
areas.

Incoming Calls while Voice Mail is Active

l To answer calls, press @ while handset is ringing/vibrating.
e Calls are forwarded immediately when No Callis set. (Available only for subscribers
in Kanto, Koshin, Tokai and Kansai areas, and when used in those areas.)
Il & appears on handset after message is recorded.

When Voice Mail is Canceled (Kanto Koshin, Tokai and Kansai)

Il While handset is ringing/vibrating, press @ to forward the call. (This function is for
one time only. Voice Mail remains canceled.)

Il When the call is not successfully forwarded, Unavailable appears and Incoming Call
Notice returns.

Il When Side Key Settings (see P.12-3) is set to EBForward Voice Mail, calls can be
forwarded by pressing for 1+ seconds while handset is ringing/vibrating.

o oSS ST Cancel Voice Mail I

m P Functions % Services ® Cancel Secretary |

Choose [BYes # Press (®
k> 3 Y—EX OFF (Secretary Service Off) appears following Connecting to Network....

13-4

(0= el (=112 Check Voice Mail status I

m P Functions % Services ® Check Secretary |
Choose IBYes # Press (®

Service status appears.

HEVALITEERETE Check Voice Mail messages I

m P> Functions % Services % Play Voice Mail |
Choose [Yes # Press (®)

¢ Follow the guidance for further operations after handset connects to Voice Mail Center.
Press @) when finished.

& disappears after messages are checked, unless they are checked from a
touch-tone landline.

Ring Time

Choose Call for Call Forwarding or Voice Mail and select Ring Time from 5 to 30

seconds (by 5 seconds).

¢ This function cannot be set from landlines or while handset is out-of-range or outside your
subscription area.

e This function is disabled when No Call is set. (No Call is available only for subscribers in
Kanto, Koshin, Tokai and Kansai areas.)

Set Ring Time for Call Forwarding or Voice Mail I

BEEMR20 Seconds

m P Functions % Services ® Ring Time |

Select Ring Time # Press (®)
R~ 02 (Saved) appears following Connecting to Network....

Mail together with Message Recorder (see P.12-4).
Example: Ring time for Call Forwarding or Voice Mail: 10 seconds
Ring time for Message Recorder: 9 seconds
In this example, Message Recorder responds first. (Priority may change depending
on signal conditions.) If Message Recorder memory is full, Voice Mail will activate.

@ Adjust Ring Time to set the response priority when using Call Forwarding or Voice

13-5
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Call Waiting ) N
On/Off Activate or cancel Call Waiting I

M Subscribers in Hokkaido, Hokuriku, Kyushu, Okinawa, Tohoku, Niigata, Chugoku and Shikoku areas
cannot set this service from handsets (service itself is available).

m P Functions % Services # Call Waiting |

Choose [On or BOff » Press (®

DU3=3—)L ON (Call Waiting On) or I 3= 33—/ OFF (Call Waiting Off) appears
following Connecting to Network....

Check Call Waiting status I

W Subscribers in Hokkaido, Hokuriku, Kyushu, Okinawa, Tohoku, Niigata, Chugoku and Shikoku areas
cannot set this service from handsets (service itself is available).

m P Functions » Services ® Confirm Service |

Choose IBYes # Press (®
DU = 3—)b ON (Call Waiting On) or U= J—)L OFF (Call Waiting Off) appears
following Connecting to Network....

Laleelpilale el 55 Put Line 1 on hold to answer Line 2 I

When a tone sounds during a call, press @
[ Press (3 to switch between two lines.

Handset does not ring or vibrate for incoming calls while a line is engaged.
A tone sounds from Earpiece and Incoming Call appears.

3 Way Calling

(o)1= 2 leria =14 BT 1E8 Open another line during a calll I

Enter a phone number during a call ® Press @

Line 2 is open. Line 1 is put on hold.
¢ Phone Book, Redial, Call History and Notepad Memory are available.

Switch Line Switch between two open lines I

During a call, press (® # Select @Switch Line % Press (®)

The line switches. The other line is put on hold.
® Press @ to toggle between two lines.

Ending a Call while Someone is on Hold

Il A beep sounds and Caller on Hold appears.
Press (3 or @) to talk with the party on hold.

Line 1 Ends while Line 2 is on Hold

Il A beep sounds and Caller on Hold appears.
Press @ or @ to talk with the party on hold.

Kanto, Koshin, Tokai and Kansai Areas

Il When Voice Mail or Call Forwarding is active, unanswered incoming calls are
transferred to Voice Mail or the forwarding number. Call Waiting is disabled if No Call
is selected, then all calls are transferred directly.

Ending a Call while Someone is on Hold

W When @ is pressed, a beep sounds and Caller on Hold appears.
Press @ or @ to talk with the party on hold.

Line 1 Ends while Line 2 is on Hold

Il A beep sounds and Caller on Hold appears.

Press @ or @ to talk with the party on hold.
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Break Away (while

Switching Lines) Original call ends Line 1 and Line 2 remain connected I

M Available for subscribers in Kanto, Koshin, Tokai and Kansai areas.
While switching between two lines, press (®) # Select EBreak Away
% Press (8 » Choose [lYes # Press (®

Break Away... appears. You are disconnected, but Line 1 and 2 remain connected.
(If you made the call, you are charged for the remaining call.)
® Press @ to return to Standby.

3 Way Calling Use two lines simultaneously I

Press (®) while switching between two lines # Select B3 Way Calling
% Press (®)

* You cannot switch lines (see above) once shifted to 3 Way Calling.

13-7
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S Away Original call ends Line 1 and Line 2 remain connected
(from 2 Open Lines)

M Available for subscribers in Kanto, Koshin, Tokai and Kansai areas.
Press (® during 3 Way Calls # Select @Break Away % Press (® »
Choose [Yes # Press (®)

Break Away... appears. You are disconnected, but Line 1 and 2 remain connected. (If you
made the call, you are charged for the remaining call.)
® Press @ to return to Standby.

Ending a Call during 3 Way Calls

[l Both lines are disconnected.

Line 1 Ends during 3 Way Calls

B Line 2 remains connected.
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Function List

Settings for items with gray background are affected by Reset.

'Also available during calls.

2Currently not available in Hokkaido, Hokuriku, Kyushu and Okinawa areas.

SCurrently not available in Tohoku, Niigata, Chugoku and Shikoku areas.

4Available only when switching between two open lines. Break Away is currently not
available in Hokkaido, Tohoku, Niigata, Hokuriku, Chugoku, Shikoku, Kyushu and

Okinawa areas.

M 2. Privacy

Functions Menu

Description

Function Default Refer to
0. Keypad Lock Off P.11-2
1. Auto Key Lock Off P.11-3
2. Secret Mode' Off P.11-6
3. Phone Book Lock | Off P.11-3
4. Restrict Dial Off P.11-4
5. Accept Call Off P.11-5
6. Reject Call All Off P.11-5
7. Reset All - P.11-7
8. Change Code - P.11-2
9. Reset Defaults - P.11-7
Il 3. Settings 1
Function Default Refer to
0. Guide' - P.1-25
1. Memory - P.5-8
2. Off-Line Mode Off P.3-6
3. Batlery Saving Eggel:]zi\;r;g: gfrfl Panel Saving On/Off: On (5 minutes), P.12-28
. . Backlight: On (15 seconds), Keypad Light: On (15
ST ERES secongs), In-C(ar Backlight): Off,ygrightr?ess: Le\(/el 4 P77
5. SEBEIR (Language) | B4EE (Japanese) P.7-9
. Sub Display On/Off: On, Backlight Settings: On (15 seconds),
CE P Adjust C?on)t/rast: Contrast 5, RScipient D?splay: (On ! P.7-8
7. Group Settings - P.5-16
8. Signal Alert Off P.12-2
9. Side Key Settings | Incoming Calls: Message Recorder, Standby: Details P.12-3

0. My Number' Open handset phone number
1. Sounds Call Functions, Volume, Sound Effects, etc.
2. Privacy Manage handset security with Keypad Lock, Auto Key Lock, etc.
3. Settings 1 Dlsplay settings such as Light Settings, Group Settings and Side Key
Settings
4. Settings 2 Display settings including User Dictionary and Manner Settings
5. Clock Alarm, Clock Display, etc.
6. Charges Call Charge, Total Talk Time, etc.
7. Services Activate Optional Services such as Voice Mail and Call Forwarding
8. Vodafone live! Access Mail, Web, Station and V-Applications
1. Sounds
Function Default Refer to
0. Call Functions Delayed Ringer: Off, Close to End Call: On z'g:g' P-2-10,
1. Volume' Level 5 P.2-11
3. Sound Effects Refer to the table in "Sound Effects" P.8-5
5. Ringer Out Earphone/Speaker P.12-33
6. Speaker’ off P.8-21
7. Original Tones - P.8-8
8. Instrument Effects |- P.8-16
9. Tone Octave - P.8-21
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4. Settings 2

7. Services

Function Default Refer to
0. Ring Time® 20 Seconds P.13-5
1. Call Forwarding - P.13-3
2. Voice Mail Call P.13-4
3. Cancel Secretary |- P.13-3, P.13-4
4. Check Secretary - P.13-3, P.13-5
5. Call Waiting® 3 - P.13-6
6. Confirm Service® 3 |- P.13-6
7. Play Voice Mail - P.13-5
8. 3 Way Calling* - P.13-7
9. Setup Preset International Call: 0046010 P.2-5
Il 8. Vodafone live!

Function Default Refer to
1. Mail - Vodafone live!
2. Web - Vodafone live!
3. Station Vodafone live!
4. V-Appli - Vodafone live!

[l Other Settings Affected by Reset

Size

Function Default Refer to
Manner Mode Canceled P.3-3
Message Recorder Canceled P.12-4
Phone Book Search
Method Memory No. Search P.5-12
Pen Light Lighting Time: 1 Minute P.12-31
Schedule View Day Detail/Stamps P.12-17
Scan Code Display | e 4ium Font/100% P.12-25

Function Default Refer to
Wallpaper: Off, Display Images: All Off, Fonts: Font 3, |P.7-2, P.7-5,
0. Display Settings Large Font: Off, Show Indicators: On, P.7-6, P.7-2,
Power On Message: Off P.7-9
Battery Level: Icon 1, Signal Strength: Icon 1,
1. Display Patterns Title Bars: Color 1, Menu Design: Menu Design 1, P.7-6
Guide Keys: Pattern 1, Indicator Bar: Background 1
2. Spending Memo' |- P.12-30
3. User Dictionary - P.4-15
Recorder Settings, Play, Outgoing Message,
4. Message Recorder Volume Level, IS-Car I%/ecordger, gnswer TgiJme P.12-4
5. Disney Style Off P.7-10
Message Recorder: On, Ring Tone Level: All Silent,
) Vibration: All On, LED Indicator: Small Light,
2k [ BTG S Whisper Mode: On, Sound Volume: Silen?c, P.3-4
V-Appli Volume: Silent, V-Appli Vibration: On
7. Incoming Light All Off P.7-10
8. Animation Scr_een Animation: Off, Vodafone live!: All On, P.7-10, P.7-9
Mail Background: On
9. Calculator - P.12-29
5. Clock
Function Default Refer to
0. Alarm - P.12-7
1. Auto Power On Off P.12-11
2. Auto Power Off Off P.12-12
3. Clock Display Large P.7-3
4. Useful Diary - P.12-20
5. Stopwatch - P.12-23
6. Kitchen Timer - P.12-24
9. Clock Settings’ - P.1-20
M 6. Charges
Function Default Refer to
0. Total Charges 0 Yen P.2-20
1. Call Charge 0 Yen P.2-20
2. Total Talk Time 0 hours 0 minutes P.2-19
3. Call Time 0 minutes 0 seconds P.2-19
4. Instant Display Off P.2-19, P.2-20

14-4
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Troubleshooting

Problem

Possible Cause

Solution

Problem

Possible Cause

Solution

Handset does not
turn on

¢ |s @) pressed for 1+ seconds?
e |s battery low or dead?

e |s battery installed?

* Press @) for 1+ seconds.

¢ Charge battery or install a
charged battery.

e Install battery properly.

wr appears and
cannot make calls
from handset

¢ |s handset out-of-range?

* Move to a place where signal is
strong and retry.

Keypad does not
respond

¢ |s Key Guard active?
(ct appears)

¢ |s Keypad Lock active?
() appears)

¢ Cancel Key Guard (see P.1-19).

e Cancel Keypad Lock
(see P.11-2).

Cannot charge
battery

¢ Is Rapid Charger connected
correctly to handset?

¢ |s Rapid Charger plugged in
firmly?

e |s battery installed?

¢ Are handset, battery, Charger
Terminals & Connection
Terminal and External Device
Connector clean?

¢ Battery may not be charged if
temperature is not within 5°C - 35°C.

¢ Battery has run out or is defective.

 Plug in again.
¢ Plug in again.

¢ Install battery properly.
¢ Clean with a cotton swab.

¢ Handle within ambient
temperature of 5°C - 35°C.
¢ Replace battery with a new one.

Charging time is
shorter

¢ Charging time shortens when
battery is not empty.

Cannot enter
numbers from
handset Keypad

¢ |s Key Guard active?
(<t appears)

¢ |s Keypad Lock active?
(5 appears)

¢ |s Restrict Dial active?

¢ Cancel Key Guard (see P.1-19).

e Cancel Keypad Lock
(see P.11-2).

e Cancel Restrict Dial (see P.11-4).

Handset or
accessories are hot

¢ Rapid Charger may heat up while
charging. Handset may also heat
up if used for long periods. This
is normal if they are not
extremely hot.

Cannot place calls
from Phone Book

¢ |s the number saved as Secret
Mode entry?
¢ |s Phone Book Lock active?

¢ Activate Secret Mode
(see P.11-6).

e Cancel Phone Book Lock
(see P.11-3).

Battery runs out
quickly

¢ Battery runs out faster depending
on the environment
(temperatures, charging/signal
conditions), usage or settings.

* Refer to "Estimated Hours of Use
(fully charged battery)," "Battery
Time" and "Extend Battery Time"
(see P.1-11 - 1-12).

Beep continues after
dialing and call
cannot be connected

¢ Did you dial the number including
the area code or first 07

¢ |s handset out-of-range?
(wr appears)

¢ Is handset off-line? (& appears)

e Dial the number including the
area code or 0.

* Move to a place where signal is
strong and retry.

¢ Cancel Off-Line Mode
(see P.3-6).

Calls are interrupted
or cut

¢ |s signal weak?

¢ |s battery low or dead?

* Move to a place where signal is
strong and retry.

¢ Charge battery or install a
charged battery.

Hear noise while
talking on the phone

¢ This may happen when signal is
weak or unstable.

Display flickers

e Display may flicker under
fluorescent lights.

Display is dark when
Backlight is off

¢ Panel construction characteristic;
not a malfunction.

14-6

For repairs and after-sales services, contact Vodafone Customer Center, Customer
Assistance (see P.14-20).
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Character Code List

. Indicators & Recharge Warning

M appears

Appendix
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Handset is out-of-range. Move for a better signal.

B Recharge Battery appears and short beeps sound

Handset is in Off-Line Mode (see P.3-6).
Battery is low (see P.1-12 - 1-13).

Cancel the setting.
Charge or replace battery immediately.

Key Guard is active (see P.1-19).

B X appears
M <t appears

Cancel to use Keypad. Incoming calls suspend Key Guard. Press keys for Anykey

Answer (see P.2-6) to answer calls.

Cancel to place calls, etc. Press keys for Anykey Answer (see P.2-6) to answer calls.

Keypad Lock is active (see P.11-2).

l & appears
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l Rapid Charger

Power Source

100 VAC, 50/60 Hz

Power Consumption

8 VA

Output Voltage/Current

5.6 VDC/500 mA

Charging Temperature

5°C - 35°C

Dimensions (W x H x D)

Approximately 48 x 17 x 46 mm
(without protruding parts, cord)

Cord Length

Approximately 1.5 m

M Battery
Voltage 3.7V
Battery Type Lithium-ion
Capacity 750 mAh

Dimensions (W x H x D)

Approximately 36 x 4.5 x 51 mm
(without protruding parts)
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Anti-Flicker.....ccoovmiimrnierienneeennennns 6-17
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Call Charge............ .. 2-20
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Call TimMe ....evrrrernerersrns e 2-19
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Display Images.... e 7-5
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E
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F
Face Arrange.........ccoeumrimsinnnsaninnnnns 9-16
FAX transmissions .......c.cceseriunnsannns 12-33
File Cabinet.........c.cccovvemriccmriccenncennianns 9-2
0T 1 | 7-6
Forward Voice Mail ..........ccccuueeeee 2-9, 13-4
Frame (saved image) .......cccerrvmnrsnnns 9-18
Frame (Sha-mail mode) .......c..cccveueues 6-10
Function List ......ccccunmierisnninnisnicennnns 14-2
Functions Menu ........cccocemiieeriiennians 1-22

G
Group Ring Tone (Phone Book)....... 5-16
Group Search (Phone BookK)............. 5-12
Group Settings (Phone Book)........... 5-16
[T T L, 1-25
Guide Keys (Display Patterns)............ 7-6

H
handset codes.........cccuvmrrrinrniennsnnnnane 1-26
handset phone number

(opening My Number) .......cccceeuernee 2-21
Handy Features.........cccceirirniniiennnas 1-22
headphones.........cccoeriiiiniiensiennen 12-32
Hiragana to Katakana/
Alphanumerics Conversion........... 4-13

hold (incoming calls)

1
Image Quality ......ccceeemrrmnserssersnrinnnans 6-18
Image Size (mobile camera).............. 6-18
images (changing file format)......6-19, 9-19
images (editing) .......cccerrrrrrsennssnnnane 9-12
Image Decoration..........ccccvvmniuniinnnnns 9-15
Inbox Auto Sort........ccueemnirinirssniinnnans 5-10
In-Car Backlight .........cccceecrriinrnienniannns 7-7
In-Car Charger.........ccccuerserinrssanssnnnsns 1-17
In-Car Recorder.........ccuurriersnnsunssnnnaes 124
incoming calls ......cccvccerircerissennienscnnnns 2-6
incoming calls (answering)................. 2-6
incoming calls (Call Waiting)............ 13-6
incoming calls (rejecting)........c.cveueusae 2-8

Incoming Light....................
Incoming Notice
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Incoming TONE.......ccuveerimrrismerssannssanns 9-23
Index MenU.......cccuemrvmrsmnnsemserssensanninns 1-21
Indicator Bar (Display Patterns).......... 7-6
Infrared .......cccevierimerinnne e 10-2
Input Method........cccnveriiinricceriennes 4-10
Instrument Effects........ccccvveriierniannns 8-16
International Call ..........cceeervrriiercennennns 2-5

K
Katakana Search (Phone BooK)........ 5-13
key assignments (text entry)............... 4-3
Key GUArd ........cccocvmmvminennsemsessessannnns 1-19
Key Ops Guide (mobile camera) ....... 6-20
Keypad LocK.......ccceemimmniemiiniirinnnanns
Kitchen Timer

L
Language.......cccerrrermssmrisnnssmssssassssannas 7-9
LED Indicator (for sounds).........ccc.c... 8-4
Lens Effects ......ccccervemrienriennienniianns 6-11
Light Settings......cccerrmrrnsnrssnrssnnssannas 7-7
List (Data Folder files)..........ccurueen. 9-3,9-5
List File Names.........ccccovrerniernrunnniaennas 9-4

M
mail address (Phone BookK).................. 5-3
Mail Folder (Phone BooK)..... ...5-10
Manner Mode ........cccvmriiemniennnnnnisennas 3-3

Memory NO......cccrvrrmnrmrierner e 5-5
Memory No. Search..........cccvvreiunuens 5-13
Memory Status (File Cabinet).....6-22, 9-2

Memory Status (Phone Book)

Menu Design (Display Patterns).......... 7-6
Merge Panorama.........cccerrvumrnsensssanns 9-21
Message Recorder..........cccvrueeruns 2-9,12-4
Mic Settings (mobile camera)............ 6-19
Missed Calls........ccccervemrncmrnsnrssnnsianns 2-15
mobile camera .......cccccrvreernrerssnnnsnenas 6-2
Mobile Light .......ccccriemirmnimnsnneriennns 6-17
Moving Photo Frame..........c.cccceiunnunn 9-19
[ [T] T ST=1 (=Y (o) i
My Voice Memo........cccvnerrnsnrssannssanns 12-6

N
Notepad Memory ........cccceeeieriierinnanes 2-13

(0]
Off-Line Mode ........ccccoeremirmnrnisensennnnns 3-6
One Hiragana Predictive Entry..........4-14
One Hiragana Word Call ............. ..4-14
One-Hiragana Conversion.................. 4-12
Original Size (Camera mode image).....6-21
Original TONEes .......coceeermrmrecnrnrnnnnas
Original Voice ...
out-of-range ........cccuieriurrssnnsnnnsensseninns
owner Profile .......coemirnieicnncnicennnes

P
Pager Code (entering) ......cccceeurreunsanas 4-10
Pager Code (list) ...ccuvverrrmrrrenrssunnssannns 4-11
Panel Saving ......cccoreemvmcmncinsnnanns 12-28
Paste.......cccmmnimnimnneene e 4-17
PC transSmisSions ......cccoceevvvernsiensnnes 12-33
Pen Light ... 12-31
Personal Data...........cceeervrminrsennsanssenins 5-4
Personal Ring Tone.........cccccevrriunnnnnne 5-10
Phone Book (deleting entries)........... 5-15
Phone Book (editing) .............. e 5-15
Phone BooK (Saving).......ccuserssurnnsannnans 5-3
Phone Book (searching)... 5-12
Phone BooK..........ccusmnernimiersnnnsnisnnnnes 5-2
Phone Book Entry List.............. 5-11, 5-14
Phone Book Entry List with images .....5-14
Phone Book Lock.......
Phonetic Conversion
Photo (Phone BOOK)........ccecernurensanenas
Pictographs......cccocinvemmnrnnmnssnssnnnsennans
Picture Call/Mail.........cccevurrmrsersrnssennnes
Play Voice Mail...........cccomrrernruennsannnns
Postcard .......ccccvvmnnsennierinennss s
Power On Message........ccouvmrumrersnrsnnaes
power oNn/off......ccevrmnierniennieniinnnnnens
Power On/Off (Sound Effects)............. 8-5
Power Saving.......ccocceemvmnmnsesenenenns 12-28
Predictive (conversion).........cccvveunrnnee 4-5
Previous Usage (conversion).............. 4-5
Property.....iiininiriinnsessnenns 9-8

Push Tones......ccccorieceicceeceennnecccsnnnns 12-2

Q
Quick CoNVersion ........ccumuernsersenines 4-13
Quick Operations .........ccuecesserserssnrnnns 1-24
Quick Silent ... 2-6
R
Rapid Charger .........cccoeveerisersnrnnnnsanas 1-16
Redial ............ . 2-4,2-14
Reject Call.......cccoovervirimirere e 11-5
Reset All............... e 1127
Reset Defaults .......cccovvvmmiicenrscnnnsanns 11-7
Reset Learning ........ccccceeeriiiiniennnanae 4-14
Restrict Dial .......cccvevnimnerssenseninnnanas 11-4
RiNg TiMe. ... 8-5
Ring Time
(Call Forwarding & Voice Mail)........ 13-5
Ringer Out.........ccoccmnmmiierinnsnnieninnnans 12-33
Rotate Thumb (Camera mode image) 6-7
S
Save As Thumb
(Camera mode image) ........c.ocueuerunns 6-7
Save Dictionary ........cccooeveerrersersernenaes 4-16
ST: V7 (o S ... 6-20
Scan Code..... .. 12-25
Schedule.................. ..12-13
Screen Animation.........cceeevsemnerieninns 7-10
Search by Reading (Phone BookK) ...... 5-13
Secret Mode (Data Folder)................. 9-24
Secret Mode (Phone Book) .... e 11-6
Security Code......oommnmnrrnmrsensersnrsennes 1-26
Select Mode (mobile camera)............ 6-20
Self TIMer....ccvereerinisrssrr e 6-9
Send All Push TONES .....ccccveeevrerrenns 12-2
Send With Code........ccconiminrrnmrsniianne 2-5
STET01 QANT] (o JSTo] o 5-10
Set IR Password.......ccccveerrrcrrncennans 10-3
Set LED to Sound........ccceemvmrvunscnniennns 8-6
Sha-mail mode.......ccocrrveemrriicnnnns 6-5, 6-7
Show Indicators ......ccccveerrremrerseersseenas 7-2
Show Thumbnails
(Camera mode image)........c..ccuueene 6-21
Shutter ClicK.....ccveerrrerrrerrscersennsanns 6-16
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Side KeY....covrvrrrmrniesse s i

Side Key Settings.........cccevvverninnniaenns 12-3
Signal Alert.......ooeerecerrceccenne 12-2
Signal Strength (Display Patterns)..... 7-6
signal strength indicator..........c.cccc..... 1-7
Simple Animation........cccocceeeencsesnnns 9-8
Simple Mode........ccomnierinnrinsseniensnnas 2-16
Slide ShOW......ccevrviriserrrirsernenenae 9-12
Small Light.....ccoeeereceeccsseas 1-6
SN00ZE .....evrremrerrsersn e 12-8
Soft FOCUS ....cccevriemriirisee e 6-18
Soft KeY .o 1-23
Sound Effects......cccocvrmrnierinrsnnnsnisennnes 8-5
Sound Volume.......ccccvvvrmnvmmnsnssssnninnes 8-6
ST 0T 1= 8-21
Speaker Phone........cccouvermnnrssnnssannns 8-21
Speed Dial........cccocenriieriirinnnsena, 5-14
Spending Memo ........ccvverierinrinnnnns 12-30
Split Image.......ccueerrrerrnsrrssnrssnnssannns 9-19
Standby......cccccerriminrnr 1-18
StopwatCh.......ccceeerecrrrisrrrrrrernas 12-23

T
text (deleting) ....cccocerverrnsemnnnenssscnnnans 4-16
L) (A (Te [1 (4T ) I 4-16
text (entering) ....c..cccuvernrernseenssnenisennans 4-4
text (entry modes).......ccccrvrerrnsennisnnnnnns 4-2
Text MemO ......ccccvvvrmnsmmssnnnsseessennnnnns 4-18
Title Bars (Display Patterns)............... 7-6

Toggle Preview........cccccvvennisnsssnnsans
Tone Octave ......ccccvrveerrerscnisesssessnens

Total Charges.......ccocrvserversnssenssansnes
Total Talk Time....
U
Useful Diary ......ccocvierinnnnnseninnninnnas 12-20
User Dictionary .......cccccvvseriseerisenninnns 4-15
\')
V-Appli Vibration.........cccvecernccnrisnnnans 3-5
Vibration .......cccccvimvvnmncnnnsssnsesineennes 8-3
Vibration Pattern........cccoueceriecericnnnnns 8-4
14-18

Vodafone live! Animation ..........cccuuueus 7-9

Voice Mail.......cceonremnierinmsnnsenssensseninns 13-4

Voice Memo........cccuvemnruremsseessmesssansnnas 12-6
w

Wallpaper ........cccoomimrimiinnininnsanienanns 7-2

Wallpaper mode.........ccueverrsnnssnenas 6-5, 6-7

Wallpaper Size..........cocevienienienierinnnnas 6-23

Whisper Mode.........cocuremnrannnsseeminnnnnas 3-5
y4

F 70T 1 1 1 6-5

Warranty & After-Sales Services

W Warranty

Warranty is provided when you purchase V302SH.

¢ Check the name of distributor and date of purchase.
¢ Read through contents and keep in a safe place.

* The warranty term is described in the warranty.

Il After-Sales Services

See P.14-6 "Troubleshooting" before contacting us for repair. If you cannot find

solutions or solve problems, contact Vodafone Customer Center, Customer

Assistance (see P.14-20) of your subscription area and provide detailed description.

¢ During the warranty term, the repair is performed under the terms and conditions
described in the warranty.

¢ After the warranty term, repairs are performed if possible upon your request at
your expense.

For other services, contact the distributor, the nearest Vodafone shop or Vodafone

Customer Center, General Information (see P.14-20). Replacement parts are

available for 6 years after termination of production.

¢ Vodafone is not liable for any damages resulting from accidental loss/alteration of
handset data. Please keep a separate record of Phone Book entries, etc.

¢ Disassembling or modifying handset may violate the Radio Law. Modified handset
will not be repaired.

@ ¢ Vodafone is not liable for any damages resulting from use of this product.

xipuaddy h
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Customer Service

If you have questions about Vodafone handsets or services, please call General .
Information. For repairs, please call Customer Assistance. V302SH Instruction Manual

Basic Operations

Vodafone Customer Centers October 2005, First Edition

From a Vodafone handset, dial toll free at Vodafone K.K.
157 for General Information or
113 for Customer Assistance

For additional information, please visit a Vodafone shop.

H Call these numbers toll free from landlines
Model: V302SH

Subscription Area Service Center Phone Number Manufacturer: SHARP Corporation
Hokkaido, Aomori, Akita, Iwate, Yamagata, Miyagi, .
Fukushima, Niigata, Tokyo, Kanagawa, Chiba, General Information ® 0088-240-157
Saitama, Ibaraki, Tochigi, Gunma, Yamanashi, A
Nagano, Toyama, Ishikawa, Fukui Customer Assistance @ 0088-240-113
General Information @ 0088-241-157
Aichi, Gifu, Mie, Shizuoka
Customer Assistance @ 0088-241-113
General Information @ 0088-242-157
Osaka, Hyogo, Kyoto, Nara, Shiga, Wakayama
Customer Assistance @ 0088-242-113
General Information @ 0088-259-157
Hiroshima, Okayama, Yamaguchi, Tottori, Shimane
Customer Assistance @ 0088-259-113
General Information @ 0088-247-157
Tokushima, Kagawa, Ehime, Kochi
Customer Assistance @ 0088-247-113
Fukuoka, Saga, Nagasaki, Oita, Kumamoto, Miyazaki, General Information ® 0088-250-157
Kagoshima, Okinawa Customer Assistance @ 0088-250-113

/* Please help the mobile industry maintain high environmental
# ) standards. Recycle your old handsets, batteries and charger
\-— units (all manufacturers and brands). Before you recycle,
E) AL UY1DIL-Ru-T-0 . .
please remember these important points:
eHandset, batteries and chargers submitted for recycling cannot be
returned.
eAlways be sure to erase all data recorded on old handsets (Phone
Book entries, call records, mail, etc.) before recycling.

14-20



Introduction

Thank you for purchasing the V302SH.

eFor proper handset use, read this manual
beforehand.

¢This manual has been produced for V302SH
Vodafone live!

eKeep this manual in a convenient place for
reference.

¢ Accessible Vodafone services may vary by service
area, subscription, etc.

V302SH transmits at 1.5 GHz and is compatible with
the Vodafone K.K. network.
This product is exclusively for use in Japan.

Note

¢ Copying this manual in whole or part without
authorization is prohibited.

eManual content is subject to change without prior
notice.

e Efforts have been made to ensure the accuracy and
clarity of this manual. Please contact Customer
Service, General Information (see P.16-15)
concerning unclear or missing information.

Use Side Key to activate specified functions with
handset closed or to release shutter. In this
manual, Side Key is indicated as shown to the
right. "S" is not inscribed on the actual Side Key.

Symbols

. Multi Selector

Use Multi Selector to select menu items, move cursor, scroll, etc.

In this manual, Multi Selector operations are
indicated as shown to the right. .@ 7 ' _

Basic Multi Selector Operations A

m($): Press ©) or (9
m(0s: Press ¢0) or
m33: Press (9), (), €0) or (0

B side Key

¢ |n this manual, most operations are described with handset open.
e Sample screen shots, etc. are provided for reference only. Actual handset windows,

menus, etc. may differ in appearance.



. Page References

When appears next to a page reference, indicated pages are in Basic

Operations Manual. When only a page reference appears, indicated pages are in
Vodafone live! Manual.

. Abbreviated Steps

Handset operations starting from Index Menu are abbreviated as follows:

Press <@l to open Handy Features menu

Press (® Perform the operation such as opening a window

> Menu Item % Handy (&) & Selection % Operation » Menu (Q)‘

Select the folder or file and press (®)

Select the menu item and press @ Press the corresponding key in parentheses

MEMO
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Vodafone live! Basics

l V-Applications

Download V-Applications, including games and 3D graphics.

Use Vodafone live! services to exchange text and multimedia messages with
compatible handsets, download sounds and images as well as V-Applications, browse
the Mobile Internet or receive up-to-date area information via Station.

H Mail

Sky Mail
Use this basic service to exchange short text
messages (of up to 128 alphanumerics) with
other Vodafone handsets, email-compatible
mobiles, PCs and other similar devices.

Long Mail

Exchange long text messages (of up to 6,000
alphanumerics) with other Long Mail-compatible
Vodafone handsets, email-compatible mobiles,
PCs, and other similar devices. Attach images/
sounds to messages for multimedia messaging.

Web Downloads

Download V-Applications via
Web (Vodafone Web).

‘ Download

Network V-Applications

Enjoy Network games and
access real time information.

Stocks

Standby V-Application

Set a V-Application to activate
when handset enters Standby.

Standby V-Application

Download and use V302SH-compatible V-Applications.

l Station

Access a variety of area-specific local information, periodically updated automatically.

Designate the date/time for the timely delivery
of special salutations, like birthday or holiday
congratulations, etc. to friends or family with
compatible Vodafone handsets.

Specif Appears at
pecity Specified
Date/Time £&—1 ~ Time ‘-

Service Center

L/ LT/
—p —p
) = ) =
Service Center Service Center
Greeting Sky Melody

Request the latest hits from Sky Melody Center
to use as handset Ring Tones/Alarm Tones.

)

‘
Sky Melody

Service Center

Main List

Area information is updated
automatically by location.

Local Info f .

News
Weather

My List
Save area information in My
List to receive update notices.

Local Info %

News
Weather

Weather Indicator

Set handset to show updated
weather forecast for your area.

wk
Forecast
Indicators

An additional contract is required to use Long Mail and receive e-mail from PCs, etc.

Hweb

Access the Mobile Internet. Browse for image or sound files as well as information.

Web Information

Mobile Internet sites from Web
menu to download files/info.

Images
A-‘ Text Info [

Sounds

(Mobile) Internet

Access Vodafone live!l-compatible |Enter Mobile Internet URLs to |Where available, request
view specific sites/pages
directly, or access Log List.

=
@;] Mobile Internet Access E

Auto Delivery Service

automatic info updates from
compatible Mobile Internet sites.

Delivery

A Auto
Service |

An additional contract is required to use Web service.

¢ Receive current location info automatically.
¢ Receive urgent information, such as emergency/disaster warnings, automatically.

® Separate subscription is required for fee-based information.

Customer Center, General Information (see P.16-15).

@ ¢ For more information concerning Vodafone live! services, contact Vodafone

¢ To disable individual Vodafone live! services, see P.1-5.

MBIAIBAQ jOAI| BUOJBPOA i
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Customizing Handset Address

Default OOO0O000O00000@ A.vodafone.ne.jp

I ]
Account Name ‘ Domain Name

Custom I Entered Account Name I@IA.vodafone.ne.jp I

Avaries by subscription area.
If you have further questions, please contact Vodafone Customer Center, General Information
(see P.16-15).

¢ Handset must connect to the Network to customize handset address.
¢ Customizing handset mail address helps reduce spam.
¢ Web must be activated before handset address can be customized (see P.1-5).

ARWN=

Press (@l
Select llVodafone Web and press (®)

Select My Vodafone and press (®)

Select U IJF)VX—)VERTE - EEX—/VERTE in SEEEFHE and

press (®

¢ Follow onscreen instructions (Japanese only).
For Web basic operations, see P.7-8.
Center Access Code: see (Basic)P.1-26

handset address, contact Vodafone Customer Center, General Information (see P.16-15).

@ Onscreen instructions are subject to change. For more information on customizing

1-4

Memory Status

Save up to approximately 375 KB between Inbox (Mail), Storage Type (Web), and
Saved Information (Station).
Open Memory Status window to confirm Mail, Web and Station memory.

m P Functions ® Settings 1

1 Select Memory and press (®)

Disabling Vodafone live!

Disable any or all Vodafone live! services. Use this function to restrict access to or
prevent unauthorized use of Vodafone live! services on your handset.
All services are active by default.

1 Press ®k=E=]
2 Enter Security Code
3 Select a service and press (®)

4 Choose BlOffand press (®
To activate, choose IBOn % Press (®

1-5
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Opening New Messages

1 When mail arrives, animation plays and Delivery
Notice appears
A (Long Mail) or £ (Sky Mail) appears according to message type.
¢ When handset is closed, notification followed by Il appears on
Sub Display. Open handset to see Delivery Notice.

Press (®

Inbox opens (see P.2-5).

15:05 A Wﬂ

9/20[Tue] 12:34

Message Received

N

o Sho ]

Delivery Notice

3 Select a message and press (® o —r
Message window opens (see P.2-6 "Message Contents"). '59"/5% 12:34 2]
* Press to see newer messages or for older ones. Z#Kimura Tetsuya

BrireTomorrow’s meeti
4 Press @ to exit 0

The meeting schedule|
d for tomorrow has b
een postponed. Pleas
e come over to confe
rence room 1 at 11.

Menurz

Delivery Report

Il When messages are sent with Confirm Delivery On (see P.3-5, P.6-2), handset
receives a Delivery Report from the Center. Open Delivery Reports in the same
manner as standard messages.

Ring Tone Volume

Il While handset is ringing, press (5) (up) or (Q) (down).
* Ring Tone Level setting (see (Basic)P.8-2) changes accordingly.
* Cancel Manner Mode (see (BasicJP.3-3) to adjust the level.

H Press to instantly mute incoming information tone for that information only.

e See P.4-2 to open Inbox when Delivery Notice does not appear.
* See (Basic]P.7-9 "Vodafone live! Animation" to disable incoming mail animation.

. New Mail Notifications during Operations

When mail arrives while using handset functions, a notification
such as New Mail from (Sender’'s name) appears.
¢ See P.6-2 "Mail Notice" to hide or edit notification.
* New Mail appears for:
m Messages sorted to Secret Mode Mail Folders
m Messages from senders saved as Secret Mode Phone Book entries
(when handset is not in Secret Mode)
m Messages with Privacy Level 3 or 4

New Mail from Kimura
New Message

29/128
| have a business tr
ip today,ll

» Names do not appear when Phone Book Lock (see (Basic]P.11-3) is
active.

* To receive notification while V-Application is active, select Show Message in Incoming
Settings (see P.12-2).

¢ Notification does not appear when:
m A Greeting message arrived before the designated date/time  ®In Standby
® The current window does not support notifications

Inbox

. Inbox Contents

To open Inbox while Delivery Notice for mail appears, press (®); otherwise, open Mail
and press (® twice. To select a different view for Mail Box, see "List" (P.4-23 "Mail
Box Menu").

Unread/Read

Long Mail: /&

Messages other than Long Mail: &

(If subscribed to Long Mail, 4 appears for e-mail messages.)

3 brE
15:05
£-8wKitayama Kaoru

AoKinura Tetsuya ¢ Indicator color varies by message status:
=1 S m Unread: Red
ggﬁ?rtnglrjaﬂe iko ® Protected: Yellow

Message Type (see P.2-6)

lls. Kawahashi, please|
bring a camera and
a tripod to the wedd

0 o 3

I'eIN MeN H

@ Incoming Mail... and received text appear for incoming linked me
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Il Message Type

Sky Mail (mail from Vodafone handsets)

E-mail (messages received via the Internet)

Long Mail with attachments

Long Mail Notice (Server Mail, initial portion included)

Unretrieved List (Long Mail)

BBS Notice

Polling (BBS accessed)

Greeting

| @ P @ S| P

Unsaved Sky Melody

. Message Contents

Select a message and press (®) to open it.

Sending Priority: see P.6-5

'%: Low, % (blue arrow): Normal, & (orange arrow): High,

®: By Express (4&: Long Mail or Long Mail Notice)
Image Display Size
100%: [, 200%: [Ld

Retrieving Long Mail
The Center sends the initial portion of Long Mail messages when:

® The message is over 385 single-byte characters

® The sender's address is over 56 single-byte characters
® The subject is over 41 single-byte characters

® The message was sent to multiple recipients

m Files are attached to the message

¥ (Long Mail Notice) appears in Inbox when the remaining portion of Long Mail
message is held at the Center.

e Use Unretrieved List to retrieve multiple Long Mail messages at one time (see

@ e To retrieve complete Long Mail automatically, see P.6-3 "Auto Retrieve."
P.5-3).

I'eIN MaN H

. Retrieving a Selected Long Mail Message

71 Open a message
&More appears at the bottom of the message.

A<Kimura Tetsuya—
EwieTomorrow’s meeti
ng

The| meeting schedule
d fpr tomorrow has b

(4] c
15:05 I i f
/28 12:34 ,—W—B] Received Date & Time

Message Number

Sender

¢ Number or address appears. Name appears if saved in
Phone Book.

Press (0l

Download starts.

« After the message is retrieved, Inbox opens. (Long Mail Notice that day, OK?

The capaéity of the

een| postponed. Pleas

le come over to confe Message Text
rence room 1 at 11.

Attachments
¢ Files are attached to the message.

Privacy Level (see P.3-11)
e Lv2 appears for Sky Melodies.

2-6

disappears and the message is saved.)

Sky Melody

If Mail service is disabled, Sky Melody cannot be used. Activate Mail to use Sky
Melody (see P.1-5).

Requesting Melody Files
Press (&), select @Sky Melody and press (®)
Press (®

Follow voice prompts and select a melody

Press

Sky Melody Center sends the melody.

RNRWN=
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Changing Sky Melody Center Number

Do not change this number unless instructed to do so. Otherwise, Sky Melody Center
access will be disabled.
Press (& » Select @Sky Melody # Press (® ® Press % Press
&7 (Long Press) ® Enter new number #® Press ®
* #1790 is set by default.

Saving to Data Folder

1

O QN

When Sky Melody arrives, animation plays and Delivery Notice

appears

& appears.

* When handset is closed, MAIL followed by I appears on Sub Display. Open handset to
see Delivery Notice.

Press (®
* X Sky Melody Center appears.

Select the message and press (®)
Title appears and melody plays as set in Sound Volume.

Press
Select To Data Folder and press (®)

Melody is saved to Data Folder and message is automatically deleted.
* When memory is full, delete files (see (Basic)P.9-24) and try again.
To use as Ring Tone, see (Basic)P.8-3.

@ Sky Melody files cannot be modified or attached to Long Mail.
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Creating Text Messages

Procedure

Enter Recipient (see P.3-4)

|Phone Book
Address
Locations [2-Touch Mail
[Sent Mail

Direct |Mobi|e Number|
Entry |Mai| Address |

. UL

Enter Subject (Long Mail: see P.3-4)

Compose Message (see P.3-

=

)

@

Attach Files (Long Mail: see P.3-7 - 3-9)

Still Image

Animation

Melody

c

Send Message

Incoming Calls during Message Creation

B Content is saved temporarily. To resume editing, follow these steps.
Press (8 % Choose IlYes # Press (®

3-2

Undeliverable messages are stored at the Center for up to 72 hours, and delivered

when recipient's handset connects to the Network.

. Character Entry Limits

Character limits vary by Mail Type.

Character Entry Limits

Sky Mail 128 single-byte alphanumerics
Long Mail 6,000 single-byte alphanumerics, up to 6 KB
Greeting 112 single-byte alphanumerics

Long Mail message text character limit differs by attachment size and recipient count.

B Entry Item Availability

|

Character limits vary by Mail Type.

Recipient Sender Subject Message | Date & Time | Attachments
Sky Mail Available N/A N/A Available N/A N/A
Long Mail Available N/A Available Available N/A Available
Greeting Available Available N/A Available Available N/A

To send Long Mail messages, enter a recipient and either attach a file or enter a
subject or message text.

Creating & Sending a Message

Save frequently used addresses to 2-Touch Mail.

Press (&), select llLong Mail, B Sky Mail or
ElGreeting and press

Mail Composition window opens.

2 Select M1o and press (®

(505 T
Long Mai |

7o [No Address ]
BShite [No Subject ]
Erext [No Body Text ]
&ant[No Attach ]

QJFE

Save Auto Send OF

@Save eSelect | Sende

Mail Composition Window
(Long Mail)

3-3
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0 NO O K

Phone Book
K Select lPhone Book and press O]

HE Open an entry
To search Phone Book, see Steps 2 - 3 on (Basic)P.5-11.

2-Touch Mail List
H Select B2-Touch Mail and press (®)
2-Touch Mail: see P.3-12
Select a recipient

Sent Mail
Select E}Sent Mail and press (®)
Sent Mail: see P.3-5
Select a recipient

Direct Entry
Select @Mobile Number or BIMail Address and press (®)

Enter recipient's Vodafone handset number or mail address
To select from Phone Book, see Steps 1 - 3 on (Basic]P.5-11.

Press (®
® For Sky Mail, skip ahead to Step 7.

Select Brite and press (@)
* Enter up to 256 single-byte alphanumerics (254 single-byte katakana or 125 double-byte
characters).

Enter subject and press (®)
Select Erext and press (®)

New Message window opens.

Enter a message
Using Mail Templates: see P.3-15
Using Fixed Text: see P.3-6
To copy from Phone Book, see (Basic]P.4-9.
To copy from Text Memo, press # Select BCall Text Memo ® Press (®) »
Select Text Memo # Press (®

Press (®
Mail Composition window returns.
Attaching Images & Sounds: see P.3-7
Option Settings: see P.3-10
Saving to Outbox: see P.3-10
To set Confirm Delivery (see P.6-2), select Confirm Delivery
% Press (® ® Choose llOn # Press (®
Save as Auto Send: see P.3-12

10 Press

¢ Messages are delivered even if handset is closed.
Message delivery status and result appear on Sub Display.

1!5:n5 il
Long Mai |

&0 [Kimura Tetsuya]
Brive[| got your mai]
Erext [Thank you in a]
@ [No Attach ]

OFF|
Save Auto Send OFF|

@Save efelect Sends

Mail Composition Window
(Long Mail)

@ Using both single and double-byte characters may reduce character entry limit.

When Mail Address is Entered

Il Mail addresses count toward the message text character limit.

M Single-byte katakana and Pictographs are invalid in message text and subject.
Entered single-byte katakana is changed to double-byte, and Pictograph is replaced
with single-byte 2.

Sending from Phone Book Entries

H To select a recipient from Phone Book, perform Steps 1 - 3 on (Basic)P.5-11
Press (® % Select Send Mail (Phone) or Send Mail (E-mail) % Press (®) &
Select Mail Type # Press (®

Save Auto Send for Failed Messages

Il Save As Auto Send? appears when message delivery fails with Auto Send On (see
P.6-2) and Save Auto Send Off.
To set Save Auto Send, choose IBYes » Press @

I Last 9 sent mail records are saved.
Il Recipients' names appear if saved in Phone Book. Names for Secret Mode Phone
Book entries appear only when handset is in Secret Mode.
Il Vodafone handset numbers appear with @ :, etc. Mail addresses appear with é&2:.
Il Changes to Phone Book entries are not reflected in Sent Mail.
Il To delete records from Sent Mail, follow these steps.
After Step 3 (Sent Mail) on P.3-4, press ® Select Delete or
Delete All % Press (®) % Choose [BYes ® Press (®

sabessal 1xa] Buipussg h
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Entering Recipients (Long Mail)

Bl Enter up to five recipients. To add recipients, follow these steps. - T
5:05
After Step 3 on P.3-4, select 10 ® Press (®) ® Selecta e lai | Address
T0Kimura Tetsuya

number ® Press (® ® Enter a recipient (see Step 3 on
P.3-4)
* To enter additional recipients, repeat the above steps from
"Select a number."
= Press <0l to return to Mail Composition window.
M In Address list, I appears before recipient's name, number or
address. Change the status to Cc (carbon copy) as follows:
Select a recipient ® Press % Select Cc &
Press (®
l To edit, open Address list and follow these steps.
Select a recipient ® Press ® Select Change # Press (®) % Edit
address ® Press (®
B To delete, open Address list and follow these steps.
Select a recipient ®» Press % Select Delete » Press (®

Sending to Server (Sky Mail)

B Intranet integration is required to send messages to the Server.
After Step 2 on P.3-3, select 3@ Server » Press @ » Enter Server Address
(within 20 digits) ® Press (® ® Enter Sub Address (within five digits) #
Press (®

Address List

. Using Fixed Text (Japanese Only)

* Set BEZ#EIR (Language) to FZEE (Japanese) (see (Basic]P.7-9) to use Preset Fixed Text,
Editable Text or Custom Fixed Text (see P.6-2).

¢ Follow these steps after Step 7 on P.3-4. Mail Composition window returns after Fixed
Text is entered.

1 Press 9l

¢ Fixed Text cannot be inserted after entering characters.

Select B/ and press (®
Select a type and press (®

Select a message and press (®)
To select other Fixed Text, press » Select another message #® Press @
To use Editable Fixed Text, select Editable Fixed Text ® Press (® # Press »
Enter text ® Press (®)
®m Press or if any ® Enter text ® Press (®

5 Press @

KARWN

3-6

* Edit Preset Fixed Text after it is copied to Long Mail or e-mail messages.
e Character limit depends on message type and the number of parentheses.

. Converting Mail Type

Change Mail Types while editing Sky Mail or Long Mail messages.

¢ The following are deleted when Long Mail is converted to Sky Mail:
m Subject ® Attachments ® Recipients other than the first one
m Message text exceeding Sky Mail character limit

e Follow these steps after Step 7 on P.3-4. After conversion, New Message window
returns. Complete and send the message.

7 Press
2 Select E3To Long Mail or E3Convert Sky Mail and press O)

Choose IBYes and press (®
¢ When converting Sky Mail to Long Mail, entered address appears in TO field.

When a Sky Mail Message Exceeds the Character Limit

B Mail Message Exceeds Limit Convert to Long Mail? appears.
To convert Sky Mail to Long Mail, choose Il Yes # Press (®
* The message above does not appear if you are using Fixed Text.

Attaching Images & Sounds

Attach images or sound files to Long Mail.

e Attach up to five files. (Only one animation file can be attached.)

* Split to four smaller images or reduce image size (see (Basic)P.6-23).

e For more information, contact Vodafone Customer Center, General Information
(see P.16-15).

. Attaching Files from Data Folder

Follow these steps after Step 9 on P.3-5. Mail Composition window returns after a file

is attached.

Select #an and press (®
If files are already attached, select a number ® Press (®)
To change attached file, select a file # Press (®) # Press

2 Select IData Folder and press (®)
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Select a folder and press (®

¢ Files cannot be attached if not selectable.
To open images or play sounds, select a file ® Press <0l or
m To return, press <@l or BT

4 Select afile and press (®
For large JPEG images, select IDAttach 1/4 Size or BAttach Original % Press (®
(Files may not be attached even if the file size is reduced.)
For large animation files, choose llYes # Press (®) (Files may not be attached even if
the file size is reduced.)
To attach a Burst Shot image, use 9 to select an image #® Press ®
When attaching a sound file, select a format ® Press (®)

Chords over 6 are deleted. Tone and loudness settings are

[Velody Format )
ignored.

Chords over 17 are deleted, and tones of the following change
EISMAF (MA-2) Format |to Piano:
Drum (FM) ® Drum (WT) ®Original (FM) ® Original (WT)

EISMAF (MA-3) Format | Up to 32 chords can be sent

Editing Images

Il To add stamps/text to attached images, follow these steps after Step 4.
Select Pan P Press (®) # Select an image # Press ® Select
ElMarker Stamp » Press (®) % Edit image (see Steps 2 - 5 on (Basic)P.9-15) $
Press <0l
e Stamps/text cannot be added if the attached Sha-mail image is unsaved.
e While adding Marker Stamps, unsaved changes may be deleted by incoming calls.

Adding & Deleting Attachments

M To attach additional files, follow these steps.
Select #an  Press (@) ® Select a number # Press (®)
» Perform from Step 2 in "Attaching Files from Data
Folder"” on P.3-7
= Press <@l to return to Mail Composition window.
l To delete attachments, follow these steps.
Open Attachment list and select a file » Press »
Select E)Delete » Press (®) # Choose [BYes # Press (®
mPress <@l to return to Mail Composition window.

505
Attachment
04-09-21 11-54
=

@ Set eSelect NMenurs)

* Some sound files cannot be converted.
* Tone and loudness of sound files may change after conversion. Some files may be
too large to attach after conversion.

B Attaching Mail & Web Files |

1 Select an image or sound file in mail or Web info

and press (&> HATH

505 il
9/21 12:30 21

ZA@Kimura Tetsuya

® Selected image is outlined in blue. Brieelly lovely Sakura
» } Isn’t she cute?
2 Select [%7Copy (image) or ¥l Copy (sound) and
press

Copied files are saved to Clipboard temporarily.
* Some images or sounds cannot be copied.

Press

In Long Mail Composition window, select £att and press (®)
Choose BlClipboard and press (®)

Select [ Attach and press (®
Adding & Deleting Attachment: see P.3-8
To open images or play sounds, select ElOpen File % Press @
® To return, press <90l (image) or <@l (sound).

Create and send the message
Creating & Sending a Message: see P.3-3

ODORW

Depending on the file size of images or sounds, File Exceeds Limit Cannot Attach
may appear and file is not attached.

. Attaching Images Captured while Creating Message

¢ Follow these steps after Step 9 on P.3-5. Mail Composition window returns after an image
is attached.
e This function is not available when files are already attached.

1 Select #an and press ®
Select E}Sha-mail Shoot and press (®)

Camera is activated.

For details, see Steps 2 - 3 in "Capturing Still Images" on (Basic)P.6-7.

2

Capture image
3 Cap g
4

Press (®

Image is attached.

o |[f Save & Send Image is On (see P.6-3), the captured image is automatically saved to
Data Folder.
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Saving to Outbox I

e Save up to 100 KB.
¢ When memory is full, delete messages (see P.4-10) before creating new ones.
e Follow these steps after Step 9 on P.3-5.

1 Press @l
2 Choose [ Yes and press @®

Outbox opens. Latest message comes first.
3 Press @ to exit

The order in which addresses (To and Cc) or attachments appear may change when
saving Long Mail.

Option Settings [

Confirm or change send options when sending Sky Mail or Greeting messages.
¢ Sky Mail options are available only when sending to Vodafone handsets.

* These settings are valid for one message when set during message composition.
¢ Option Settings are not available when resending messages.
15:05

Sky Mai |

Mo [Kimura Tetsuyal
Eext [Thank you in al

Save Auto Send OFF]

l@Save eSelect  Sendrs I

Mail Composition Window
(Sky Mail)

I Set a matching PIN for recipients using PIN Filter (see P.6-3) I

In Mail Composition window, select Option Settings ® Press (®) »
Select IIPIN % Press (®) # Enter recipient's 4-digit PIN ® Press (®)
To return to Mail Composition window, press <0l IEETA. I

3-10

Restrict copying/forwarding the message, or require Security I

Code to open it

MR Level 1

In Mail Composition window, select Option Settings % Press (®) %
Select BPrivacy # Press (®) % Select from lLevel 1to @Level 4 »

Press (®)
To return to Mail Composition window, press <01 IFETA.
Privacy Level Copy/Forward Security Code

1 Allowed Not Required

L(iw 2 Prohibited Not Required

High 3 Allowed Required
4 Prohibited Required

Set priority when sending mail I

M Available for Sky Mail.
EEMNormal

In Mail Composition window, select Option Settings ® Press (®) »
Select E)Set Priority » Press (®) # Select from IlLow to @By Express

» Press (®)

To return to Mail Composition window, press <0 IFEA.

By Express messages are delivered faster for additional fees. Other levels
indicate the importance of the message and do not affect delivery speed.

Activate Polling to receive BBS messages (see P.6-5) I

M Available for Sky Mail.
BEEMNOff (not to receive BBS messages)

In Mail Composition window, select Option Settings % Press (®) »
Select @Polling » Press (8 » Choose IlOn # Press (®
To return to Mail Composition window, press < IFERA.

Select a recipient type

Under normal conditions, set Recipient Type to None I

M Available for Sky Mail.
BEEMRNone

In Mail Composition window, select Option Settings ® Press (®) »
Select BlRecipient Type % Press (® # Select from INone to
BlComputer % Press (®

To return to Mail Composition window, press <01 IEFA.
¢ Select Mobile Phone to send to a Vodafone handset, or Computer to send to a PC
connected to a Vodafone handset.
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Save as Auto Send

When Save Auto Send is active, the message is saved to Outbox and is sent automatically
when signal returns.

e Activate Auto Send beforehand (see P.6-2).

e Save up to 10 messages.

1 In Mail Composition window, select Save Auto Send and press (®)
2 Choose lOn and press (®

Auto appears in the right bottom corner.
To cancel, choose ElOff ® Press (® (Omit the next step.)

3 Press

¢ Auto Send initiates message send up to three times including initial attempt.
e Auto Send Long Mail takes priority over Sky Mail.
¢ Auto Send failed deliveries are saved to Sent and Outbox.

When Auto Send is Activated

M Approximately 10 seconds after signal returns, an Auto Send message is sent. When
there is more than one, messages are sent in five second intervals.

Bl Consecutively saved Long Mail messages are sent in succession.

B Sent appears when Auto Send is complete.
For unsent messages, press (® to open Outbox.
¢ 4 or 7 appears next to failed Auto Send messages.

Select [Add Address and press (®

Select a number and press (®)
To change addresses, select a number ® Press (® » Edit address #® Press (®)
To delete an entry, select a number ® Press % Select Delete % Press (®
% Choose IBYes # Press (®
To delete all entries, press % Select Delete All % Press (® % Choose
D Yes » Press (®
® When selecting a number with no entry, press % Choose MYes »
Press (® (All entries are deleted.)

5 Phone Book

i Select Phone Book and press (®)
* Changing Phone Book entries does not affect 2-Touch Mail Addresses.
H Open an entry
To search Phone Book, see Steps 2 - 3 on (Basic]P.5-11.

R W

Direct Entry

H Select BMobile Number or EJE-Mail and press (®)
Enter recipient's Vodafone handset nhumber or mail address
To select from Phone Book, see Steps 1 - 3 on (Basic)P.5-11.

6 Press @

An icon corresponding to the address type appears.
* Repeat Steps 4 - 6 for other entries.

7 Press @ to exit

2-Touch Mail
Add Address

Save up to nine frequently used addresses to 2-Touch Mail to send mail from Standby
(see P.3-13) or add addresses to mail from 2-Touch Mail List (see P.3-4).

1 Press [&, select BMail Settings and press ®
2 Sselect II2-Touch Mail and press (®

3-12

Adding to 2-Touch Mail while Creating Message

Il When there is no entry in 2-Touch Mail, add an address from Mail Composition
window.
After Step 2 on P.3-3, select B)2-Touch Mail % Press (® % Choose [#Yes »
Press (®) ® Perform from Step 5 above

Creating & Sending

Use 2-Touch Mail to create and send messages from Standby.
Save addresses in 2-Touch Mail (Mail Settings) beforehand (see P.3-12).

1 In Standby, press the assigned number (Il - E]) with Keypad ( - )
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Sending Long Mail
Press (0l
The address is entered automatically.
Sending Sky Mail
Press

The address is entered automatically.

Create and send the message
Creating & Sending a Message: see P.3-3

ail Templates

Save frequently used messages to Mail Templates. Choose a template and fill in fields

to ea

sily create messages. Templates consist of fixed text and Items (free text fields).

Fixed text is editable.

Saving Mail Templates

e Save up to 10 templates per category.
* JTT—% (Japanese templates) and Preset Text (English templates) are saved by
default. Edit default templates to make your own templates.

1
2
3

3-14

Press (®), select My Files and press (®
Select @Mail Templates and press (®)

Select a category and press (®
To edit title, select a number ® Press % Select ElChange Title % Press (®
% Edit title ®» Press (®
m Default template titles cannot be changed.
To delete templates, select a number ® Press HETE » Select @Delete # Press (@)
% Choose [BYes # Press (®
m Default templates cannot be deleted.

Press (2> I, select IICreate New and press (®)

To edit existing templates, select a number # Press (®) twice

Enter title and press (®

e Enter up to 24 single-byte characters.

6 Enter text
¢ Enter up to 2,000 single-byte characters.
e Use up to 10 Items (I - [&).
e Press to delete Items.
To enter ltems, press <@l % Select a number ® Press (@)
m [tems in use cannot be selected.

Press (®
Select @New Entry or ElOverwrite and press (®)

© N

Select a number and press (®)

Creating Mail Directly from Mail Templates

l Follow these steps after Step 3 in "Saving Mail Templates" on P.3-14.
Select a number # Press <0l HIFIl # Select IACreate Long Mail or
BlCreate Sky Mail % Press (® » Perform from Step 5 below

Using Mail Templates

Use saved Mail Templates to easily create text messages.
Follow these steps after opening New Message window in Step 7 on P.3-4. When
finished, Mail Composition window returns. Complete and send the message.

1 PressQl

* Templates cannot be inserted after entering text.
Select IIMail Templates and press (®)
Select a category and press (®

Select a template and press (®)
* To keep the text unchanged, skip ahead to Step 9.

Press @l
Select a number and press (®)
Enter text and press (®

¢ Enter up to 100 single-byte characters per Item.
Repeat Steps 5 - 7 for other Items
Press (®

Check message and press (®)
¢ For Long Mail, template title will be the subject if not already entered.

SO0 NOO RWN
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One-Shot Mail

Save a Sky Mail message as One-Shot Mail and send to a specific recipient with
handset closed. Location Info can be pasted into the message text.

Saving One-Shot Mail

e Available only for Sky Mail. One-Shot Mail will not be saved to Outbox.
¢ Entered contents remain until changed.

1 Press [&, select ElOne-Shot Mail and press ®
2 Select BlCreate and press ®

Enter a recipient’s number and message text
For details, see P.3-3 "Creating & Sending a Message."
To paste Location Info, select SendLocationinfo % Press (® % Choose [lOn »

Press (®
4 Press &l when finished

Location Info

B Latest Location Info is pasted. If no Location Info is obtained, nothing is pasted.
B Location Info counts toward the character limit.

Sending One-Shot Mail with Handset Closed

Save One-Shot Mail (above) and activate One-Shot Mail in Side Key Settings for
Standby (see (Basic]JP.12-3) before sending One-Shot Mail.

Close handset and press for 1+ seconds

One-Shot Mail is sent (handset vibrates for 0.5 seconds).

¢ When delivery fails, Save Auto Send is set. (When Auto Send is Off or Outbox is full,
handset vibrates for another second.)

Sending One-Shot Mail with Handset Open

B Press [Z> # Select BOne-Shot Mail % Press (@) % Select ISend # Press (®
% Choose [BYes » Press (®

3-16

Greeting

Send messages to compatible Vodafone handsets anytime, to be opened at the
designated date/time in the future; ideal for holidays, birthdays and other special
occasions.

© WONO® O K WNh=

—
o

Press [&, select E)Greeting and press ®
Select Mo and press (®)

Enter a recipient's number and press (®
To enter a recipient, see Step 3 on P.3-4.

Select Som and press (@)

e When Sender is set in Mail Settings (see P.6-5), entered name appears automatically.

* Skip ahead to Step 6 if no entry is required.

Enter name and press (®)
¢ Enter up to 12 single-byte alphanumerics (10 single-byte katakana or 3 double-byte
characters).

Select Erxt and press (®
Enter message text and press (®)
Select % and press (®

The current date and time appear.

Specify the date and time and press (® (Recipients cannot open

Greeting messages until then.)
® Apply 24-hour clock format.

Press

3-17
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Checking Messages

Received messages are saved to Inbox, sent ones to Sent and drafts to Outbox.

e Jr or /& appears when there is unread mail in Inbox.
¢ Set Mail Box display layouts to List or Folder (see P.4-14).

1 Press [&, select ElMail Box and press ®
To check the number of saved messages, select Elinbox or ElOutbox » Press
® Press to return.
To toggle layout, select [linbox, BlSent or EJOutbox » Press » Select
BEMail Box Display % Press (®
m Security Code is required when there is a Secret Mode Mail Folder.

2 select Minbox, BSent or EJOutbox and press (®)
Mail Box Contents: see P.4-4
When Mail Box Layout is set to Folder, select appropriate folder ® Press (@

Select a message and press (®
Message window opens (see P.4-5 "Message Contents").
® Press to see newer messages or for older ones.
® For Outbox messages, Mail Composition window opens.
® To edit Outbox messages, select an item # Press (®) # Edit the message
= To save edited messages, press <@l » Select IlSave as or ElOverwrite »
Press (®
o |f attached image is too large, it may not appear.
* For Sky Melody messages, the title appears and melody plays.
To edit Sent messages, press EITE # Select Edit % Press (® % Select an item
% Press (® # Edit the message
Use () to scroll.
To open messages with Privacy Level 3 or 4, enter Security Code.

4 Press @ to exit

W

Save Auto Send for Outbox Messages

B For one message, press ® Select @Mail Box » Press (® # Select
Eloutbox % Press (® % Select a message ® Press % Select
Save Auto Send % Press (®
H For multiple messages, press ® Select EMail Box % Press (® # Select
ElOutbox % Press (® % Select a message and press <0l (repeat for
other messages) ® Press % Select Save Auto Send % Press (®)
® To uncheck, select a message with ¥ ® Press <0l
m To clear all check marks, press (&> IIENM » Select Reset Check(s) ® Press (®)
% Choose [BYes # Press (®
Il Save Auto Send is disabled for protected or incomplete messages.

Enlarging Images and SMAF File Images

Il Select an image (or a SMAF file with image) ®» Press » Select
®1Enlarge Display or ®Enlarge Image » Press (®
= Use €39 to view the portion outside Display.
* Images can only be enlarged when ®&7Enlarge Display or € Enlarge Image appears.

» Greeting messages are saved in Inbox. Sender's name and message cannot be
viewed until the specified date and time.

When Mail Box Layout is Set to Folder

Newly received/sent messages and drafts are saved to Main Folder. Messages are

sorted to the specified Mail Folder if set in the sender or recipient's Phone Book

Option Settings (see P.4-17 - 4-18).

@ e To activate Display Backlight, press -@9.

xog |ley h



. Mail Box Contents

Select a Mail Box and press (®). Inbox, Sent or Outbox opens.

¢ To select a different view for Mail Box, see "List" (P.4-23 "Mail Box Menu").

* Press to reply, forward, edit, etc.

Unread/Read (Inbox), Mail Type (Sent/Outbox)

_ Long Mail: &

s Sl Messages other than Long Mail: £
LraK i tayama Kaoru If subscribed to Long Mail, & appears for e-mail
4 oKimura Tetsuya ( 9 , A app
Zr5aCCCRXXX. YYY messages.) )

BeiatotRetko ¢ Indicator color varies by message status:
ZriwKimura = Unread: Red
Erexllr. Yamamoto and - Yell
Ms. Kawahashi, please Protected: Yellow

bring a camera and m Unread Delivery Report: Green
@ tripod to the wedd m Saved as Auto Send: Light blue
ing. | will bring a
@Check eSelect  Menurs

Message Type (see below)

xog [lepy E

@ Incoming Mail... and received text appear for incoming linked messages.

Il Message Type
B Sky Mail (mail to/from Vodafone handsets)
& E-mail (messages sent/received via the Internet)
@ Long Mail with attachments
! Long Mail Notice (Server Mail, initial portion included)
¥ Unretrieved List (Long Mail)
&' BBS Notice
Re Polling (BBS accessed)
& Greeting
! Unsaved Sky Melody
=5 PD Mail (messages sent via mail terminals3)

" Appears only in Inbox. 2Appears only in Sent.

3Mail terminal (e.g. Sky e pad manufactured by SHARP) is a Vodafone accessory.

Connect a Vodafone handset to exchange messages.
l Additional Indicators

% Failed Auto Send Sky Mail
& Failed Auto Send Long Mail

These indicators appear only in Outbox.

. Message Contents

Select a message and press (® to open it.
Sending Priority: see P.6-5

®: By Express (4: Long Mail or Long Mail Notice)
Image Display Size
_ 100%: [, 200%: [Ed
‘55’/521 12:30 —'_Wz_]— Received or Sent Date & Time
P I —
A2Kimura Tetsuya—L Message Number
Sender or Recipient

meeting schedule
r tomorrow has b Phone Book.
postponed. Pleas
me over to confe

rerice room 1 at 11. Message Text

Attachments
¢ Files are attached to the message.

Privacy Level (see P.3-11)
e Lv2 appears for Sky Melodies.

Received, Sent, etc.: Delivery Status (Sent only)
Sent message delivery status (see below)

8l: Report (Sent only)
Delivery Report

"&: Low, = (blue arrow): Normal, & (orange arrow): High,

¢ Number or address appears. Name appears if saved in

Delivery Status Indicators

Received |Message delivered*

Sent Message delivered or sent to e-mail
Delivery failed, or was canceled
(not saved at the Center)

? Message status unknown

X

*Appears when confirming delivery from a message window (see P.4-18) or when
sending messages with Confirm Delivery On (see P.3-5, P.6-2).

Changing Scroll Unit

H Press (&> » Select EMail Box % Press (®) ® Select EdMail Box Settings »

Press (® % Select IlScroll Unit % Press (8 ® Select an option ® Press (®)

xog |ley h
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Using Received Messages
Replying to Messages

Open a message

2 Press (> HETH
3 Select Return Mail or Reply to All and press (®

¢ Use Long Mail to send the same message to up to five recipients at one time.
* Select Reply to All to send the same reply to all recipients (To/Cc). Reply to All may not
appear for some messages.

4 Select Mail Type, original message quote option and press (®
Mail Composition window opens. Recipient is automatically entered.
¢ For Long Mail, subject is entered prefaced with Re.:.

Send the message
To create and send a message, see Step 5 (Step 7 for Sky Mail) and onward on P.3-4.

Forwarding Messages

¢ Messages with Privacy Level 2 or 4 cannot be forwarded.
¢ Long Mail is always forwarded as Long Mail.

Open a message

Press (&> HIYTH

Select Forward and press (®)
Mail Composition window opens.
* For Long Mail, subject is automatically entered prefaced with Fw:.

Select &0 and press (®)

Enter recipients and press (®
¢ Files attached to the original message are automatically attached to forwarded
messages.
To enter recipients, see Step 3 on P.3-4.
When files cannot be attached, select llUnderstood and press (®) to send the
message without the attachment.

6 Press

(3 I N WN =

4-6

Resending Messages

71 Open a message
2 Press IR
3 Select Resend and press (®)
4 Choose [ Yes and press @®

Linked Info

. Saving Linked Info to Phone Book

Linked Info is indicated by a dotted underline. Save a linked phone number, mail
address or URL from within message text or sender's address to Phone Book; use

Linked Info within a message as indicated below:

Phone Number

Numbers, #, #, etc. between 10 and 24 digits, starting with 0.
Numbers, #, #, etc. following TEL: (case insensitive).
Example: TEL:090392XXXX1 (X is any number)

xog |le|\ H

Mail Address

Single-byte alphanumerics and dots, etc., before and after @.
Example: abe@[[].co.jp (Clis any alphanumeric character)

71 Open a message

2 Saving Sender Address

Press (&> H[YTH
H Select Add to Phone Book and press (®)

Saving Linked Info
i Select a phone number or mail address and press (®)
H Select 3 Add to PhoneBook and press (®)

3 select MNew Entry and press (®)

Number or address is entered in corresponding Phone Book field. Complete other fields
and save (see (Basic)P.5-4 - 5-5).

Edit number/address if necessary ® Press (® ® Select an icon ® Press (@) #

Complete other fields and save (see (Basic)P.5-4 - 5-5)
To save to an existing Phone Book entry, select ElNew ltem ® Press (® ® Open a

Phone Book entry (perform Steps 1 - 3 on (Basic)P.5-11) # Select an icon # Press (@ »
Press % Press (@ % Choose [lYes # Press (®
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Using Linked Info

Use numbers (TEL:), addresses or URLs (http://) to place calls, send messages or
access Mobile Internet sites. Available only when number, address or URL is
underlined with a dotted line.

OGRW =

4-8

Press [&), select @Mail Box and press @

Select Il/nbox or B1Sent and press (®
When Mail Box Layout is set to Folder, select appropriate folder » Press (®)

Open a message containing a phone nhumber, mail address or URL
Select a number, address or URL and press

Phone Numbers
Select 3 Call and press (®

Phone number appears.
Press 0

The number is dialed.

Mail Addresses
H Select 3 Send Mail and press (®)
A select @ISend Long Mail or BSend Sky Mail and press (®

To create and send a message, see Step 5 (Step 7 for Sky Mail) and onward on
P.3-4.

URLs

Select 3 Open Link and press (®)
URL appears.
Press (®) again, select IlSend and press (®
Handset connects to the Network.
For more about accessing Mobile Internet sites, see P.7-7.

Protecting Messages

Protect important messages saved in Inbox, Sent or Outbox from unintentional deletion.
¢ Unretrieved List (Long Mail), unread Long Mail Notices and incoming linked messages
are protected and will not be deleted automatically.
* Protect up to 40 messages in Sent. All messages in Inbox and Outbox can be protected.
¢ Protected messages are not deleted from Outbox even after they are sent.

1
2

3

LN

Q@ NOO,

Press [&), select @Mail Box and press @

Select Il/nbox, BSent or E]Outbox and press (®)
When Mail Box Layout is set to Folder, select appropriate folder » Press (®)

Select a message and press <0l
¥l appears.
» Auto Send (light blue indicator) and failed Auto Send (% or Z-) messages are not
selectable.
To uncheck, select a message with ¥ ® Press <0l

Repeat Step 3 and select all the messages to protect
® Select up to 50 messages at one time.

To clear all check marks, press (&> I # Select Reset Check(s) ® Press (® »

Choose IBYes % Press (®

Press (&> HIYTH

Select Protect Message and press (®)
Choose IBOn and press (®

Protected message indicators change to yellow.
To cancel protection, choose E1Off # Press (®

Press &) to exit

xog |le|\ H
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Deleting Messages

. Selecting Messages to Delete

1 Press [, select BMail Box and press ®

2 select Dinbox, BSent or ElOutbox and press (®)
When Mail Box Layout is set to Folder, select appropriate folder ® Press (@)

Deleting a Message
I Select a message and press (2> I
¢ Auto Send (light blue indicator) and failed Auto Send (% or Z-) messages are not
selectable.
H Select Delete and press (®)

Deleting Selected Messages

H Select a message and press <2l

¥l appears.

* Auto Send (light blue indicator) and failed Auto Send (% or Z-) messages are not

selectable.
To uncheck, select a message with ¥ ® Press {8l

Repeat Step ll to select all messages to delete

® Select up to 50 messages at one time.

To clear all check marks, press ® Select Reset Check(s)  Press (®
% Choose [BYes # Press (®

Press (&> H[YTH
B Select Delete and press (®)

4 Choose [l Yes and press @®
5 Press @) to exit

@ Advance Mail (see (BasicJP.12-10) messages must be deleted one by one.

4-10

Delete All

NOO AW Nl

Press [, select EMail Box and press (®)

Select Ilinbox, BlSent or EJOutbox and press [2) T
* To delete all messages in a Mail Folder, select a folder and press [ llenu }

Select Delete All and press (®

Select DSelect All or BRead/Unprotected (BUnprotected for Sent
and Outbox) and press (®

Enter Security Code
Choose [l Yes and press (®
Press @) to exit

@ When Outbox is set to ElUnprotected, Advance Mail (see (Basic]P.12-10), Auto Send

and failed Auto Send messages are not deleted. For [lSelect All, failed Auto Send
messages are not deleted.

Auto Delete

When memory is full, handset cannot receive new messages. Activate Auto Delete
Old to automatically delete oldest received messages to make room for new ones.
Auto Delete Old is Off by default.

RNRWN=
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Press (&), select @Mail Box and press (®
Select EdMail Box Settings and press (®
Select BlAuto Delete Old and press (®)

Choose IBOn and press (®
To cancel, choose BJOff % Press (@)

Press @) to exit

When memory is full, oldest sent messages are automatically deleted to make room for
new ones. To prevent unintentional deletion, protect important messages (see P.4-9).
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Chat Mail Log

Use Chat Mail Log folders to organize messages exchanged between your handset
and up to five addresses per folder. Sent and received messages appear by date,
designated by sender.

Saving Members

e Save up to five members per group (Group 1 - Group 3).
e Same address can be entered in multiple groups.

1 Press [&), select @Mail Box and press @

Select @Chat Mail Log and press (®
Security Code is required when there is a Secret Mode Mail Folder.
When adding members to an existing group, select a group ® Press »
Select Save Member % Press (®) % Skip ahead to Step 5

3 Select a group and press (®)
To change members, select a group ® Press WY & Select Save Member »
Press (® ® Select a number ® Press (8 ® Enter number or address ® Press (@)
To delete a member, select a group ® Press N & Select Save Member »
Press (® ® Select a number % Press % Select Delete » Press (®) &
Choose IBYes % Press (®
To delete all members, select a group % Press » Select Save Member %
Press (® ® Press % Select Delete All % Press (® ® Choose [Yes »

Press (®
Choose IBYes and press (®

Select a number and press (®)

Phone Book
Select @Phone Book and press (®
¢ Changes to Phone Book entries are not reflected in Chat Mail groups. Edit member
addresses directly.
H Open an entry
To search Phone Book, see Steps 2 - 3 on (Basic]P.5-11.

(RS N

Direct Entry
Select ElMobile Number or E\Mail Address and press (®)

Enter recipient's Vodafone handset number or mail address
To open Phone Book, see Steps 1 - 3 on (Basic]P.5-11.

7 Press(®

* Repeat Steps 5 - 7 to add more members.

4-12

8 Press @ to exit

@ Changing members does not affect messages already saved in Chat Mail Log.

Opening Chat Mail Log

Received Sky Mail messages with Privacy Level 2 or higher, Long Mail messages in
Unretrieved List and Greeting messages do not appear in group contents even if the
address is saved.

1 Press [&), select @Mail Box and press @
2 Select @Chat Mail Log and press (®)

Security Code is required when there is a Secret Mode Mail Folder.

To delete all messages, select a group ® Press HETE » Select Delete All Mail »
Press (® ® Choose [BYes # Press (®)

m Messages in Mail Box are not deleted.

Select a group and press (®)
Group opens and contents appear (see below).

xog |le|\ i

. List Contents

Received or Sent Date & Time

——— Sender

e Number or address appears. Name appears if saved in
Phone Book.

e Owner appears for mail sent from handset if Owner Profile
is blank. Owner Profile name appears when set (see
(Basic)P.2-21).

e meet tomorrow?

Message Text

Chat Mail Log Menu

B While Chat Mail Log folder is open, press to reply, forward, etc.
B To open a message, select a message and press (®).

Chat Mail Log.
e Each group holds up to 100 messages. When full, oldest messages are
automatically deleted to make room for new ones.

@ ¢ Deleting a message from Inbox or Sent automatically deletes the same message in
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Mail Folders
Mail Box Layout

From Mail Box Settings, set Layout to Folder or List for Inbox, Sent and Outbox.
Listis set by default (Mail Folders are hidden).

Press [, select BMail Box and press ®
Select EMail Box Settings and press (®)
Select BlLayout and press (®)

Security Code is required when there is a Secret Mode Mail Folder.
Select Iinbox, B1Sent or E]Outbox and press (®)
Select E)Folder and press (®

¢ Follow the same steps to change Layout for each Mail Box.
To hide folders, select IlList % Press (®)

Press @) to exit
Folder Name

From Mail Box Settings, change Layout to Folder for Inbox, Sent or Outbox, then use
Mail Folders to organize messages. Sort messages to one of nine Mail Folders in
Inbox, Sent or Outbox.

¢ Change folder names to customize Mail Folders.

* Main Folder cannot be renamed.

Press [, select BMail Box and press ®

Select EdMail Box Settings and press (®)

Select ElSet Folders and press (®)

Select [l/inbox, BSent or E]Outbox and press (®)
Select @lFolder Name and press (®)

Mail Folders appear.

GQRAWN=
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Select a folder and press (®

Enter name
e Enter up to 18 single-byte characters.

Press (®

* Repeat Steps 6 - 8 to rename other folders.

Press @) to exit

Secret Mode

Security Code is required to open a Secret Mode Mail Folder.
¢ Set Mail Box Layout to Folder to use Secret Mode.
® Main Folder cannot be set to Secret Mode.

© WONOOGRWN=

Press [, select EMail Box and press (®)

Select EdMail Box Settings and press (®)

Select E}Set Folders and press (®)

Select [l/inbox, BSent or E]Outbox and press (®
Select BSecret Mode and press (®)

Enter Security Code

Select a folder and press (®

Choose IBOn and press (®
* Repeat Steps 7 - 8 for other folders.

To cancel, choose BlOff ® Press (@
Press &) to exit

4-15
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Moving Messages

¢ Set Mail Box Layout to Folder before attempting to move messages (see P.4-14).
¢ Unretrieved List (Long Mail) and incoming linked messages cannot be moved; these
messages are saved in Main Folder.

Press [, select BMail Box and press (®)
Select Iinbox, B1Sent or E]Outbox and press (®)
Select a folder and press (®)

Select a message and press <2l
¥l appears.
 Auto Send (light blue indicator) and failed Auto Send (% or Z-) messages are not
selectable.
To uncheck, select a message with ¥ ® Press <0l

AWN=

Repeat Step 4

® Select up to 50 messages at one time.
To clear all check marks, press (&> I » Select Reset Check(s) ® Press (® »
Choose IlYes # Press (®

Press [2) HTTH
Select Move to Folder and press (®)

$)]

Select a folder and press (®)
* Repeat Steps 4 - 8 to move other messages.

Press @) to exit

© WONO
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Sorting to Folders Automatically

. Sorting by Phone Book Entry

Sort messages automatically by phone number or mail address.

When a Phone Book entry contains multiple numbers/addresses, use Set All to apply
settings to all entry items or One Number/Address to designate individual

numbers/addresses.

71 Open a Phone Book entry
To search Phone Book, see Steps 1 - 3 on (Basic)P.5-11.

Press (®

Select Edit and press (®)

Select Option Settings and press (®)
Select @Mail Folder and press (®

Select Il/nbox Auto Sort or BSent Auto Sort and
press (®

All Numbers/Addresses
H Select IISet All and press (®)

Individual Numbers/Addresses
Select BOne Number/Address and press (®)

N OORhWN

(505 il
Ueda Mikio 005
1Friends
B.Bédvén

o il
B)Pattern 1
~)Pattern 2

™ Mail Folder 1
($Mail Folder 2

031230XX3

K Select a Vodafone handset number or a mail address and

press (®
ElChoose IBOn and press (®

Canceling
E Choose EJOff and press (®

8 Selectafolder and press (®
When setting for One Number/Address, press <01 IRTl.

Press <0l twice

For more, see Step 6 and onward on (Basic)P.5-15.

@ * Sent messages are sorted by the first recipient address.

e Individual settings are replaced when Set All is selected and vice versa.

4-17
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. Sorting Messages from Unsaved Numbers or Addresses

Designate a folder to sort messages from numbers or addresses not saved in Phone
Book. Use Designate Folder to filter unsolicited messages (spam).
Designate Folder is Off by default.

Press [&), select @Mail Box and press @
Select EdMail Box Settings and press (®)
Select EDesignate Folder and press (®)

Choose [BOn and press (®
To cancel, choose EOff » Press (8 (Omit the next steps.)

RARWN=

Select a folder and press (®
Press @) to exit

o O

Non-delivery natifications are also sorted to a designated folder.

o

» Messages are not sorted when Phone Book Lock (see (Basic]P.11-3) is active.
¢ Messages from numbers and addresses in Secret Mode Phone Book entries are
not sorted by this function, even if handset is in Secret Mode.

Confirm Delivery & Cancel Delivery

Confirm delivery of Sky Mail and Greeting messages, or cancel Sky Mail delivery.
Use Confirm Delivery or Cancel Delivery for messages sent to compatible Vodafone
handsets.

71 Open a message
¢ Select a message with Sent or 2.

Press (2> HIYTH
Select Confirm Delivery or Cancel Delivery and press (®)
Choose IBYes and press (®

When complete, the Center sends a Delivery Report.

RWN
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Sending from Outbox

Sending a Message

Press [, select BMail Box and press (®)
To check the number of saved messages, select ElOutbox # Press [ Menu |
®m Press to return.

2 Select ElOutbox and press (®
* Light blue indicator appears for Auto Send messages, and % or % appears for failed
Auto Send messages.

3 Select a message and press (®)
Mail Composition window opens.
For Auto Send (light blue indicator) messages, Cancel Auto Send? appears. Choose
D Yes » Press (®
For Failed Auto Send (% or ) messages, Re-save As Auto Send? appears. Select
DSave As Auto Send or BCancel % Press (@)
To edit Outbox messages, select an item # Press (@) # Edit the message
= To save edited messages, press <0l » Select [Save as or BOverwrite »
Press (®

4 Press Send
* Sent messages are deleted from Outbox. To prevent unintentional deletion, protect
important messages (see P.4-9).

@ When sent from Outbox, failed messages remain in both Outbox and Sent.

Send Continuously

Send Long Mail from Outbox continuously.
Up to three messages are sent at one time.

1 Press B, select EMail Box and press (®)
2 Select ElOutbox and press (®

Select a Long Mail message and press <2
¥l appears.
* Auto Send (light blue indicator) and failed Auto Send (X or Z-) messages are not
selectable.
To uncheck, select a message with ¥ % Press <0l

xog |le|\ H
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4 Repeat Step
e Select up to 50 messages at one time.
To clear all check marks, press [2> I # Select Reset Check(s) # Press (®) &
Choose [@Yes # Press (®

Press (& HTH

Select Send Continuously and press (®)
After messages are sent, handset returns to Standby.
* Sent messages are deleted from Outbox. To prevent unintentional deletion, protect
important messages (see P.4-9).
A confirmation appears for unsent messages. Choose [lYes # Press (® (Other
messages are sent.)

o O

Attachments

Saving Attachments to Data Folder

Save attachments (image and sound) to Data Folder.

1 Open a message with at least one attached file

2D Selectafile and press (2> HETH

¢ Select an image in the message.

¢ Files can only be saved when To Data Folder appears.
To open properties, select Property # Press (®)
® Press to return.
To play sound, select ®lPlay ® Press (®
® To adjust volume, press (5) (up) or (Q) (down) during playback.
To change tone or loudness, select Tone or Adjust Loudness % Press (®)
(See (Basic)P.8-12 - 8-13 for more.)

3 Select To Data Folder and press (®)

Press (®
* When memory is full, delete files (see (BasicJP.9-24) and try again.

4-20

Wallpaper & Display Images

Save images as Wallpaper or as Display Images to use them for Power On/Off, Alarm

or incoming calls.

1 Open a message containing images
Select an image and press

* Images can only be used when Save As Wallpaper or To Display Images appears.

To open properties, select &} Property # Press (®)
®m Press to return.

Wallpaper
E Select Save As Wallpaper and press (®)
¢ For E-Animation (NEVA files), omit the next step.
Use {9 to specify display area and press (®)

* Depending on size or type, display area cannot be specified for some images.

¢ Existing image is replaced.

Display Images
E Select To Display Images and press (®)
 E-Animation (NEVA files) cannot be used for Elincoming Call and @Alarm.
¢ Maximum image size:

Power On W 120 x H 130 dots Incoming Call |W 120 x H 38 dots

Power Off W 120 x H 130 dots Alarm W 120 x H 51 dots

H Select an item and press (®
Display Images appear 200% larger.
* For E-Animation (NEVA files), omit the next step.

Use {9 to specify display area and press (®)

* Depending on size or type, display area cannot be specified for some images.

¢ Existing image is replaced.

4-21
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Other Function Mail Box Menu

I Set handset to play attached sound files automatically I I Check sender's address I
Default/ol] Open a Mail Box and select a message ® Press 2> H[ITW # Select
Press [&) » Select EMail Box % Press (®) # Select Show Address or Display Address % Press (®
EdMail Box Settings » Press (®) » Select @Sound Auto Play » « Show/Display Address is not available for Outbox.
Press (® ® Choose [BOn or EOff » Press (®)
I Select a view for Mail Box I
* When more than one sound file is attached, the first file plays.
e Press to stop playback. BEEMRPattern 1
» Depending on file type, sound may not play automatically, or playback starts Open a Mail Box and press » Select List % Press (®) »
when an image is opened. E-Animation (NEVA file) sound may play
automatically even if Sound Auto Play is Off. Selecta pattern % Press @
¢ Setting applies to Inbox, Sent and Outbox.
Mail Box/Message Menu Message Menu
Combining Spllt Mail Images I Copy message text I
Download images attached to Split Mail beforehand. Open a message and press HETE » Select Copy # Press (®) »

Use () to underline the first line of the text block ® Press (® # Use

Press [&), select @Mail Box and press @
to specify text ® Press (®) % Perform from Step 5 on (Bsic)P.4-17

2 Select ulnbox and press @ To change the starting position, press &].
3 Select a Split Mail message and press @ * Text can only be saved when Copy appears.
e Subjects of Split Mail messages are Upper Left, Upper Right, Lower Left and Lower
Right. Check all four messages. I Change font and image size I
Press (&> IR EEEMMedium Font/100%

Select Combine Split Mail and press (®) Open a message and press » Select Display Size % Press
Combined Image appears. (® » Select a size # Press (®

Press @ @ * Press to toggle between Medium Font/200%, Small Font/100%, Small

S Gk

Font/200%, Large Font/100%, Large Font/200% and Medium Font/100%.

(P appears for 100% and [ for 200%.)

* Images may not be combined properly if file names of Split Mail images are * The setting applies to both received and sent messages. It remains even after
changed, or the same file name exists. exiting Mail.

e Combined image may be rough.

¢ Receiving Split Mail costs receiving four Long Mail.

Image is saved to Data Folder and Menu returns.

o
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Unretrieved List
Acquire Mail List

Retrieve a list of messages stored at the Center (Server Mail), then retrieve selected
messages.

1 Press [, select BMail Box and press ®

Select BIMail Request and press (®)
To retrieve all Server Mail, select E)Retrieve All % Press (®) % Choose [BYes #

Press (®

To delete all Server Mail, select ElDelete All Mail % Press (®) % Enter Security Code
% Choose [lYes # Press (®

3 select MAcquire List and press (®
Choose IBYes and press (®

After Unretrieved List is retrieved, Inbox opens.
e When Unretrieved List has already been retrieved, it is refreshed.

Press (®
Unretrieved List (containing sender's name, handset number or address of each Server
Mail) appears.

For details, select a message ® Press (03

®m Press ) to return.

Message and press (9 to see notice from the Server.) To see the rest, retrieve or

@ Server Message appears in the list when there is more Server Mail. (Select Server
delete messages on the list and refresh Unretrieved List.

Retrieving Selected Messages

Retrieve up to three messages at one time.

7 Open Unretrieved List
To retrieve all messages, press [2> X #» Select Retrieve all Mail % Press (®)
(Omit the next steps.)

2D Select a message and press (®
The box is checked.
To uncheck, select a message with ¥ ® Press (@)

Repeat Step 2
Press (&) N

Select Next and press (®
After messages are retrieved, Inbox opens.
¢ Downloaded messages are deleted from Unretrieved List.

Deleting Unretrieved List Messages

Deleted messages cannot be recovered.

KW

71 Open Unretrieved List

2 Deleting Selected Messages

E Select a message and press (®
The box is checked.
To uncheck, select a message with ¥l # Press (®)

Repeat Step
Press (&> HYTH
B Select Delete Item and press (®)

Deleting All Messages
Press (2> HYTH
H Select Delete all Mail and press (®
Enter Security Code

3 Select MDelete and press ®
e Unretrieved List is deleted from Inbox.
To cancel, select BlCancel # Press (®

|le|\ Janies i
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Server Mail

Delete Server Mail directly without downloading it first.

1 Open a message (Long Mail Notice)
e Select a Long Mail message with Ys.

D Press
3 Select Delete Mail and press (®)

@ To delete Long Mail Notice only, select Delete and press (®).

4 Choose dYes and press (®

5-4
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Basic Settings Long Mail Settings

I Select contents or cancel notices for messages received I Additional Settings

during handset use

Press (&> & Select EMail Settings % Press (®) » Select ElMail Notice attaching them to messages (see (Basic)P.6-22)
% Press (® # Select from lIName to @Off % Press (® EEEMION (save image)

Press (&) # Select @Mail Settings # Press (®) #» Select [B2-Touch Mail

BEEMEName I Automatically save new Sha-mail images to Data Folder before I

Request a Delivery Report (see P.2-4) to confirm message
delivery % Press (®) » Select B)Save & Send Image # Press (®) ® Choose
ROt IOn or BOff » Press (®
Press (&> # Select EMail Settings # Press (®) % Select
GEConfirm Delivery % Press (® ® Choose [On or BOff » Press (® I Retrieve complete Long Mail manually or automatically I
@ ¢ Delivery Report is available for: EEMManual
m Sky Mail messages sent to Vodafone handsets . . .
= Groeting mossages Press (2> » Select EMail Settings # Press (® # Select @Auto Retrieve
= L ong Mail messages sent to a single Vodafone handset % Press (® # Select llAuto or B Manual % Press (®)
* To change sg:-ttings for individual messages, see P.3-5. .
*To check dghvery status of Sky Mail or Greeting messages sent without Even when Auto Retrieve is active, Long Mail Notices may appear when signal
Confirm Delivery, see P.4-18. . . .
is weak, etc. When short, complete message may be delivered automatically

. even if Manual is set.
Outbox messages saved as Auto Send when handset is

out-of-range are sent automatically when signal returns

Sky Mail Settings

Press [Z> & Select BMail Settings # Press (® % Select BAuto Send

% Press (® » Choose IlOn or BOff » Press (® PIN Filter
@ Save Auto Send does not appear in Mail Composition window when Auto Send Set PIN to reject incoming messages without the matching PIN. Sender must include
we the same PIN to send mail to your handset. PIN Setting is effective only when PIN
Filter is active.
Save phrases to Custom Fixed Text (No.118 to 127) * PIN Filter cannot be used for Long Mail messages.
e Pin Filter is Off by default.

Saving Text
Press (&> & Select @ X—/LE2E # Press (®) #» Select B1—H—FHY
% Press (® # Select a number ® Press (® # Enter text ® Press (®)
* Enter up to 128 single-byte alphanumerics (126 single-byte katakana or 61 double-byte
characters).
Editing Text
Press (2> & Select @.X—/UZRE # Press (®) # Select Bl1—H—F&Y
% Press (® # Select a number ® Press (®) # Edit text ® Press (®)
To delete text, open an entry and press (Long Press) # Press (®

Press (&), select EMail Settings and press @
Select ElSecurity and press (®)

Select IAPIN Setting and press (®)

Enter a 4-digit PIN and press (®

Select EPIN Filter and press (®)

QRAWN=

other Vodafone handsets, the recipient must have the same Custom Fixed Text

@ When sending Sky Mail or Greeting messages using Custom Fixed Text to
saved under the same number to read the message.
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6 Select a type and press (®

Distandard Standard Sky Mail messages
ElConcatenation | Two or more linked messages
ElPolling Location Info/Polling requests
EE-Mail E-mail messages

*E-mail under 128 bytes is also rejected.

Choose [BOn and press (®

* Repeat Steps 6 - 7 for other types.
To cancel PIN Filter, choose BE)Off % Press (®

8 Press @) to exit

@ Senders of rejected mail are not notified.

Address Filter

Activate Address Filter to reject incoming mail from up to 10 numbers (digits only) or
addresses saved in Reject List.

¢ Address Filter cannot be used for Long Mail messages.

¢ Reject List is effective only when Address Filter is active.

. Saving to Reject List

Press (&), select EMail Settings and press @
Select ElSecurity and press (®)
Select E)Reject List and press (®)

Select a number and press (®)
® Select ===mmm=n==mmz---=- fOr new entry.
To edit entry, select an entry ® Press (@ # Edit % Press (®
To delete entry, select an entry ®» Press (8 ® Press Cz] (Long Press) ® Press (®

Enter a phone number or mail address and press (®
* Enter up to 60 single-byte alphanumerics for mail addresses.
* Repeat Steps 4 - 5 to add more numbers/addresses.

6 Press @ to exit

3)]

. Activating Address Filter

Address Filter is Off by default.

1 Press (&, select @BMail Settings and press (®
2 Select ElSecurity and press (®)
3 Select @Address Filter and press (®)

4 Choose lIOn and press (®
To cancel, choose BJOff # Press (@)

Additional Settings

I Set priority when sending mail I

BEEMENormal
Press (&> » Select EMail Settings » Press (®) # Select EdSet Priority
» Press (® # Select from IlLow to @By Express » Press (®

® To change priority for individual messages, see P.3-11.

By Express messages are delivered faster for additional fees. Other levels
indicate the importance of the message and do not affect delivery speed.

I Save Sender name for Greeting I

Press (&> & Select EMail Settings % Press (®) ® Select ElSender
Press (® ® Enter name # Press (®)
To delete Sender mid-entry, press &= (Long Press) ® Press (@)
¢ Enter up to 12 single-byte alphanumerics (10 single-byte katakana or 3 double-byte
characters).
m Using both single and double-byte characters may reduce character entry limit.

BBS

Save and share BBS messages.

¢ Send Polling request (see P.3-11) to receive BBS messages (Sky Mail option setting).
¢ Save and share Location Info.

sbumes |lep h
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BBS Share messages & Location Info I
BEEMROff
Activating BBS
Press (&> ® Select @Mail Box » Press (® % Select EBBS # Press (®
% Select [BSettings # Press (® #» Choose llOn # Press (® # Select
DIMessage or BlLocation Info » Press (®)
Enter Code appears for BlLocation Info. Enter Security Code ® Choose Ml Yes »
Press (®

Canceling BBS
Press (2> » Select @Mail Box » Press (® % Select EBBS # Press (®

% Select IBSettings » Press (® » Choose BOff % Press ()

e Saved messages remain even after BBS is canceled. Reactivate BBS to use.
¢ Set PIN to restrict message access (see P.6-3).

SEVG e ESEER [ Save messages & Location Info I

Saving Messages
Press (&> » Select @Mail Box # Press (® % Select @BBS # Press (®)
» Select ElNew Message » Press (®) ® Enter message # Press (®)
To delete the message mid-entry, press & (Long Press) ® Press (@)
¢ Activate BBS to share the message.

o TR — %7 U appears by default.
e Enter up to 128 single-byte alphanumerics (126 single-byte katakana or 61 double-byte

characters).
m Using both single and double-byte characters may reduce character entry limit.

Saving Location Info
Press (2> » Select @Mail Box » Press (® % Select EBBS # Press (®
» Select ElLocation Info » Press (® # Enter Security Code # The
latest information appears # Press (2]
To update opened Location Info, press ® Press (®
¢ Activate BBS to share the message.

Resetting Mail & Access Points

Il When BBS is accessed, handset receives a Polling message.
To open Polling messages, press ® Select EMail Box » Press (® »
Select Ilinbox % Press (® » Select a message with Re ® Press (@

6-6

Reset Mail settings
Refer to P.16-2 for the settings affected by Reset

Press [&> #» Select EMail Settings # Press (®) # Select EReset »
Press (®) ® Enter Security Code # Select IDReset » Press (®) %
Select MOK or BCancel  Press (®

Delete All Delete all sent/received mail messages at one time I

Press [&> #» Select EMail Settings # Press (®) # Select EReset »
Press (® ® Enter Security Code # Select BDelete All % Press (® %
Select [ISelect All or BRead/Sent Only % Press (® % Select OK
or BlCancel # Press (®)

* Messages are deleted as follows:

Dselect Al Delete all Inbox, Sent and Outbox messages, except for saved or failed
Auto Send messages
BE)Read/Sent Only | Delete all unprotected read Inbox and Sent messages

\elesii 2l Set Mail Center Address or Server Address I

MM Short Message: ¥7032, Data Access: ¥7132, Long Mail Line: ¥7042, Server Address: 5000
Center Address
Press » Select EMail Settings % Press (® # Select
EdAccess Points % Press (® # Enter Security Code #» Select
BlCenter Address » Select from [lShort Message to ElLong Mail
Line % Enter Center Address # Press (®
Server Address
Press » Select EMail Settings % Press (®) % Select
EdAccess Points % Press (® % Enter Security Code # Select
D Server Address % Press (® % Select IBServer Address or BSub
Address % Press (®) ® Enter Server Address or Sub Address &

Press (®

Do not change Center Address or Server Address unless instructed to do so.
Otherwise, access to the service will be disabled.

6-7
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Getting Started

Use Web (Vodafone Web) to access the Mobile Internet directly from handset.

Browse for image or sound files as well as information.

¢ An additional contract is required to use Web service.

¢ Address questions about Vodafone Web to Vodafone Customer Center, General
Information (see P.16-15).

. Web Info Content ‘

Sample Web information page: [ a—

« Press 9! to see the previous page. From that | g2 12:69—g=— Download
page, press then toreturntothe [=2—Z (&) | Date & Time
initial page. o

e For details, see P.7-8 "Basic Operations." P AU AN

* When there is more than one item with the same title in %%gi@%ﬁgéﬁaé Content
Message Folder (Overwrite Type), the most recent item A ADBHE. —FEE
appears first. To see the next saved item, press ?g*ﬁé/v(aﬂw@:

WIS, select Next and press (®).

There are four types of Web information. They can be identified by the indicators
below. Information is saved differently according to type.

= Overwrite Type (temporarily saved information)
R} Storage Type (saved information)
5 Work Type (unsaved information)

No Indicator Vodafone Web Menu

Enlarging Images and SMAF File Images

M Select an image (or a SMAF file with image) ® Press (® ® Select Enlarge
Display (or Enlarge Image) » Press (®
¢ Images can only be enlarged when Enlarge Display or Enlarge Image appears.

* Use & to view the portion outside Display.

@ Handset returns to Standby after 20 minutes of inactivity.

B overwrite Type

Overwrite Type information is saved temporarily in Message Folder.

Up to five titles are saved, and up to three information items are saved under each
title. When full, oldest items are deleted to make room for new ones.

iR A |8 Jc|DJE (AlBJc]DJE |

Info with the same title is
added to the list.

Three info items can be
saved under each title.

(B JCc|DJEJF ] (AlBJc]DJE |

Oldest title (Title A) and its
contents are deleted to make
room for new ones.

When full, oldest info (D1)
is deleted.

Overwrite Type information is similar to data saved in cache memory of a Web
browser on a PC. Content remains even after handset power is turned off.

solseg qop i
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. Storage Type ‘

Storage Type information is saved in Message Folder until it is deleted manually.

Approximately 375 KB is shared between Inbox (Mail), Storage Type (Web) and

Saved Information (Station). (Saving large files reduces the number of items that can

be saved.)

¢ Overwrite Type and Work Type information can be changed to Storage Type (see P.8-2).

e Storage Type information is similar to files stored on a computer hard disk or floppy disk.
Content remains even after handset power is turned off.

e Memory Status: see P.1-5

. Work Type ‘

Work Type information is not saved in Message Folder.
To change Work Type information to Storage Type, see P.8-2.

Vodafone Web Menu

M Vodafone Web Menus are saved temporarily. New Menu replaces old. Temporarily
saved Menus remain even after handset power is turned off.
Il Vodafone Web Menus cannot be saved to Message Folder.

Using Web

Use Web to access the Mobile Internet for information as well as image, sound and
other files.

Opening Vodafone Web Menu

Access Mobile Internet sites by selecting a topic from Vodafone Web Menu.
Address questions about Vodafone Web to Vodafone Customer Center, General
Information (see P.16-15).

1 Press <@J, select IBVodafone Web and press (®)
Vodafone Web Menu opens.
* Vodafone Web Menu content is subject to change.
Alternatively, press (Long Press) in Standby # Select EWeb # Press (@) »
Select [BVodafone Web # Press (@)

2 Highlight a menu item and press (®
* Handset remains connected to the Network even if it is closed.
To disconnect, press &=].

3 Repeat Step 2 to open additional links
Basic Operations: see P.7-8

4 Press @ to exit Web

7-6

e Temporarily saved Information and Vodafone Web Menus may open without
connecting to the Network.

e While information appears, press for 1+ seconds to activate or cancel Manner
Mode.

Entering URLs Directly

Enter URLSs directly to access Mobile Internet sites.

Press <@J, select @Internet and press (®
Select @New and press (®

Enter URL
To copy from Phone Book, press (2> HIEM # Press <0l » Open a Phone
Book entry (see Steps 2 - 3 on (B=sic)P.5-11) » Select an item # Press (@) twice

Press (®)
To edit URL, press 2z] # Edit URL # Press (@

Select [lSend and press (®)

Handset connects to the Network.

Press @) to exit

O O K WN =

@ Some sites may not be accessed. Images, layouts, etc. may not appear the same as
on PCs.

B Using URL Log
Access Mobile Internet sites using previously entered URLs. Up to 30 URLs are
saved. When log memory is full, oldest URLs are deleted to make room for new ones.

Press <@J, select @Internet and press (®

Select a URL and press (®
e Shortcut: Select a URL and press

Press (®

Select [lSend and press (®)
To edit URL, select BJEdit % Press (® % Edit URL ® Press (®)
To delete log, select ElDelete # Press (8) » Choose [Yes # Press (®

RNRW N
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Basic Operations

B Moving Cursor |
Move cursor to select items. Selectable items are underlined with a dotted line.
Use ({) to scroll through items.

15:05 15:05 s
9/22 12:00 9/22 12:00 9/22 12:00
—a1—R Z—a1—RX Za1—X

soiseg oM ’

of e

Use ¢09 to move left and right when multiple items are listed in one row.
Cursor does not appear when there are no selectable items.

. Scrolling Pages

Triangular indicators appear at the top when information Scroll Right
continues outside the current window. Use €9 to scroll. Scroll Up

Scroll Down
Scroll Left

. Text Entry & Item Selection

Enter text or select items to send information.

Text Entry Field

« Highlight "] and press (®). Text entry window opens.
Enter text and press (®).

Check-box

« Highlight O (check-box) and press (®). The box changes
¥, indicating that the item is selected.

¢ In addition to [0, O may also appear as selection
indicators.

RO —

HIEFL .

5k _I—Menu List

%’i\ﬂl * Highlight the field and press (®) to select an item.
e —Command Button

¢ Use to send, reset, etc.

« Highlight "] and press (®) to execute the indicated
command.

to

Input Memory

applications.
W Up to five entries are saved. When full, oldest entries are deleted to make room for

new ones.

Using Input Memory

Select Binput Memory % Press (® % Select an entry ® Press (®

Il Entered text is saved to Input Memory, except Security Code. Use saved text in other

H In a text entry window, press % Select E& Saved Info » Press (®) »

solseg qop i
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Auto Delivery Service

Register with Auto Delivery Service to receive update notifications and other
information on handset. Use the notification to access the information provider or

Mobile Internet sites to download more information.

Register from Mobile Internet sites that support Auto Delivery Service.

Delivered information is automatically saved to Message Folder.

1 When new information arrives, animation plays

and Delivery Notice appears

& appears.

* When handset is closed, Il appears on Sub Display. Open
handset to see Delivery Notice.

2 Press@®

Information appears (and is deleted from Unread Messages).

15:05 d ﬂﬂ

9/22[Thu] 12:00

New Information

Delivery Notice

Ring Tone Volume

Il While handset is ringing, press (5) (up) or (Q) (down).
* Ring Tone Level setting (see (Basic)P.8-2) changes accordingly.
« Cancel Manner Mode (see (Basic)P.3-3) to adjust the level.

In Standby

H Press to instantly mute incoming information tone for that information only.

H Press @l & Select EUnread Messages % Press (®) # Select a title  Press (®
* Once read, information appears in EMessage Folder (see P.8-3).

e |f information is received during an operation, Delivery Notice may not appear.
e When Screen Savers is active (see P.9-3), new information appears automatically.
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Opening Saved Info & Links

Overwrite Type information is saved to Message Folder automatically.

Favorites, Storage Type & Bookmarks

Save frequently used information/URLs to Favorites, Storage Type or Bookmarks.

Function Description Moving Title | Adding Icon | Editing Title 1 Press (0l
Favorites Save Mobile Internet site content. Available Available N/A Favorites
Handset does not connect to the .
Storage TYPe |y ok 1o open saved information N/A N/A N/A Select BlFavorites and press (®)
- P : — To rearrange the list, select a title % Press (2> I # Select @Move % Press (®)
Bookmark ﬁavtej Imtks . Mo’(bllte l’[rl?ltewett Sltist. N/A N/A Availabl * Use <@ o move the fitle % Press @
ookmarks aca;esssethcgr;ir;zc s to the Network to vailable H Select a title and press @
. To remove information from Favorites, press (2> MM » Select Save % Press (@)

% Select @Cancel Favorite % Press (@)

¢ Save information of some interest to Storage Type and save frequently used information
® [nformation deleted from Favorites appears in Storage Type.

to Favorites.
e Information in Favorites is saved as Storage Type.
e Sharp's Space Town Mobile Internet site (Japanese Only) is bookmarked by default. Visit Message Folder
Space Town for various downloads such as Wallpapers, games and Dictionary files. i Select G Message Folder and press (®)
To open folder status, select information type ® Press [ llenu |

Saving Information & URLs HsSelect IIStorage Type or BOverwrite Type and press (®
ElSelect a title and press (®

Seinjea paouBAPY

e Save up to 30 links in Bookmarks.

e For Storage Type memory, see P.16-11. Bookmarks
1 Open information and press (&> HIEMH H Select E\Bookmarks and press (®
« Information can only be saved when Save appears. HSelect a title and press
2 Select Save and press (®) Overwrite Type information is saved to Message Folder by title. When more than one
¢ Available destinations appear. item shares the same title, the number of titles may not correspond to the number of

items.

3 Favorites & Storage Type

HE Select Save to Favorites or Save to Accumulate and press (®)
Information returns. (Bl appears for information saved to Favorites, and 41 for
Storage Type.)

Bookmarks
E Select Save to Bookmarks and press (®)
Press (®



Editing & Deleting Using Linked Info

Use numbers, addresses or URLs (http://) to place calls, send messages or access
Mobile Internet sites.

¢ Available only when number, address or URL is underlined with a dotted line.
¢ Words may be substituted for the numbers, addresses and URLs.

B Editing Titles
1 Press @l

SeINjea PodUBAPY a

2

Adding Icons (Favorites)
Select E)Favorites and press (®
H Select a title and press (2> HITHE

To delete icon, select E]Delete Icon # Press (@) % Choose [BYes # Press (®
Select ElSelect Icon and press (®)

Press (@l to open more icons.

Use ¢}» to select icon and press (®

Editing Titles (Bookmarks)
Select ElBookmarks and press ()
H Select a title and press (®)
Kl Select BEdit and press (®)
Edit title and press (®

Deleting Entries

N B

OOh W

Press (@l

Favorites

Select BFavorites and press (®
To delete all entries, press % Select MDelete All % Press (®) &
Enter Security Code ® Skip ahead to Step 6

Message Folder

H Select BMessage Folder and press (®
To delete all entries, select information type ® Press I » Select
BlDelete All % Press (® % Enter Security Code ® Skip ahead to Step 6

Select IAStorage Type or BOverwrite Type and press (®)

Bookmarks
Select ElBookmarks and press (®)

Select a title and press (®
® For Bookmarks, skip ahead to Step 5.

Press [&> N[N
Select Delete or ElDelete and press (®)
Choose [ Yes and press (®

1 Open information containing a phone number, mail address or URL

Phone Numbers
EHHighlight a number and press (®)
H Select Dial and press (®

The number is dialed.

Mail Addresses
HHighlight an address and press (®
Select Send and press (®
Select IlSend Long Mail or ElSend Sky Mail and press (®)
Creating & Sending a Message: see P.3-3

URLs
HHighlight a URL and press (®)

Handset connects to the Network.

Saving to Phone Book

B To save as new entry, open information and follow these steps.
Select a phone number or mail address ® Press (®) ® Select Save » Press (®)
% Select INew Entry % Press (®) % See (Basic)P.5-4 - 5-5 for more about Phone
Book

B To save as new item, open information and follow these steps.
Select a phone number or mail address #» Press (® & Select Save # Press (®)
» Select ElNew ltem ® Press (® % Select an entry (see (Basic)P.5-13) ® Press (@)
» See (Basic)P.5-4 - 5-5 for more about Phone Book

Images

Saving to Data Folder

Download and save images from Mobile Internet sites to Data Folder. Some images
may not be saved due to size or other factors.

1 Open information

8-5
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2 Select an image and press (®

* Images can only be saved when To Data Folder appears.
To open properties, select &} Property ® Press (®)
= Press to return.

Select &' To Data Folder and press (®)
Press (®)

R W

* When memory is full, delete files (see (Basic)P.9-24) and try again.

Use ¢ to specify display area and press (®
* Depending on size or type, display area cannot be specified for some images.
¢ Existing image is replaced.

Melody Files

Linked Images

B From Menu, select To Link Address and press (®) to jump to the linked site.

Wallpaper & Display Images

Save images as Wallpaper or as Display Images to use them for Power On/Off, Alarm

or incoming calls.

* Some images may be too large to use as Wallpaper or Display Images.

¢ Image files saved as Wallpaper or Display Images are not saved to Data Folder.

71 Open information

Select an image and press (®
® Selected image is outlined in blue.
* Images can only be used when Save As Wallpaper or
To Display Images appears.
To open properties, select &} Property ® Press (®)
® Press to return.

Wallpaper
E Select Save As Wallpaper and press (®)
¢ For E-Animation (NEVA files), omit the next step.

Display Images
E Select To Display Images and press (®

15:05
9/22 12:00
45
AP EAED= v A
<ATY,

 E-Animation (NEVA) cannot be used for Ellncoming Call and EAlarm.

¢ Maximum image size:

Playing Sound Files

71 Open information

Select a sound file and press (®
To change tone or loudness, select Tone or Adjust Loudness % Press @
(See (gasic)P.8-12 - 8-13 for more.)
To open properties, select € Property ® Press @
® Press to return.

Select @ Play and press (®)
The sound plays.
Press (@l to stop playback.
To adjust volume, press (&) (up) or () (down) during playback.

Seinjea paouBAPY H

Linked Sounds

B From Menu, select To Link Address and press (® to jump to the linked site.

Power On W 120 x H 130 dots |Incoming Call

W 120 x H 38 dots

Power Off W 120 x H 130 dots | Alarm

W 120 x H 51 dots

H Select an item and press (®
Display Images appear 200% larger.
* For E-Animation (NEVA files), omit the next step.

8-6

Saving to Data Folder

71 Open information
2 Select a sound file and press (®
3 Select € To Data Folder and press (®)

* Files can only be saved when ¥ To Data Folder appears.
To attach to mail, select ®1Copy # Press (® # Perform from Step 3 in "Attaching Mail &
Web Files" on P.3-9

4 Press(@®

* When memory is full, delete files (see (Basic)P.9-24) and try again.
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Dictionary Files

Refer to (Basic]P.4-15 "V302SH Download Dictionary" for the handling of Dictionary files.

Check the title and version of the file.

Open information
« [E] indicates Dictionary files.

Select a file and press (®

[7l To download and activate dictionary, select Save Dictionary % Press (®) ®» Select a
number ® Press (@)
u To replace the current dictionary, choose [l Yes # Press (®)

[ To open properties, select Property ® Press @
u Press &7 to return.

N

Select Show and press (®

Title and version appear.

Open information
« [E] indicates Dictionary files.

Select a file and press (®
Select Save to Library and press (®

¢ Files can only be saved when Save to Library appears.

Press (®

Select a number and press (®)
[ When overwriting, choose [lYes ® Press (®

O QN =
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File Organization

Handset has two storage areas. Files are automatically sorted into Memory by function
and into File Cabinet by file format. Handset File Cabinet capacity is approximately 8 MB.

Handset Memory Structure

.....................

~

Memory
Phone Book

Schedule
Text Memo
Mail Box
Bookmarks
Message Folder

Saved Information

....................

File Cabinet

Data Folder

Camera
(Shortcut)

Images
Melodies

Animation
Burst Shots

V-Appli Library
Camera

Action Snap Folder

Voice Folder

File Cabinet Memory Status
To check memory usage status, press (®) # Select My Files » Press (®) »

Save files created/obtained using
assorted handset functions.
Memory capacity varies by
function.

Files are sorted into folders by file
format. File Cabinet capacity is
fixed and shared by all folders.

Select ElMemory Status » Press ®

Data Folder

Contents

Files created or obtained via Web or Sky/Long Mail are organized in separate folders

according to file format. Files are sorted as follows:

Mobile Camera Data
Data Folder ¢ Shortcut to still and video images captured in Sha-mail,
Camera Wallpaper, Camera or Action Snap mode
(Shortcut)
Images ——— Image Files including Still Images
Melodies —+—— Melody Files such as Original Ring Tones
Animation ——— Animation Files
Burst Shots —t—— Burst Shot Files

Create QR Codes from image/melody files in Data Folder (see P.12-27).

Window Description

To open Data Folder from Standby, follow these steps.

Press (®) » Select My Files » Press (®) » Select Data Folder i
D Data Folder % Press (® Data Folder
HCamera
&1 mages
Millelodies
EAnimation
W§Burst Shots
o (pen | Menurs
Data Folder
B File View
Open a folder to view files.
e Example: Images folder
* To customize the appearance of File View, see P.9-5 "Display Settings."
M File View (List)
Format, Name and Size (of selected image)
Saved Files
e Icons appear for files other than images or images not
supported by handset.
9-3
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B File View (List File Names)

File Size

Folder Name

@ To view folders first, select Thumbnails or File Listin Display Settings for Images,

Animation or Burst Shots folder (see P.9-5).

lcons

Saved Files (format and file name)

B stillimage & Animation Files

(JPEG, PNG, or PNG/JPEG Animation)

Icon Format Description
[ P :
(P: white) PNG PNG image
[P} .
(P: purple) Transparent PNG Transparent PNG image
[} JPEG JPEG image
Burst Shot (consisting of Index Image and )
B 4,9, or 25 frames) Burst Mode image
(E: white) E-Animation (NEVA files) Animation (may include sound)
(E: Yellow) E-Animation (NEVA files) with jump buttons | Animation (may include sound)
B Animation Animation

*Blue icon: forwardable, red icon: unforwardable

e Unforwardable files cannot be edited, combined, attached to Long Mail, converted to QR

Codes or sent via infrared.

* A yellow triangle appears (ffl) on icons of the files used in Phone Book, Useful Diary or

Schedule entries.

. Sound Files

Icon Format Description

B SMAF Melon via ng or Long Mail
(may include images)

) Melody Melody via Web or Long Mail
Melody downloaded from Sky

B

Sky Melody Melody Center (unforwardable).

m Original Ring Tone Original melody (forwardable)

i Voice Voice/sound you recorded
(forwardable)

*Blue icon: forwardable, red icon: unforwardable

¢ Unforwardable files cannot be edited, combined, attached to Long Mail, converted to QR
Codes or sent via infrared.

* A yellow triangle appears () on icons of the files set for Ring Tones, Alarm, etc.

Display Settings

Customize appearance of each folder in Data Folder.

Setting Description
List' Thumbnails appear
List File Names®  |File names appear
Thumbnails' Sub folders appear (thumbnails appear within)
File List® Sub folders appear (file names appear within)
"Not available for Melodies folder.

2Appears as List for Melodies folder.
3Appears as Folder for Melodies folder.

m > My Files % Data Folder

1 Select afolder and press (2> HIETH

2 Select @Display Settings and press (®)
3 Enter Security Code

4 Select a type and press (®

In this manual, most operations are described with Data Folder appearance set to
List. Operations may differ if folders are set to appear.
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Opening Files

Handset Data Folder

index e LTI

1 Select @l Data Folder and press (®
2 Select a folder and press (®

Thumbnails or file names appear (see P.9-3 "File View").

3 Select afile and press O]
The content plays or appears.
® Press to open or play the next file, and press to open or

play the previous one. (Available in most cases.) ‘ 4
@Sha-nail @ Show | Menurs

File View
(Images Folder)

A

Opening Burst Shot Files
Index Image appears. Use ¢ to view single frames.
JPEG Images Exceeding W 240 x H 320 Dots

Images are reduced to fit Display. To restore the original size, press (&> TN,
select Original Size and press (®).

4 Press &7 to return to File View

E-Animation Files with Jump Buttons

Il Some E-Animation files contain jump buttons with which to access the Mobile
Internet or open linked images. Follow these steps to use the buttons.
Open an E-Animation file and press » Select E-Animation Mode
® Press (®
e Click buttons on screen for operations.

@ Exchange files via infrared with compatible devices (seeP.10-2).

9-6

Sending Files via Long Mail
Attach files to Long Mail from Data Folder.

m » My Files % Data Folder % Open a folder

1 Selecta file and press

Select Attachment and press (®)
For large JPEG image, select IBAttach 1/4 Size, B Attach Original or E)Attach Split Mail
P Press (®
For Melody files or Original Ring Tones, select a file format (see (OJP.3-8) ® Press (®

Complete other fields and send Long Mail (see Step 2 and onward

on (O JP.3-3)

Sending Burst Shot Images

H Press (® » Select My Files % Press (® % Select [lData Folder » Press (® »
Select Burst Shots % Press (®) # Select a file ® Press (® ® Select an image
with ¢ & Press % Select @Attach Screen % Press (® % Perform
from Step 2 on (O JP.3-3

Sending Split Images

B To split an image (240 x 320 dots) into four frames and attach to Long Mail, follow
these steps.
Press (® # Select My Files % Press (® % Select [lData Folder » Press (®)
® Select a folder % Press (®) ® Select an image ® Press »
Select Attachment % Press (® » Select E)Attach Split Mail % Press (@) »
Select or enter recipient % Choose [l Yes # Press (® (See Step 3 and
onward in "Send Continuously" on (O JP.4-19.)

M Split Mail transmission charges are equivalent to sending four Long Mail messages.
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Properties . Creating Simple Animation ‘
m » My Files m P Functions ® Settings 2 % Animation % Simple Animation % New|
1 Open Data Folder or a folder within it, and select a folder or file 1 Enter title and press (®
* Enter up to 32 single-byte characters. Title is mandatory.
2 Press [ Nenu | o Files are saved by title by default; change file names later (see P.9-23).
3 Selgct Property and press (®) 2 Select tempo and press @
Details appear. In animation, images appear in numerical order at the tempo. lsﬁi""?pm MefinEiien

« Press () to scroll down.

« ltem Descriptions File Neme[Easy-goin]

Tempo[Slightly Slow]

Title' Melody file name —
Type File/folder type
Location File/folder location
File Size Data Size
Memory Used File size on handset
| number and pr
Width x Length2 Image size in dots 3 Select a number and press @
OK: can be copied within Data Folder 4 Select an image in Data Folder and press (®
Copy/Fwd . . ;
Invalid: not supported For operations in Data Folder, see P.9-6.
S OK: can be saved To use a 4-Burst Shot (all frames), select a Burst Shot file # Press (@) # Select
ave Invalid: not supported D Animate Burst File % Press (®)
OK: can be transferred to external device ®» Animate Burst File is available only when [ is selected in Step 3 with no other
Transfer Invalid: not supported images specified. Burst Shot files of 240 x 320 dots are not available.
Phone Book (Photo)3 Yes: set for Photo setting To use a Burst Shot framg, select g Burst Shot file # Press (®) ® Select BlChoose One
o Ves: set for Ring Tones. Alarm. etc » Press (8 ® Select an image with €03 ® Proceed to Step 5
9 — 9 — - To start over from selecting an image in Data Folder, press [ Change |
Set Useful Diary’ Yes: set for Useful Diary To start over from Step 3, press <0 IEZNA.
Schedule Memo® Yes: set for Schedule
" Appears for files in Melodies folder. 5 Press @ -
2Appears for JPEG/PNG/Burst Shot images, etc. The image is set. Simple Animation
To play animation, press (2> [[ITH » Select 4

3 . . . . .
Number of entries for which the file is used also appears. File Name[Easy-goin]

D Animation Playback % Press (®) Tempo[Slightly Slow]
21_11-08
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: H H m To return, press <@l % Press &7
An I matlon FI Ie To change images, select one » Press » Select
BlChange # Press (® # Start over from Step 4
S|mp|e Animation To delete images, select one % Press » Select

BElDelete # Press (@ % Choose [BYes # Press (®
Select up to four images to create Simple Animation. Images appear one after another

at the selected tempo. 6 Repeat Steps 3- 5 to add images
¢ Use JPEG images captured with mobile camera or obtained via Web/Long Mail. * Select up to four images.
¢ Simple Animation files are saved to Animation folder. However, those made of a single 7 Press @ when finished
Image are saveq o Images fqlder. To send animation via Long Mail, select ElAttachment % Press () » Perform from
* When memory is full, delete files to free some space (see P.9-24). Step 2 on (OJP.3-3
* Image quality may change when used for animation. ® For large animation, choose IlYes ® Press @® (File may be too large to be attached

even if the size is reduced.)

8 Select [lSave and press (®
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B Editing Animation | Setting Image & Animation as Wallpaper

When memory is full, delete files to free some space (see P.9-24). Save As Wallpaper can be selected only for compatible files.
m P> Functions % Settings 2 % Animation % Simple Animation % Edit | m > My Files ® Data Folder % Open a folder % Open a file % Menu (£) |
1 Select animation and press (® Images

2 Edittitle and press (® H Select BDisplay Setting and press (®

HSelect IISave As Wallpaper and press (®)
3 Select tempo and press (®)

To add images, select a number ® Press (8 # Select an image # Press (®) twice Animation
To change images, select a number ® Press » Select BChange # Press (® Select Save As Wallpaper and press (®)
» Select an image ® Press (®) twice Press (®)
To delete images, select a number # Press ® Select ElDelete # Press (®) . . . .
* Choose MYes # Press ® Setting Image & Animation as Display Images
4 When finished editing, press @l To Display Images can be selected only for compatible files.
5 select @Save and press ® EXEXEY > My Files ® Data Folder % Open a folder % Open a file % Menu (&) |
6 Select @INew Entry and press (®) 1 Images
The animation is saved to Data Folder (Animation). K Select EDisplay Setting and press @
To overwrite, select ElOverwrite  Press (®) Select ETO Display Images and press @
9N Opening Animation Files Animation
il Select To Display Images and press
m P> My Files % Data Folder a piay g P O

2 Select an item and press (®

For more, see Step 4 and onward on P.7-5.

1 Select a folder and press (®)
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Select anlmgthn file and press (® Saving Burst Shot |mages
The selected animation plays.
Press <0l to stop. Save all frames and Index Image of a Burst Shot file () as individual images at one
To use animation files, see below. time, or select a single image to save.
= . . Individual Burst Shot images are saved to Data Folder (Images) in JPEG format.
Using Images & Animation (Source file remains.)
Some images may not be used. m P> My Files % Data Folder % Burst Shots ® Open a Burst Shot file
Chanainqg Display Size 1 Saving All Images Individually
ging play HPress (2> HIETR
1 Open afile and press H Select ESave Single Frames and press (®)
Display size toggles between 100% (with indicators), 100% (no indicators), Enlarged (with ) )
indicators) and Enlarged (no indicators). Saving a Single Image
* Size may not be changed or size options may vary depending on the file. When enlarged, Kl Select a frame or Index Image with and press [ Menu |
the entire image may not appear on Display. H Select [E)Save Screen and press

o [&: 100%, EJ: Enlarged

9-10 9-11
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Slide Show

Allimages in Data Folder (Images, Animation or Burst Shots) or Camera folder appear

sequentially. Adjust Slide Show speed.

IEEAE > My Files » Data Folder % Open a folder
1 Select an image and press

2 Wslide Show and press (®

Select IBSlide Show and press (®

Slide Show starts from the selected image.
To stop Slide Show, press (®).
= To resume, press (®).
To skip images manually, press [ llext |

Setting Interval

M Interval is Standard by default. To change interval, follow these steps.
After Step 2 above, select ElDisplay Speed % Press (®) # Select an interval

» Press (®

Editing Images

Enlarging/Reducing Image

» My Files % Data Folder % Open a folder & Open a file %
Menu (&>) % Image Size

Select IAEnlarge/Reduce and press (®)
* If Move does not appear at the lower left, press <0l (TRYER.
* Shortcut: From Data Folder, open an image and press <0l

9-12

To Center the Point to Enlarge

* Press <0l and use ¢$9 to move the point to the center of Display.

* Image stops when you release the key or the limit is reached.
To Return to Resize Mode

Press <l [B¥EA.

2 Press and hold (%) to enlarge and () to reduce
the size
To stop resizing, release the key (stops automatically when the
limit is reached).
To soften images, press [ Soft B

¢ Portions outside Display are cut when saved.
* When <@l is pressed after resizing, image
returns to the original size.

Press (®

Resized image is saved as a new entry.

Changing Image Size

@llove oSave Softm

Resize images in Data Folder to send via Long Mail or set as Wallpapers.
* Alternatively, crop image for size. File size changes when images are resized.

¢ Images may not appear depending on the size.
® Change Image Size can be selected only for compatible files.

. Resize to Preset Size

» My Files ® Data Folder % Open a folder ® Open a file % Menu (&)
» Image Size % Change Image Size

Select from llWallpaper to B Alarm and press (®

A rectangle appears on the image (except for lBWallpaper.)

Wallpaper W 240 x H 320 dots
Sha-mail Size W 120 x H 160 dots
Power On/Off W 120 x H 130 dots
Incoming Call W 120 x H 38 dots
Alarm W 120 x H 51 dots

To start over from selecting preset size, press &=] or (2> INETE.

@Resize 0K  Sizer
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2 Selecting Display Area 2 Entering Text
Use ¢$» to specify display area and press (®) H Select Character and press (®
¢ Display area may not be specified depending on image size. Enter text and press @
¢ Enter up to 16 single-byte characters.

Enlarge or Reduce To reenter text, press <@l % Start over from Step 1

Press @ Press - to change the color and to toggle Border On and Off.
Move appears in the left bottom corner. .
Press (©) to enlarge and (Q) to reduce the size, and press (® Adding Stamps
H Select a stamp and press (®
Press_ ® To change stamp, press <@l
Image is saved as a new entry. Press - to change the color and to toggle Border On and Off.

. Cropping Images \ Use ¢¥ to move text or stamp to target location and press (®

R W

D My Files ® Data Folder % Open a folder % Open a file % Menu (&) Choose DYes and press (®
» Image Size ® Change Image Size To add more text or stamp, select ElMarking » Press (® % Press (&> IR &
Repeat Steps 2 - 4
1 Select (3Cut and press ® To check the image, select ElCheck Image # Press (®)
To cancel editing, select @Cancel Edit % Press (8 » Choose [#Yes % Press (®
2 Use 9 to move + to the upper left corner of the
portion to crop and press (®) 5 Select IComplete and press (®)
3 Use ¢ to move + to the lower right corner of the 6 Choose DYes and press (®

Image is saved as a new entry.

portion
To cancel, press <@l ® Start over from Step 2 Visual Effects
4 Press Dress up images with preloaded visual effects.

To start over from selecting preset size, press &= or (2> INEZE.
To adjust display area/scale, see Step 2 in "Resize to Preset

¢ Apply to JPEG images including Burst Shot files.
* Use images between W 52 x H 52 and W 240 x H 320 dots. Images larger than

Size" above. W 240 x H 320 dots are automatically cropped and centered.
5 Press @ twice * Blimage Decoration or ElBurst Shot Effects can be selected only for compatible files.
Image is saved as a new entry. BN > My Files # Data Folder ® Open a folder % Open a file # Menu () |
Marker Stamp 1 Select @Picture Effect and press (®

To decorate Burst Shot images, select ElBurst Shot Effects % Press (®) % Skip

Add text/stamps (arrows/plus sign) to images.
Ps ( P an) 9 ahead to Step 3

¢ Apply to JPEG and PNG images. Some images may not be used.
e Marker Stamp can be selected only for compatible files. @

» My Files % Data Folder % Open a folder % Open a file %
Menu (&) % Picture Effect
Select IMarker Stamp and press (®)
To specify the color, select EdFont Color % Press (®) ® Select a combination ® Press (®)

To not to outline text/stamp with the latter color, select EJBorder % Press (® % Choose
Boff » Press (®

For Burst Shot files, decorations are added to all images. To decorate a single
image, save it as an individual image first (see P.9-11).

2 Select BImage Decoration and press O)

@ For PNG images, Font Color and Border cannot be selected (White w/ Black
applies).

9-14 9-15
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Select an effect and press (®

e Picture Effects:

Sepia

Renders image in sepia tones

Sparkling

Adds sparkling effect to bright portions of an image

Soap Bubbles

Superimposes bubbles over an image

Kaleidoscope

Renders an image as a kaleidoscopic image

Emboss

Renders images in black and white relief

Scrunch

Renders image as a pencil sketch

Aluminum Can

Superimposes image onto a 3D can image

Round Frame

Adds a round, opaque frosting to the edges of an image

Soft Frame Adds a soft, opaque edged frame to image
Zigzag Frame Adds a jagged edged frame around image
Press (®

Image is saved as a new entry.

@ Edited images may be too large to save or send via Long Mail.

¢ Use portrait images.

Face Arrange

Make smiley, angry or sad faces.
¢ Apply to JPEG images.

¢ Face Arrange may not fit all images. Adjust position and size as required (see P.9-17).
® Face Arrange can be selected only for compatible files.

P My Files ® Data Folder % Open a folder ® Open a file % Menu (&)
®» Picture Effect » Face Arrange

1 Select a type and press (®

(1opjo4 ereq) saji4 buibeuep B

Mirror: Copies right side of face onto Stretches face to lengthen
- ) Slender

Right-half |left side appearance

Mirror: Copies left side of face onto Crush Face Shortens distance between

Left-half right side top and bottom of face

Grin Pulls eyes down & mouth up |Dark Darkens skin tone

Mad Pulls eyes up & mouth down |Fair Brightens skin tone

Sad Pulls eyes & mouth down Angry Mark |Adds a stress mark to face

To start over, press 0! IETA.

9-16

Press (®

Image is saved as a new entry.

When using Face Arrange, take care not to create images that may embarrass or
offend others. Always obtain permission before photographing others.

. Adjusting Face Arrange Position

After Face Arrange (Step 1 on P.9-16), change the positions and sizes of targets to fit
your images. Changes apply to the current image only.

Select E3Positioning and press (®)

Face Arrange targets appear.

2 Press

A rectangle appears with =+ in the upper left corner.

3 Set the face line

5l!l z
Set Upper Face Line

=

"

Use ¢ to move + to
the upper left corner

®
—

am
15:05
Set Lower Face Line

@Back | ®0K = Setm

Use 53 to move + to
the lower right corner

To start over, press <! IERTA.
4 Set the eyes and then mouth in the same way

W.,
15:05 —
Right Eye/LowerRight

Right Eye

O

5 [&] 2
Left Eye/Lower Right

@Back | #0K Setm
Left Eye

<] W
15:05
Right Eye/Upper Left

®
-—)

@Back  e0K | Setm

Face line is set

5 4] [+
Mouth/Lower Right

Mouth
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5 Press when finished

After Arranging Face..., all the targets appear.
 To start over from the face line, return to Step 2.
To restore the original positions, press <0l [TXX.

6 Press ®
7

Choose IBYes and press (®

Image is saved to Data Folder as a new entry with Face Arrange positions adjusted, and
Face Arrange menu returns.

e Complete Face Arrange. Face Arrange is applied to the adjusted positions.

Additional Picture Effects

* Frame, Burst Mode Frame, 90° turn, Change File Format and Moving Photo Frame
can be selected only for compatible files.
e Edited images are saved as new entries.

m Add Frame to JPEG images I

SN > My Files # Data Folder % Open a folder % Open a file # Menu (&) |

Framing Standard Images
Select @Picture Effect % Press (®) % Select @Frame % Press (®) »
Select DMPreset Frames or EOriginal Frames % Press (®) % Select a
frame # Press (®) twice

To check frames, select one ® Press <0l
® Press <0 to return to Frame list.

Framing Burst Shot Images
Select @Burst Mode Frame % Press (®) # Select [BPreset Frames or
BOriginal Frames % Press (® # Select a frame ® Press (®) twice

To check frames, select one ® Press <0l
= Press <0l to return to Frame list.

For Burst Shot files, frames are added to all images. To frame a single image,
save it as an individual image first (see P.9-11).

P> My Files % Data Folder % Open a folder % Open a file % Menu (&)
= Picture Effect

Select 390° turn  Press (® # Press (®)°
*To rotate further, press (2> [TXEA. Each press rotates image by 90 degrees.

9-18

\leihlefglei i Add Moving Photo Frame to JPEG images to create
Frame animations

P My Files % Data Folder % Open a folder % Open a file % Menu (&)
®» Picture Effect ® Moving Photo Frame

Select a frame # Press (®) twice

To view file animation alone, select one ® Press <0l
®m Press {0l to return to Moving Photo Frame list.
¢ Animations are saved as E-Animation files with a .nva extension.

Moving Photo Frame size is W 120 X H 130 dots. For images larger than this
size, Moving Photo Frames appear centered. Resize or crop images to fit frame
(see P.9-14).

Change File _

P My Files % Data Folder % Open a folder % Open a file % Menu )
®» Change File Format

Select a format # Press (®)

* Apply to images smaller than 120 x 160 dots.
* The original format cannot be selected.

@ Changing file format may affect image quality.

Combining Images
Some images may not be combined and menu items may vary by file type.

Split Screen

Combine up to four reduced images into one.

¢ Apply to JPEG images including Burst Shot files.

* Make sure there is enough free memory.

¢ Images are placed in the upper left, upper right, lower left and
lower right in numerical order.

Split Image

IIEEAE > My Files » Data Folder % Open a folder

1 Select an image for upper left and press (®)
* To use a Burst Shot image for upper left, select any standard image temporarily and
change it to a Burst Shot image later (see Step 10 on P.9-20).

9-19

(1opjo4 ereq) saji4 buibeuepy H



(1opjo4 ereq) saji4 buibeuep B

ON O ORhWN

©

10

—r
N =

Press
Select BlComposite and press (®)

Select ISplit Image 120 x 160 or B Split Image 240 x 320 and press (®

Enter name and press (®)
e Enter up to 32 single-byte characters. Name is mandatory.

Select a number and press (®)
Data Folder opens.

Select a folder and press (®

Select an image and press (®
* Some images may not be selected.
To change the image, press [Change B
To start over from selecting a number, press <0l IFERA.

Press (®

Repeat Steps 6 - 9 to add images
To preview Split Image, press » Select
DSplit Screen » Press (®)
® To return, press P Press &7
To change images, select one ® Press » Select
BElChange » Press (® » Start over from Step 7
To delete images, select one # Press » Select
BlDelete # Press (® % Choose [BYes # Press (®

15:05 W'
Split Picture

File Name[MyPhoto ]
5-09-20_15-17

@ Set | eSelect  Menurs)

Press <2l when finished
To send Split Image via Long Mail, select ElAttachment % Press (® % Perform from
Step 2 on (O JP.3-3

Select [lSave and press (®

Image is saved as a new entry.

Using a Single Image of Burst Shot File

M Follow these steps after Step 6.

Select Burst Shots % Press (®) % Select a Burst Shot file ® Press (® »
Use ¢ to select an image ® Press (® ® Perform from Step 10 above

* 1/4 - 4/4, etc. is added to the file name.
B Index Image can be used (H is added to the file name).

9-20

Panorama Images

Combine two images into one.

=
=

Select two images
Panorama Image Effects:

Merge Panorama

Standard Applicable to all kinds of shots
Near View Best suited for close-up shots with parallax correction
Document Use for images with text

¢ Use JPEG images between W 48 x H 64 and W 120 x H 160 dots/W 160 x H 120 dots.

e Some portions may be cropped to adjust two images to the same size.
¢ The result may not be satisfactory if color tones are different between two images.

BRI » My Files % Data Folder % Open a folder

Select an image and press (®

Press

* For Burst Shot images, skip ahead to Step 4.
Select ElComposite and press (®)

Select Merge Panorama and press (®)
The first selected image appears on the left when combined.
* Merge Panorama can be selected only for compatible files.

Select from IStandard to E\Document and press (®)
Select B and press (®

Data Folder opens.

Select another image and press (®

N OO, AW =

9-21
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Press (®
The selected image appears on the right. Two images are set.
e If the image is too large or too small, select another.
To change the image press % Start over from Step 7

Press <0l when finished

Combined image appears.
e Use 5% to scroll the image.
To switch the positions, press [2) [TTIER.

10 Press @

Image is saved as a new entry.
Combining Split Mail Images

Use one of four Split Mail images to combine them all into one.

¢ Images may not be combined properly if file names of Split Mail images are changed, or

the same file name exists.
¢ When combined, image quality may change.

05-09-20_15-17
[E305-09-20_15-18

Set eSelect

Using for Incoming Tone/Sound Effects

] Files cannot be used if the file name exceeds 24 single-byte characters.

m P> My Files % Data Folder % Melodies

1 Selecta file and press
2 Select Blincoming Tone or E)Sound Effects and press (®)

¢ Incoming Tone or Sound Effects can be selected only for compatible files.

3 Select an item and press (®

Editing Melodies & Adjusting Tone or Loudness

H Press (® » Select My Files » Press (® ® Select IlData Folder % Press (®) %
Select Melodies % Press (®) % Select a melody ® Press [ Menu |
= To edit melodies, select B Edit » Press (@) % Perform from Step 3 on P.8-14
® To adjust tone, select B Tone # Press (®) # Perform Steps 10 - 13 on P.8-12 - 8-13
® To adjust loudness, select EdAdjust Loudness # Press (®) # Perform Steps

P My Files ® Data Folder % Open a folder % Open a file % Menu )
» Composite

15-18 on P.8-13
¢ Melody format files are saved as Original Ring Tone format after Edit.

n 1 Select EICombine Split Mail and press (®

(1opjo4 ereq) saji4 buibeuep

Press (®)

Image is saved as a new entry.

Editing Files & Folders

To change folder names, set folders to appear from Display Settings (see P.9-5).

Melody Files

Some functions may not be available and menu items may vary by file type.

Playback Volume

I Rename folders (except Folder 0) or files I

m > My Files % Data Folder

Folder Names
Select a folder ® Press (® # Select from Folder 1to Folder 9 %

m » My Files % Data Folder » Melodies

Press % Select EJFolder Name # Press (®) % Enter name

1 Selectafile and press
2 Select MhPlayback Volume and press ®
3 Use (D to adjust level and press (®

9-22

% Press (®

File Names
Select a folder ® Press (® # Select a file # Press »
Select Change File Name % Press (® ® Enter name # Press (®)

e Changing names does not affect titles of sound files.
@ e When you attach a file to Long Mail, single-byte katakana used in the name
change to double-byte, and Pictographs are deleted.
* Some single-byte Symbols may not be used for file names.

9-23
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Secret Mode Restrict access to folders (except Folder 0) I

m » My Files % Data Folder ® Open a folder |
Select from Folder 1to Folder 9 % Press » Select
E)Secret Mode # Press (®) ® Enter Security Code ® Choose IlOn
or BOoff % Press (®

¢ Enter Security Code to open folders set to On.

@ Secret Mode is not available for Camera folder (shortcut).

Copy/Move Copy or move files to other folders within each Data Folder I

[IEEAEI » My Files % Data Folder % Open a folder |
Select a file » Press » Select Copy or Move % Press (®
% Select a destination folder # Press (®)

n Delete a single file or all files at once I

IEEEAE » My Files » Data Folder |
Deleting Single Files
Select a folder » Press (® # Select a file ® Press »
Select Delete # Press (® # Delete? appears ® Choose [BYes »
Press (®

*If the file is used for Incoming Tone, Picture Call/Mail, Useful Diary, etc.,
File in Use Delete? appears.

Deleting All Files
Select a folder # Press (2> HIM # Select ElDelete All % Press (®
% Enter Security Code ® Choose [BYes % Press (®

(1opjo4 ereq) saji4 buibeuep

9-24



V-Applications

4,
‘;//V This product is equipped with JBlend designed to accelerate
Java the performance of Java Application.

POWERED ] Blend - | ; ;
Powered by JBlend ™ Copyright 1997-2005 Aplix Corporation.

All rights reserved. JBlend and JBlend-related brands are trademarks or registered
trademarks of Aplix Corporation in Japan and other countries.

Java and Java-related brands are trademarks or registered trademarks of Sun
Microsystems, Inc. in the United States and other countries.
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Getting Started

B Network V-Applications |

Network V-Applications require a network connection. Before downloading an

application, check its properties for network connection information (see P.10-5).

¢ Before using a Network V-Application, a message appears indicating that a network
connection is required. To skip this confirmation, see P.11-4.

e For connection fees, contact Vodafone Customer Center, General Information (see P.16-15).

Downloading V-Applications

e User authentication may be required before download.
* Make sure signal is strong.

1 Open a Mobile Internet site offering V-Applications

2 select a V-Application and press (®
After V-Appli Received Data Analyzing..., properties (see P.10-5) appear.
When a V-Application is paused (&), choose [l Yes # Press (®

3 Press @l

Download starts.
e Download may take time.

To return to the site, press 2> IIFIN.

4 V-Application is automatically saved after [ —
15:05
download (see sample screen shot shown to the
right) GOLF
¢ When you download a new version of V-Application set for is Saved
Standby, a confirmation appears and Standby V-Application may Ength?ri]dLFi{glt':W'?m
be canceled. ’
5 Press O
V-Appli Library opens. @ Yes No

To return to the site, press (2> I
Starting V-Applications: see P.10-5

10-4

. Properties ‘

V-Application properties appear before - b
download. Check information and start. BULFI y Name
own | oa
Download Size: 30KB|—— Download Size
Save Size: 45K —— Save Size
Continue?
Network Conneciion
Requi red Network Information
Start download:
Press <@/
@ Yes No = Cancel download:
Press

Starting V-Applications
EERE » vodaone live! # V-Appli

1 Select IV-Appli Library and press (®
When a V-Application is paused (4), choose [BYes ® Press @

2 Select a V-Application and press (®
V-Application starts (& appears).
* For operations, refer to the source Mobile Internet site, etc.
¢ VV-Applications are enlarged twice vertically and horizontally when activated.

Starting Network V-Applications

H After Step 2 above, select llConnect % Press (®
s When [[lConnectis selected in Off-Line Mode (see (Bzsic)P.3-6), Establish Network
Connection? appears. Choose [l Yes or ENo and press (®).

Opening Java'™ License Information

H Press (® & Select Vodafone live! % Press (® # Select @V-Appli % Press (®
» Select BV-Appli Settings » Press (®) » Select B Other Settings % Press (®
% Select @Copyright % Press (®

Memory Status
H Press (® # Select My Files % Press (®) % Select ElMemory Status » Press (®

10-5
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* When receiving calls, mail, etc., a running V-Application pauses. To set it to remain
active, see "Incoming Settings" (P.12-2 "General Settings").
* While using a V-Application, press for 1+ seconds to activate or cancel Manner Mode.

T\ Exit, Pause & Resume

1 Press [#) while using a V-Application

Exiting V-Application
H Select E)End and press (®
V-Appli Library returns (& disappears).

solseq uoneolddy-A

Pausing V-Application
Select [lPause and press (®)

Handset returns to Standby (4 appears).
¢ VV-Application resumes from where it was paused.

1 While a V-Application is paused, press (® in Standby

* & appears while a V-Application is paused.

Select @ Resume and press (®)
[7l To end the V-Application, select BEnd # Press (®
¥ To open Index Menu and keep the V-Application paused, select ElCancel  Press ®

N

Opening V-Appli Library while V-Application is Paused

l When V-Appli Paused Exit? appears, choose [l Yes # Press (®
* Paused V-Application ends.
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Managing V-Applications

Opening V-Application Properties

EERET » vodafone live! % V-Appli % V-Appli Library

1 Selecta V-Application and press [ Menu |

Select llProperty and press (®)
To read the rest, press (). (Press (&) to scroll back.)
To return to V-Appli Library, press ® or (0.

suoleolddy-A Buisn E

Vendor Name of the distributor (or supplier/manufacturer)
Version Version of the V-Application

Size Downloaded file size

Network Connect Network connection required or not

StandbyDisp Compatibility with Standby V-Application (see P.11-3)

Deleting V-Applications

Preloaded V-Applications can be deleted.

IEEERET » vodafone live! % V-Appli % V-Appli Library

1 Selecta V-Application and press (&> HIETH
2 Select BlDelete and press ®

If the V-Application is set for Standby (see P.11-3), Cannot Delete Application set as
Standby V-Appli appears and Menu returns. To proceed, cancel the setting and try again.

3 Choose DYes and press @

e Security Code may be required.

Standby V-Application

Set a V-Application to activate when handset enters Standby.

¢ Only one V-Application can be set at a time, and some do not run in Standby.
¢ This setting is not available when a V-Application is paused (&).
e Standby V-Appli is Off by default.

m P Vodafone live! % V-Appli % V-Appli Settings
Select IIStandby V-Appli and press (®

For network connection confirmation, select ElNetwork Connection % Press (®) %

Select @ Connect (default; confirmation appears) or ElStay Off-line (disable
confirmation) ® Press (@)

2 select MON/Off and press (®

3 Choose [On and press ®
To cancel Standby V-Application, choose EJOff » Press (®) (Omit the next steps.)

4 Select a V-Application and press (®
5 Press @) to exit

e

¢ V-Applications may not start when an external device (hands free kit, etc.) is
connected to handset.

¢ VV-Application set for Standby that also responds to incoming communications may

take priority over incoming settings set in Call Functions.
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Network Connection Confirmation

A confirmation appears before starting Network V-Applications, which can be
disabled. Connect is set by default (confirmation appears).

P Vodafone live! % V-Appli % V-Appli Settings % Other Settings %
Confirm Network

n 1 Select MConnect and press ®

To disable the confirmation, select BlStay Off-line » Press ®

When a V-Application set for Standby starts automatically, confirmation does not
appear regardless of this setting. Activate confirmation from Network Connection in
Standby V-Appli menu (see P.11-3).
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General Settings

Incoming Settings Select a hgndget response to incoming calls, etc. while a
V-Application is active

SRR Pause Application

m P Vodafone live! % V-Appli % V-Appli Settings # Incoming Settings|
Select from [incoming Callto EAlarm » Press (® » Selecta
handset response » Press @

V-Applications pause for incoming calls, mail, etc.

A message appears for incoming calls, mail, etc. For example,
090392XXXX1 appears. Press @ to answer the call or read the
message.

Pause Application

Show Message

* For V-Applications started from Standby, a message appears regardless of the setting.

HEVE AT 5 Adjust the volume of V-Application sounds I

ML evel 3

P> Vodafone live! % V-Appli % V-Appli Settings % Volume/Vibration
» Playback Volume

Use () to adjust volume # Press (®
* In Manner Mode, volume set in Manner Settings (see (Basic)P.3-5) applies.

. : When activated, handset vibrates while compatible
Vibration o
V-Applications play

BEEMRON

> Vodafone live! % V-Appli % V-Appli Settings ® Volume/Vibration
» Vibration

Choose [BOn or BOff » Press (®
« In Manner Mode, vibration set in Manner Settings (see (Basic]P.3-5) applies.

Backlight Select a Backlight status for V-Applications I

PEEMRNormal

IEEERET » vodatone live! % V-Appli % V-Appli Settings # Backlight % On/Off |
Select from [ Always Active to E)JNormal % Press (®)

Always Active Backlight remains on while V-Applications are running

Always Inactive |Backlight does not turn on while V-Applications are running

Normal Backlight turns on or off depending on Light Settings (see (Basic)P.7-7)

12-2

Backlight flashes while playing compatible V-Applications I

DEEMRON

P Vodafone live! % V-Appli % V-Appli Settings ®» Backlight % Set
to Flash

Choose [On or BOff » Press (®

Resetting V-Appli & Center Address

Reset V-Application settings
Refer to P.16-3 for the settings affected by Reset

P Vodafone live! % V-Appli % V-Appli Settings % Other Settings #»
Reset V-Appli

Enter Security Code # Select llReset  Press (® » Select IDOK or
BCancel » Press (8

Clear Memory

P Vodafone live! % V-Appli % V-Appli Settings % Other Settings #»
Reset V-Appli

Enter Security Code # Select BClear Memory % Press (®) # Select
DOK or BCancel # Press (®

* All V-Application settings will be canceled after Clear Memory.

Restore V-Appli Library to default setting I

ol s Set V-Application Center Address I
BEEMRY 7162

P Vodafone live! % V-Appli % V-Appli Settings % Other Settings #»
Center Address

Enter Security Code » Enter Center Address # Press (®)

Do not change Center Address unless instructed to do so. Access to the service
will be disabled.

12-3
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Getting Started

Use Station to access a variety of area-specific local information, periodically updated
automatically. An additional contract is required to use Station service.

. Station Info Content ‘

Sample Station information page: N Received
Use (Q) or €29 to scroll information. T | Date & Time
St Continues

= N L=Info Type

Content

B A i
. SEEREDF
P N

SRTNE, E LI
i LBl o

Request confirmation after subscribing to or unsubscribing from fee-based
information.

To subscribe to fee-based information, contact Vodafone Customer Center, General
Information (see P.16-15).

m » Vodafone live! » Station

1 Select BlConfirm Request and press (®)
Original subscription status appears.
O: Subscribed
X: Not subscribed

Press (®
Choose IBYes and press (®

Confirm Request Accepted appears.
¢ Handset returns to Standby.

WN

When Reply from Service Center Arrives

Il Delivery Notice appears.
To see the reply, press (® ® Select Station Notification  Press (®)
mPress @) to exit. (Reply will be deleted.)
e Alternatively, in Station, open New Information to check the reply (see P.13-8 "In
Standby").

Opening Main List
m > Vodafone live! » Station |

1 Select EMain List and press (®
[ If Main List is empty, choose Il Yes # Press (®

2D Select a topic and press ®
e Subscription is required for viewing fee-based information.
[ Station Info Content: see P.13-4

@ If title list appears after Step 2, select a title and press (®) to open information.

3 Press @ to exit Station

Updating Main List

Il Main List is updated automatically when:
e Specified hours pass (see P.15-3)
¢ Handset receives different area information
¢ An update time for each topic in My List is reached
l To update Main List manually, follow these steps.
Press (® # Select Vodafone live! % Press (®) % Select E}Station » Press (®)
® Select @Update List % Press (®
* Handset returns to Standby (:& appears in gray). When Main List is updated,
Complete appears.
¢ Updates may not be received depending on signal strength.

13-5
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My List
Saving to My List

Save topics to My List to receive periodic updates. The information is updated
automatically.

e Save up to 20 topics.
¢ Urgent Information is saved automatically.

From Information

WN =

LN

Open information
Press (&) HTTH
Select Save and press (®

* Topic can only be saved when Save appears.

Select IlSave to My List and press (®
« If the topic is already in My List, llSave to My List does not appear.

From List

W Nl

Select a topic

Press (&> HIYTH

o |f the topic is already in My List, Saved appears.

Select Save to My List and press (®)
¢ |f the topic has more than one information item, handset saves as many items as
possible.

Follow the same steps to save from title list within a topic.

13-6

Editing My List

. Moving Saved Topics

Urgent Information cannot be moved.

LB » vodaone live! % Station % My List

1 Select a topic and press
2 Select Move and press (®)

Use ($) to move cursor to target location and press (®
The topic is moved.

solseg uoiels h

B Deleting Topics

¢ Urgent Information cannot be deleted.

¢ Deleting a topic automatically deletes all information saved under the topic.

LB » vodaone live! % Station % My List

1 Select a topic and press
2 Select Delete and press (®)

Delete? appears.
e Check the number of information items.

3 Choose [ Yes and press (®
Received Information

. Unread Information

1 When a topic in My List is updated, animation
plays and Delivery Notice appears
:& appears in red.
* When handset is closed, ) appears on Sub Display. Open
handset to see Delivery Notice.

Press (®)

Select a topic and press (®

Information appears (and is deleted from New Information).
Saving Information: see P.14-2
To save files within information to Data Folder, see P.14-4 "To
Data Folder."

WN

9/22[Thul 12:38

New Information

Delivery Notice
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Ring Tone Volume

Il While handset is ringing, press (5) (up) or (Q) (down).
* Ring Tone Level setting (see (Basic)P.8-2) changes accordingly.
« Cancel Manner Mode (see (Basic)P.3-3) to adjust the level.

H Press to instantly mute incoming information tone for that information only.

In Standby

H Press (® # Select Vodafone live! % Press (® # Select E)Station  Press (®)
® Select IINew Information » Press (®) # Select a topic # Press (®

 Information may appear automatically without a notice.

¢ For Urgent Information, Urgent Information appears even when it arrives with
other information.

« |f information is received during an operation, Delivery Notice may not appear.

¢ Depending on information type, Ring Tone may not sound or other tone may sound.

¢ When Screen Savers is active (see P.15-3), new information appears automatically.

. Read Information

* My List holds up to 100 information items.
¢ Urgent information is saved to My List.

m > Vodafone livel ® Station

1 Select ElMy List and press (®

® Topics with unread information appear in red.

Select a title and press (®

2 Select a topic and press (®)

e

13-8

When there are 100 information items in My List and new information arrives, the
oldest item is replaced. Save important information to Saved Information (see P.14-2).
Even when there are fewer than 100 items, items may be deleted depending on the
size or type of information.
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Saving Information

Saved Information

Information in Main List is updated automatically (see P.13-5).

To protect information, save items to Saved Information.

e Approximately 375 KB is shared between Inbox (Mail), Storage Type (Web) and Saved
Information (Station).

e Information in My List can be saved to Saved Information.

1 Open information

D Press

¢ Information can only be saved when Save appears.

3 Select Save and press ®

¢ Information can only be saved when Station Info Log appears.

4 Select Station Info Log and press (®)
* When memory is full, delete entries (see below) and try again.

@ Information may not be saved if memory is low (used for Inbox, Storage Type or

Saved Information).

Checking Information

m » Vodafone live! » Station

Select B Saved Information and press (®)
* Received date and time appearin| ]

2 Select atitle and press (®

To save files within information to Data Folder, see P.14-4 "To Data Folder."

Deleting Selected Information

m P Vodafone live! % Station % Saved Information
1 Select atitle and press (2> HETH

2 Select Delete and press (®)

3 Choose MYes and press @

14-2

Deleting All Information

H Press (® # Select Vodafone live! % Press (® #» Select ElStation  Press (®)
» Select BSaved Information % Press » Select BlDelete All »
Press (® % Enter Security Code ® Choose IBYes # Press (®

Using Linked Info

Use numbers, addresses or URLs (http://) to place calls, send messages or access
Mobile Internet sites.

¢ Available only when number, address or URL is underlined with a dotted line.
e Words may be substituted for the numbers, addresses and URLs.

1 Open information containing a phone number, mail address or URL

Phone Numbers
HHighlight a number and press (®

H Select Dial and press (®)
The number is dialed.

Mail Addresses
HHighlight an address and press (®
H Select Send and press (®
Select IlSend Long Mail or ElSend Sky Mail and press (®)
Creating & Sending a Message: see P.3-3

URLs
HHighlight a URL and press (®

Handset connects to the Network.

Saving to Phone Book

B To save as new entry, open information and follow these steps.
Select a phone number or mail address # Press (®) ® Select Save # Press (@
» Select INew Entry » Press (®) % See (Basic)P.5-4 - 5-5 for more about Phone
Book

B To save as new item, open information and follow these steps.
Select a phone number or mail address # Press (®) ® Select Save # Press (®
% Select BINew Item # Press (®) # Select an entry (see (Bzsic)P.5-13) # Press (®)
» See (Basic)P.5-4 - 5-5 for more about Phone Book

14-3
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Files within Information

Use information in My List or Saved Information.

1) e G S8 Save images and other files within information to Data Folder I

Open information and select a file » Press (® # Select ' To Data
Folder % Press (® % Perform Step 4 on P.8-6

* Files can only be saved when [ To Data Folder appears.
¢ Some files may not be saved to Data Folder.

Wallpaper & . .
Display Images Save images as Wallpaper or as Display Images I

Open information and select an image # Press (® # Select Save As
Wallpaper or To Display Images % Press (® % Perform Step 3-H1
(Wallpaper) or 3-H (Display Images) on P.8-6

* Images can only be used when Save As Wallpaper or To Display Images appears.

* Some images may be too large to use as Wallpaper or Display Images.
¢ Image files saved as Wallpaper or Display Images are not saved to Data Folder.

Weather Indicator

Activating Weather Indicator

The weather forecast for your current location (sent via the Center) appears as
Weather Indicator in Standby.

e Subscription to fee-based information is required to use this service.

e Off (no Weather Indicator) is set by default.

m P Vodafone live! % Station % Weather Indicator % Standby Display

1 Choose DOn and press (®
To cancel, choose BJOff # Press (@)

Press (®

Weather Indicator appears when forecast is updated.

Choose IYes and press (®), then follow onscreen prompt to see the indicators.

@ After you subscribe to fee-based information, Weather Icon Set Now? appears.
On is set for B Standby Display automatically.

14-4

. Indicators & Updates
Weather Indicator is updated when:
] P

w3 | (®Weather Indicator update time arrives

@A different area forecast is received
gfg:ear gt!es (B?ygt g f_Fr’;‘”'V/ Chance of | @Main List update time arrives (see P.15-3)
@fggﬁ{jy tes (Night) || & Then @Manually updated (see P.13-5)
@”:Rain Example: &/ &
;Snow » Partly cloudy with
< :Thunder Showers a chance of rain

—_———

Weather Forecast

See a more detailed weather forecast.
m P Vodafone live! » Station ® Weather Indicator

Select lWeather Forecast and press (®)
Information appears.

Changing Weather Indicator Info Number

Il Do not change Info Number unless instructed to do so.
Press (® % Select Vodafone live! % Press (®) # Select E)Station % Press (®
® Select B Weather Indicator % Press (® #® Select E)Set Info Number %
Press (® ® Enter Security Code ® Enter a new Info Number % Press (®)
® 57451 is set by default.

Location Info

Checking Location Info

m > Vodafone live! » Station |

Select ELocation Info and press (®
Location Info Log opens.
When Location Info is protected (see P.14-6), enter Security Code.
To update Location Info, press ® Select Update Location Info % Press (®)
To clear Location Info, press % Select Delete All % Press (® ® Choose
D Yes » Press (®

2 Select Location Info and press (®
To delete Location Info, press ® Select Delete % Press (@)

14-5
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Using Location Info

¢ Send via One-Shot Mail (see P.3-16)

e Share on BBS (see P.6-6)

¢ Send via Web (see P.9-4)

¢ Copy and paste into messages (see below)

Pasting into Messages

H In a text entry window, move cursor to the paste location and follow these steps.
Press ® Select BB Saved Info % Press (® » Select ElLocation
Info % Press (® twice ® Use ¢ to move cursor # Press (®
e | ocation Info is inserted to the left of the cursor.

Up to five locations, including the current one, are saved in Location Info Log. When
this limit is exceeded, the oldest Location is replaced with the newest.

Restrict access to Location Info Log by making Security Code required to open
Location Info.
No (Security Code not required) is set by default.

m P Vodafone live! % Station % Location Info
Press

Select Set Security Code and press (®

Select [INeed Setting and press (®)

* Handset is set to ask for Security Code.
¥ To cancel, choose EINo # Press (®

WN =
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Sub Menu Settings

<) BV Change font and image size I

EEEMMedium Font/100%

Open information and press ®» Select Set Display Size »
Press (® % Select a size # Press (®)

e Some images always appear at 100% depending on the original size.
® Select 100% if information does not appear properly at 200%.

Press to toggle size as follows: Medium Font/200% — Small Font/100% —
Small Font/200% — Medium Font/100%. (8 appears for 100% and [t for 200%.)

Select from three scroll units I

BEEMRLine
Open information and press » Select Screen Scroll »
Press (®) # Select from IBFull Screen to ElLine % Press (®

Save to -
Text Memo Copy text and save to Text Memo (see (Basic)P.4-18) I

Open information and press » Select Save # Press (®) »
Select Save to Text Memo » Press (®) # Use ({) to underline the first
line of the text block to copy ® Press (®) % Use () to specify text &
Press (®) ® Select a number # Press (®

To overwrite, choose B Yes # Press (®
e Text can only be saved when Save to Text Memo appears.

Copy Copy text I

Open information and press (2> AN # Select Copy » Press (®) »
Use () to underline the first line of the text block to copy # Press (®
% Use () to specify text » Press (®

* Text can only be copied when Copy appears.

Property Open information details I

Open information and press » Select Property ® Press (®)

Press (® again to return to information.
e Check Reception No. The smaller the number, the later the information is received.

Basic Settings

Set new information to automatically appear in Standby I

BEEMROff

m P> Vodafone live! % Station % Station Settings % Screen Savers |
Choose [On or BOff # Press (®

¢ When there are multiple pages/information items, they appear in turn every five seconds.
(As for images, only those in the latest information appear.)

* When Web Screen Savers is On, Station Screen Savers appears afterward.

« While information appears in Standby, press (®) to open it.

¢ While information appears in Standby, Wallpaper does not appear. When a
V-Application is set for Standby, information does not appear in Standby.
e Full information may not appear in Standby.

e EVENE LT G4 Set an interval for Main List automatic update
A4 Times/Day

m P Vodafone live! % Station ® Station Settings ® Update Frequency|
Select from 14 Times/Day to E)Off % Press (®

e Main List is updated automatically when not updated by other means (see P.13-5) within
the set interval.

SV [Riien ) gl o 1518 Save topics to My List directly using Info Number I

m » Vodafone live! ® Station » Station Settings » Save Info Number|

Enter Info Number # Press (®
e When 20 topics are saved in My List, No Space Cannot Save appears. Delete topics (see
P.13-7) and try again.

Image Link Select vyhether to update Wallpaper automatically when the
source image is updated

limage Link is available only when the information containing the image
used as Wallpaper is saved to My List (see P.13-6).

Default{Olij
m > Vodafone live! ® Station » Station Settings ® Image Link |
Choose IOn or BOff  Press (®

@ * When Wallpaper is updated, the original image used as Wallpaper is deleted.

@ ® Battery runs out faster with Screen Savers.

e Station Image Link and Web Image Link cannot be set On at the same time.
When either is set on, the other one turns off automatically.

e Wallpaper is updated automatically only when the image is saved as
Wallpaper directly from opened information, not from Data Folder.

15-3
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Resetting Station & Center Address

. Reset Station settings
Reset Statlon Refer to P.16-3 for the settings affected by Reset I

m > Vodafone live! » Station ® Station Settings % Reset Station |
Enter Security Code # Select lDReset » Press (® » Select IDOK or
BCancel » Press (®)

O [==1 1 Eg s’ Delete all information in Station I

m > Vodafone live! ® Station » Station Settings » Reset Station |
Enter Security Code # Select BClear Memory % Press (®) # Select
DOK or BCancel # Press (8

@ ¢ All files in the following locations will be deleted:

® New Information ® Main List
u My List" ® Saved Information ™ Location Info
*Urgent Information remains.
¢ When Clear Memory is performed, ongoing Main List update (see P.13-5) will

stop.

(o115 (= e[l 15 Set Station Center Address I

PEEMNX 7052

m P> Vodafone live! ® Station » Station Settings ® Center Address |
Enter Security Code » Enter Center Address # Press (®)

Do not change Center Address unless instructed to do so. Otherwise, access to
the service will be disabled.

15-4
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Reset Settings

Mail Settings

See P.6-7 for resetting Mail Settings.

Web Settings

See P.9-5 for resetting Web settings.

Screen Savers Off

Text Only Acquire Image: On, Acquire BGM: On
Auto Retrieve Auto Retrieve

Image Link Off

Server Address X7122

Location Info On

Set Display Size Medium Font/100%

Screen Scroll Line

V-Application Settings

See P.12-3 for resetting V-Application settings.

2-Touch Mail Add Address: all deleted, Save & Send Image: On
Auto Send On
PIN Setting 0000
Security PIN Filter Off (all)
Reject List Deleted
Address Filter Off
Auto Retrieve Manual
Mail Notice Name
Confirm Delivery Off
Set Priority Normal
Sender Deleted
Custom Fixed Text Deleted
Sound Auto Play Off
Auto Delete Old Off
List Pattern 1

Incoming Settings Pause Application (all)
Playback Volume Level 3

Vibration On

Backlight On/Off: Normal, Set to Flash: On
Center Address X7162

Confirm Network Connect

Access Server Address

Server Address: 5000, Sub Address: none

Points Center Address

i

BBS

2

Station Settings

See P.15-4 for resetting Station settings.

Scroll Unit Line

Layout List (all)

Set Folders Folder Name: all deleted, Secret Mode: Off (all)
Display Size Medium Font/100%

One-Shot Mail®

Recipient and message text: deleted
Confirm Delivery and Send Location Info: Off

Screen Savers Off

Update Frequency 4 Times/Day
Center Address X7052
Image Link Off
Weather Indicator Off

Designate Folder

Off

Short Message: ¥7032, Data Access: ¥7132, Long Mail Line: ¥7042

2Settings: Off, New Message: deleted (#7viRT—#7 % L), Location Info: deleted (no data)
3When Side Key Settings (see (Basic)P.12-3) for Standby is One-Shot Mail, the setting

automatically returns to Off after resetting Mail Settings.

@ Sky Melody Center Address returns to #1790.

16-2
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Display Messages

Mail

Out-of-Range
Cannot Send

Delivery Rejected
Cannot Send

Confirm

No response
Connection
interrupted

Connection
Interrupted

Cannot connect to
Network

15:05
Connection
Interrupted
Reconnect?
Yes
BENo
L

16-4

Send failed due to weak signal.
» Make sure signal is stable and try again.
The message was not delivered to the recipient.
®» Check the handset number and try again.
The Center is undergoing maintenance.
® Wait and try again.
Unknown if the Center received the message.
®» Confirm delivery (see P.4-18).

Unknown if the Center received the message.
» Wait and try again.

The Center did not receive the message.
® Wait and try again.
Disconnected due to weak signal.
% Choose [l Yes and press (® to reconnect.

The message was not delivered to the recipient.
®» If recipient is using PIN Filter, enter the matching PIN and
resend (see P.3-10).
®» The recipient may be using Address Filter for security.
®» If included, remove 184 or 186 from the recipient number
and try again.

. Sha-mail Cannot be Sent ‘

Possible causes include the following. For details, contact Vodafone Customer
Center, General Information (see P.16-15).
¢ Recipient does not subscribe to Super Mail or Long Mail.
¢ Recipient handset is not JPEG-compatible.
m Convert JPEG files to PNG files before sending to PNG-compatible handsets (see (Basic)P.9-19).

. When Handset Memory is Full ‘

New messages cannot be delivered to handset. Undeliverable mail is saved at the
Center for up to 30 days.
¢ Delete messages to free memory for new ones (see P.4-10).

When memory is available, new messages are delivered automatically.
¢ Delete unprotected messages automatically to receive new ones (see P.4-11 "Auto Delete").
¢ Even if memory is not full, handset cannot receive new messages larger than remaining

memory.

Web

Cannot connect to
Network

No response
Connection
interrupted

5 -
Connection
Interrupted
Reconnect?

DVes

ENo

The Center did not respond.
» Wait and try again.
Server Address is incorrect.
®» Correct Center Address and try again. See "Server
Address" (P.9-5 "Reset & Changing Center Address).
You are out-of-range.
®» Try again where signal is stable.
The Center did not respond, or time limit passed.
®» Establish a connection within the time limit.

Disconnected due to weak signal.
» Choose [@Yes and press (®) to reconnect.

16-5
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155 il

V-Applications

Download Size: 30KB

Network Connection
Requi red

Battery Low
Download May Fail

Cannot Download

No Space
Cannot Save

New Version Found
Application will be
Updated

Continue Download?

@ Yes No s

A V-Application is paused.
®» Close the application and try again.

Download may fail due to low battery.
®» Charge battery beforehand.

Library memory is full.
» Delete files/applications in File Cabinet (see (Basic)P.9-2)
and try again.

100 V-Applications are already saved.
®» Delete applications (see P.11-2) and try again.

You are downloading a new version of the saved application.
» Press <0l to continue downloading or
press [2> A to cancel.

e Improper Data Cannot Download Application

@ V-Applications cannot be downloaded when the following messages appear:

e Application Size too large Cannot download
e V-Appli already saved

16-6

Station
Cannot connect to

Cannot Update

Service unavailable
in this area

You tried to update Main List or Location Info out-of-range.
» Try again where signal is stable.
Location Info cannot be received from the Center.
» Try again.
You tried to update Main List or Location Info outside the
Service Area.
% Try again within the Service Area.

16-7
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l Pictograph Code 3 Pictographs in ] are animated.

Pictograph List

Code_|Pictograph| Code |Pictograph)| Code |Pictograph| Code |Pictograph| Code |Pictograph
Open Pictograph Code mode and press [& 01 i 19 = 37 55 3] 73 &
Use 6 to select a Pictograph and press (® to enter it. 02 P 20 38 ﬁ 56 % 74
m 03 21 & 39 : 57 75
- Il Pictograph Code 1 04 ] 20 40 58 =) 76 10p
3 Code |Pictograph| Code |Pictograph| Code |Pictograph| Code |Pictograph| Code |Pictograph 05 X 23 4 m 59 < 7 bk
3 01 e | 1o W | a7 ® | s 2| 73 ) 06 24 = 42 B | e W [ 7s ©
=3 02 [ 20 s 38 {0 56 74 - 07 6] 25 43 61 H 79 &
03 2| of 2 39 [ 57 E 75 - 08 26 44 i 62 80 v
04 2 22 A& | a0 @ | ss Bi | 7e ) 09 N 27 @ 45 2 | es 81 pr|
s | B | 23 [ & | 4 @ [ so a | 7 | & 10 28 46 b | ea | B | 82 | &
06 il 24 {2 42 () 60 pd 78 % 11 Tl 29 47 G 65 (1] 83 8
07 A 25 o 43 ()] 61 ] 79 (2] 12 [v] 30 48 - 66 84 g
08 26 B | 4 @ | e I 80 & 13 [¢] 31 49 F | e7 85 <
09 = 27 @B 45 ) 63 & 81 ] 14 [+ 32 50 68 o 86 =
10 | H [ s | &) 4 | © | 64 | | 82 | @ 15 | 4 [ s 51 69
11 & | 20 g | a7 @ | es & | s [ 16 34 52 70 (I
12 30 | 48 & | es & 84 A 17 = 35 53 71
13 @ 31 e 49 e 67 il 85 8- 18 = 36 54 E]] 72
14 @ | 30 @ | s | @ | es Fle | © M Pictograph Code 4 Pictographs in CJ are animated.
15 & 33 @ 51 & 69 2| 87 @
16 5] 34 WP 52 & 70 4 88 @ Code |Pictograph| Code |Pictograph| Code |Pictograph{ Code |Pictograph| Code |Pictograph
17 & | 35 @ | s3 @ | 7 | eo @ 01 L5 17 s B | 49 2 | 65 -
18 M | 36 @ | =4 | 7 90 a 02 Y 18 4 | 34 g 50 [®) 66 g
. . . . 03 B 19 >k 35 51 . 4 67
B Pictograph Code 2 Pictographs in ] are animated. o s - e - o = pos >
Code_|Pictograph| Code |Pictograph] Code |Pictograph| Code |Pictograph| Code |Pictograph 05 21 @ 37 [N} 53 69 @
01 19 = 37 & 55 A 73 C1] 06 L8 22 [ 38 FER 54 7 70 S
02 20 [N 38 = 56 L) 74 | 07 G 23 o 39 R 55 [ 71 &
03 = 21 Y 39 = 57 B 75 i 08 o 24 9 40 56 72 =
04 H 22 i 40 & 58 3 76 [ 09 25 it 41 57 ] 73 &)
05 2 23 ] a4 = 59 o 77 (5] 10 it | 26 e 42 ] 58 & 74
06 24 42 60 S 78 & 11 ! 27 )N 43 @ 59 &5 75
07 e 25 @ 43 & 61 9@ 79 12 L 28 N 2 44 ) 60 & 76 =
08 = 26 M| aa Fy 62 A 80 e 13 & 29 ) 45 P 61 @® 77
09 & 27 i 45 [Ep 63 £ 81 (7] 14 S 30 El 46 & 62 @)
10 2 28 [ 46 64 = 82 @ 15 @ 31 A 47 63 &
11 G| 20 Y 47 65 o) 83 B 16 32 48 = 64 o
12 & 30 ] 48 £ 66 Y. J 84 [
13 i El d 49 E? 67 w® 8 ks ¢ Pictographs do not appear in e-mail or on incompatible Vodafone handsets.
14 b 32 S 50 % 68 B 86 ] @ * Pictographs with ~ appear with background animation in received messages when
15 @ 33 e 51 e 69 of 87 Ed Mail Background (see (Basic)P.7-9) is On. (When more than one is included in a
16 34 ) 52 . 70 i 88 (=) message, animation for first entered Pictograph appears.)
17 E 35 i 53 55 71 a5 89 =
18 ] 36 54 el 72 & 90 =
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l Pictograph Code 5 Pictographs in ] are animated.

Memory List

Xipuaddy a

Code |Pictograph| Code |Pictograph| Code |Pictograph| Code |Pictograph| Code |Pictograph
01 K 17 i 33 [Er 49 = 65 & _
02 S 18 £ 34 50 =) 66 i , Mail
03 o 19 B 35 51 67 © Sent Approximately 120 KB
04 e 20 B 36 % 50 =] 68 =) Outbox Approximately 100 KB*
05 e 21 g 37 :f*{ 53 = 69 =) Inbox Approximately 375 KB
06 28 22 ] 38 54 & 70 4] *Shared with Storage Type (Web) and Saved Information (Station).
07 i 23 S 39 Fal 55 | 71 Web
08 = 24 s 40 i 56 ﬁﬁ 72 e Overwrite Type Up to 15 information items
09 :“'ﬂ 25 ﬁ 41 LL] 57 B 73 g Storage Type Approximately 375 KB’
10 ;r_r 26 i 42 =] 58 ® 74 Eami Work Type Information Approximately 32 KB
11 o 27 Bl 43 5 59 = 75 .
> i o8 - 4 &u o ,&9 6 - Bookmarks Up to 30 links
13 =y 20 T | a5 s o1 9 Internet Up to 30 URLs
14 B 30 &1 46 & 62 |\ *Shared with Inbox (Mail) and Saved Information (Station).
15 & | s @ | 47 & | e3 Er Station
16 b 32 ol 48 ] 64 Main List Up to 63 titles
Saved Information Approximately 375 KB’
B Pictograph Code 6 Pictographs in ] are animated. My List Up to 20 topics (100 information items)
Code_|Pictograph| Code_|Pictograph| Code _|Pictograph| Code | Pictograph| Code |Pictograph Location Info Uptos
01 | 13 n 25 B 37 e 49 *Shared with Inbox (Mail) and Storage Type (Web).
02 £ 14 = 26 P 38 @ 50 [A] V-Application
03 2 15 27 39 @ | s (B] V-Appli Library 'Up to 8 MB (100 items)’
04 ke 16 E 28 40 ) 52 ] - — -
05 = = =) 29 2 41 & = ® Shared with File Cabinet (see (Basic)P.9-2).
06 i 18 == 30 42 > 54 ty
07 S| 19 [+ ] 31 43 L] 55 ™
08 e 20 32 | a4 ) 56 é
09 Ll 21 [ 33 &) 45 Ty 57 9
10 i 22 a 34 a7 46 i 58 | OQvodatone
11 %] 23 @ 35 1 47 &8
12 24 36 = 48 )

e Pictographs do not appear in e-mail or on incompatible Vodafone handsets.
@ ¢ Pictographs with ’ appear with background animation in received messages when
Mail Background (see (Basic)P.7-9) is On. (When more than one is included in a
message, animation for first entered Pictograph appears.)
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A
Attach 1/4 Size
Acquire List .....cocriirimninninneniecennns
Add Address (2-Touch Mail) ............. 3-12
Address Filter.......cccoomniemnnnnserinnssniians 6-4
Attach Original .......ccccceremirecicininnns 3-8

Attachment (attaching images, etc.).... 3-7
Attachment (changing sound format) . 3-8

Attachment (saving) ......ccccceervveernsannns 4-20

Auto Delete Old........cccermreernierinnriannas 4-11

Auto Delivery Service.........ccceeurrunnne 7-10

Auto Retrieve.........ccoeiieemrriicienne 6-3, 9-3

Auto Send........ccocriirinmninnnn 6-2
B

Backlight (V-Application) .........c....... 12-2

Bookmarks ........ccceeerisuerisnnniannans .. 8-2
Bookmarks (accessing from)....
Bookmarks (deleting from)....
Bookmarks (saving to)
By EXPress .....cccevrimnsaninnssnninnns

chat group .....ccceeriminsicnisissersnnanas
Chat Mail LOg ...ccocvmrumrermrerecnracnas
Clear Memory .........cccouvunne

Clipboard .........ccourmnmrninserinssesssannen
Combine Split Mail.....
Confirm Delivery........
Confirm Network....
Confirm Request....
Convert Sky Mail....

Copyright (V-Application) ................. 10-5
{117 o 7-8
Custom Fixed Text .......cccueerviervnrsunnianns 6-2
D
Data ACCeSS ......ccvvmerirmerisernssensssnenssnnnas
Delete All (mail messages)...
Delete All Mail (Server Mail).........
Delete all Mail (Unretrieved List)......... 5-3
Delete ltem
(Unretrieved List message).......c...... 5-3
Delivery Report........cccccvvcemninnrsnnnsennas 24
Dictionary files.......ccccoeriimrinninsininnns 8-8
Display Images ........c.cceu.. 4-21, 8-6, 14-4
F
Favorites......cccemnneriimnnenrnessseennannnns 8-2
Favorites (canceling)........ccccoerrvuerniannnas 8-3
Favorites (deleting entries).........c.c...... 8-4
Favorites (opening information) ......... 8-3
Favorites (saving t0) .......ccccecervrernscannnns 8-2
Fixed TeXt.....cccvmrirmmirmrnsemnsenssannnnseenas 3-6
Folder Name.........ccceoevremnsemnerseniaeninns 4-14
Forward ........ccoemrvcmmncsnncssssenssenssennas 4-6
G
Greeting......ccocemeermsrnsennssnnsenannas 1-2, 3-17
|
Image LinK......cccceveerinnrisennisannnnas 9-4, 15-3
images (Saving) .....ccverrsserrssensinas 8-5, 14-4
131 oo ) G 4-2
Inbox Auto Sort........ccvemmiemierssesinnnns 4-17
Incoming Mail.........ccconmmnerirninsinnenns 4-4
Incoming Settings .......ccceereerrerinrnnnee 12-2
information content..................... 7-4,13-4
Input Memory.......cccoccvimnieriinisnsiensenns 7-9

Internet

L
Layout (Mail) .....occoernremrremrrennseensnnnnas 4-14
Link Limiter .....cccccvimnsmiiniercennsansennnes 9-4
Link Limiter Code ......ccccoournrermnrurnniannnans 9-4
Location Info......cccceomiriceinriiccenns 6-6, 14-5
Location Info (Web)........cceeerricrricennnnas 9-4
Long Mail........ccccevmmierierinnianinnnns 1-2, 3-2
Long Mail (retrieving).......cc.cceeruenns 2-7,5-3
Long Mail Line ......ccocvsmnremnersnnnsnssennnes 6-7
Long Mail Notice........ccceveerrremrnrnnnsannnas 2-7
M

1 | 2-1
Mail (checking messages) ......c.curueenas 4-2
Mail (checking new messages)............ 2-4
Mail (copying message text).............. 4-23
Mail (creating & sending)........cccureuennns 3-3
Mail (deleting messages).......ccorriuen 4-10
Mail (disabling) ......cccueeerrvmmrienrssnnnsannas 1-5
Mail (editing messages)........ccuvuerrrunnnas 4-2
Mail (entering message text)............... 3-4
Mail (entering recipient).........cceccevvueenas 3-4
Mail (entering subject) ......ccccvverrinennne 34
Mail (protecting messages)................. 4-9
Mail (resetting) .......ccvseerrveernsnnrsnnnsennas 6-7
Mail (saving to OutboXx)........ccvvumrrians 3-10
mail address

(customizing handset address)....... 14
L1V F= TL I = 7o) 4-2
Mail Box (changing List view)............4-23
Mail Box (contents) ............. 2-5, 4-4, 4-13
Mail Notice......cccmrrmmrrmrrnnrsnrsnnnaenas 6-2
Mail Request .......ccccvvverrimmrsmsrnsnnnnsannns 5-2
Mail Templates..... e 3-14
Main List............... e 13-5
Melody Format..........ccccceiimiininiinnnnnas 3-8
Memory List ......cccccmvrnnnrnnisnnisnnnnes 16-11
Memory Status..........ccoeerverinnnnnnne 1-5, 10-5
Message Contents.........cccveemnerines 2-6,4-5

Message Folder (deleting information) ..8-4
Message Folder (opening information) ..8-3

Mobile Internet (accessing) .......ccceueeee. 7-6
More (Long Mail)......ccccereemrrerrnennnannns 2-7
Move to Folder.......cccueornrmmnrserriinnrinnns 4-16

My List...cccooirmirrieriensniensensse e 13-6
My List (checking information)......... 13-8
My List (deleting information)........... 13-7
My List (saving information).............. 13-6
N
Network V-Applications..................... 10-4
New Information.........cccecerieeriinrnianns 13-7
Next (Unretrieved List).......cccoecriinrnnns 5-3
(o)
One-Shot Mail ........ccvemrvcmrssnrssnnnsanns 3-16
Open LinK... e 4-8
Option Settings .....cccuecervvemrisnrsssnnninns 3-10
[O11] 1 ¢To ) G, 4-2, 4-19
OVerwrite TYPe ....ccvvererrssmssmsssensnssnnnnas 7-5
P
Pause Application........c.ccovserirernianns 12-2
Phone Book (saving t0) ......ccceecerienranes 4-7
Pictograph List.......cccooiriieriniinninanne 16-8
o | 3-10
PIN Filter ......cceviierrinrnnescsenss s 6-3
PIN Setting ......cooveerimrmrenseneseseseseas 6-3
Playback Volume (V-Application)..... 12-2
2o 1113 T 3-11, 6-6
Privacy Level ........ccovevrimnicennienninens 3-11
Protect Message........cccuvmmrermnsenrssannnnas 4-9
R
Reacquire..........ccoeervmnsmnsenisesinnssnnssnninns 9-2
Recipient Type.......ccceeiriiericrinncnnnn, 3-11
Reject List......cccovrvmrninmnsnnssnnnennsennnnes 6-4
Reply 10 All ... 4-6
Resend ......cccvmrnemrnn s 4-7
Reset .....ccccvimiinieninen 6-7, 9-5, 12-3, 15-4
Retrieve All (Server Mail).........ccevcureuee 5-2
Retrieve all Mail (Unretrieved List) ..... 5-3
Return Mail........coovvmnmninnierinnennenns 4-6
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S
Saved Information..........ccocveeerinrnnne 14-2
Save & Send Image........ccecrrrmrinnninnes 6-3
Save As Wallpaper............. 4-21, 8-6, 14-4
Save Auto Send........ccceeeeirnnierneninnnns 3-12
Save Dictionary........ccvecrrirrrnsnrssnnnans 8-8
Save Info Number .......ccccvveveceniicncnns 15-3
Save to Accumulate.........ccoereeriniiennnes 8-2
Save to Text Memo ......cccccveerernn 9-2, 15-2
Saved Information (checking)........... 14-2
Saved Information (deleting) ............ 14-2
Saved Information (saving) e 14-2
Screen Savers ......cooceeeeeerssmeensnes 9-3, 15-3
Screen Scroll.... ... 9-2,15-2
Scroll Unit......cccecerismsmnsnnennessssssnnens 4-5
Secret Mode...... 4-15
ST (=T o1 g [0 o o 8-4
Send Mail ...... .4-8
EST=T 3T LY 6-5
EST=Y 3 4-2
Sent Auto Sort.......cccevveerrinrnsnnnanens 4-17
Sent Mail .....c.evecereecrercerrce s 35
L5111 3-6
Server Address .......cccoceeerrsncanennans 3-6, 9-5
Set Display Size ........coceeerrernrnne 9-2,15-2
Set Info Number ........ccccevrnnierinriannne 14-5
Set Priority....ccccocmveriininiienienans 3-11,6-5
Set to Flash (V-Application).............. 12-3
Sha-mail Shoot.........ccceenimnierinisiniiens 39
Short Message .........ccocuvmnemnerinnnsninns 6-7
Show AdAress......cccoeerreerrssnrssnnssannns 4-23
Show MesSSage ......cceerrrmrrsmnrssansssannns 12-2
Side Key..rcsresenisese s i
Sky Mail......cooeeeereerereremreerenenens 1-2,3-3
SKy Melody ......ccceemrnmrrnsnrssnsssannns 1-2, 2-7
SMAF (MA-2) Format ........ccceceeeameenennee 3-8
SMAF (MA-3) Format .... . 3-8
Sound Auto Play............ 4-22
sound files (saving)...... .. 8-7
Space TOWN......ccccevirvmrsnsesse e 8-2
Standby Display............... v 14-4
Standby V-Application..... e 11-3
Station.......cceeveerieriaene e 13-4
Station (disabling)........cccuverriseiisnrinns 1-5
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Station (resetting).......cccvemriernsersinrans 15-4

Storage TYPe....corrrmrrsserrssunsssannsans 7-6, 8-2
Sub AdAress .......cccrrmnimnneensnsse s 3-6
T
Text ONlY .. 9-3
To Long Mail ......ccocrvvemriernssennssennnannnnas 3-7
U

Unread Messages (Web)....
Update Frequency..............
URL log (accessing from).........cccueuenne
Vv
V-Application ........ccccoeevmmrrnnnsnnssnnnnas 10-4
V-Application (deleting) .........ccceueuues 11-2
V-Application (downloading)............. 10-4
V-Application (exiting or pausing)....10-6
V-Application (resetting)..........cccceuen 12-3
V-Application (resuming).......ccceeeernes 10-6
V-Application (starting)........cc.cceeeerueen 10-5
Vibration (V-Application) .................. 12-2
Vodafone live! (disabling).......cccccrsunns 1-5
Vodafone Web.........cccucemiieminsenrssnnnianns 7-6
w
LT 7-4
Weather Forecast ............ccviiiieninnnns 14-5
Weather Indicator ..........cceecernierniaennne 14-4
Web (disabling).....cccoerurernreenseessnnnnnas 1-5
Web (resetting) .....cccocnremnnennisennianninas 9-5
Work Type information (Web) ............. 7-6

Customer Service

If you have questions about Vodafone handsets or services, please call General
Information. For repairs, please call Customer Assistance.

Vodafone Customer Centers

From a Vodafone handset, dial toll free at
157 for General Information or
113 for Customer Assistance

H Call these numbers toll free from landlines

Subscription Area

Service Center

Phone Number

Fukushima, Niigata, Tokyo, Kanagawa, Chiba,
Saitama, Ibaraki, Tochigi, Gunma, Yamanashi,
Nagano, Toyama, Ishikawa, Fukui

Hokkaido, Aomori, Akita, lwate, Yamagata, Miyagi,

General Information

@ 0088-240-157

Customer Assistance

@ 0088-240-113

Aichi, Gifu, Mie, Shizuoka

General Information

@) 0088-241-157

Customer Assistance

@ 0088-241-113

Osaka, Hyogo, Kyoto, Nara, Shiga, Wakayama

General Information

@ 0088-242-157

Customer Assistance

@ 0088-242-113

Hiroshima, Okayama, Yamaguchi, Tottori, Shimane

General Information

@ 0088-259-157

Customer Assistance

@ 0088-259-113

Tokushima, Kagawa, Ehime, Kochi

General Information

@ 0088-247-157

Customer Assistance

@ 0088-247-113

Kagoshima, Okinawa

Fukuoka, Saga, Nagasaki, Oita, Kumamoto, Miyazaki,

General Information

@® 0088-250-157

Customer Assistance

@ 0088-250-113
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V302SH Instruction Manual
Vodafone live!

October 2005, First Edition
Vodafone K.K.

For additional information, please visit a Vodafone shop.

Model: V302SH
Manufacturer: SHARP Corporation

Please help the mobile industry maintain high environmental
standards. Recycle your old handsets, batteries and charger
# units (all manufacturers and brands). Before you recycle,
evusonasko-o  please remember these important points:
RTETEEE - eHandset, batteries and chargers submitted for recycling cannot be
returned.
eAlways be sure to erase all data recorded on old handsets (Phone
Book entries, call records, mail, etc.) before recycling.





